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Safety messages

Safety messages are provided throughout this manual to protect personnel and equipment. Read each safety message carefully
before proceeding to the next step.

Other information

Full product specifications can be found in the product data sheet. Troubleshooting information can be found in the configuration
manual. Product data sheets and manuals are available from the Micro Motion web site at www.emerson.com.

Return policy

Follow Micro Motion procedures when returning equipment. These procedures ensure legal compliance with government
transportation agencies and help provide a safe working environment for Micro Motion employees. Micro Motion will not accept
your returned equipment if you fail to follow Micro Motion procedures.

Return procedures and forms are available on our web support site at www.emerson.com, or by phoning the Micro Motion
Customer Service department.

Emerson Flow customer service

Email:

• Worldwide: flow.support@emerson.com
• Asia-Pacific: APflow.support@emerson.com

Telephone:

North and South America Europe and Middle East Asia Pacific

United States 800-522-6277 U.K. 0870 240 1978 Australia 800 158 727

Canada +1 303-527-5200 The Netherlands +31 (0) 704 136
666

New Zealand 099 128 804

Mexico +41 (0) 41 7686
111

France 0800 917 901 India 800 440 1468

Argentina +54 11 4837 7000 Germany 0800 182 5347 Pakistan 888 550 2682

Brazil +55 15 3413 8000 Italy 8008 77334 China +86 21 2892 9000

Central & Eastern +41 (0) 41 7686
111

Japan +81 3 5769 6803

Russia/CIS +7 495 981 9811 South Korea +82 2 3438 4600

Egypt 0800 000 0015 Singapore +65 6 777 8211

Oman 800 70101 Thailand 001 800 441 6426

Qatar 431 0044 Malaysia 800 814 008

Kuwait 663 299 01

South Africa 800 991 390

Saudi Arabia 800 844 9564

UAE 800 0444 0684

2 

http://www.emerson.com
http://www.emerson.com
mailto:flow.support@emerson.com
mailto:APflow.support@emerson.com


Contents

Chapter 1 Before you begin ........................................................................................................... 7
1.1 About this manual ........................................................................................................................... 7

1.2 Transmitter model code .................................................................................................................. 7

1.3 Profibus-PA functionality ................................................................................................................. 7

1.4 Determining version information ....................................................................................................  8

1.5 Communication tools .....................................................................................................................  9

1.6 Additional documentation and resources ........................................................................................ 9

Chapter 2 Startup .......................................................................................................................  11
2.1 Applying power ............................................................................................................................. 11

2.2 Setting the node address ..............................................................................................................  11

2.3 Setting the IO mode ...................................................................................................................... 11

2.4 Make a startup connection to the transmitter ...............................................................................  13

2.5 Verify the zero ............................................................................................................................... 13

Chapter 3 Introduction to configuration and commissioning ......................................................  17
3.1 Planning the configuration ............................................................................................................ 17

3.2 Pre-configuration worksheet ......................................................................................................... 19

3.3 Restoring a working configuration ................................................................................................  19

Chapter 4 Configuration .............................................................................................................  21
4.1 Overview ....................................................................................................................................... 21

4.2 Default target mode .....................................................................................................................  21

4.3 Configuration map ........................................................................................................................ 21

4.4 Configuring the analog input function block channels ................................................................... 23

4.5 Configuring the totalizer block mode ............................................................................................  25

4.6 Configuring standard volume flow measurement for gas ..............................................................  27

4.7 Changing the measurement units .................................................................................................  29

4.8 Configuring the petroleum measurement application ..................................................................  34

4.9 Configuring the concentration measurement application .............................................................  37

4.10 Changing the output scale ..........................................................................................................  40

4.11 Changing process alerts ..............................................................................................................  41

4.12 Configuring alert status severity .................................................................................................. 44

4.13 Changing the damping values .....................................................................................................  47

4.14 Changing two-phase flow (slug flow) limits and duration ............................................................  49

4.15 Configuring cutoffs .....................................................................................................................  50

4.16 Changing the measurement mode parameter ............................................................................  51

4.17 Configuring sensor parameters ...................................................................................................  52

4.18 Configuring the display ...............................................................................................................  53

Configuration and Use Manual  Contents
20000327 October 2018

Configuration and Use Manual  3



4.19 Enabling LD optimization ............................................................................................................  59

4.20 Configuring pressure compensation ...........................................................................................  59

4.21 Configuring temperature compensation ..................................................................................... 62

Chapter 5 Configure device options and preferences ................................................................... 65
5.1 Configure the transmitter display .................................................................................................. 65

5.2 Enable or disable operator actions from the display ......................................................................  68

5.3 Configure security for the display menus ......................................................................................  70

5.4 Configure alert handling ...............................................................................................................  71

5.5 Configure informational parameters .............................................................................................  74

Chapter 6 Complete the configuration ........................................................................................  77
6.1 Test or tune the system using sensor simulation ...........................................................................  77

6.2 Back up transmitter configuration ................................................................................................. 79

Chapter 7 Transmitter operation ................................................................................................  81
7.1 Record the process variables .........................................................................................................  81

7.2 Viewing process variables .............................................................................................................  81

7.3 I&M functions ................................................................................................................................ 82

7.4 Using sensor simulation mode ......................................................................................................  83

7.5 Accessing diagnostic information with a PROFIBUS host ...............................................................  83

7.6 Viewing transmitter status and alerts ............................................................................................  83

7.7 View and acknowledge status alerts .............................................................................................. 85

7.8 Using the totalizers and inventories ..............................................................................................  88

7.9 Read totalizer and inventory values ...............................................................................................  90

7.10 Start and stop totalizers and inventories .....................................................................................  91

7.11 Reset totalizers ...........................................................................................................................  92

7.12 Reset inventories ........................................................................................................................  93

Chapter 8 Measurement support ................................................................................................  95
8.1 Options for measurement support ................................................................................................  95

8.2 Calibration ....................................................................................................................................  95

8.3 Comparison and recommendations ..............................................................................................  96

8.4 Use Smart Meter Verification (SMV) ..............................................................................................  97

8.5 Zero the meter ............................................................................................................................ 107

8.6 Meter validation and meter factors .............................................................................................  109

8.7 Performing density calibration ....................................................................................................  112

Chapter 9 Troubleshooting .......................................................................................................  119
9.1 Guide to troubleshooting topics .................................................................................................  119

9.2 Transmitter does not operate .....................................................................................................  119

9.3 Transmitter does not communicate ............................................................................................  119

9.4 Function blocks in OOS mode .....................................................................................................  119

9.5 Zero or calibration failure ............................................................................................................  120

9.6 Output problems ........................................................................................................................  120

Contents Configuration and Use Manual
October 2018 20000327

4  Micro Motion Model 2700 Transmitters with PROFIBUS-PA



9.7 Status alerts ................................................................................................................................  125

9.8 Diagnosing wiring problems .......................................................................................................  131

9.9 Checking two-phase flow (slug flow) ........................................................................................... 132

9.10 Obtaining and checking the diagnostic variables ....................................................................... 132

9.11 Checking the core processor .....................................................................................................  135

9.12 Checking sensor coils and RTD ..................................................................................................  140

Appendix A Flow meter installation types and components .........................................................  147

Appendix B Using the transmitter display ....................................................................................  159
B.1 Components of the transmitter interface ....................................................................................  159

B.2 Use the optical switches ..............................................................................................................  159

B.3 Access and use the display menu system ....................................................................................  159

B.4 Display codes for process variables .............................................................................................  164

B.5 Codes and abbreviations used in display menus ..........................................................................  165

B.6 Display menus ............................................................................................................................. 168

Appendix C Using ProLink III with the transmitter ........................................................................ 175
C.1 Basic information about ProLink III ..............................................................................................  175

C.2 Connect with ProLink III ..............................................................................................................  176

Appendix D PROFIBUS-PA status byte ..........................................................................................  179

Appendix E Slave diagnostic response bytes ................................................................................  185

Appendix F Model 2700 PROFIBUS block parameters ................................................................... 195
F.1 Slot identification ........................................................................................................................  196

F.2 Physical block ..............................................................................................................................  197

Appendix G NE53 history .............................................................................................................  391

Configuration and Use Manual  Contents
20000327 October 2018

Configuration and Use Manual  5



Contents Configuration and Use Manual
October 2018 20000327

6  Micro Motion Model 2700 Transmitters with PROFIBUS-PA



1 Before you begin

1.1 About this manual
This manual helps you configure, commission, use, maintain, and troubleshoot
Micro Motion Model 2700 transmitters with PROFIBUS-PA.

Important
This manual assumes that the following conditions apply:
• The transmitter has been installed correctly and completely according to the

instructions in the transmitter installation manual
• The installation complies with all applicable safety requirements
• The user is trained in local and corporate safety standards

1.2 Transmitter model code
You can verify that this manual pertains to your transmitter by ensuring the model code
on the transmitter tag matches the format.

Example:

The transmitter has a model number of the following form: 2700(***/G/*/*/*/*/*).

G Output Option Code of PROFIBUS-PA

1.3 Profibus-PA functionality
The transmitter supports the following methods of configuration and operation:

• Configuration methods:
— Enhanced Device Description (EDD) language for use with a PROFIBUS

configuration tool such as Siemens ® Simatic ® Process Device Manager (PDM). In
this manual, the term "EDD" is used to refer to this type of configuration

— FDT/DTM technology for use with DTM files that run inside a frame application
(FDT) such as PACTware®

— Direct read and write of PROFIBUS-PA bus parameters
• Operation methods:

— GSD file with a PROFIBUS host, which is used to get the definition of the cyclic
process variables that the host uses.
The transmitter supports two GSD options--

1. Profile-specific, which is created by PNO
2. Manufacturer-specific, which is created by Micro Motion in order to

implement a larger set of function blocks.

Note
The GSD file archive from the Emerson website contains both types of GSD files.

See Setting the IO mode for more information about the two GSD options.
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In this manual, the term "host" or "PROFIBUS host" is used to refer to this type of
operation.

• Enhanced Configuration tool Device Description (EDD) files. The device description file
provides operation and configuration capabilities.
Specific manufacturers use different configuration tools. Here are the three that Micro
Motion supplies:

1. Enhanced Device Description Language (EDDL) files, which are used by the AMS
Device Manager configuration tool.

2. PDM files, which are used by Simatic PDM software configuration tool.
3. DTM files, which are used by FDT frame applications like PACTware for

configuration purposes.
• Identification and maintenance (I&M) functions:

— I&M 0
— I&M 1
— I&M 2
— PA I&M 0
The transmitter supports both classic and condensed status byte formats. (Refer to
PROFIBUS-PA status byte).

• Class mode conforms to the PROFIBUS-PA Profile v3.01, Section 3.7.3.6
• Condensed mode conforms to the PROFIBUS-PA Specification June 2005 Amendment

2 to the PROFIBUS Profile v3.01, Condensed Status and Diagnostic Messages v1.0.

1.4 Determining version information
The following table lists the version information you may need to know and describes how
to obtain the information. Make sure you have the latest versions of the transmitter and
ProLink III.

Note
The hardware for transmitters with v2.x and lower firmware is incompatible with the
hardware needed to support v3.0 and higher firmware. To upgrade from an earlier
firmware version to v3.0 or higher firmware requires hardware replacement.

Table 1-1: Communication tools for Model 2700 transmitter with PROFIBUS-PA

Component Tool Method

Transmitter software With ProLink III Device Tools > Device Information > Transmitter Electronics >
Software Revision

With EDD Overview > Device Information > Revision > Software

With display OFF-LINE MAINT > SWRev

Core processor

software

With ProLink III Device Tools > Device Information > Enhanced Core Processor
> Software Revision

With EDD Not available

With display OFF-LINE MAINT > SWRev

ProLink III With ProLink III Help > About ProLink III
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Table 1-1: Communication tools for Model 2700 transmitter with PROFIBUS-PA (continued)

Component Tool Method

GSD version Text editor Open fileV4x_057A.gsd or PA139742.GSD and check
parameter GSD_REVISION

EDD version With EDD Overview > Device Information > Revision > DD

Both EDD and DTM files can be downloaded from http://www.emerson.com/en-us/
support/software-downloads-drivers. Search for Device Install Kits to access the "Search
For DD, DTM, and GSD Files" page.

You can find the Commissioning MVD Profibus PA Documentation Supplement at http://
www.emerson.com/documents/automation/commissioning-mvd-profibus-pa-
en-64054.pdf. This supplement assists you with connecting to the transmitter with
Siemens Simatic® Process Device Manager (PDM).

Basic information on using the display is provided in Using the transmitter display.

1.5 Communication tools
Most of the procedures described in this manual require the use of a communication tool.
The following table lists the communication tools that can be used, as well as their
functionality and requirements.

Note
You can use ProLink III, the EDD, or PROFIBUS bus parameters for transmitter setup and
maintenance. It is not necessary to have more than one of these methods available.

Table 1-2: Communication tools for Model 2700 transmitter with PROFIBUS-PA

Tool View/

operation

Setup/maintenance Requirements

Transmitter display Partial Partial Setup/Maintenance Transmitter with display

ProLink III Full Full ProLink III v3.2 or later

Host Partial None GSD file V4x_057A.gsd or PA139742.GSD

EDD Full Full PDM file set

DTM Full Full DTM file set

Bus parameters Full Full None

Basic information on using the display is provided in Using the transmitter display.

1.6 Additional documentation and resources
Topic Document

Connecting the transmitter to Simatic PDM Commissioning MVD Profibus PA Documentation
Supplement
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Topic Document

Hazardous area installation See the approval documentation shipped with
the transmitter, or download the appropriate
documentation at www.emerson.com.

Product Data Sheet Micro Motion Series 1000 and Series 2000
Transmitters with MVD™ Technology Product Data
Sheet

Sensor Sensor documentation

Transmitter installation Micro Motion®  Model 1700 and 2700 Installation
Manual

All documentation resources are available at www.emerson.com or on the user
documentation DVD.
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2 Startup

2.1 Applying power
Before you apply power to the flow meter, close and tighten all housing covers.

  DANGER
Operating the flow meter without covers in place creates electrical hazards that can
cause death, injury, or property damage. Make sure all covers are in place before
applying power to the transmitter.

Turn on the electrical power at the power supply. The flow meter will automatically
perform diagnostic routines. If the transmitter has a display, the status LED will turn green
and begin to flash when the transmitter has finished its startup diagnosis.

Note
If this is the initial startup, or if power has been off long enough to allow components to
reach ambient temperature, the flow meter is ready to receive process fluid approximately
one minute after power-up. However, it may take up to ten minutes for the electronics in
the flow meter to reach thermal equilibrium. During this warm-up period, you may
observe minor measurement instability or inaccuracy.

2.2 Setting the node address
The factory default for the node address is 126. To set the node address:

• With the display, choose OFF-LINE > CONFG > ADDRESS PBUS.
• With Prolink III, choose Device Tools > Configuration > Communications > Profibus-

PA.
• With a PROFIBUS host, use the change address function of the host.

2.3 Setting the IO mode
The transmitter can function in two different Modes: Profile-specific and Manufacturer-
Specific. The factory default is Manufacturer-specific.

About this task

The two modes control which function blocks are available for use, and whether the
format of the status byte is "classic" or condensed". (Defined in more detail in PROFIBUS-PA
status byte.)

• In Profile-specific mode, the transmitter has the use of three AI blocks and one totalizer
block. The status byte output format defaults to classic mode.

• In Manufacturer-specific mode, the transmitter has the use of four AI blocks, four
totalizer blocks, and two AO blocks. The status byte output format defaults to
condensed mode.

Table 2-1 shows the slot identifications and blocks permitted by each mode.
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Note
You must select modules exactly as described in the table, or select an empty module for
slots that you do not intend to use. If any modules are left unconfigured, the transmitter
will not send data.

Table 2-1: I/O mode slot configuration

Slot Profile-specific mode Manufacturer-specific mode

1 AI 1 AI 1

2 AI 2 AI 2

3 AI 3 AI 3

4 Totalizer 1 Totalizer 1

5 AI 4

6 Totalizer 2

7 Totalizer 3

8 Totalizer 4

9 AO 1

10 AO 2

To set the I/O mode of the transmitter:

There are two GSD files that correspond to the two I/O modes. If you are using a PROFIBUS
host with GSD files to operate the transmitter, you must use the GSD that corresponds to
the I/O mode you have chosen. The following table lists the GSD files names. Load the
correct GSD file into your PROFIBUS host or configuration tool.

Note
If you use the local display, the Ident number is the only available option.

Table 2-2: PROFIBUS GSD file names

Name Ident number GSD file name

Profile specific 0 PA139742.GSD

Manufacturer specific 1 V4x_057A.gsd

Note
Set the I/O mode in the Physical Block before loading the GSD files.

Procedure

1. Determine the method you are using to set the I/O mode in the Physical Block.
• If you are using EDD files, go to Step 2.
• If you are using bus parameters, go to Step 3.
• If you are using the local display, go to Step 5.

2. From the EDD, choose MMI Coriolis Flow > Physical Block > Device and specify
the Ident Number.
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3. For bus parameters, select I/O Mode .

4. Then select Block; Physical Block (Slot 0) Index: 40 (identification number
selector)

5. From the display, go to the Config section to Ident SEL and specify either 0 or 1.
Refer to Figure B-3.

2.3.1 Overriding the status byte format
Each I/O mode has a default status byte format -- classic or condensed.

About this task

For more information about status byte format, refer to PROFIBUS-PA status byte.

Use the following procedure to override this format. To set the I/O mode of the
transmitter:

Procedure

1. Determine the method you are using to set the I/O mode:
• If you are using EDD files, go to Step 2.
• If you are using bus parameters, go to Step 4.

2. From the EDD, choose MMI Coriolis Flow > Physical Block > Features supported.

3. Go to Condensed Status and make the change.

4. For bus parameters, select Status byte format .

5. Then select Block; Physical Block 1 (Slot 0) Index: 43 (Condensed status
diagnostics).

2.4 Make a startup connection to the transmitter
About this task

For all configuration tools except the display, you must have an active Profibus connection
to the transmitter for configuration purposes.

2.5 Verify the zero
Verifying the zero helps you determine if the stored zero value is appropriate to your
installation, or if a field zero can improve measurement accuracy.

About this task

The zero verification procedure analyzes the Live Zero value under conditions of zero flow,
and compares it to the Zero Stability range for the sensor. If the average Live Zero value is
within a reasonable range, the zero value stored in the transmitter is valid. Performing a
field calibration will not improve measurement accuracy.

Important
In most cases, the factory zero is more accurate than the field zero. Do not zero the meter
unless one of the following is true:
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• The zero is required by site procedures.
• The stored zero value fails the zero verification procedure.

Procedure

1. Allow the flowmeter to warm up for at least 20 minutes after applying power.

2. Run the process fluid through the sensor until the sensor temperature reaches the
normal process operating temperature.

3. Stop flow through the sensor by shutting the downstream valve, and then the
upstream valve if available.

4. Verify that the sensor is blocked in, that flow has stopped, and that the sensor is
completely full of process fluid.

5. From ProLink III, choose Device Tools > Calibration > Zero Verification and
Calibration > Verify Zero and wait until the procedure completes.

6. Observe the drive gain, temperature, and density readings. If they are stable, check
the Live Zero or Field Verification Zero value. If the average value is close to 0, you
should not need to zero the meter.

7. If the zero verification procedure fails:

a) Confirm that the sensor is completely blocked in, that flow has stopped, and
that the sensor is completely full of process fluid.

b) Verify that the process fluid is not flashing or condensing, and that it does
not contain particles that can settle out.

c) Remove or reduce sources of electromechanical noise if appropriate.
d) Repeat the zero verification procedure.
e) If it fails again, zero the meter.

Postrequisites

Restore normal flow through the sensor by opening the valves.

Related tasks

Zero the meter

2.5.1 Terminology used with zero verification and zero
calibration

Term Definition

Zero In general, the offset required to synchronize the left pickoff and the right
pickoff under conditions of zero flow. Unit = microseconds.

Factory Zero The zero value obtained at the factory, under laboratory conditions.

Field Zero The zero value obtained by performing a zero calibration outside the
factory.

Prior Zero The zero value stored in the transmitter at the time a field zero calibration
is begun. May be the factory zero or a previous field zero.
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Term Definition

Manual Zero The zero value stored in the transmitter, typically obtained from a zero
calibration procedure. It may also be configured manually. Also called
“mechanical zero” or “stored zero”.

Live Zero The real-time bidirectional mass flow rate with no flow damping or mass
flow cutoff applied. An adaptive damping value is applied only when the
mass flow rate changes dramatically over a very short interval. Unit =
configured mass flow measurement unit.

Zero Stability A laboratory-derived value used to calculate the expected accuracy for a
sensor. Under laboratory conditions at zero flow, the average flow rate is
expected to fall within the range defined by the Zero Stability value (0 ±
Zero Stability). Each sensor size and model has a unique Zero Stability
value. Statistically, 95% of all data points should fall within the range
defined by the Zero Stability value.

Zero Calibration The procedure used to determine the zero value.

Zero Time The time period over which the Zero Calibration procedure is performed.
Unit = seconds.

Field Verification Zero A 3-minute running average of the Live Zero value, calculated by the
transmitter. Unit = configured mass flow measurement unit.

Zero Verification A procedure used to evaluate the stored zero and determine whether or
not a field zero can improve measurement accuracy.
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3 Introduction to configuration and
commissioning

3.1 Planning the configuration
Refer to the configuration overview flowchart below to plan transmitter configuration. In
general, perform configuration steps in the order shown here.

Note
Depending on your installation and application, some configuration tasks may be
optional. This manual provides information on topics that are not included in the
configuration overview flowchart, such as using the transmitter, troubleshooting, and
calibration procedures. Be sure to review these topics as required.
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3.2 Pre-configuration worksheet
The pre-configuration worksheet provides a place to record information about your flow
meter and your application. This information will affect your configuration options as you
work through this manual. You may need to consult with transmitter installation or
application process personnel to obtain the required information.

If you are configuring multiple transmitters, make copies of this worksheet and fill one out
for each individual transmitter.

Table 3-1: Pre-configuration worksheet for transmitters and sensors

Transmitter Sensor

Model code Model code

Serial number Serial number

Software version

Node Address

Table 3-2: Pre-configuration worksheet for transmitter -- measurement units for
enumerated process variables

Measurement units

Mass flow Volume flow

Density Temperature

External Pressure

Table 3-3: Pre-configuration worksheet for transmitter -- installed applications

Installed applications

Meter verification software ☐

Petroleum measurement application ☐

Concentration measurement application ☐

3.3 Restoring a working configuration
At times it may be easier to start from a known working configuration than to
troubleshoot the existing configuration. To do this, you can::

• Restore a configuration file saved through ProLink III, if one is available. In ProLink III,
select Device Tools > Configuration Transfer > Save Load Configuration Data > Load
.

• Restore the factory configuration (ProLink III v2.6 or later required; transmitter must be
connected to an enhanced core processor). In ProLink III, select Device Tools >
Configuration Transfer > Restore Factory Configuration.

Neither of these methods will restore all of the transmitter’s configuration. For example,
neither method will restore the configuration of the AI, AO, and totalizer function blocks.
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Using the restore factory configuration option will also not restore such things as the
configuration of the display.
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4 Configuration

4.1 Overview
This chapter describes how to change the operating settings of the transmitter.

Note
All procedures provided in this chapter presume that you have established communication
with the transmitter and that you are complying with all applicable requirements. Refer to
Using ProLink III with the transmitter for the documentation for your PROFIBUS host or
configuration tool.

4.2 Default target mode
The default target mode for all blocks is Auto. It is not necessary to set blocks to
Out-of-Service (OOS) mode before changing the parameters described in this chapter.

4.3 Configuration map
Use the map in the following table to guide you through either a complete or partial
configuration of the transmitter.

Table 4-1: Configuration map

Topic Method Section

Display ProLink III EDD

Analog input
function
block

✓ ✓ Configuring the analog input
function block channels

Totalizer
block mode

✓ ✓ Configuring the totalizer block
mode

Gas
standard
volume

✓ ✓ Configuring standard volume flow
measurement for gas

Measureme
nt units

✓ ✓ ✓ Changing the measurement units

Petroleum

measurem
ent

application

✓ ✓ Configuring the petroleum
measurement application
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Table 4-1: Configuration map (continued)

Topic Method Section

Display ProLink III EDD

Concentrat
ion

measurem
ent

application

✓ ✓ Configuring the concentration
measurement application

Output scale ✓ Changing the output scale

Process
alerts

✓ Changing process alerts

Alert
severity

✓ ✓ Configuring alert status severity

Damping ✓ ✓ Changing the damping values

Two-phase-
flow

✓ ✓ Changing two-phase flow (slug flow)
limits and duration

Cutoffs ✓ ✓ Configuring cutoffs

Measureme
nt mode

✓ ✓ Changing the measurement mode
parameter

Sensor
parameters

✓ ✓ Configuring sensor parameters

Display
functionality

✓ ✓ ✓ Configuring the display

LD
optimization

✓ ✓ Enabling LD optimization

Pressure
compensati
on

✓ ✓ ✓ Configuring pressure compensation

Temperatur
e
compensati
on

✓ ✓ ✓ Configuring temperature
compensation
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4.4 Configuring the analog input function block
channels
You can set each of the transmitter's analog input (AI) function blocks to measure one
transducer block channel.

About this task

The AI blocks are set at the factory to a default setting that is adequate for most
applications, but you can change the assignments of the AI blocks to meet special needs.

Make sure the transducer block engineering units match the AI engineering units and the
Analog Output (AO) engineering units so you do not receive a Configuration Error and so
the AI block does not remain Out of Service (OOS). (Refer to Function blocks in OOS
mode .)

The following table shows the default channel configuration for each block.

Table 4-2: Default channel configuration

Block Default channel Default units

AI 1 Mass flow g/s

AI 2 Temperature degC

AI 3 Volume flow l/s

AI 4 Density g/cm3

The following table shows the available transducer block channels.

Table 4-3: Analog Input block channel assignment options

Channel value Process variable

Slot Index Value

11 (0x0B) 17 (0x11) 0x0B11 Volume flow

11 (0x0B) 21 (0x15) 0x0B15 Mass flow

11 (0x0B) 25 (0x19) 0x0B19 Density

11 (0x0B) 29 (0x1D) 0x0B1D Temperature

11 (0x0B) 64 (0x40) 0x0B40 Gas Standard Volume Flow

11 (0x0B) 114 (0x072 0x0B72 Pressure

11 (0x0B) 160 (0xA0) 0x0BA0 Drive Gain

12 (0x0C) 29 (0x1D) 0x0C1D API Corrected Density

12 (0x0C) 30 (0x1E) 0x0C1E API Corrected Volume Flow

12 (0x0C) 31 (0x1F) 0x0C1F API Average Corrected Density

12 (0x0C) 32 (0x20) 0x0C20 API Average Corrected Temp

12 (0x0C) 33 (0x21) 0x0C21 API CTL
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Table 4-3: Analog Input block channel assignment options (continued)

Channel value Process variable

Slot Index Value

12 (0x0C) 47 (0x2F) 0x0C2F ED Reference Density

12 (0x0C) 48 (0x30) 0x0C30 ED Specific Gravity

12 (0x0C) 49 (0x31) 0x0C31 ED Standard Volume Flow

12 (0x0C) 50 (0x32) 0x0C32 ED Net Mass Flow

12 (0x0C) 51 (0x33) 0x0C33 ED Net Volume Flow

12 (0x0C) 52 (0x34) 0x0C34 ED Concentration

12 (0x0C) 53 (0x35) 0x0C35 ED Baume

To configure the AI function block channels, use the following procedure.

Note
You must also change the Transducer block unit's code. If the two unit's codes do not
match, it results in an error. For more information on modifying the Transducer block
units, refer to Configuring the totalizer block mode.

Note
With Prolink III there is no option to change the transducer scale engineering units, so you
must use one of the other methods to make that change.

Procedure

1. Determine the method you are using to configure the AI function block channels:
• If you are using EDD files, go to Step 2.
• If you are using bus parameters, go to Step 4.
• If you are using ProLink III, go to Step 5.
• If you are using the display, go to Step 9.

2. From the EDD, choose MMI Coriolis Flow > Function Block.

3. For using EDD:

Option Description

For Analog Input Block
(Slots 1 through 4):

a. Select Analog Input 1...4 > General.
b. Select Channel.
c. Select Out Scale Units Index.

For Analog Output Block

(Slots 1 and 2):

a. Analog Output 1...2 > Parameters >
OutScale.

b. Select Out Scale Units Index.

4. For bus parameters:
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Option Description

For Channel: a. Select

Block Analog Input Block (Slots 1, 2, 3, and 5)

Index 30 (transducer block channel)

.

For AI Block units: a. Select

Block Analog Input Block (Slots 1, 2, 3, and 5)

Index 28, Parameter 3 (units index)

.

For AO Block units a. Select

Block Analog Output Block (Slots 9 and 10)

Index 27, Parameter 3 (units index)

.

5. From ProLink III, select Device Tools > Configuration > Communications >
Profibus-PA.

6. Select a channel for each AI function block.

7. Select units for each AI and AO function block.

8. Click Apply.

9. From the display, select CONFIG-AI > A1 CHAN, scroll to AI1 Units and modify as
needed.

10. Select AI2 CHAN, scroll to AI2 Units and modify as needed.

11. Select AI3 CHAN, scroll to AI3 Units and modify as needed.

12. Select AI4 CHAN, scroll to AI4 Units and modify as needed.

4.5 Configuring the totalizer block mode
About this task

The behavior of the four totalizer function blocks can be configured in two ways:

• Standard configuration provides standard PROFIBUS totalizer function block behavior.
In this mode, the totalizer block integrates the data received from the transmitter
transducer block. The Out value of a totalizer in this mode will not match the totalizer
data reported by the transducer block, ProLink III, or the display.

• Internal configuration modes using one of the options in the table below cause the
totalizer function block to pass through the specified totalizer value from the
transducer block;
Internal configuration mode is recommended for improved accuracy and to avoid
mismatches between the totalizer block, Prolink, and the display.
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For more information about the four totalizer function blocks, refer to Model 2700
PROFIBUS block parameters.

Table 4-4: Totalizer selection options

Value Operation mode

0 Standard (Profile Specific)

1 Internal Mass Total

2 Internal Volume Total

3 Internal Mass Inventory

4 Internal volume inventory

5 Internal GSV Total

6 Internal GSV Inventory

7 Internal API CorrVol Total

8 Internal API CorrVol Inventory

9 Internal ED_StdVolTotal

10 Internal ED_StdVollnv

11 Internal ED_NetMassTotal

12 Internal ED_NetMassInv

13 Internal ED_NetVolTotal

14 Internal ED_NetVollnv

Use the following procedure to configure the totalizer block mode:

Procedure

1. Determine the method you are using to set the I/O mode:
• If you are using the EDD, go to Step 2.
• If you are using bus parameters, go to Step 6.
• If you are using the display, go to Figure B-9.

2. From the EDD, choose MMI Coriolis Flow > Function Block.

3. Depending upon which totalizer value you are modifying, select one of the
following:

Option Description

Totalizer 1 Totalizer 1 > Parameter

Totalizer 2 Totalizer 2 > Parameter

Totalizer 3 Totalizer 3 > Parameter

Totalizer 4 Totalizer 4 > Parameter
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4. Go to Integration Function Block.

5. Make your selection.

6. For bus parameters, select one of the following:

Option Description

Totalizer 1 Mode > Block: Totalizer 1 (Slot 4) Index: 52

Totalizer 2 Mode > Block: Totalizer 1 (Slot 4) Index: 52

Totalizer 3 Mode > Block: Totalizer 1 (Slot 4) Index: 52

Totalizer 4 Mode > Block: Totalizer 1 (Slot 4) Index: 52

7. Set to the mode value from Table 4-4.

8. From the display, select CONFIG TOT > TOT1 MODE > TOT1 CHAN > TOT1 Units.

9. Repeat Step 8 for values 2 through 4 as needed.

4.6 Configuring standard volume flow
measurement for gas
Two types of volume flow measurement are available:

• Liquid volume (the default)
• Gas standard volume

Only one type of volume flow measurement can be performed at a time (which means if
liquid volume flow measurement is enabled, gas standard volume flow measurement is
disabled). Different sets of volume flow measurement units are available, depending on
which type of volume flow measurement is enabled. If you want to use a gas volume flow
unit, additional configuration is required.

Note
If you use the petroleum measurement application or the concentration measurement
application, liquid volume flow measurement is required.

To configure gas standard volume flow you must:

• Enable gas standard volume flow
• Specify the standard density (density at reference conditions) of your gas
• Select the measurement unit to use
• Set the low flow cutoff value

Note
The display allows you to select a volume measurement unit from the set available for the
configured volume flow type, but it does not allow you to configure gas standard volume
flow.
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4.6.1 Enabling and configuring gas standard volume
Gas Standard Volume Flow Measurement Unit specifies the unit of measure displayed for
the gas standard volume flow rate.

About this task

To enable and configure gas standard volume:

Procedure

Use the appropriate procedure in the table that follows to either enable or configure gas
standard volume for your transmitter:

ProLink III

for enabling and
configuring

gas standard volume

Device Tools > Configuration > Process Measurement > Flow tab.

a. Set Vol Flow Type to Gas Standard Volume.
b. Select units from the Std Gas Vol Flow Units list.
c. Configure Gas Standard Volume Flow Cutoff.
d. If you know the gas density, enter the density in the Standard

Density of Gas box and click Apply to complete the task.
e. If you do not know the gas density, access the Gas Wizard.

1. If the gas you are measuring is in the Choose Gas list,
select it and click Next:
• If correct, go to 1.f.
• If incorrect, change the reference conditions and

enter the new reference information.

2. If the gas you are measuring is not in the Choose Gas
list, enter Other Gas Property.
• Select the method from Molecular Weight, Specific

Gravity Compared to Air, or Density, and the
provide the required information. If you select
Density, you must enter the value in the configured
density units and you must provide both the
temperature and the pressure at which the density
value was determined.

3. Verify the revised reference temperature and pressure.

f. Click Next > Finish > Apply  to complete the task.

Bus Parameters

for enabling

and configuring

gas standard volume

a. Enabling GSV:

Block: Transducer Block 1 (Slot 11)

Index 62 (Enable GSV)

b. Configuring GSV:

Block: Transducer Block 1 (Slot 11)

Index 63 (Gas density)

Index 67 (GSV flow units)

Index 69 (GSV flow cutoff)
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EDD for enabling GSV MMI Coriolis Flow > Transducer Block > Measurement > Process
Variable > Volume Flow Type

a. Set the Volume Flow type to STD Gas Volume.

EDD for configuring GSV MMI Coriolis Flow > Transducer Block > Measurement > Process
Variable > Volume Flow 

a. Gas Std Density.
b. Gas Std Vol Flow Units
c. Gas Std Vol Flow Cutoff

4.7 Changing the measurement units
The transmitter is able to store measurement units in two different places: the transducer
block and the AI block.

Both the transducer block and the AI block are independent and can be set to different
values, which affects configuration in the following ways:

• If you are using a PROFIBUS configuration tool or the display, units are sent to match in
both the relevant AI block and the transducer block.

• If you are using ProLink III, go to Device Tools > Configuration > Communications >
Profibus-PA to configure units. Although units can be configured in some of the other
menus, doing so may produce unintended results.

Note
Changing the measurement units for a process variable automatically changes the
associated totalizer units as well. For example, setting the mass flow units to g/s
automatically sets the mass totalizer unit to grams.

Note
Configure the AI block channel before configuring the AI block units. The AI blocks
produce an error if the measurement units are set to a value that is impossible for the
configured channel.

To configure measurement units, refer to the following tables and the procedures at the
end of both Configuring the analog input function block channels and Setting the IO
mode.

Table 4-5: Mass flow measurement units

Mass flow unit Unit description

EDD ProLink III Display

g/s g/s G/S Grams per second

g/min g/min G/MIN G/MIN

g/h g/hr G/H Grams per hour

kg/s kg/s KG/S Kilograms per second

kg/min kg/min KG/MIN Kilograms per minute
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Table 4-5: Mass flow measurement units (continued)

Mass flow unit Unit description

EDD ProLink III Display

kg/h kg/hr KG/HR Kilograms per hour

kg/d kg/day KG/D Kilograms per day

t/min mTon/min T/MIN Metric tons per minute

t/h mTon/hr T/H Metric tons per hour

t/d mTon/day T/D Metric tons per day

lb/s lbs/s LB/S Pounds per second

lb/h lbs/hr LBS/H Pounds per hour

lb/d lbs/day LB/D Pounds per day

STon/min sTon/min ST/MIN Short tons (2000 pounds) per minute

STon/h sTon/hr ST/H Short tons (2000 pounds) per hour

STon/d sTon/day ST/D Short tons (2000 pounds) per day

LTon/h ITon/hr LT/H Long tons (2240 pounds) per hour

LTon/d ITon/day LT/D Long tons (2204 pounds) per day

Table 4-6: Liquid flow measurement units new

Liquid flow unit Unit description

EDD ProLink III Display

CFS ft3/sec CUFT/S Cubic feet per second

CFM ft3/min CUF/MN Cubic feet per minute

CFH ft3/hr CUFT/H Cubic feet per hour

ft3/d ft3/day CUFT/D Cubic feet per day

m3/s m3/sec M3/S Cubic meters per second

m3/min m3/min M3/MIN Cubic meters per minute

m3/h m3/hr M3/H Cubic meters per hour

m3/d m3/day M3/D Cubic meters per day

gal/s US gal/sec USGPS U.S. gallons per second

GPM US gal/min USGPM U.S. gallons per minute

gal/h US gal/hr USGPH U.S. gallons per hour

gal/d US gal/d USGPD U.S. gallons per day
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Table 4-6: Liquid flow measurement units new (continued)

Liquid flow unit Unit description

EDD ProLink III Display

Mgal/d mil US gal/day MILG/D Millions of U.S. gallons per
day

L/s l/sec L/S Litres per second

L/min l/min L/MIN Litres per minute

L/h l/hr L/H Litres per hour

ML/d mil l/day MILL/D Million litres per day

ImpGal/s Imp gal/sec UKGPS Imperial gallons per second

ImpGal/s Imp gal/min UKGPM Imperial gallons per minute

ImpGal/h Imp gal/hr UKGPH Imperial gallons per hour

ImpGal/d Imp gal/day UKGPD Imperial gallons per day

bbl/s barrels/sec BBL/S Barrels per second (1)

bbl/min barrels/min BBL/MN Barrels per minute (1)

bbl/h barrels/hr BBL/H Barrels per hour (1)

bbl/d barrels/day BBL/D Barrels per day (1)

bbl(fed)s Beer barrels/sec BBBL/S Beer barrels per (2) second

bbl(fed)min Beer barrels/min BBBL/MN Beer barrels per minute (2)

bbl(fed)/h Beer barrels/hr BBBL/H Beer barrels per hour (2)

bbl(fed)/d Beer barrels/day BBBL/D Beer barrels per day (2)

(1) Unit based on oil barrels (42 U.S. gallons)
(2) Unit based on U.S. beer barrels (31 U.S. gallons)

Table 4-7: Volume flow measurement units -- Gas

Gas Volume flow unit Unit description

EDD ProLink III Display

Nm3/s Nm3/sec NM3/S Normal cubic meters per
second

Nm3/m Nm3/min NM3/MN Normal cubic meters per
minute

Nm3/h Nm3/hr NM3/H Normal cubic meters per
hour

Nm3/d Nm3/day NM3/D Normal cubic meters per
day

NL/s NLPS NLPS Normal liter per second
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Table 4-7: Volume flow measurement units -- Gas (continued)

Gas Volume flow unit Unit description

EDD ProLink III Display

NL/m NLPM NLPM Normal liter per minute

NL/h NLPH NLPH Normal liter per hour

NL/d NLPD NLPD Normal liter per day

SCFS SCFS SCFS Standard cubic feet per
second

SCFM SCFM SCFM Standard cubic feet per
minute

SCFH SCFH SCFH Standard cubic feet per hour

SCFD SCFD SCFD Standard cubic feet per day

Sm3/s Sm3/S SM3/S Standard cubic meters per
second

Sm3/m Sm3/min SM3/MN Standard cubic meters per
minute

Sm3/h Sm3/hr SM3/H Standard cubic meters per
hour

Sm3/d Sm3/day SM3/D Standard cubic meters per
day

SL/s SLPS SLPS Standard liter per second

SL/m SLPM SLPM Standard liter per minute

SL/h SLPH SLPH Standard liter per hour

SL/d SLPD SLPD Standard liter per day

Table 4-8: Density measurement units

Density unit Unit description

EDD ProLink III Display

g/cm3 g/cm3 G/CM3 Grams per cubic centimeter

g/L g/l G/L Grams per liter

g/ml g/ml G/ML Grams per milliliter

kg/L kg/l KG/L Kilograms per liter

kg/m3 kg/m3 KG/M3 Kilograms per cubic meter

lb/gal lbs/USgal LB/GAL Pounds per U.S. gallon

lb/ft3 lbs/ft3 LB/CUF Pounds per cubic foot

lb/in3 lbs/in3 LB/CUI Pounds per cubic inch

STon/yd3 sT/yd3 ST/CUY Short ton per cubic yard
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Table 4-8: Density measurement units (continued)

Density unit Unit description

EDD ProLink III Display

degAPI degAPI D API Degrees API

SGU SGU SGU Specific gravity unit (based on Water at 60 degF )

Table 4-9: Temperature measurement units

Temperature unit Unit description

EDD ProLink III Display

°C °C °C Degrees Celsius

°F °F °F Degrees Fahrenheit

°R °R °R Degrees Rankine

°K °K °K Degrees Kelvin

Table 4-10: Pressure measurement units

Pressure unit Unit description

EDD ProLink III Display

In ft H20 @ 68 DegF In Water @ 68 °F FTH20 Feet Water @ 68 °F

In ft H20 @ 4 DegC In Water @ 4 °C INW4cH20 Inches Water @ 4 °C

In inch H20 @ 68
DegF

In Water @ 68 °F INH20 Inches Water @ 68 °F

mm H20 @ 4 DegC mm Water @ 4 °C mmW4C Millimeters Water @ 4 °C

mm H20 @ 68DegFC mm Water @ 68 °F mmH20 Millimeters Water @ 68 °F

inch Hg @ 0DegC In Mercury @ 0 °C INHG Inches mercury @ 0 °C

mm Hg @ 0DegC mm Mercury @ 0 °C mmHG Millimeters mercury @ 0 °C

psi PSI PSI Pounds per square inch

bar bar BAR Bar

millibar millibar mBAR Millibar

g_per_cm2 g/cm2 G/SCM Grams per square centimeter

kg_per_cm2 kg/cm2 KG/SCM Kilograms per square centimeter

pa pascals PA Pascals

MegaPa megapascals MPA Megapascals

KiloPa Kilopascals KPA Kilopascals

torr @0 DegC Torr @ 0C TORR Torr @ 0 °C
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Table 4-10: Pressure measurement units (continued)

Pressure unit Unit description

EDD ProLink III Display

atm atms ATM Atmospheres

4.8 Configuring the petroleum measurement
application
The petroleum measurement parameters determine the values that are used in petroleum
measurement-related calculations. The petroleum measurement parameters are available
only if the petroleum measurement application is enabled on your transmitter.

Note
The petroleum measurement application requires liquid volume measurement units. If
you plan to use petroleum measurement process variables, ensure that liquid volume flow
measurement is specified. Refer to Enabling and configuring gas standard volume.

4.8.1 About the petroleum measurement application
Some applications that measure liquid volume flow or liquid density are particularly
sensitive to temperature factors, and must comply with American Petroleum Institute
(API) standards for measurement. The petroleum measurement application enables
Correction of Temperature on volume of Liquids (CTL).

Terms and definitions

The following terms and definitions are relevant to the petroleum measurement
application:

• API -- American Petroleum Institute
• CTL -- Correction of Temperature on volume of Liquids: The CTL value is used to

calculate the VCF value.
• TEC -- Thermal Expansion Coefficient
• VCF -- Volume Correction Factor: The correction factor to be applied to volume process

variables. VCF can be calculated after CTL is derived.

CTL derivation methods

There are two types of derivation methods for CTL:

• Method 1 is based on observed density and observed temperature.
• Method 2 is based on a user-supplied reference density (or thermal expansion

coefficient, in some cases) and observed temperature.

Petroleum measurement reference tables

Reference tables are organized by reference temperature, CTL derivation method, liquid
type, and density unit. The table selected here controls all the remaining options.

• Reference temperature:
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— If you specify a 5x, 6x, 23x, or 24x table, the default reference temperature is 60 °F,
and cannot be changed.

— If you specify a 53x or54x table, the default reference temperature is 15 ° C;
however, you can change the reference temperature, as recommended in some
locations (for example, to 14.0 or 14.5 °C).

• CTL derivation method:
— If you specify an odd-numbered table (5, 23, or 53), CTL is derived using method 1

described above.
— If you specify an even-numbered table (6, 24, or 54), CTL is derived using method 2

described above.
• The letters A, B, C, or D that are used to terminate table names define the type of liquid

that the table is designed for:
— A tables are used with generalized crude and JP4 applications.
— B tables are used with generalized products.
— C tables are used with liquids with a constant base density or known thermal

expansion coefficient.
— D tales are used with lubricating oils.

• Different tales use different density units:
— Degrees API
— Relative density (SG)
— Base density (kg/m3)

The following tables summarize the options cited above. For Density unit and range, use
one of the last three columns (Degrees API, Base density, or Relative density).

Table 4-11: Petroleum measurement method 1 reference temperature tables

Table Base temperature Degrees API Base density Relative density

5A 60 °F, non-configurable 0 to +100

5B 60 °F, non-configurable 0 to +85

5D 60 °F, non-configurable 0 to +85

23A 60 °F, non-configurable 0.6110 to 1.0760

23B 60 °F, non-configurable 0.6535 to 1.0760

23D 60 °F, non-configurable 0.8520 to 1.1640

53A 15 °C, configurable 610 to 1075 kg/m3

53B 15 °C, configurable 653 to 1075 kg/m3

53D 15 °C, configurable 825 to 1164 kg/m3

Table 4-12: Petroleum measurement method 2 reference temperature tables

Table Base temperature
Reference

temperature

Supports

6C 60 °F, non-configurable 60 °F Degrees API
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Table 4-12: Petroleum measurement method 2 reference temperature tables
(continued)

Table Base temperature
Reference

temperature

Supports

24C 60 °F, non-configurable 60 °F Relative density

54C 15 °C, configurable 15 °C Base density in kg/m3

4.8.2 Configuring for petroleum measurement
About this task

The petroleum measurement configuration parameters allow you to set a table type and
set a user-defined thermal expansion coefficient (TEC).

Table 4-13 lists and defines the petroleum measurement configuration parameters you
can modify to perform these configuration tasks. For the petroleum measurement values,
refer to Table F-44.

Table 4-13: Petroleum measurement parameters

Variable Description

Table type Specifies the table that is used for reference temperature and reference
density unit. Select the table that matches your requirements. Refer to
the petroleum measurement reference tables. (check on this reference).

User defined TEC (1) Thermal expansion coefficient. Enter the value to be used in CTL
calculation.

Temperature units (2) Read-only. Displays the unit used for reference temperature in the
reference table.

Density units Read-only. Displays the unit used for reference density in the reference
table.

Reference

temperature

Read-only unless Table Type is set to 53x or 54x.

If configurable:

• Specify the reference temperature to be used in CTL calculation.
• Enter reference temperature in °C.

(1) Configurable if Table Type is set to 6C, 24C, or 54C.
(2) In most cases, the temperature unit used by the petroleum measurement reference table should

also be the temperature unit configured for the transmitter to use in general processing. To
configure the temperature unit, refer to Changing the measurement units.

Procedure

Use the following procedure to set the petroleum measurement table type and set a user-
defined TEC, using your communication tool of choice.
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ProLink III for setting the

petroleum measurement

table type

Device Tools > Configuration > Process Measurement >
Petroleum Measurement tab.

a. Select the table type value from the API Table Type list.
b. Click Apply to complete the task.

Bus Parameters

for setting the

petroleum measurement

table type

a. Table type: (Block: Transducer Block 2 (Slot 12)

Index 40 (APIU2540) CTL table type)

EDD

for setting the

petroleum measurement

table type

MMI Coriolis Flow > Transducer Block > API
a. Specify the API2540 CTL Table Type.

ProLink III

for setting a

user-defined TEC

Device Tools > Configuration > Process Measurement >
Petroleum Measurement tab.

a. Enter a coefficient in the User defined TEC box.
b. Click Apply to complete the task.

Bus Parameters

for setting a

user-defined TEC

a. TEC: (Block: Transducer Block 2 (Slot 12)

Index 39 (API thermal expansion coeff.))

EDD

for setting a

user-defined TEC

MMI Coriolis Flow > Transducer Block > API
a. Specify the API Thermal Expansion Coeff.

4.9 Configuring the concentration measurement
application
Micro Motion®  sensors provide direct measurements of density, but not of concentration.
The concentration measurement application calculates process variables such as
concentration or density at reference temperature, using density process data
appropriately corrected for temperature.

Note
For a detailed description of the concentration measurement application, see the
Micro Motion®  Enhanced Density Application: Theory, Configuration, and Use.
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Note
The concentration measurement application requires liquid volume measurement units. If
you plan to use concentration measurement process variables, ensure the liquid volume
flow measurement is specified. Refer to Configuring standard volume flow measurement
for gas.

4.9.1 About the concentration measurement application
The concentration measurement calculation requires a concentration measurement
curve, which specifies the relationship between temperature, concentration, and density
for the process fluid being measured. Micro Motion supplies a set of six standard
concentration measurement curves (refer to the following table). If none of these curves is
appropriate for your process fluid, you can configure a custom curve or purchase a custom
curve from Micro Motion.

The derived variable, specified during configuration, controls the type of concentration
measurement that will be produced. Each derived variable allows the calculation of a
subset of concentration measurement process variables (see the table below). The
available concentration measurement process variables can be used in process control,
just as mass flow rate, volume flow rate, and other process variables are used. For
example, an event can be defined on a concentration measurement process variable.

• For all standard curves, the derived variable is Mass Conc (Dens).
• For custom curves, the derived variable can be any of the variables listed in the

following table.

The transmitter can hold up to six curves at any given time, but only one curve can be
active (used for measurement) at a time. All curves that are in transmitter memory must
use the same derived value.

Table 4-14: Standard curves and associated measurement units

Name Description
Density

unit

Temperature

Unit

Deg Balling Curve represents percent extract, by mass,
in solutions based on "Balling". For
example, if a wort is 10 °Balling and the
extract in solution is 100﹪sucrose, the
extract is 10﹪ of the total mass.

g/cm3 °F

Deg Brix Curve represents a hydrometer scale for
sucrose solutions that indicates the
percent by mass of sucrose in solution at a
given temperature. For example, 40 kg of
sucrose mixed with 60 kg of water results
in a 40° Brix solution.

g/cm3 °C

Deg Plato Curve represents percent extract, by mass,
in solution, based on °Plato. For example, if
a wort is 10°Plato and the extract in
solution is 100% sucrose, the extract is 10%
of the total mass.

g/cm3 °F
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Table 4-14: Standard curves and associated measurement units (continued)

Name Description
Density

unit

Temperature

Unit

HFCS 42 Curve represents a hydrometer scale for
HFCS42 (high fructose corn syrup)
solutions that indicates the percent by
mass of HFCS in solution.

g/cm3 °C

HFCS 55 Curve represents a hydrometer scale for
HFCS55 (high fructose corn syrup)
solutions that indicates the percent by
mass of HFCS in solution.

g/cm3 °C

HFCS 90 Curve represents a hydrometer scale for
HFCS90 (high fructose corn syrup)
solutions that indicates the percent by
mass of HFCS in solution.

g/cm3 °C

4.9.2 Configuring for concentration measurement
About this task

Complete configuration instructions for the concentration measurement application are
provided in the Micro Motion Enhanced Density Application: Theory, Configuration, and Use
manual.

Note
The concentration measurement manual uses Pro Link III as the standard configuration
tool for the concentration measurement application. Because the PROFIBUS parameters
are very similar to the Pro Link III labels, you can follow the instructions for Pro Link III and
adapt them to your host. All of the parameters related to the concentration measurement
application can be found in Transducer Block 2 (Slot 12). Refer to Table F-48.

The typical configuration procedure simply sets up the concentration measurement
application to use a standard curve. The following steps are required:

Procedure

1. Set the transmitter’s density measurement unit to match the unit used by the curve
(as listed in Table 4-14).

2. Set the transmitter’s temperature measurement unit to match the unit used by the
curve (as listed in Table 4-14).

3. Set the derived variable to Mass Conc (Dens).

4. Specify the active curve.
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4.10 Changing the output scale
About this task

Because Coriolis meters publish the process variable in engineering units, there is no need
to scale a Coriolis meter's output.

The AI function blocks can be configured to scale their output. The output scale is
established by defining a process variable value at 0% of scale and at 100% of scale. The
output of the AI block will be translated to a value between these two limits. To see the AI
function block layout, refer to Analog Input (AI) function block parameters.

If you choose to use output scaling, note that it has no effect on the process values found
in the transducer block. This results in the following behaviors:

• ProLink III and the display use the process values in the transducer block. Therefore, the
output of a scaled AI block may differ from the value reported by other communication
tools.

• Two-phase and flow cutoffs are configured in the transducer block. Therefore, output
scaling has no effect on the behavior of the transmitter with regard to two-phase or
flow cutoffs.

Note
When Coriolis meters require no scaling, make sure the Out_Scale and PV_Scale
parameters have the same settings.

Procedure

Use the following procedure to change the output scale, using your communication tool
of choice.

Bus Parameters

for changing

the output
scale

a. Output Scale:

Block: Analog Input Block

Slot (1, 2, 3, and 5)

Index 28, (Parameter1 (EU100)

Index 28, (Parameter2 (EU0)

EDD for
changing

the output
scale

a. MMI Coriolis Flow > Function Block > Analog Input1 ...4 >
Parameters > OutScale

b. Out Scale EU0
c. Out Scale EU100

MMI Coriolis Flow > Function Block > Analog Input1 ...4 > Parameters >
OutScale > Out Scale EU0 > Out Scale EU100
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4.11 Changing process alerts
The transmitter uses process alerts to indicate that a process value has exceeded its user-
defined limits. The transmitter maintains four alert values for each process variable. In
addition, the transmitter has an alert hysteresis function to prevent erratic alert reports.

Note
Process alerts are only posted through the AI function blocks (refer to Analog Input (AI)
function block parameters) and totalizer blocks (refer to Totalizer block parameters) and
are not shown on the display or in ProLink III.

4.11.1 Changing alert values
About this task

The process alert values are the limits for process variables. Whenever a process variable
exceeds a process alert value, the alert will be reflected in the “Alert Summary” parameter
in each block.

Each AI function block and totalizer block has four process alert limits: high alert, high-high
alert, low alert, and low-low alert. See the following figure. The high and low process alert
values represent normal process limits. The high-high and low-low process alert values are
used for more complex alert signals to indicate a more severe problem than a regular
process alert indicates.
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Figure 4-1: Alert values

A. Process variable
B. Normal process range
C. High-high alert
D. High alert
E. Low alert
F. Low-low alert

Procedure

Use the following procedure to change the alert values, using your communication tool of
choice.
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Bus Parameters

for changing

the alert values

a. AI block limits:

Block: Analog Input Block (Slot 1, 2, 3, and 5)

Index 37 (Hi Hi Limit)

Index 39 (Hi Limit)

Index 41 (Lo Limit)

Index 43 (Lo Lo Limit))

b. Totalizer block limits:

Block: Totalizer Block (Slots 4, 6, 7, and 8)

Index 34 (Hi Hi Limit)

Index 35 (Hi Limit)

Index 36 (Lo Limit)

Index 37 (Lo Lo Limit))

EDD

for changing

the output scale

a. To use analog input:
1. MMI Coriolis Flow > Function Block > Analog Input1 ...4 >

Parameters
2. Limits > Hi-Lim > Hi-Hi Lim > Lo Lim > Lo Lo Lim

a. To use the totalizer:
1. MMI Coriolis Flow > Function Block > Totalizer 1...4 >

Parameter
2. Limit > Hi-Lim > Hi-Hi Lim > Lo Lim > Lo Lo Lim

4.11.2 Changing alert hysteresis
About this task

The alert hysteresis value is a percentage of the output scale. After a process alert is
created, the transmitter will not create new alerts unless the process first returns to a value
within the range of the alert hysteresis percentage. The following figure shows the
transmitter’s alert behavior with an alert hysteresis value of 50%.

Note the following about hysteresis:

• A low hysteresis value allows the transmitter to broadcast a new alert every time or
nearly every time the process variable crosses over the alert limit.

• A high hysteresis value prevents the transmitter from broadcasting new alerts unless
the process variable first returns to a value sufficiently below the high alert limit or
above the low alert limit.
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Figure 4-2: High versus low alert hysteresis values

A. Process variable
B. Alert created
C. New alerts not created
D. Hysteresis value
E. New alert created here
F. High alert
G. Low alert

Bus Parameters

for changing

the alert values

1. Hysteresis:

Block: Analog Input Block (Slots 1, 2, 3, and 5)

Index 37 (Hysteresis)

EDD for changing

the output scale

1. MMI Coriolis Flow > Function Block > Analog Input1 ...4 >
Parameters

2. Limits > Alert Hys

4.12 Configuring alert status severity
About this task

The severity level of some status alerts can be reclassified. For example

• The default severity level for Alert A020 (calibration factors unentered) is Fault, but you
can reconfigure it to either Informational or Ignore.

• The default severity level for Alert A102 (drive over-range) is Informational, but you can
reconfigure it to either Ignore or Fault.
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A list of all status alertss and default severity levels is shown in the table below (For more
information on status alerts, including possible causes and troubleshooting suggestions,
see Status alerts.

Table 4-15: Status alerts and security levels

Alert

code

Index Description Default severity Configurable

A001 1 EEPROM checksum Fault No

A002 2 RAM error Fault No

A003 3 Sensor failure Fault Yes

A004 4 Temperature sensor failure Fault No

A005 5 Input overrange Fault Yes

A006 6 Transmitter not configured Fault Yes

A008 8 Density overrange Fault Yes

A009 9 Transmitter initializing/warming up Ignore Yes

A010 10 Calibration failure Fault No

A011 11 Calibration too low Fault Yes

A012 12 Calibration too high Fault Yes

A013 13 Zero too noisy Fault Yes

A014 14 Transmitter failed Fault No

A016 16 Line temperature out-of-range Fault Yes

A017 17
Meter RTD temperature

out-of-range

Fault Yes

A018 18
EEPROM Error

(Transmitter)

Fault No

A020 20 Calibration factors unentered Fault Yes

A021 21 Incorrect sensor type Fault No

A022 22 Configuration corrupt Fault Yes

A023 23 Totals corrupt Fault Yes

A024 24 CP program corrupt Fault Yes

A025 25 Boot sector fault Fault Yes
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Table 4-15: Status alerts and security levels (continued)

Alert

code

Index Description Default severity Configurable

A026 26
Sensor/Transmitter

communications failure

Fault No

A028 28 Sensor/Transmitter write failure Fault No

A030 30 Hardware/software incompatible Fault Yes

A031 31 Low power Informational No

A032 32
Smart Meter Verification

in progress and outputs fixed

Fault Yes

A033 33 Tube Not Full Fault Yes

A034 34 Smart Meter Verification failed Informational Yes

A035 35 Smart Meter Verification aborted Informational Yes

A102 42 Drive overrange Informational Yes

A103 43 Data loss possible Informational Yes

A104 44 Calibration in progress Informational Yes

A105 35 Two-phase flow (Slug flow) Informational Yes

A106 35 Function block simulate Informational Yes

A107 47 Power reset occurred Informational Yes

A116 35 Power reset occurred Informational Yes

A117 57
API temperature

outside standard range

Informational Yes

A120 60
Concentration measurement:

unable to fit curve data

Informational No

A121 61
Concentration measurement:

extrapolation alert

Informational Yes

A131 71
Smart Meter Verification

in progress

Informational Yes
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Table 4-15: Status alerts and security levels (continued)

Alert

code

Index Description Default severity Configurable

A132 72 Simulation mode active Informational Yes

ProLink III

for configuring

status alert severity

1. Device Tools > Configuration
2. Select the Alert Severity tab.
3. Select an alert from the Alert Name list.
4. Select a severity from the Alert Severity list.
5. Click Apply.

Bus Parameters

for configuring

status alert severity

1. Select alert:

Block Transducer: Block 1 (Slot 11)

Index 149 (Alert index)

2. Select severity:

Block Transducer: Block 1 (Slot 11)

Index 150 (Alert severity)

EDD

for configuring

status alert severity

1. MMI Coriolis Flow > Transducer Block > Alert > Alert Status
Parameter

2. Select alert from Alert Index.
3. Select severity from Alert Severity.

4.13 Changing the damping values
About this task

A damping value is a period of time, in seconds, over which the process variable value will
change to reflect 63% of the change in the actual process. Damping helps the transmitter
smooth out small, rapid measurement fluctuations.

• A high damping value makes the output appear to be smoother because the output
must change slowly.

• A low damping value makes the output appear to be more erratic because the output
changes more quickly.

Note
There is also a “damping” parameter in each AI block called AI PV Filter Time (index 32). In
order to avoid having two (potentially conflicting) damping values, you should set
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damping values only in the transducer block. The AI PV Filter Time parameter for each AI
block should be set to 0.

When you specify a new damping value, it is automatically rounded down to the nearest
valid damping value. Valid damping values are listed in the following table.

Table 4-16: Valid damping values

Process variable Initial values Valid damping values

Flow (mass and volume) 0.80000 0, 0.04, 0.08, 0.16, ... 40.96

Density 1.60000 0, 0.04,.0.08, 0.16, ... 40.96

Temperature 4.80000 0, 0.6, 1.2, 2.4, 4.8, ...76.8

ProLink III path

for changing

damping values

1. Device Tools > Configuration > Process Measurement
2. Select Flow tab and enter a damping value in the Flow Rate

Damping box, then click Apply.
3. Select Density tab and enter a damping value in the Density

Damping box, then click Apply.
4. Select Temperature tab and enter a damping value in the

Temperature Damping box, then click Apply.

Bus Parameters

for changing

damping values

1. Damping:

Block Transformation: Block 1 (Slot 11)

Index 33 (flow damping)

Index 34 (temperature damping)

Index 35 (density damping)

EDD

for changing

damping values

1. MMI Coriolis Flow > Transducer Block > Measurement > Process
Variable

2. Select Mass Flow > Flow Damping.
3. Select Temperature > Temperature Damping.
4. Select Density > Density Damping.

4.13.1 Damping and volume measurement
When configuring damping values:

• Liquid volume flow is derived from mass and density measurements. Therefore, any
damping applied to mass flow and density will affect liquid volume measurement.

• Gas standard volume flow is derived from mass flow measurement, but not from
density measurement. Therefore, only damping applied to mass flow will affect gas
standard volume measurement.
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Note
Be sure to set damping values accordingly.

4.14 Changing two-phase flow (slug flow) limits and
duration
About this task

Slugs—gas in a liquid process or liquid in a gas process—occasionally appear in some
applications. The presence of slugs can significantly affect the process density reading.
The two-phase flow parameters can help the transmitter suppress extreme changes in
process variables, and can also be used to identify process conditions that require
correction.

Two-phase flow parameters are as follows:

• Two-Phase Flow Low Limit — the point below which a condition of two-phase flow will
exist. Typically, this is the lowest density you expect to observe for your process. The
default value is 0.0g/cm3. The valid range is 0.0–10.0g/cm3.

• Two-Phase Flow High Limit — the point above which a condition of two-phase flow will
exist. Typically, this is the highest density you expect to observe for your process. The
default value is 5.0g/cm3. The valid range is 0.0–10.0 g/cm3.

• Two-Phase Flow duration — the number of seconds the transmitter waits for a two-
phase flow condition to clear. If the transmitter detects two-phase flow, it will post a
two-phase flow alert and hold its last “pre-two-phase” flow rate until the end of the
two-phase flow duration and the measurement quality will be marked “uncertain.” If
two-phase flow is still present after the two-phase flow duration has expired, the
transmitter will report a flow rate of zero (the measurement quality will remain at
“uncertain”). The default value for two-phase flow duration is 0.0 seconds. The valid
range is 0.0–60.0seconds.

Note
The two-phase flow limits must be entered in g/cm3, even if another unit has been
configured for density. Two-phase flow duration is entered in seconds. Raising the Two-
Phase Flow Low Limit or lowering the Two-Phase Flow High Limit will increase the
possibility of detecting two-phase flow conditions. Conversely, lowering the Two-Phase
Flow Low Limit or raising the Two-Phase Flow High Limit will decrease the possibility of
detecting two-phase flow conditions. If two-phase flow duration is set to 0, the mass flow
rate will be forced to 0 as soon as two-phase flow is detected.

A list of all status alerts and default severity levels is shown in Configuring alert status
severity. (For more information on status alerts, including possible causes and
troubleshooting suggestions, see Status alerts.)

ProLink III path

for changing

damping values

1. Device Tools > Configuration > Process Measurement
2. Select Density tab and set the density limits for Two-Phase

Flow Low Limit and Two-Phase Flow High Limit.
3. Set the two-phase flow duration in the Two-Phase Flow

Timeout box.
4. Click Apply.
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Bus Parameters

for changing

damping values

1. two-phase flow:

Block Transformation: Block 1 (Slot 11)

Index 130 (duration)

Index 131 (low limit)

Index 132 (high limit)

EDD for changing

damping values

1. MMI Coriolis Flow > Transducer Block > Calibration > Slug
Limit

2. Select Two Phase Hold last measured value time.
3. Select Two Phase Density Low Limit.
4. Select Two Phase Density High Limit.

4.15 Configuring cutoffs
About this task

Cutoffs are user-defined values below which the transmitter reports a value of zero for the
specified process variable. Cutoffs can be configured for either mass flow, volume flow, or
density.

The following table lists the default values and relevant comments for each cutoff. Note
that the mass flow cutoff is not applied to the volume flow calculation. Even if the mass
flow drops below the cutoff, and therefore the mass flow indicators go to zero, the volume
flow rate will be calculated from the actual mass flow process variable.

Table 4-17: Valid damping values

Cutoff Default values Comments

Mass 0.065% of maximum flow
rate of the sensor

Micro Motion recommends a mass flow cutoff value
of 0.5% of the sensor's maximum flow rate for
standard operation, and 2.5% of the sensor's
maximum flow rate for empty-full-empty batching.

Liquid volume 0.065% of maximum flow
rate of sensor

The lower limit for volume flow cutoff is 0. The upper
limit for volume flow cutoff is the sensor's flow
calibration factor, in L/s, multiplied by 0.2.

Density 0.2 g/cm3 The range for density cutoff is 0.0--0.5 g/cm3.
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ProLink III path

for configuring

cutoff values

1. Device Tools > Configuration > Process Measurement:
a. Select Density tab and enter a value in the Density Cufoff

box.
b. Click Apply.

2. Select Density tab and enter a value in the Density Cufoff box.
3. Go back to ProLink > Configuration.

a. Select Density tab and enter a value in the Density Cufoff
box

b. Click Apply.

Bus Parameters

for configuring

cutoff values

1. Cutoffs:

Block Transducer: Block 1 (Slot 11)

Index 9 (Mass Flow Cutoff)

Index 39 (Liquid volume flow cutoff)

Index 40 (Density cutoff)

Index 69 (Gas standard volume flow cutoff)

EDD

for configuring

cutoff values

1. MMI Coriolis Flow > Transducer Block > Measurement > Process
Variable

2. Select Mass Flow and fill in Mass Flow Low Cutoff.
3. Select Volume Flowand fill in Volume Flow Low Cutoff.
4. Select Density and fill in Density Cutoff.

4.16 Changing the measurement mode parameter
About this task

The measurement mode parameter defines how the flow is added to or subtracted from
the totalizers.

• Forward flow moves in the direction of the arrow on the sensor.
• Reverse flow moves in the direction opposite from the arrow on the sensor.

The following table shows the possible values for the measurement mode parameter and
the transmitter’s behavior when the flow is positive or negative. Only the unidirectional
and bidirectional values are recognized by the PROFIBUS specification, so other values will
be unrecognized by a PROFIBUS host or configuration tool. However, the transmitter will
operate correctly in any of the modes listed in the table below.
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Table 4-18: Totalizer behavior for each measurement mode value

Measurement mode
value

Bus index Forward flow Reverse flow

Unidirectional

(forward only)

0 Increase No change

Reverse only 1 No change Increase

Bidirectional 2 Increase Decrease

Absolute value 3 Increase Increase

Negate/forward only 4 No change Increase

Negate/bidirectional 5 Decrease Increase

ProLink III path

for changing

the measurement

mode parameter

1. Device Tools > Configuration > Process Measurement > Flow
tab

2. Select a value from the Flow Direction list.
3. Click Apply.

Bus Parameters

for changing

the measurement

mode parameter

1. Measurement Mode:

Block Transducer: Block 1 (Slot 11)

Index 10 (measurement mode)

EDD for changing

the measurement

mode parameter

1. MMI Coriolis Flow > Transducer Block > Measurement >
Process Variable

2. Select Mass Flow and fill in Measurement Mode.

4.17 Configuring sensor parameters
About this task

The sensor parameters are used to describe the sensor component of your flow meter.
These sensor parameters are not used in transmitter processing, and are not required:

• Serial number
• Sensor material
• Liner material
• Flange
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ProLink III path

for changing

the sensor parameters

1. Device Tools > Configuration > Informational
Parameters > Sensor tab

2. Enter the sensor serial number in the Sensor s/n box.
3. Enter the sensor serial material from the Sensor Matl list.
4. Select the liner material from the Liner Matl list.
5. Select the flange from the Flange list.
6. Click Apply.

Bus Parameters for
changing

the sensor parameters

1. Sensor parameters:

Block Transducer: Block 2 (Slot 12)

Index 10 (sensor serial number)

Index 13 (sensor material)

Index 14 (liner material)

Index 15 (flange type)

EDD for changing

the sensor parameters

1. MMI Coriolis Flow > Transducer Block > Device
Information

2. Select Sensor Serial Number.
3. Select Sensor Material.
4. Select Liner Material.
5. Select Flange Type.

4.18 Configuring the display
About this task

You can restrict the display functionality or change the variables that are shown on the
display.

Each display function and its associated parameter are listed in the table below.

Table 4-19: Display functions and parameters

Display

functions

EDD name Display code Enabled Disabled

Totalizer

reset

Totalizer

Reset

TOTALS RESET Resetting mass and
volume totalizers is
permitted

Resetting mass and
volume totalizers is
not possible

Start/stop

totalizers

Start/Stop

Totalizer

TOTALS STOP Operators can start
and stop totalizers
from the display.

Operators cannot
start or stop totalizers
from the display.
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Table 4-19: Display functions and parameters (continued)

Display

functions

EDD name Display code Enabled Disabled

Auto scroll

If enabled, you
may want to
configure the
Scroll Rate.

Refer to
Guidelines for
setting the
scroll rate.

Auto Scroll AUTO SCROLL The display
automatically scrolls
through each process
variable.

Operators must use
the Scroll function to
view process
variables.

Off-line

menu

Offline
Menu

DISPLAY OFFLN Operators have

access to the off-line
menu.

Operators must use
the Scroll function to
view process
variables.

Off-line

password

If enabled, the
display offline
password must
also configured.
Refer to
Guidelines for
setting the off-
line password.

Offline

Password

OFFLINE PASSW A password is
required for the
offline menu.

The offline menu is
accessible without a
password.

Alert

menu

Alert Menu DISPLAY ALERT Operators have

access to the alert
menu.

No access to the alert
menu.

Acknowledge

all alerts

ACK

All Alerts

DISPLAY ACK Operators can
acknowledge all
current alerts at once.

alerts must be
acknowledged
individually.

Display

backlight

Backlight DISPLAY BKLT Display backlight is
ON.

Display backlight is
OFF.

Note
If you use the display to disable access to the off-line menu, the off-line menu will
disappear as soon as you exit the menu system. If you want to re-enable access, you must
use a different method (such as, ProLink III).

Note
If you are using the display to configure the display:
• You must enable Auto Scroll before you can configure the Scroll Rate.
• You must enable the off-line password before you can configure the password.
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Display path

for configuring

the display parameters

1. Device Tools > Configuration > Transmitter Display >
General tab.

2. Modify Display Option, Backlight, and Scroll Option as
needed.

3. Click Apply.
4. To modify security settings, go to Device Tools >

Configuration > Transmitter Display > Display Security tab.
5. Modify options as needed.
6. Click Apply.
7. To modify display variables, go to Device Tools >

Configuration > Transmitter Display > Display Variables tab
8. Modify options as needed.
9. Click Apply.

10. To acknowledge all alerts, go to Device Tools > Configuration
> Transmitter Display > Ack All tab.

11. Select Enabled for Acknowledge All Alerts (Ack All) from
Display.

12. Click Apply.
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Bus Parameters

for changing

the display parameters

1. Display options:

Block Transducer: Block 1 (Slot 11)

Index 220 (Totalizer reset)

Index 221 (Totalizer start/stop)

Index 222 (Auto Scroll enabled/disabled)

Index 223 (Offline menu enabled/disabled)

Index 224 (Offline password enabled/disabled)

Index 225 (Alert menu enabled/disabled)

Index 226 (Acknowledge all alerts)

Index 227 (Set offline password)

Index 228 (Auto scroll period)

Index 229 (Display backlight)

Index 247 (Update period)

EDD for changing

the display parameters

1. MMI Coriolis Flow > Transducer Block > Display
Configuration

a. Select Display Option.
• Totalizer Reset
• Start/Stop Totals
• Offline Menu
• Alert Menu
• ACK all alerts
• Offline password
• Auto Scroll
• Scroll Period
• Language

b. Select Display Parameters.
• Backlight
• Display Parameters
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4.18.1 Guidelines for setting the scroll rate
The scroll rate is used to control the speed of scrolling when auto scroll is enabled. Scroll
rate defines how long each display variable will be shown on the display.

The time period is defined in seconds (for example, if scroll rate is set to 10, each display
variable will be shown on the display for 10 seconds). The valid range is from 1 to 30
seconds, with a default value of 30 seconds.

4.18.2 Guidelines for setting the update period
The update period (or display rate) parameter controls how often the display is refreshed
with current data.

The default is 200 milliseconds. The range is 100 to 10,000 milliseconds. The update
period value applies to all displayed process variables.

4.18.3 Guidelines for setting the off-line password
The off-line password prevents unauthorized users from gaining access to the off-line
menu.

4.18.4 Guidelines for setting the display language
The display can be configured to use any of the following languages for data and menus:

• English
• French
• German
• Spanish

4.18.5 Changing the display variables and precision
About this task

The display can scroll through up to 15 process variables in any order. You can select the
process variables you wish to see and the order in which they should appear.

Additionally, you can configure display precision for each display variable. Display
precision controls the number of digits to the right of the decimal place. The range of the
display precision is 0 to 5.

The following table shows an example of a display variable configuration. Notice that you
can repeat variables and you can choose a value of “None”. The actual appearance of each
process variable on the display is described in Using the transmitter display.

Table 4-20: Example of a display variable configuration

Display variable Process variable

Display variable 1 Mass flow

Display variable 2 Volume flow
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Table 4-20: Example of a display variable configuration (continued)

Display variable Process variable

Display variable 3 Density

Display variable 4 Mass flow

Display variable 5 Volume flow

Display variable 6 Mass totalizer

Display variable 7 Mass flow

Display variable 8 Temperature

Display variable 9 Volume flow

Display variable 10 Volume totalizer

Display variable 11 Density

Display variable 12 Temperature

Display variable 13 None

Display variable 14 None

Display variable 15 None

ProLink III for
changing

display variables

1. Device Tools > Configuration > Transmitter Display > Display
Variables tab

2. For each display variable, select a process variable from the list.
3. Enter a precision in the appropriate box under Decimal Places

for x Variables box, where x is either Diagnostic, Process, or
Totalizer.

4. Click Apply.

Bus Parameters for
changing

display variables

1. Display variables:

Block Transducer: Block 1 (Slot 11)

Indices 232 through 246

2. Display precision:

Block Transducer: Block 1 (Slot 11)

Index 231 (Number of decimals)
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EDD for changing

the display variables

1. MMI Coriolis Flow > Transducer Block > Display
Configuration

a. Select Display Parameters.
• Set values for Display Variable 1 through Display

Variable 15

b. Select Display Precision.
• Select Display Variable and set No. of Decimal.

4.19 Enabling LD optimization
About this task

LD Optimization is a special compensation is that is specifically for hydrocarbon liquids. LD
Optimization should not be used with any other process fluids. LD Optimization is
available only with certain large sensor sizes. If your sensor can benefit from LD
Optimization, the enable/disable option will appear in ProLink III or on the display. (Refer
to Figure B-11 to view the display path.)

Important
If you send the transmitter to a calibration facility to perform a water calibration, either
during startup or any time thereafter, LD Optimization must be disabled. When you have
completed the calibration, re-enable LD Optimization.

Display path for LD
optimization

(scroll and select
simultaneously for 4 seconds)

1. OFF-LINE MAINT > CONFG > MTR F > FACTOR LD > LD
OPT

4.20 Configuring pressure compensation
Due to process pressure change away from calibration pressure, there can be a change in
sensor flow and density sensitivity. This change is called pressure effect. Pressure
compensation corrects for these changes.

Not all sensors and applications require pressure compensation. Contact customer service
before you configure pressure compensation.

Configuring pressure compensation requires three steps:

1. Determining pressure compensation values
2. Enabling pressure compensation
3. Selecting a pressure source

4.20.1 Pressure Compensation Values
There are three values involved in pressure compensation:
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• Flow factor -- The flow factor is the percent change in flow rate per psi. Consult the
product flow data sheet for your sensor for this value. You will need to reverse the sign
of the flow factor . For example, if the flow factor in the product data sheet is --0.001%
per psi, the pressure compensation flow factor would be +0.001% per psi.

• Density factor --The density factor is the change in fluid density, in g/cm3 per psi.
Consult the product data sheet for your sensor for this value. You will need to reverse
the sign of the density factory. For example, if the density factor in the product data
sheet is -0.00004 g/m3 per psi, the pressure compensation flow factor would be
+0.00004 g/m3 per psi.

• Flow calibration pressure --The pressure at which the flow meter was calibrated. Refer to
the calibration document shipped with your sensor. If the data is unavailable, use 20
psi. (1,4 bar).

4.20.2 Enabling pressure compensation
To enable pressure compensation, you will need the three pressure compensation values.

About this task

Use the following procedure to configure the totalizer block mode:

Procedure

1. Determine the method you are using to enable pressure compensation::
• If you are using the EDD, go to Step 2.
• If you are using bus parameters, go to Step 7.
• If you are using ProLink III, go to Step 8.

2. From the EDD, choose MMI Coriolis Flow > Transducer Block > Compensation >
Pressure.

3. At Pressure Comp, select Enabled.

4. Specify values for Flow Factor, Density Factor, and Cal Pressure.

5. Set the Pressure Units value to match the pressure source.

6. Optionally, you can set External Pressure to a fixed pressure value.

7. For bus parameter:

a) Select Enable pressure comp. > Block: Transducer Block 1 (Slot 11) Index
112 (enable pressure compensation).

b) Select Pressure correction values > Block: Transducer Block 1 (Slot 11)
Index 116 (flow factor) / Index 117 (density factor) / Index 118 (flow
calibration pressure).

c) Select Pressure units > Block: Transducer Block 1 (Slot 11) Index 115
(pressure units).

d) Select Optional: Fixed pressure value > Block: Transducer Block 1 (Slot
11) Index 113 (pressure value).

8. Select Device Tools > Configuration > Process Measurement > Pressure
Compensation.

9. Set Pressure Compensation Status to Enabled.

10. Enter the following values:

a) Enter the flow factor in the Flow factor box.
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b) Enter the density factor in the Density factor box.
c) Enter the flow calibration pressure in the Flow Calibration Pressure box.

11. Set the pressure units to match the source.

12. Optionally, you can enter a fixed pressure value in the External Pressure box.

13. Click Apply.

4.20.3 Configuring a pressure source
You need to choose one of two sources for pressure data: either Analog Output function
block or Fixed pressure data.

About this task

• Analog Output function block -- This option allows the PLC to write a pressure value to
the transmitter.

• Fixed pressure data -- This option uses a known, constant pressure value.

Note
If you configure a fixed pressure value, ensure that it is accurate. If you configure polling
for pressure, ensure that the external pressure measurement device is accurate and
reliable.

If you configure pressure compensation to use an AO block for pressure compensation,
the other AO block remains available for temperature compensation. However, only one
of the AO blocks can be set up for external pressure.

If you configure fixed pressure data, use the procedures described in Enabling pressure
compensation.

Use the following procedure to configure an AO function block for pressure
compensation:

Procedure

1. Determine the method you are using to configure fixed pressure or an AO function
block for pressure compensation:
• If you are using the EDD, go to Step 2.
• If you are using bus parameters, go to Step 4.
• If you are using the display, go to Step 5.

2. From the EDD, choose MMI Coriolis Flow > Function Block > Analog Output n >
Parameters > General.

3. Set In Channel to pressure.

Note
When setting the IN channel to Pressure through the EDD, the OUT channel will be
automatically set to Pressure as well.

4. For bus parameter:

a) Select Configure channel.
b) Then select Block: Transducer Block 1 (Slot 11) Index 121 (AO

Compensation, value = 1).
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Note
Setting the IN channel through bus parameters does not automatically
change the OUT channel. You must manually set the OUT channel to
Pressure or the block will go into OSS mode.

c) Select Configure channel .
d) Then select Block: Analog Block Output Block (Slots 9 and 10) Index 37 (IN

channel), value = 0x0b72 / Index 38 (OUT channel), value = 0x0b71.

5. For the display, select CONFG AO > AO1 INCH.

6. Scroll thorough AO1 PV UNITS > AO1 OUTCH > AO1 OUT UNITS .

7. Continue to scroll through AO2 INCH > AO2 PV UNITS > AO2 OUTCH > AO2 OUT
UNITS as needed.

Related information

Other/t_EnablingPressComp.dita

4.21 Configuring temperature compensation
External temperature compensation can be used with the petroleum measurement
application or the enhanced density application:

• If external temperature compensation is enabled, an eternal temperature value (or a
fixed temperature value), rather than the temperature value from the Coriolis sensor, is
used in petroleum measurement or enhanced density calculations only. The
temperature value from the Coriolis sensor is used for all other calculations.

• If external temperature compensation is disabled, the temperature values from the
Coriolis sensor is used in all calculations.

Configuring temperature compensation requires two steps:

1. Enabling external temperature compensation.
2. Configuring a temperature source.

4.21.1 Enabling Temperature Compensation
You can enable temperature compensation through either the EDD, the bus parameters,
or ProLink III.

About this task

Use the following procedure to enable temperature compensation:

Procedure

1. Note
To configure temperature compensation through ProLink III, you must have
Concentration Measurement as an application and under the PROFIBUS tab, you
have to select Acyclic as the Compensation Select value.

Determine the method you are using to configure fixed temperature or an AO
function block for temperature compensation:
• If you are using the EDD, go to Step 2.
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• If you are using ProLink III go to Step 4.
• If you are using bus parameters, go to Step 6.

2. From the EDD, choose MMI Coriolis Flow > Transducer Block > Compensation >
Temperature.

3. Enable or disable Ext Temp.

4. Select Device Tools > Configuration > Process Measurement > Concentration
Measurement.

5. At the bottom of the tab under Line Temperature Data, set the Use External
Temperature Value field to Enabled.

6. For bus parameter:

a) Select Enable temperature comp.
b) Then select Block: Transducer Block 1 (Slot 11) Index 110 (enable

temperature compensation).

4.21.2 Configuring a temperature source
External temperature data is reported through an analog output (AO) function block. The
transmitter has two AO blocks, each of which can be assigned to a compensation variable
channel.

About this task

Use the following procedure to configure an AO function block for temperature
compensation:

Procedure

1. Determine the method you are using to configure fixed temperature or an AO
function block for temperature compensation:
• If you are using the EDD, go to Step 2.
• If you are using bus parameters, go to Step 4 .
• If you are using the display, go to Step 5.

2. From the EDD, choose MMI Coriolis Flow > Function Block > Analog Output n >
Parameters > General.

Note
When setting the IN channel to Temperature through the EDD, the OUT channel is
automatically set to Temperature as well.

3. Set IN Channel to Temperature.

4. For bus parameter:

a) Select Configure channel. .
b) Then select Block: Transducer Block 1 (Slot 11) Index 121 (AO

Compensation), value = 1.
c) Select Configure channel. .
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Note
Setting the IN channel through bus parameters does not automatically
change the OUT channel. You must manually set the OUT channel to
Temperature or the bloc will go into OOS mode.

d) Then select Block: Analog Output Block (Slots 9 and 10) Index 37 (IN
channel), value = 0x0b1D / Index 38 (OUT channel), value = 0x0b6F.

5. For the display, select CONFG AO > AO1 INCH.

6. Scroll thorough AO1 PV UNITS > AO1 OUTCH > AO1 OUT UNITS .

7. Continue to scroll through AO2 INCH > AO2 PV UNITS > AO2 OUTCH > AO2 OUT
UNITS as needed.
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5 Configure device options and
preferences

5.1 Configure the transmitter display
You can control the process variables shown on the display and a variety of display
behaviors.

5.1.1 Configure the language used for the display
Display OFF-LINE MAINT > OFF-LINE CONFG > DISPLAY > LANG

ProLink III Device Tools > Configuration > Transmitter Display > General

Display Language controls the language used for process data and menus on the display.

Procedure

Select the language you want to use.
The languages available depend on your transmitter model and version.

5.1.2 Configure the process variables and diagnostic variables
shown on the display
You can control the process variables and diagnostic variables shown on the display, and
the order in which they appear. The display can scroll through up to 15 variables in any
order you choose. In addition, you can repeat variables or leave slots unassigned.

About this task

Procedure

For each display variable you want to change, assign the process variable you want to use.

Default display variable configuration

Display variable Process variable assignment

Display Variable 1 Mass flow

Display Variable 2 Mass total

Display Variable 3 Volume flow

Display Variable 4 Volume total

Display Variable 5 Density

Display Variable 6 Temperature

Display Variable 7 Drive gain

Display Variable 8 None
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Display variable Process variable assignment

Display Variable 9 None

Display Variable 10 None

Display Variable 11 None

Display Variable 12 None

Display Variable 13 None

Display Variable 14 None

Display Variable 15 None

5.1.3 Configure the number of decimal places (precision)
shown on the display

Display Not available

ProLink III Device Tools > Configuration > Transmitter Display > Display Variables

You can specify the number of decimal places (precision) that are shown on the display for
each process variable or diagnostic variable. You can set the precision independently for
each variable.

About this task

The display precision does not affect the actual value of the variable or the value used in
calculations.

Procedure

1. Select a variable.

2. Set Number of Decimal Places to the number of decimal places you want shown
when the process variable or diagnostic variable appears on the display.

Tip
The lower the precision, the greater the change must be for it to be reflected on the
display. Do not set the precision too low or too high to be useful.

5.1.4 Configure the refresh rate of data shown on the display
Display OFF-LINE MAINT > OFF-LINE CONFG > DISPLAY > RATE

ProLink III Device Tools > Configuration > Transmitter Display > Display Variables

You can set Refresh Rate to control how frequently data is refreshed on the display.

Procedure

Set Refresh Rate to the desired value.
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5.1.5 Enable or disable automatic scrolling through the
display variables

Display OFF-LINE MAINT > OFF-LINE CONFG > DISPLAY > AUTO SCRLL

ProLink III Device Tools > Configuration > Transmitter Display > General

You can configure the display to automatically scroll through the configured display
variables or to show a single display variable until the operator activates Scroll. When you
set automatic scrolling, you can also configure the length of time each display variable is
displayed.

Procedure

1. Enable or disable Auto Scroll as desired.

Option Description

Enabled The display automatically scrolls through each display variable as
specified by Scroll Rate. The operator can move to the next
display variable at any time using Scroll.

Disabled
(default)

The display shows Display Variable 1 and does not scroll
automatically. The operator can move to the next display variable
at any time using Scroll.

2. If you enabled Auto Scroll, set Scroll Rate as desired.

The default value is 10  seconds.

Tip
Scroll Rate may not be available until you apply Auto Scroll.

5.1.6 Enable or disable the display backlight
Display OFF-LINE MAINT > OFF-LINE CONFG > DISPLAY > BKLT

ProLink III Device Tools > Configuration > Transmitter Display > General

You can enable or disable the display backlight.

Procedure

Enable or disable Backlight.

The default setting is Enabled.

5.1.7 Enable or disable Status LED Blinking
Display Not available

ProLink III Device Tools > Configuration > Transmitter Display > General
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By default, the status LED blinks (flashes) to indicate unacknowledged alerts. If you disable
Status LED Blinking, the status LED does not blink, whether alerts are acknowledged or
not. It still changes color to indicate active alerts.

Procedure

Enable or disable Status LED Blinking.

The default setting is Enabled.

5.2 Enable or disable operator actions from the
display
You can configure the transmitter to let the operator perform specific actions using the
display.

5.2.1 Enable or disable Totalizer Start/Stop from the display
Display OFF-LINE MAINT > OFF-LINE CONFG > DISPLAY > TOTALS STOP

ProLink III Device Tools > Configuration > Totalizer Control Methods

You can control whether or not the operator is able to start and stop totalizers and
inventories from the display.

About this task

Restriction
• You cannot start and stop totalizers individually from the display. All totalizers are

started or stopped together.
• You cannot start or stop inventories separately from totalizers. When a totalizer is

started or stopped, the associated inventory is also started or stopped.
• If the petroleum measurement application is installed, the operator must enter the off-

line password to perform this function, even if the off-line password is not enabled.

Procedure

1. Ensure that at least one totalizer is configured as a display variable.

2. Enable or disable Totalizer Reset as desired.

Option Description

Enabled Operators can start and stop totalizers and inventories from
the display, if at least one totalizer is configured as a display
variable.

Disabled (default) Operators cannot start and stop totalizers and inventories
from the display.
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5.2.2 Enable or disable Totalizer Reset from the display
Display OFF-LINE MAINT > OFF-LINE CONFG > DISPLAY > TOTALS RESET

ProLink III Device Tools > Configuration > Totalizer Control Methods

You can configure whether or not the operator is able to reset totalizers from the display.

About this task

Restriction
• This parameter does not apply to inventories. You cannot reset inventories from the

display.
• You cannot use the display to reset all totalizers as a group. You must reset totalizers

individually.
• If the petroleum measurement application is installed, the operator must enter the off-

line password to perform this function, even if the off-line password is not enabled.

Procedure

1. Ensure that the totalizers you want to reset have been configured as display
variables.

If the totalizer is not configured as a display variable, the operator will not be able to
reset it.

2. Enable or disable resetting the totalizer as desired.

Option Description

Enabled Operators can reset a totalizer from the display, if the totalizer
is configured as a display variable.

Disabled (default) Operators cannot reset totalizers from the display.

5.2.3 Enable or disable the Acknowledge All Alerts display
command

Display OFF-LINE MAINT > OFF-LINE CONFG > DISPLAY > ALERT

ProLink III Device Tools > Configuration > Transmitter Display > Ack All

You can configure whether or not the operator can use a single command to acknowledge
all alerts from the display.

Procedure

1. Ensure that the alert menu is accessible from the display.

To acknowledge alerts from the display, operators must have access to the alert
menu.

2. Enable or disable Acknowledge All Alerts as desired.
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Option Description

Enabled (default) Operators can use a single display command to acknowledge
all alerts at once.

Disabled Operators cannot acknowledge all alerts at once. Each alert
must be acknowledged separately.

5.3 Configure security for the display menus
Display OFF-LINE MAINT > OFF-LINE CONFG > DISPLAY

ProLink III Device Tools > Configuration > Transmitter Display > Display Security

You can control operator access to different sections of the display off-line menu. You can
also configure a password to control access.

Procedure

1. To control operator access to the maintenance section of the off-line menu, enable
or disable Off-Line Menu.

Option Description

Disabled Operator cannot access the maintenance section of the off-line menu.

2. To control operator access to the alert menu, enable or disable Alert Menu.

Option Description

Enabled (default) Operator can access the alert menu. This access is required to
view and acknowledge alerts, but is not required for Smart
Meter Verification (if applicable), configuration, or calibration.

Disabled Operator cannot access the alert menu.

Note
The transmitter status LED changes color to indicate that there are active alerts, but
does not show specific alerts.

3. To require a password for access to the maintenance section of the off-line menu ,
enable or disable Off-Line Password.

Option Description

Enabled Operator is prompted for the off-line password at entry to the
Smart Meter Verification menu (if applicable) or entry to the
maintenance section of the off-line menu.

Disabled (default) No password is required for entry to the Smart Meter
Verification menu (if applicable) or entry to the maintenance
section of the off-line menu.
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4. To require a password to access the alert menu, enable or disable Alert Password.

Option Description

Enabled Operator is prompted for the off-line password at entry to the
alert menu.

Disabled (default) No password is required for entry to the alert menu.

If both Off-Line Password and Alert Password are enabled, the operator is
prompted for the off-line password to access the off-line menu, but is not prompted
thereafter.

5. Set Off-Line Password to the desired value.

The default value is 1234. The range is 0000 to 9999.

The same value is used for both the off-line password and the alert password.

Tip
Record your password for future reference.

5.4 Configure alert handling
The alert handling parameters control the transmitter’s response to process and device
conditions.

5.4.1 Configure Fault Timeout
Display Not available

ProLink III Device Tools > Configuration > Fault Processing

Fault Timeout controls the delay before fault actions are performed.

Procedure

• Set Fault Timeout as desired.

The default value is 0 seconds. The range is 0 to 60 seconds.

If you set Fault Timeout to 0, fault actions are performed as soon as the alert condition
is detected.

The fault timeout period begins when the transmitter detects an alert condition.
During the fault timeout period, the transmitter continues to report its last valid
measurements.

If the fault timeout period expires while the alert is still active, the fault actions are
performed. If the alert condition clears before the fault timeout expires, no fault
actions are performed.
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5.4.2 Configure Status Alert Severity
Display Not available

ProLink III Device Tools > Configuration > Alert Severity

Use Status Alert Severity to control the fault actions that the transmitter performs when
it detects an alert condition.

About this task

Restriction
• For some alerts, Status Alert Severity is not configurable.
• For some alerts, Status Alert Severity can be set only to two of the three options.

Tip
Use the default settings for Status Alert Severity unless you have a specific requirement
to change them.

Procedure

1. Select a status alert.

2. For the selected status alert, set Status Alert Severity as desired.

Option Description

Fault Actions when fault is detected:
• The alert is posted to the Alert List.
• Outputs go to the configured fault action (after Fault Timeout

has expired, if applicable).
• Digital communications go to the configured fault action (after

Fault Timeout has expired, if applicable).
• The status LED (if available) changes to red or yellow

(depending on alert severity).

Actions when alert clears:
• Outputs return to normal behavior.
• Digital communications return to normal behavior.

Informational Actions when fault is detected:
• The alert is posted to the Alert List.
• The status LED (if available) changes to red or yellow

(depending on alert severity).

Actions when alert clears:
• The status LED (if available) returns to green and may or may

not flash.
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Status alerts and options for Status Alert Severity
Table 5-1: Status alerts and Status Alert Severity 

Alert code Status message Default severity Notes Configurable?

A001 EEPROM Error (Core
Processor)

Fault No

A002 RAM Error (Core Processor) Fault No

A003 No Sensor Response Fault Yes

A004 Temperature Overrange Fault No

A005 Mass Flow Rate Overrange Fault Yes

A006 Characterization Required Fault Yes

A008 Density Overrange Fault Yes

A009 Transmitter Initializing/
Warming Up

Fault Yes

A010 Calibration Failure Fault No

A011 Zero Calibration Failed:
Low

Fault Yes

A012 Zero Calibration Failed:
High

Fault Yes

A013 Zero Calibration Failed:
Unstable

Fault Yes

A014 Transmitter Failure Fault No

A016 Sensor RTD Failure Fault Yes

A020 No Flow Cal Value Fault Yes

A021 Incorrect Sensor Type (K1) Fault No

A026 Sensor/Transmitter
Communications Failure

Fault No

A032 Meter Verification in
Progress: Outputs to Fault

Varies Applies only to transmitters with
Smart Meter Verification.

If outputs are set to Last Measured
Value, severity is Info. If outputs are
set to Fault, severity is Fault.

No

A033 Insufficient Right/Left
Pickoff Signal

Fault Yes

A034 Meter Verification Failed Fault Applies only to transmitters with
Smart Meter Verification.

Yes

A102 Drive Overrange Informational Yes
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Table 5-1: Status alerts and Status Alert Severity (continued)

Alert code Status message Default severity Notes Configurable?

A104 Calibration in Progress Informational Can be set to either Informational
or Ignore, but cannot be set to
Fault.

Yes

A105 Slug Flow Informational Yes

A106 Burst Mode Enabled Informational Can be set to either Informational
or Ignore, but cannot be set to
Fault.

Yes

A107 Power Reset Occurred Informational Normal transmitter behavior;
occurs after every power cycle.

Yes

A131 Meter Verification in
Progress: Outputs to Last
Measured Value

Informational Applies only to transmitters with
Smart Meter Verification.

Yes

5.5 Configure informational parameters
The informational parameters can be used to identify or describe your meter. They are not
used in process measurement and they are not required.

5.5.1 Configure Sensor Serial Number
Display Not available

ProLink III Device Tools > Configuration > Informational Parameters > Sensor

Sensor Serial Number lets you store the serial number of the sensor component of your
flowmeter in transmitter memory. This parameter is not used in processing and is not
required.

Procedure

1. Obtain the sensor serial number from your sensor tag.

2. Enter the serial number in the Sensor Serial Number field.

5.5.2 Configure Sensor Material
Display Not available

ProLink III Device Tools > Configuration > Informational Parameters > Sensor

Sensor Material lets you store the type of material used for your sensor’s wetted parts in
transmitter memory. This parameter is not used in processing and is not required.

Procedure

1. Obtain the material used for your sensor’s wetted parts from the documents
shipped with your sensor, or from a code in the sensor model number.
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To interpret the model number, refer to the product data sheet for your sensor.

2. Set Sensor Material to the appropriate option.

5.5.3 Configure Sensor Liner Material
Display Not available

ProLink III Device Tools > Configuration > Informational Parameters > Sensor

Sensor Liner Material lets you store the type of material used for your sensor liner in
transmitter memory. This parameter is not used in processing and is not required.

Procedure

1. Obtain your sensor’s liner material from the documents shipped with your sensor,
or from a code in the sensor model number.

To interpret the model number, refer to the product data sheet for your sensor.

2. Set Sensor Liner Material to the appropriate option.

5.5.4 Configure Sensor Flange Type
Display Not available

ProLink III Device Tools > Configuration > Informational Parameters > Sensor

Sensor Flange Type lets you store your sensor’s flange type in transmitter memory. This
parameter is not used in processing and is not required.

Procedure

1. Obtain your sensor’s flange type from the documents shipped with your sensor, or
from a code in the sensor model number.

To interpret the model number, refer to the product data sheet for your sensor.

2. Set Sensor Flange Type to the appropriate option.

5.5.5 Configure Descriptor
Display Not available

ProLink III Device Tools > Configuration > Informational Parameters > Transmitter

Descriptor lets you store a description in transmitter memory. The description is not used
in processing and is not required.

Procedure

• Enter a description for the transmitter or device
You can use up to 16 characters for the description.
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6 Complete the configuration

6.1 Test or tune the system using sensor
simulation
Use sensor simulation to test the system's response to a variety of process conditions,
including boundary conditions, problem conditions, or alert conditions, or to tune the
loop.

Prerequisites

Before enabling sensor simulation, ensure that your process can tolerate the effects of the
simulated process values.

About this task

Procedure

1. Navigate to the sensor simulation menu.

2. Enable sensor simulation.

3. For mass flow, set Wave Form as desired and enter the required values.

Option Required values

Fixed Fixed Value

Sawtooth Period

Minimum

Maximum

Sine Period

Minimum

Maximum

4. For density, set Wave Form as desired and enter the required values.

Option Required values

Fixed Fixed Value

Sawtooth Period

Minimum

Maximum

Sine Period

Minimum
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Option Required values

Maximum

5. For temperature, set Wave Form as desired and enter the required values.

Option Required values

Fixed Fixed Value

Sawtooth Period

Minimum

Maximum

Sine Period

Minimum

Maximum

6. Observe the system response to the simulated values and make any appropriate
changes to the transmitter configuration or to the system.

7. Modify the simulated values and repeat.

8. When you have finished testing or tuning, disable sensor simulation.

6.1.1 Sensor simulation
Sensor simulation allows you to test the system or tune the loop without having to create
the test conditions in your process. When sensor simulation is enabled, the transmitter
reports the simulated values for mass flow, density, and temperature, and takes all
appropriate actions. For example, the transmitter might apply a cutoff, activate an event,
or post an alert.

When sensor simulation is enabled, the simulated values are stored in the same memory
locations used for process data from the sensor. The simulated values are then used
throughout transmitter functioning. For example, sensor simulation will affect:

• All mass flow rate, temperature, and density values displayed or reported via outputs
or digital communications

• The mass total and mass inventory values
• All volume calculations and data, including reported values, volume totals, and volume

inventories
• All mass, temperature, density, or volume values logged to Data Logger

Sensor simulation does not affect any diagnostic values.

Unlike actual mass flow rate and density values, the simulated values are not temperature-
compensated (adjusted for the effect of temperature on the sensor’s flow tubes).
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6.2 Back up transmitter configuration
ProLink III provides a configuration upload/download function which allows you to save
configuration sets to your PC. This allows you to back up and restore your transmitter
configuration. This is also a convenient way to replicate a configuration across multiple
devices.

About this task

Restriction
This function is not available with any other communications tools.

Procedure

• To back up the transmitter configuration using ProLink III:

a) Choose Device Tools > Configuration Transfer > Save or Load Configuration
Data.

b) In the Configuration groupbox, select the configuration data you want to save.
c) Click Save, then specify a file name and location on your computer.
d) Click Start Save.

Results

The backup file is saved to the specified name and location. It is saved as a text file and can
be read using any text editor.
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7 Transmitter operation

7.1 Record the process variables

About this task

Emerson suggests that you make a record of specific process variable measurements,
including the acceptable range of measurements, under normal operating conditions. This
data will help you recognize when the process or diagnostic variables are unusually high or
low, and may help you diagnose and troubleshoot application issues.

Procedure

Record the following process and diagnostic variables, under normal operating conditions.

Variable

Measurement

Typical average Typical high Typical low

Flow rate

Density

Temperature

Tube frequency

Pickoff voltage

Drive gain

7.2 Viewing process variables
Process variables include measurements such as mass flow rate, volume flow rate,
temperature, and density. You can view process variables with the display (if your
transmitter has a display), ProLink III, a PROFIBUS configuration tool (such as Simatic PDM)
using the EDD, or from a Class 2 PROFIBUS host using bus parameters.

Using the display

By default, the display shows the mass flow rate, mass total, volume flow rate, volume
total, temperature, density, and drive gain. If desired, you can configure the display to
show other process variables. For more information, refer to Changing the display
variables and precision.

The LCD panel reports the abbreviated name of the process variable (for example, DENS
for density), the current value of that process variable, and the associated unit of measure
(for example, G/CM3). See Using the transmitter display for information on the codes and
abbreviations used for display variables.

To view a process variable with the display:

• If Auto Scroll is enabled, wait until the desired process variable appears on the LCD
panel.

• If Auto Scroll is not enabled, Scroll until the name of the desired process variable either:
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— Appears on the process variable line,
— Begins to alternate with the units of measure

The precision of variables shown on the display is configurable, as described in Changing
the display variables and precision. The display precision affects only the value shown on
the display, and does not affect the actual process value stored in the transmitter.

Process variable values are displayed using either standard decimal notation or
exponential notation:

• Values < 100,000,000 are displayed in decimal notation (such as 1234567.8).
• Values ≥ 100,000,000 are displayed using exponential notation (such as 1.000E08)

— If the value is less than the precision configured for that process variable, the value
is displayed as 0 (there is no exponential notation for fractional numbers).

— If the value is too large to be displayed with the configured precision, the displayed
precision is reduced (that is, the decimal point is shifted to the right) as required so
that the value can be displayed.

.

Using ProLink III

The Process Variables display automatically when you first connect to the transmitter. This
window displays current values for the standard process variables (mass, volume, density,
temperature, external pressure, and external temperature).

To view petroleum measurement process variables (if the petroleum measurement
application is enabled), select the desired variable from the drop-down menu in the
Process Variables window.

To view concentration measurement process variables (if the concentration measurement
application is enabled), select the desired variable from the drop-down menu in the
Process Variables window. The concentration measurement process variables that are
displayed depend on the configuration of the concentration measurement application.

Using PROFIBUS EDD

Select View > Process Variables to view standard process variables. petroleum
measurement and concentration measurement variables are not displayed on this screen.
Select Device > API to view petroleum measurement variables. Select Device > CM
Process Variables to view concentration measurement variables.

Using bus parameters

To view standard process variables, examine index 26 (AI Out) of the appropriate AI
function block. Refer to Setting the IO mode for information about how slots correspond
to AI function blocks.

7.3 I&M functions
The transmitter implements the following PROFIBUS identification and maintenance (I&M)
functions:

• I&M 0
• I&M 1
• I&M 2
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• PA & M0

Refer to Amendment 3 to the PROFIBUS Profile for Process Control Devices V 3.01:
Identification and Maintenance Functions Version 1.0, December 2004 Order No. 3.042.

The I&M functions contain a variety of device and manufacturer information, all of which is
hard-coded (read only). The I&M functions are not accessible through ProLink III or the
display. If you are using Siemens Simatic PDM, v6.0 SP2 or higher is required. Earlier
versions do not support I&M functions.

Refer to I & M functions for the bus parameters associated with the I&M functions.

7.4 Using sensor simulation mode
Sensor simulation mode causes simulated values to be substituted for actual process data
from the sensor. Sensor simulation mode can be enabled only with ProLink III.

About this task

Sensor simulation is only available if you have an enhanced core processor. For more
information about sensor simulation mode, refer to Test or tune the system using sensor
simulation.

ProLink III

for Sensor
simulation

1. Device Tools > Diagnostics > Testing > Sensor Simulation
2. Select Enable Simulation Status.
3. Select a wave form from the Wave Form lists for mass flow,

density, and temperature.
a. If you select a Fixed wave, enter a value in the Fixed Value

box.
a. If you select a Triangular or sine wave, enter the period in

the Period box.
b. Enter minimum and maximum amplitude in the Minimum

and Maximum boxes.

4. Click Apply.

7.5 Accessing diagnostic information with a
PROFIBUS host
The transmitter sends diagnostic information to a PROFIBUS host in the form of slave
diagnostic response bytes. The number of bytes sent depends on whether the transmitter
is configured for Manufacturer-specific or Profile-specific mode.

Refer to Setting the IO mode for information about the mode, and Slave diagnostic
response bytes for information on interpreting the diagnostic bytes.

7.6 Viewing transmitter status and alerts
You can view transmitter status using the display, ProLink III, EDD, or bus parameters.
Depending on the method chosen, different information is displayed.
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Using the display

The display reports alerts in two ways:

1. With a status LED, which reports only that one or more alerts has occurred.
2. Through the alert queue, which reports each specific alert.

Note
If access to the alert menu from the display has been disabled (refer to Configuring the
display), then the display will not list alert codes in an alert queue and the status LED will
not flash. The status LED will indicate status using solid green, yellow, or red.

The status LED is located at the top of the following figure. The status LED can be in one of
six possible states, as listed in Table 7-1. The procedure for responding to alerts is shown in
Figure B-2.

Figure 7-1: Status LED

A. Status LED

Table 7-1: Status LED states

Status LED state Alert priority

Green No alert -- normal operating mode

Flashing green (1) Unacknowledged corrected condition

Yellow Acknowledged low severity alert

Flashing yellow (1) Unacknowledged low severity alert

Red Acknowledged high severity alert

Flashing Red (1) Unacknowledged high severity alert

(1) If the display alert menu has been disabled, alerts cannot be acknowledged. In this case, the
status LED never indicate an unacknowledged alert.

Using ProLink III

ProLink III provides allows you to view alert information by choosing Device Tools > Alerts.
The alerts are divided into three categories: Failed: Fix Now, Maintenance: Fix Soon, and
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Advisory: Informational. For a more complete view of each Alert, click on the Detail View
button.

Using EDD

The transmitter sets its PROFIBUS output status to bad or uncertain whenever an alert
condition occurs. You can view the current alerts by selecting View > Device Status and
then selecting Critical, Informational,or Operational. All possible alerts are shown,
independent of configured alert severity. Currently active alerts are shown by a check
mark.

Using bus parameters

The transmitter sets its PROFIBUS output status to bad or uncertain whenever an alert
condition occurs. You can view alerts by reading the status words of the block where the
alert originated. The status words are one or more parameters whose bits indicate alert
conditions:

• Index 23 (Alert summary) of each AI function block (Slot 1, 2, 3, and 5).
• Indies 139–146 of transducer block 1 (Slot 11).

You must view all of the status words to get a comprehensive list of current alerts.

7.7 View and acknowledge status alerts
The transmitter posts status alerts whenever a process variable exceeds its defined limits
or the transmitter detects a fault condition. You can view active alerts, and you can
acknowledge alerts. Acknowledging alerts is not required.

7.7.1 View and acknowledge alerts using the display
You can view a list containing all alerts that are active, or inactive but unacknowledged.

Prerequisites

Operator access to the alert menu must be enabled (default setting). If operator access to
the alert menu is disabled, you must use another method to view or acknowledge status
alerts.

About this task

Note
Only Fault and Informational alerts are listed. The transmitter automatically filters out
alerts with Status Alert Severity set to Ignore.

Procedure

See Figure 7-2.
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Figure 7-2: Using the display to view and acknowledge the status alerts (alarms)
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Postrequisites

• To clear the following alerts, you must correct the problem, acknowledge the alert,
then power-cycle the transmitter: A001, A002, A010, A011, A012, A013, A018, A019,
A022, A023, A024, A025, A028, A029, A031.

• For all other alerts:
— If the alert is inactive when it is acknowledged, it will be removed from the list.
— If the alert is active when it is acknowledged, it will be removed from the list when

the alert condition clears.

7.7.2 View and acknowledge alerts using ProLink III
You can view a list containing all alerts that are active, or inactive but unacknowledged.
From this list, you can acknowledge individual alerts or choose to acknowledge all alerts at
once.

Procedure

1. View alerts on the ProLink III Device Tools > Alerts tab.

All active or unacknowledged alerts are listed, and displayed according to the
following categories:

Category Description

Failed: Fix Now A meter failure has occurred and must be addressed
immediately.

Maintenance: Fix Soon A condition has occurred that can be fixed at a later
time.

Advisory: Informational A condition has occurred, but requires no maintenance
from you.

Notes
• All fault alerts are displayed in the Failed: Fix Now category.
• All information alerts are displayed in either the Maintenance: Fix Soon

category or the Advisory: Informational category. The category assignment is
hard-coded.

• The transmitter automatically filters out alerts with Alert Severity set to Ignore.

2. To acknowledge a single alert, check the Ack checkbox for that alert. To
acknowledge all alerts at once, click Ack All.

Postrequisites

• To clear the following alerts, you must correct the problem, acknowledge the alert,
then power-cycle the transmitter: A001, A002, A010, A011, A012, A013, A018, A019,
A022, A023, A024, A025, A028, A029, A031.

• For all other alerts:
— If the alert is inactive when it is acknowledged, it will be removed from the list.
— If the alert is active when it is acknowledged, it will be removed from the list when

the alert condition clears.
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7.7.3 Alert data in transmitter memory
The transmitter maintains three sets of data for every alert that is posted.

For each alert occurrence, the following three sets of data are maintained in transmitter
memory:

• Alert List
• Alert Statistics
• Recent Alerts

Alert data structure Transmitter action if condition occurs

Contents Clearing

Alert List As determined by the alert status bits, a list of:
• All currently active alerts
• All previously active alerts that have not

been acknowledged

Cleared and regenerated with every
transmitter power cycle

Alert Statistics One record for each alert (by alert number)
that has occurred since the last master reset.
Each record contains:
• A count of the number of occurrences
• Timestamps for the most recent posting

and clearing

Not cleared; maintained across transmitter
power cycles

Recent Alerts 50 most recent alert postings or alert clearings Not cleared; maintained across transmitter
power cycles

7.8 Using the totalizers and inventories
The totalizers keep track of the total amount of mass or volume measured by the
transmitter over a period of time. The totalizers can be started and stopped, and the totals
can be viewed and reset.

The inventories track the same values as the totalizers. Whenever totalizers are started or
stopped, all inventories (including the petroleum measurement volume inventory and
concentration measurement inventories) are started or stopped automatically. However,
when totalizers are reset, inventories are not reset automatically—you must reset
inventories separately. This allows you to use the inventories to keep running totals across
multiple totalizer resets.

You can view all totalizer and inventory values using any of the communication tools: the
display, ProLink III, the EDD, or bus parameters. Specific starting, stopping, and resetting
functionality depends on the tool you are using. If you are using the display, consult the
display flow chart in Figure B-9.

7.8.1 Viewing current values for totalizers and inventories
You can view current totals for the totalizers and inventories with the display (if your
transmitter has a display), ProLink III, PROFIBUS EDD, or PROFIBUS bus parameters.
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Using the display

You cannot view current totals with the display unless the display has been configured to
show them. For more information, refer to Configuring the display.

To view a totalizer or inventory value, Scroll until the LCD panel shows the word TOTAL in
the lower left and the desired units in the lower right. Refer to the following table and
Figure 7-3.

Table 7-2: Display Totalizers and Inventories

Totalizer/inventory Unit name on display

Mass total Mass unit

Mass inventory Mass unit alternating with MASSI

Volume total (liquid) Volume unit

Volume inventory (liquid) Volume unit alternating with LVOLI

Gas standard volume total Volume unit

Gas standard volume inventory Volume unit alternating with GSV I

Petroleum measurement corrected volume total Volume unit alternating with TCORR

(Temperature-corrected total)

Petroleum measurement

corrected volume inventory

Volume unit alternating with TCORI

(Temperature-corrected inventory)

ED net mass total Mass unit alternating with NET M

ED net volume total Mass unit alternating with NET MI

ED net volume inventory Mass unit alternating with NETV

ED standard volume total Mass unit alternating with STD V

ED standard volume inventory Mass unit alternating with STDVI
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Figure 7-3: Totalizer and inventory values on display

A. TOTAL
B. Scroll optical switch
C. Current value
D. Units of measure

Using ProLink III

To view the current value of the totalizers and inventories with ProLink III, select Device
Tools > Totalizers and Inventories . By default, ProLink III can see totals in process
variables when they have been assigned.

Using EDD

To view the current value of the totalizers and inventories:

• For standard mass, liquid standard volume, and gas standard volume, select View > >
Process Variables > Totalizer and then select either Mass or Volume. (If the
transmitter is configured to use gas standard volume, then Volume will be replaced by
Gas Standard Volume.). Totals and inventories are displayed together.

• For petroleum measurement, select Device > Device > API Totalizer.
• For concentration measurement, select Device > Device > CM Totalizer.

Using bus parameters

To view the current value of the totalizers and inventories, examine index 26 (TOT Total) of
each totalizer function block (Slots 4, 6, 7, and 8).

7.9 Read totalizer and inventory values
Totalizers keep track of the total amount of mass or volume measured by the transmitter
since the last totalizer reset. Inventories keep track of the total amount of mass or volume
measured by the transmitter since the last inventory reset.

About this task

Tip
You can use the inventories to keep a running total of mass or volume across multiple
totalizer resets.
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7.10 Start and stop totalizers and inventories
When you start a totalizer, it tracks process measurement. In a typical application, its value
increases with flow. When you stop a totalizer, it stops tracking process measurement and
its value does not change with flow. Inventories are started and stopped automatically,
when totalizers are started and stopped.

About this task

Important
Totalizers and inventories are started or stopped as a group. When you start any totalizer,
all other totalizers and all inventories are started simultaneously. When you stop any
totalizer, all other totalizers and all inventories are stopped simultaneously. You cannot
start or stop inventories directly.

7.10.1 Start and stop totalizers and inventories using the
display
Prerequisites

• The Totalizer Start/Stop display function must be enabled.
• At least one totalizer must be configured as a display variable.

Procedure

• To start all totalizers and inventories using the display:

Note
If the PLC is connected and communicating, the start/stop and reset totalizers
commands might be overriding any totalizer commands from the local display or from
ProLink III.

a) Scroll until the word TOTAL appears in the lower left corner of the display.

Important
Because all totalizers are started or stopped together, it does not matter which
total you use.

b) Select.
c) Scroll until START appears beneath the current totalizer value.

Exit displays beneath the current totalizer value.

d) Select.
e) Select again to confirm.
f) Scroll to EXIT.

• To stop all totalizers and inventories using the display:

a) Scroll until the word TOTAL appears in the lower left corner of the display.

Important
Because all totalizers are started or stopped together, it does not matter which
total you use.
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b) Select.
c) Scroll until STOP appears beneath the current totalizer value.
d) Select.
e) Select again to confirm.
f) Scroll to EXIT.

7.11 Reset totalizers
When you reset a totalizer, the transmitter sets its value to 0. It does not matter whether
the totalizer is started or stopped. If the totalizer is started, it continues to track process
measurement.

About this task

Tip
When you reset a single totalizer, the values of other totalizers are not reset. Inventory
values are not reset.

7.11.1 Reset totalizers using the display
Prerequisites

• The Totalizer Reset display function must be enabled.
• The totalizer that you want to reset must be configured as a display variable. For

example:

— If you want to reset the mass totalizer, Mass Total must be configured as a display
variable.

— If you want to reset the volume totalizer, Volume Total must be configured as a
display variable.

Procedure

• To reset the mass totalizer:

a) Scroll until the mass totalizer value appears.
b) Select.

Exit displays beneath the current totalizer value.

c) Scroll until Reset displays beneath the current totalizer value.

d) Select.
Reset and Yes? alternately flash beneath the current totalizer value.

e) Select again to confirm.
f) Scroll to EXIT.

g) Select.
• To reset the volume totalizer:

a) Scroll until the volume totalizer value appears.
b) Select.

Exit displays beneath the current totalizer value.

c) Scroll until Reset displays beneath the current totalizer value.
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d) Select.
Reset and Yes? alternately flash beneath the current totalizer value.

e) Select again to confirm.
f) Scroll to EXIT.

g) Select.

7.12 Reset inventories
ProLink III Device Tools > Totalizer Control > Totalizer and Inventories > Reset Mass Inventory

Device Tools > Totalizer Control > Totalizer and Inventories > Reset Volume
Inventory

Device Tools > Totalizer Control > Totalizer and Inventories > Reset Gas Inventory

Device Tools > Totalizer Control > Totalizer and Inventories > Reset All Inventories

When you reset an inventory, the transmitter sets its value to 0. It does not matter
whether the inventory is started or stopped. If the inventory is started, it continues to track
process measurement.

About this task

Tip
Mass and volume inventory totals cannot be set separately. They can only be reset
together simultaneously.
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8 Measurement support

8.1 Options for measurement support
Micro Motion provides several measurement support procedures to help you evaluate and
maintain your flowmeter's accuracy.

The following methods are available:

• Smart Meter Verification (SMV) evaluates the structural integrity of the sensor tubes by
comparing current tube stiffness to the stiffness measured at the factory. Stiffness is
defined as the load per unit deflection, or force divided by displacement. Because a
change in structural integrity changes the sensor’s response to mass and density, this
value can be used as an indicator of measurement performance.

• Meter validation compares flowmeter measurements reported by the transmitter to an
external measurement standard. Meter validation requires one data point.

• Calibration establishes the relationship between a process variable and the signal
produced at the sensor. You can calibrate the flowmeter for zero, density, and
temperature. Density and temperature calibration require two data points (low and
high) and an external measurement for each.

Tip
• Perform SMV at regular intervals to get the best data on your meter's performance.
• To prove the meter against a regulatory standard, or to correct measurement error,

use meter validation and meter factors.
• Before performing a field calibration, contact customer support to see if there is an

alternative. In many cases, field calibrations have a negative effect on measurement
accuracy.

8.2 Calibration
The flow meter measures process variables based on fixed points of reference. Calibration
adjusts those points of reference. Three types of calibration can be performed:

• Zero
• Density calibration
• Temperature calibration

Density and temperature calibration require two data points (low and high) and an
external measurement for each. The density and temperature calibration procedure
changes the offset and the slope of the line that represents the relationship between
process density and the reported density value to the relationship between process
temperature and the reported temperature value.

Note
For density or temperature calibration to be useful, the external measurements must be
accurate.

Zero calibration requires only that flow through the sensor is stopped.
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Flow meters are calibrated at the factory, and normally do not need to be calibrated in the
field. Calibrate the flow meter only if you must do so to meet regulatory requirements.
Contact customer service before calibrating your flow meter.

Note
Micro Motion recommends using meter validation and meter factors, rather than
calibration, to prove the meter against a regulatory standard or to correct measurement
error.

8.3 Comparison and recommendations
When choosing among Smart Meter Verification, meter validation, and calibration,
consider the following factors:

• Process and measurement interruption
— Smart Meter verification provides an option that allows process measurement to

continue during the test.
— Meter validation for density does not interrupt the process. However, meter

validation for mass flow or volume flow requires process down-time for the length
of the test.

— Calibration requires process down-time. In addition, density and temperature
calibration require replacing the process fluid with low-density and high-density
fluids, or low-temperature and high-temperature fluids. Zero calibration requires
stopping flow through the sensor.

• External measurement requirements
— Smart Meter Verification does not require external measurements.
— Zero calibration does not require external measurements.
— Density calibration, temperature calibration, and meter validation require external

measurements. For good results, the external measurement must be three times
more accurate than the meter's specified accuracy.

• Measurement adjust
— Smart Meter Verification is an indicator of sensor condition, but does not change

flowmeter internal measurement in any way.
— Meter validation does not change flowmeter internal measurement in any way. If

you decide to adjust a meter factor as a result of a meter validation procedure, only
the reported measurement is changed: base measurement is not changed. You can
always reverse the change by returning the meter factor to its previous value.

— Calibration changes the transmitter's interpretation of process data and accordingly
changes the base measurement. If you perform a zero calibration and have an 800
enhanced core processor, you can return to the factory zero (or, if using ProLink III,
the previous zero). However, if you perform a density calibration or a temperature
calibration, you cannot return to the previous calibration factors unless you have
manually recorded them.

Micro Motion recommends obtaining the Smart Merer Verification transmitter option and
performing Smart Meter Verification on a regular basis.
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8.4 Use Smart Meter Verification (SMV)
You can run an SMV test, view and interpret the results, and set up automatic execution.

8.4.1 SMV requirements
To use SMV, the transmitter must be paired with an enhanced core processor.

See Table 8-1 for the minimum version of the transmitter, enhanced core processor, and
communication tool needed to support SMV. (If you are going to perform SMV using the
display, only the transmitter and enhanced core processor versions apply.)

Table 8-1: Minimum SMV version

Item Minimum version Minimum basic SMV
transmitter

Transmitter 3.10 4.10

Enhanced core processor 3.6 4.4

ProLink III 1.0 4.0

Siemens Simatic

Process Device Manager (PDM)
6.0.

Profibus PA device description:
device rev 3.10, DD rev 1

Siemens Simatic PDM 8.0.2 Profibus PA device description:
device rev 3.5 , DD rev 1

Siemens Simatic PDM 8.1 Profibus PA device description:
device rev 3.3 , DD rev 1

Siemens Simatic PDM 8.2 Profibus PA device description:
device rev 3.5 , DD rev 2

Siemens Simatic PDM 9 Profibus PA device description:
device rev 4.10 , DD rev 1

Asset Management Software
(AMS) 12, 12.3, 12.5

Profibus PA device description:
device rev 3.5 , DD rev 2

AMS 13.0 Profibus PA device description:
device rev 4.10, DD rev 1

If your devices or tools do not meet the minimum version requirements for SMV, you still
may have access to an older version of meter verification if the option was ordered for your
transmitter. See Table 8-2 for a description of the major differences between the older
meter verification and the newer SMV.

Table 8-2: Major differences between meter verification and SMV

Feature Meter verification (older) SMV (newer)

Measurement

interruption

Suspended during the test (3
minutes)

No interruption necessary

Configuration and Use Manual  Measurement support
20000327 October 2018

Configuration and Use Manual  97



Table 8-2: Major differences between meter verification and SMV (continued)

Feature Meter verification (older) SMV (newer)

Result storage No results stored in the transmitter Last 20 results stored in the
transmitter (licensed SMV)

Results reporting Pass/fail/abort Pass/fail/abort comparison tables
and graphs for stored test results (1)

Test start methods Manual only Manual, scheduled, event-based

(1) Detailed test analysis such as comparison graphs are not available on the local display.

8.4.2 SMV test preparation
Although it is not necessary to match factory conditions or change the transmitter's
configuration during an SMV test, the test will run more smoothly when conditions are
stable.

SMV has an output mode called Continuous Measurement that allows the transmitter to
keep measuring while the test is in progress. If you choose to run the test in Last Measured
Value or Fault modes instead, the transmitter outputs will be held constant for the two
minute duration of the test. If control loops depend on transmitter outputs, take
appropriate action.

Avoid process instability during the test. If conditions are too unstable, the SMV test will
abort. To maximize process stability:

• Maintain a constant fluid pressure and temperature.
• Avoid changes to fluid composition, e.g., two-phase flow or settling.
• Maintain a constant flow rate.

Tip
• The SMV test runs best when flow is stopped through the sensor.
• SMV is not affected by any configured transmitter parameters for flow, density, or

temperature.

8.4.3 Run SMV

Run an SMV test using the display

Procedure

1. Navigate to the Smart Meter Verification menu.
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Figure 8-1: SMV – Top-level menu
Scroll and Select simultaneously 

for 4 seconds

ENTER METER VERFY

Scroll

RUN VERFY RESULTS READ SCHEDULE VERFY

Select

EXITScroll Scroll Scroll

Scroll Select

Select Select Select

2. Choose Run Verify.

3. Choose Outputs and select the desired output behavior.

Option Description

Continue

Measuring

During the test, all outputs will continue to report their assigned
process variable. The test will run for approximately 90 seconds.

Fault During the test, all outputs will go to their configured fault action. The
test will run for approximately 140 seconds.

Last Value During the test, all outputs will report the last measured value of their
assigned process variable. The test will run for approximately
140 seconds.

While the test is in progress, dots traverse the display and test progress is shown.

Postrequisites

View the test results and take any appropriate actions.
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SMV flowchart: Running a test using the display

Figure 8-2: Running an SMV test using the display
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Run an SMV test using ProLink III

Procedure

1. Choose Device Tools > Diagnostics > Meter Verification > Run Test.

You may need to wait a few seconds while ProLink III synchronizes its database with
the transmitter data.

2. Enter any desired information on the Test Definition screen, and click Next.

All information on this screen is optional.

3. Choose the desired output behavior.

Option Description

Continue During the test, all outputs will continue to report their
assigned process variable. The test will run for approximately
90 seconds.
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Option Description

Measuring

Held at Last Value During the test, all outputs will report the last measured value
of their assigned process variable. The test will run for
approximately 140 seconds.

Held at Fault During the test, all outputs will go to their configured fault
action. The test will run for approximately 140 seconds.

4. Press Start.
Test progress is displayed on the screen.

Postrequisites

View the test results and take any appropriate actions. You can also print the report.

8.4.4 View test data
You can view the results of the current test. You can also view results from previous tests.

Important
You can view previous test results and see detailed test reports only if SMV is licensed.

The transmitter stores the following information about the previous twenty SMV tests:

• Powered-on hours at the time of the test.
• Test result (Pass, Fail, Abort).
• If the test aborted, 0 is stored for these values.
• Abort code, if applicable.

In addition, ProLink III provides a detailed test reporting and analysis framework. This
information is stored on the PC where ProLink III is installed for tests that were run only on
that PC. It includes:

• Timestamp from the PC clock
• Current flowmeter identification data
• Current flow and density configuration parameters
• Current zero values
• Current process values for mass flow rate, volume flow rate, density, temperature, and

external pressure
• Customer and test descriptions (if entered by the user)

You can use ProLink III to run a test that displays a test result chart and a test report at the
completion of the test. On-screen directions are provided to manipulate the test data or
export the data to a CSV file for offline analysis.

View test result data using the display

Procedure

1. If you have just run a test, results are displayed automatically at the end of the test.
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2. If SMV is licensed, and you want to view results from previous tests:

a) Navigate to the Smart Meter Verification menu.

Figure 8-3: SMV – Top-level menu
Scroll and Select simultaneously 

for 4 seconds

ENTER METER VERFY

Scroll

RUN VERFY RESULTS READ SCHEDULE VERFY

Select

EXITScroll Scroll Scroll

Scroll Select

Select Select Select

b) Scroll to Results Read and press Select.
The runcount of the most recent test is displayed.

c) To view data for this test, press Select, then press Scroll to scroll through test
data.

d) To select a different test, press Scroll, then press Select when the transmitter
displays Results More?. When the desired test appears, as identified by
runcount, press Select.
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SMV flowchart: Viewing test results using the display

Figure 8-4: Viewing SMV test results using the display
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View test result data using ProLink III

Prerequisites

You can view test result data only if your SMV is licensed and only for tests that were run
on the PC you are currently using.

Procedure

1. Choose Device Tools > Diagnostics > Meter Verification and click Previous Test
Results.
The chart shows test results for all tests stored in the ProLink III database.

2. (Optional) Click Next to view and print a test report.

3. (Optional) Click Export Data to CSV File to save the data to a file on your PC.
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Understanding SMV results
When the SMV test is completed, the result is reported as Pass, Fail, or Abort. (Some tools
report the Fail result as Advisory instead.)

Pass Smart Meter Verification does a statistical check between the factory baseline
value, field reference point, and the current Smart Meter Verification result. Pass
indicates that the two values are statistically the same.

Fail The current SMV value is statistically different than the factory baseline value.
• If the meter passes the second test, the first result can be ignored.
• If the meter fails the second test, the flow tubes may be damaged. Call

customer support.

Abort A problem occurred with the meter verification test (such as process instability)
or you stopped the test manually. See Table 8-3 for a list of abort codes, a
description of each code, and possible actions you can take in response.

Table 8-3: SMV abort codes

Code Description Recommended actions

1 User-initiated abort None required. Wait 15 seconds before starting
another test.

2 SMV Timeout Check status of pickoff and drive coils.

3 Pickoff Voltage Low Check status of pickoff and drive coils.

4 Temperature unstable Ensure temperature is stable. Start again.

5 Cal state in progress NOT AVAILABLE

6 Unused NOT AVAILABLE

7 Drive loop AGC reported an
amplitude error

Check the status of the pickoff and the drive coils.

8 High flow (dt) standard
deviation

Reduce the flow rate and start again.

9 High flow (dt) mean value Reduce the flow rate and start again.

10 State in progress NOT AVAILABLE

11 Verification Complete NOT AVAILABLE

12 Transmitter in fault and SMV
cannot run

View the Alerts present on the device and take any
necessary actions to clear them before proceeding.

13 No factory air verification Perform factory calibration on air.

14 No factory water verification Perform a factory calibration on water.

15 Drive frequency drift from
carrier frequency

Ensure temperature, flow, and density are stable.
Start again.

Other General abort Repeat the test. If the test aborts again, contact
customer service.

Measurement support Configuration and Use Manual
October 2018 20000327

104  Micro Motion Model 2700 Transmitters with PROFIBUS-PA



8.4.5 Schedule automatic execution of the SMV test
You can set up and run a single test at a user-defined future time. You can also set up and
run tests on a regular schedule.

Manage scheduled test execution using the display

Procedure

1. Navigate to the Smart Meter Verification menu.

Figure 8-5: SMV – Top-level menu
Scroll and Select simultaneously 

for 4 seconds

ENTER METER VERFY

Scroll

RUN VERFY RESULTS READ SCHEDULE VERFY

Select

EXITScroll Scroll Scroll

Scroll Select

Select Select Select

2. Scroll to Schedule Verfy and press Select.

3. To schedule a single test or the first test in recurring execution:

a) Scroll to Set Next and press Select.
b) Enter the number of hours that the transmitter will wait before beginning the

test.

4. To schedule recurring execution:

a) Scroll to Set Recur and press Select.
b) Enter the number of hours that will elapse between tests.

5. To disable scheduled execution:
• To disable execution of a single scheduled test, set Set Next to 0.
• To disable recurring execution, set Set Recur to 0.
• To disable all scheduled execution, choose Turn Off Sched when you enter the

Smart Meter Verification menu.
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SMV flowchart: Scheduling test execution using the display

Figure 8-6: Scheduling SMV test execution using the display
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Manage scheduled test execution using ProLink III

Procedure

1. Choose Device Tools > Diagnostics > Meter Verification > Schedule Meter
Verification.

2. To schedule a single test or the first test in recurring execution, specify a value for
Hours Until Next Run.
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3. To schedule recurring execution, specify a value for Hours Between Recurring
Runs.

4. To disable scheduled execution:
• To disable execution of a single scheduled test, set Hours Until Next Run to 0.
• To disable recurring execution, set Hours Between Recurring Runs to 0.
• To disable all scheduled execution, click Disable Scheduled Execution.

8.5 Zero the meter
Zeroing the meter establishes a baseline for process measurement by analyzing the
sensor's output when there is no flow through the sensor tubes.

Prerequisites

Verify the zero and prepare the meter using the procedures in Verify the zero.

Procedure

Postrequisites

Restore normal flow through the sensor by opening the valves. Verify that the sensor
tubes are full.

Need help?
If the zero fails:

• Verify that there is no flow through the sensor, then retry.
• Remove or reduce sources of electromechanical noise, then retry.
• Set Zero Time to a lower value, then retry.
• If the zero continues to fail, contact customer service.

8.5.1 Performing the zeroing procedure
Before performing the zeroing procedure on a flow meter, you must prepare the flow
meter for the process.

About this task

Note
If the zero fails, the meter will be in a fault condition. If you need to clear the fault
condition and use the original zero, you can power cycle the transmitter.

Note
Only use this procedure if you have performed zero verification and the result
recommends a zero calibration.

To prepare for the zeroing procedure:

Procedure

1. Apply power to the flow meter. Allow the flow meter to warmup up for
approximately 20 minutes.
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2. Run the process fluid through the sensor until the sensor temperature reaches the
normal process operating temperature.

3. Close the shutoff valve downstream from the sensor.

4. Ensure that the sensor is completely filled with fluid and the flow through the sensor
has completely stopped.

  CAUTION
If fluid is flowing through the sensor, the sensor zero calibration may be
inaccurate, resulting in inaccurate process measurement. To improve the
sensor zero calibration and measurement accuracy, ensue that process flow
through the sensor has completely stopped.

To zero the flow meter, use the appropriate tool at the top of this section and
consult the display diagram in Figure B-10.

Display a. From OFF-LINE MAINT, select SWREV > CONFG > ZERO.
b. Select CAL ZERO.
c. Select ZERO/YES?.
d. Select .....................

System responds with either CAL PASS or CAL FAIL .

ProLink III a. Go to Device Tools > Calibration > Zero Verification and
Calibration.

b. Click Calibrate Zero button.
c. If required, modify Zero Time (

Calibration in Progress

LED turns red).
d. Wait until Calibration in Progress LED turns green.
e. If the Calibration Failure LED turns green you are done, but if the

LED turns red you need to troubleshoot the cause.

EDD a. Click Modify zero time if desired.
b. Click Start Zero Cal.
c. Click Execute.
d. Click Stop flow through sensor.
e. Click OK.
f. Click Zero in progress.

g. If successful, click Zeroing success, but if unsuccessful, click
Troubleshoot.
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Bus Parameters a. Modify zero time (if desired), from Block: Transducer Block 1
(Slot 11)

Index 83 (zero time)

b. Initiate zero from Block: Transducer Block 1 (Slot 11)

Index 13 (zero calibration)

c. Check status from Block: Transducer Block 1 (Slot 11)

Index 143, Bit 0x8000

d. Check for failure alerts from Block: Transducer Block 1 (Slot 11)

Index 141, Bits 0x0100, 0x0200, 0x0400, and 0x0800

e. Check zero value from Block: Transducer Block 1 (Slot 11)

Index 12 (zero point)

8.6 Meter validation and meter factors
Meter validation compares a measurement value reported by the transmitter with an
external measurement standard. Meter validation requires one data point.

Note
For meter validation to be useful, the external measurement standard must be more
accurate than the sensor. See the sensor's product data sheet for its accuracy
specification.

If the transmitter's mass flow, volume flow, or density measurement is significantly
different from the external measurement standard, you may want to adjust the
corresponding meter factor. A meter factor is the value by which the transmitter
multiplies the process variable value. The default meter factors are 1.0, resulting in no
difference between the data retrieved from the sensor and the data reported externally.

Meter factors are typically used for proving the flow meters against a Weights & Measures
standard. You may need to calculate and adjust meter factors periodically to comply with
regulations.

8.6.1 Performing meter validation
Meter validation compares flow meter measurements reported by the transmitter to an
external measurement standard. If the transmitter value for mass flow, volume flow, or
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density measurement is significantly different from the external measurement standard,
you may want to adjust the corresponding meter factor.

About this task

The flow meter’s actual measurement is multiplied by the meter factor, and the resulting
value is reported and used in further processing. If using the display, consult the flow chart
in Figure B-5.

Display Menu > MTRF > MASS > VOL > Mass Flow Settings > DENS

ProLink III 1. Select Device Tools > Configuration > Process Measurement > Flow
tab

2. Set values for Mass Flow Rate Meter Factor and Volume Flow Rate
Meter Factor.

3. Click Apply.
4. Select Device Tools > Configuration > Process Measurement >

Density tab
5. Set values for Density Meter Factor.
6. Click Apply.

EDD 1. Select MMI Coriolis Flow > Transducer Block > Measurement >
Process Variable .

2. Select Mass Flow > Mass Factor.
3. Select Density > Density Factor.
4. Select Volume Flow > Volume Factor.

Bus Parameters 1. Select Meter Factors > Block: Transducer Block 1 (Slot 11).
2. Choose the appropriate index: Index 36 (Mass factor)

Index 37 (Density factor)

Index 38 (Volume factor)

Procedure

1. Determine the meter factor(s) to use. You can set any combination of the mass flow
volume flow, and density meter factors.

All three meter factors are independent:

• The mass flow meter factor affects only the value reported for mass flow.
• The density meter factor affects only the value reported for density.
• The volume meter flow affects only the value reported for volume flow.

Therefore, to adjust volume flow, you must set the meter factor for volume flow.
Setting a meter factor for mass-flow and a meter factor for density will not produce
the desired result. The volume flow calculations are based on original mass flow and
density values, before the corresponding meter factors have been applied.

2. Calculate the meter factor as follows:

a) Sample the process fluid and record the process variable value reported by
the flow meter.
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b) Measure the sample using an external standard.
c) Calculated the new meter factor using the following formula:

NewMeterFactor = ConfiguredMeterFactor
ExternalStandard

ActualFlowmeterMeasurement

If you are calculating the volume flow meter factor, note that proving volume
in the field may be expensive, and the procedure may be hazardous for some
process fluids. Therefore, because volume is inversely proportional to
density, an alternative to direct sampling and measurement is to calculate
the volume flow meter factor from the density meter factor. This method
provides partial correction by adjusting for any portion of the total offset that
is caused by density measurement offset. Use this method only when a
volume flow reference is not available, but a density reference is available.

d) Calculate the meter factor for density, using the preceding formula.
e) Calculate the volume flow meter factor from the density meter factor, as

shown below:

MeterFactorVolume =
1

MeterFactorDensity

Note
This equation is mathematically equivalent to the equation shown below.
You can use whichever equation you prefer.

MeterFactorVolume =  ConfiguredMeterFactorDensity
DensityFlowmeter

DensityReference Device

3. Ensure that the meter factor is between 0.8 and 1.2, inclusive. If the calculated
meter factor is outside these limits, contact customer service.

Calculating the meter factor for mass flow

The flow meter is installed and validated for the first time. The mass flow measurement
from the transmitter is 250.27 lb. The mass flow measurement from the reference device
is 250 lb. The mass flow meter factor is calculated as follows:

MeterFactorMassFlow =  1
250

250.27
=  0.9989

The first meter factor for mass flow is 0.9989.

One year later, the flow meter is validated again. The mass flow measurement from the
transmitter is 250.07 lb. The mass flow measurement from the reference device is
250.25 lb. The new mass flow meter factor is calculated as follows:

MeterFactorMassFlow =  0.9989
250.25
250.07

=  0.9996

The new meter factor for mass flow is 0.9996.
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8.7 Performing density calibration
Density calibration establishes the relationship between the density of the calibration
fluids and the signal produced at the sensor. Density calibration includes the calibration of
the D1 (low-density) and D2 (high-density) calibration points.

Important
Micro Motion flow meters are calibrated at the factory, and normally do not need to be
calibrated in the field. Calibrate the flow meter only if you must do so to meet regulatory
requirements. Contact customer service before calibrating the flow meter.

Tip
Micro Motion recommends using meter validation and meter factors, rather than
calibration, to prove the meter against a regulatory standard or to correct measurement
error.

Density calibration includes the following calibration points:

• All sensors:
— D1 calibration (low-density)
— D2 calibration (high-density)

• T-Series sensors only:
— D3 calibration (optional)
— D4 calibration (optional)

For T series meters, if the density is outside of 0.8 g/cc and 1.2 g/cc, then a D3 and D4
calibration is recommended to maintain the specified density accuracy of the sensor. If
you choose to perform the D3 and D4 calibrations:

• Do not perform the D1 or D2 calibrations
• Perform the D3 calibration if you have one calibrated fluid.
• Perform both the D3 and D4 calibrations if you have two calibrated fluids (other than

air and water)

Before performing the calibration, record your current calibration parameters. If you are
using ProLink III, you can perform this task by saving the current configuration to a file on
the PC. If the calibration fails, restore the known values.

Sensor requirements

During density calibration, the sensor must be completely filled with the calibration fluid,
and flow through the sensor must be at the lowest rate allowed by your application.
Accomplish this condition by closing the shutoff valve downstream from the sensor, then
fill the sensor with the appropriate fluid.

Density calibration fluid requirements

D1 and D2 density calibration require a D1 (low density) fluid and a D2 (high density) fluid.
You can use air and water.

Important
For T-Series sensors, the D1 calibration must be performed on air and the D2 calibration
must be performed on water.

For D3 density calibration, the D3 fluid must meet the following requirements:
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• Minimum density of 0.6 g/cm3

• Minimum difference of 0.1 g/cm3 between the density of the D4 fluid and the density
of the D3 fluid. The density of the D4 fluid must be greater than the density of the D3
fluid.

• Minimum difference of 0.1 g/cm3 between the density of the D4 fluid and the density
of water. The density of the D4 fluid can be either greater or less than the density of
water.

8.7.1 Procedure for calibrating density
You can perform a density calibration using ProLink III, the EDD, or bus parameters.

Procedure

1. Close the shutoff valve that is downstream from the sensor.

2. Uses the appropriate process in the table that follows to perform a density
calibration, depending on your communication tool and the particular fluid you are
calibrating:

ProLink III

D1 density

calibration

Device Tools > Calibration > Density Calibration > Point 1 (Air)

a. Fill the sensor with D1 fluid.
b. Enter the density of D1 fluid.
c. Press Start Calibration (Displays Calibration in

Progress (LED turns yellow)).

d. Calibration in Progress (LED turns green).
e. LED turns green.
f. Close.

ProLink III

D2 density

calibration

Device Tools > Calibration > Density Calibration > Point 2 (Water)

a. Fill the sensor with D2 fluid.
b. Enter density of D2 fluid.
c. Press Start Calibration (Displays Calibration in

Progress (LED turns yellow)).

d. LED turns green.
e. Close.
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EDD

D1 and D2
density

calibration

MMI Coriolis Flow > Calibration > Density Cal

a. Fill sensor with D1 fluid.
b. D1 = density of D1 fluid.
c. Start Lo Density Cal.
d. Execute.
e. Low Density Cal in progress.
f. Fill sensor with D2 fluid.

g. D2 = density of D2 fluid.
h. Start Hi Density Cal.
i. Execute.
j. High Density Cal in progress.

k. Done.
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Bus
Parameters

D1 and D2

density

calibration

a. Fill sensor with D1 fluid.
b. Enter the density of the D1 fluid:

Block: Transducer Block 1 (Slot 11) Index 97 (D1).

c. Initiate D1 calibration:

Block: Transducer Block 1 (Slot 11) Index 87 (low density
cal)

d. Check status:

Block: Transducer Block 1 (Slot 11) Index 143, Bit 0x4000)

e. Check for failure alerts:

Block: Transducer Block 1 (Slot 11) Index 141, Bits 0x0100,
0x0200, and 0x0400

f. Check K1 value:

Block: Transducer Block 1 (Slot 11) Index 92 (K1)

g. Fill sensor with D2 fluid.
h. Enter density of D2 fluid:

Block: Transducer Block 1 (Slot 11) Index 98 (D2)

i. Initiate D2 calibration:

Block: Transducer Block 1 (Slot 11) Index 88 (high density
cal)

j. Check status:

Block: Transducer Block 1 (Slot 11) Index 143, Bit 0x2000)

k. Check for failure alerts:

Block: Transducer Block 1 (Slot 11) Index 141, Bits 0x0100,
0x0200, and 0x0400

l. Check K2 value:

Block: Transducer Block 1 (Slot 11) Index 93 (K2)

m. Done.

ProLink III

D3 density

calibration

a. Fill the sensor with D3 fluid.
b. Device Tools > Calibration > Density Calibration > Point 3 (T-

Series).
c. Enter density of the D3 fluid.
d. Press Start Calibration (Displays Calibration in

Progress (LED turns yellow)).

e. LED turns green,
f. Close.
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ProLink III

D4 density

calibration

a. Fill the sensor with D4 fluid.
b. Device Tools > Calibration Data tab
c. Enter density of the D4 fluid.
d. Press Start Calibration (Displays Calibration in

Progress (LED turns yellow)).

e. LED turns green,
f. Close.

EDD

D3 and D4

density

calibration

MMI Coriolis Flow > Calibration > T-Series Density Cal

a. Fill sensor with D3 fluid.
b. D3 = density of D3 fluid.
c. Start D3 Density Cal.
d. Execute.
e. D3 Cal in progress.
f. Fill sensor with D4 fluid.

g. D4 = density of. D4 fluid.
h. Start D4 Density Cal.
i. Execute.
j. D4 Cal in progress.

k. Done.
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Bus
Parameters

D3 and D4

density

calibration

a. Fill sensor with D3 fluid.
b. Enter the density of the D3 fluid:

Block: Transducer Block 1 (Slot 11) Index 100 (D3)

c. Initiate D3 calibration:

Block: Transducer Block 1 (Slot 11) Index 90 (D3 cal)

d. Check status:

Block: Transducer Block 1 (Slot 11) Index 143, Bit 0x0040

e. Check for failure alerts:

Block: Transducer Block 1 (Slot 11) Index 141, Bits 0x0100,
0x0200, and 0x0400

f. Check K3 value:

Block: Transducer Block 1 (Slot 11) Index 95 (K3)

g. Fill sensor with D4 fluid.
h. Enter density of D4 fluid:

Block: Transducer Block 1 (Slot 11) Index 101 (D4)

i. Initiate D4 calibration:

Block: Transducer Block 1 (Slot 11) Index 91 (D4 cal)

j. Check status:

Block: Transducer Block 1 (Slot 11) Index 143, Bit 0x0080

k. Check for failure alerts:

Block: Transducer Block 1 (Slot 11) Index 141, Bits 0x0100,
0x0200, and 0x0400

l. Check K4 value:

Block: Transducer Block 1 (Slot 11) Index 96 (K4)

m. Done.

Postrequisites

If you disabled LD Optimization before the calibration procedure, re-enable it.
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9 Troubleshooting

9.1 Guide to troubleshooting topics
This section describes guidelines and procedures for troubleshooting the flowmeter. The
information in this section will enable you to:

• Categorize the problem
• Determine whether you are able to correct the problem
• Take corrective measures (if possible)

Note
All procedures provided in this chapter assume that you have established communication
with the transmitter and that you are complying with all applicable safety requirements.
See Using the transmitter display or the documentation for your PROFIBUS host or
configuration tool.

9.2 Transmitter does not operate
If the transmitter is not receiving power and cannot communicate over the network or
display, then perform all of the procedures under Diagnosing wiring problems.

If the wiring checks do not indicate a problem with electrical connections, contact the
customer service department.

9.3 Transmitter does not communicate
If the transmitter does not appear to be communicating on the network, then:

• Make sure the PROFIBUS network has proper termination.
• Check the PROFIBUS wiring between the transmitter and the DP/PA coupler, and

between the DP/PA coupler and the host system.
• Perform the procedures under Diagnosing wiring problems.
• Make sure the node address is set correctly. The node address is set to a default value

of 126 at the factory. Refer to Setting the node address.
• If using a configuration tool such as Simatic PDM, check whether the transmitter shows

up in the live devices list.
• Make sure the I/O configuration is set up properly. See Setting the IO mode.

9.4 Function blocks in OOS mode
If all of the transmitter function blocks (AI, AO, and totalizer) are stuck in OOS mode, there
may be a fault alert active. The status alerts that will trigger OOS mode are shown in the
following table. Refer to Status alerts for a full description of status alerts and possible
remedies.
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Table 9-1: OOS mode alerts

Topic Section

A001 EPROM checksum error

A002 RAM test error (core processor)

A003 Sensor failure (no tube interrupt)

A004 Temperature sensor out-of-range

A005 Input over-range

A008 Density over-range

A014 Transmitter Failure

A016 Line RTD temperature out-of-range

A017 Meter RTD temperature out-of-range

A022 (E)EPROM configuration DB interrupt (core processor)

A023 (E)EPROM totals corrupt (core processor)

A024 (E)EPROM program corrupt (core processor)

A025 Protected boot-sector fault

9.5 Zero or calibration failure
If a zero or calibration procedure fails, the transmitter sends one or more status alerts
indicating the cause of failure.

Refer to Table 9-3 for descriptions of status alerts and possible solutions.

9.6 Output problems
Micro Motion suggests that you make a record of the process variables listed below, under
normal operating conditions. This will help you recognize when the process variables are
unusually high or low.

• Flow rate
• Density
• Temperature
• Tube frequency
• Pickoff voltages (LPO)
• Pickoff voltages (RPO)
• Drive gain

For troubleshooting, check the process variables under both normal flow and tubes-full
no-flow conditions. Except for flow rate, you should see little or no change between flow
and no-flow conditions. If you see a significant difference, record the values and contact
customer service for assistance.
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Unusual values for process variables may indicate a variety of different problems. The
following table lists several possible problems and remedies.

Table 9-2: Output problems and possible remedies

Symptom Cause Possible remedies

No output

or incorrect

process variable

CHANNEL parameter set
incorrectly

Verify the CHANNEL parameter in the AI
block matches the correct transducer block
measurement channels.

Steady non-zero

flow rate under

no-flow

conditions

Misaligned piping (especially in
new installations)

Correct the piping.

Open or leaking valve. Check or correct the valve mechanism.

Bad sensor zero Rezero the flowmeter. See Zero the meter.

Bad flow cal factor Verify characterization.
Contact customer service.

Erratic non-zero

flow rate under

no-flow

conditions

Wiring problem Verify all sensor-to-transmitter wiring and
ensure the wires are making good contact.
Refer to the installation manual.

Incorrectly grounded 9-wire
cable (only in 9-wire remote
and remote core processor
with remote transmitter
installations)

Verify 9-wire cable installation. Refer to the
installation manual.

Vibration in pipeline at rate
close to sensor frequency

Check the environment and remove the
source of vibration.

Leaking valve or seal Check pipeline.

Inappropriate measurement
unit

Check measurement units using a PROFIBUS
host or configuration tool.

Inappropriate damping value Check damping. See Damping.

Two-phase flow (slug flow) Refer to Damping.

Plugged flow tube Check drive gain and frequency. Purge the
flow tubes.

Moisture in sensor junction box
(only for 9-wire remote and
remote core processor with
remote transmitter
installations)

Open junction box and allow it to dry. Do not
use contact cleaner. When closing, ensure
integrity of gaskets and O-rings, and grease
all O-rings.
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Table 9-2: Output problems and possible remedies (continued)

Symptom Cause Possible remedies

Mounting stress on sensor Check sensor mounting. Ensure that:

• Sensor is not being used to support the
pipe.

• Sensor is not being used to correct
misaligned pipe.

• Sensor is not too heavy for the pipe.

Sensor cross-talk Check environment for sensor with similar
(±0.5 Hz) tube frequency.

Improper sensor grounding Check the sensor grounding. Refer to the
installation manual.

Incorrect sensor orientation Not all orientations work with all process
fluids. See the installation manual for your
sensor.

Erratic non-zero

flow rate

when flow

is steady

Inappropriate measurement
unit

Check measurement units using a PROFIBUS
host or configuration tool.

Inappropriate damping value Check damping. See Damping.

Excessive or erratic drive gain Refer to Checking the core processor.

Two-phase flow Refer to Checking two-phase flow (slug
flow).

Plugged flow tube Check drive gain and tube frequency. Purge
the flow tubes. Sensor may need to be
replaced.

Wiring problem Verify all sensor-to-transmitter wiring and
ensure the wires are making good contact.
Refer to the installation manual.

Inaccurate

flow rate

Bad flow cal factor Verify characterization. See Characterization.

Inappropriate measurement
unit

Check measurement units using a PROFIBUS
host or configuration tool.

Bad sensor zero Rezero the flowmeter. See Zero the meter.

Bad density calibration factors Verify characterization. See Characterization.

Bad flowmeter grounding Refer to Checking the grounding.

Two-phase flow (slug flow) Refer to Checking two-phase flow (slug
flow).

Wiring problem Verify all sensor-to-transmitter wiring and
ensure the wires are making good contact.
Refer to the installation manual.

Inaccurate
Problem with the process fluid Use standard procedures to check quality of

process fluid.
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Table 9-2: Output problems and possible remedies (continued)

Symptom Cause Possible remedies

density reading
Bad density calibration factors Verify characterization. See Characterization.

Wiring problem Verify all sensor-to-transmitter wiring and
ensure the wires are making good contact.
Refer to the installation manual.

Bad flowmeter grounding See Checking the grounding.

Two-phase flow (slug flow) Refer to Checking two-phase flow (slug
flow).

Sensor cross-talk Check environment for sensor with similar
(±0.5 Hz) tube frequency.

Plugged flow tube Check drive gain and tube frequency. Purge
the flow tubes. Sensor may need to be
replaced.

Temperature

reading

significantly
different from

process

temperature

RTD failure Check for alert conditions and follow
troubleshooting procedure for indicated
alert.

Incorrect calibration factors Perform temperature calibration.

Contact customer service.

Temperature

reading

slightly different
from

process

temperature

Incorrect calibration factors Confirm that the temperature calibration
factor is 1.00000T0.00000. If there is still
an issue, contact customer service.

Verify characterization.
Contact customer service.

Unusually high

density reading

Plugged flow tube Check drive gain and tube frequency. Purge
the flow tubes.

Incorrect K2 value Verify characterization.
Contact customer service.

Unusually low

density reading

Two-phase flow (slug flow) See Checking two-phase flow (slug flow).

Incorrect K2 value Verify characterization.
Contact customer service.
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Table 9-2: Output problems and possible remedies (continued)

Symptom Cause Possible remedies

Unusually high

tube frequency

Sensor erosion Contact customer service.

Unusually low

tube frequency

Plugged flow tube Check drive gain and tube frequency. Purge
the flow tubes. Sensor may need to be
replaced.

Unusually low

pickoff voltages

Several possible causes See Low pickoff voltage.

Unusually high

drive gain

Several possible causes See Excessive drive gain.

Damping

An incorrectly set damping value may make the transmitter’s output appear too sluggish
or too jumpy. Adjust the damping parameters in the transducer block to achieve the
damping effect you want. See Changing the damping values.

If the transmitter appears to be applying damping values incorrectly or the damping
effects do not appear to be changed by adjustments to the damping parameters, then the
AI PV Filter Time parameter in an AI function block may be improperly set. Inspect each AI
function block, and ensure that AI PV Filter Time is set to zero.

Low-flow cutoff

If the transmitter is sending an output of zero unexpectedly, then one of the low-flow
cutoff parameters may be set incorrectly. Verify that the cutoff parameters in the
transducer block are set to appropriate levels. If there are constant low flow readings when
there is no flow, the Low-Flow cutoff is set too low. Increase the setting to two times the
flow value in a no flow condition.

See Configuring cutoffs.

Output scale

An incorrectly configured output scale can cause the transmitter to report unexpected
output levels. Verify that the AI Out Scale values are set up correctly for each AI block. See
Changing the output scale.

Characterization

Incorrect characterization parameters can cause the transmitter to send unexpected
output values. However, you should suspect an incorrect characterization only if the
transmitter and sensor have recently been paired together for the first time.
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Calibration

Improper calibration may cause the transmitter to send unexpected output values.
However, you should suspect an improper calibration only if the transmitter has been
field-calibrated recently. Refer to Performing the zeroing procedure and Performing
density calibration for more information about calibration.

Note
Use meter factors, rather than calibration, to prove the meter against a regulatory
standard or to correct measurement error. Contact customer service before calibrating
your flowmeter. Refer to Performing meter validation for information about meter factors.

9.7 Status alerts
Status alerts are reported by a PROFIBUS host, the display, and ProLink III software.
Remedies for the alert states appear below. Some status alerts cause all of the function
blocks (AI, AO, and totalizer) to change to OOS mode.

Table 9-3: Status alerts and remedies

Display

code

Description Possible remedies

A001 EEPROM checksum Cycle power to the transmitter.

If a power cycle does not clear the A001 alert, then the
memory is corrupt and the transmitter needs to be
replaced.

The flowmeter might need service.
Contact customer service.

A002 RAM error Cycle power to the transmitter.

If a power cycle does not clear the A001 alert, then the
memory is corrupt and the transmitter needs to be
replaced. If the memory is bad, the A002 alert might take
as long as 15 minutes to reappear.

The flowmeter might need service.
Contact customer service.

A003 Sensor failure Check the diagnostic variables. See Obtaining and
checking the diagnostic variables.

Check the sensor coils. See Checking sensor coils and RTD.

Check wiring to the sensor. See Checking the sensor-to-
transmitter wiring.

Check for two-phase flow (slug flow). See Checking two-
phase flow (slug flow).

Check sensor tubes.
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Table 9-3: Status alerts and remedies (continued)

Display

code

Description Possible remedies

A004
Temperature

overrange

Check the diagnostic variables. See Obtaining and
checking the diagnostic variables.

Check the sensor coils. See Checking sensor coils and RTD.

Check wiring to the sensor. See Checking the sensor-to-
transmitter wiring.

Verify process temperature range is within limits for the
sensor and the transmitter.

Contact customer service.

A005 Input overrange Check the diagnostic variables. See Obtaining and
checking the diagnostic variables.

Check the sensor coils. See Checking sensor coils and RTD.

Verify process conditions.

Verify that transmitter is configured to use appropriate
measurement units. See Changing the measurement
units.

Verify flowmeter characterization. See Characterization.

Re-zero the flowmeter. See Zero the meter.

A006
Transmitter

not configured

Check the characterization. Specifically, verify the FCF and
K1 values.

Contact customer service.

A008 Density overrange Verify flowmeter characterization. See Characterization.

Check the diagnostic variables. See Obtaining and
checking the diagnostic variables.

Check the sensor coils. See Checking sensor coils and RTD.

Check for air in the flow tubes, tubes not filled, foreign
material in the tubes, or coating in the tubes.

A009
Transmitter

initializing

or warming up

Allow the transmitter to warm up. The error should
disappear from the status words once the transmitter is
ready for normal operation. If alert does not clear, make
sure the sensor is either completely full or completely
empty. Verify both the sensor configuration and the
transmitter wiring to the sensor (refer to the installation
manual).

A010 Calibration failure If an alert appears during zero, ensure there is no flow
through the sensor, then retry.
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Table 9-3: Status alerts and remedies (continued)

Display

code

Description Possible remedies

Cycle power to the flowmeter, then retry.

A011 Calibration too low Ensure there is no flow through the sensor, then retry.

Cycle power to the flowmeter, then retry.

A012 Calibration too high Ensure there is no flow through the sensor, then retry.

Cycle power to the flowmeter, then retry.

A013 Zero too noisy Remove or reduce sources of electromechanical noise,
then attempt the calibration or zero procedure again.

Possible sources of noise include:

• Mechanical pumps
• Electrical interference
• Vibration effects from nearby machinery

Cycle power to the flowmeter, then retry.

A014 Transmitter failed Cycle power to the flowmeter, then retry.

The transmitter might need service.
Contact customer service.

A016
Line Temp

out-of-range

Check the diagnostic variables. See Obtaining and
checking the diagnostic variables.

Check the sensor coils. See Checking sensor coils and RTD.

Check wiring to the sensor. See Checking the sensor-to-
transmitter wiring.

Verify flowmeter characterization. See Characterization.

Contact customer service.

A017
Meter RTD

temperature

out-of-range

Check the diagnostic variables. See Obtaining and
checking the diagnostic variables.

Check the sensor coils. See Checking sensor coils and RTD.

Contact customer service.

A018
EEPROM Error

(Transmitter)

The flowmeter might need service.
Contact customer service.

A020
Calibration factors

unentered

Check the characterization. Specifically, verify the FCF
value.
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Table 9-3: Status alerts and remedies (continued)

Display

code

Description Possible remedies

A021
Incorrect

sensor type

Check the characterization. Specifically, verify the K1
value.

A022
Configuration

corrupt

The flowmeter needs service. Contact customer service.

A023 Totals corrupt The flowmeter needs service. Contact customer service.

A024
CP program

corrupt

The flowmeter needs service. Contact customer service.

A025 Boot sector failed Cycle power to the meter.

The transmitter might need service.
Contact customer service.

A026
Sensor/transmitter

communication

failure

Check wiring between transmitter and core processor (see
Checking the sensor-to-transmitter wiring). The wires may
be swapped. After swapping wires, cycle power to the
flowmeter.

Check for noise in wiring or transmitter environment.

Check the core processor Checking the core processor.

Perform the core processor resistance test. See Performing
the core processor resistance test.

A028
Sensor/transmitter

write failure

Cycle power to the meter.

The flowmeter needs service. Contact customer service.

A030
Hardware/software

incompatible

The loaded software is not compatible with the
programmed board type. Contact customer service.

A031 Low Power The core processor is not receiving enough power. Check
the power supply to the transmitter, and check power
wiring between the transmitter and the core processor (4-
wire remote installations only).

A032
Smart Meter

Verification

in progress

Allow the procedure to complete.
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Table 9-3: Status alerts and remedies (continued)

Display

code

Description Possible remedies

and outputs fixed
If desired, abort the procedure and restart with outputs set
to Continue Measurement.
The flowmeter needs service. Contact customer service.

A033
Sensor OK /

Tubes Stopped

by Process

No signal from LPO or RPO, suggesting that sensor tubes
are not vibrating. Verify process. Check for air in the flow
tubes, tubes not filled, foreign material in tubes, or coating
in tubes.

A034
Smart Meter

Verification

failed

Rerun the test. If the test fails again, see Understanding
SMV results.

A035
Smart Meter

Verification

aborted

If desired, read the abort code. See Understanding SMV
results, and perform the appropriate action.

A102
Drive overrange

Excessive or erratic drive gain. See Checking the core
processor.

Check the sensor coils. See Checking sensor coils and RTD.

A103
Data loss possible

Cycle power to the transmitter.

The transmitter might need service.
Contact customer service.

A104
Calibration in
progress

Allow the flowmeter to complete calibration.

A105
Slug flow

Allow two-phase flow (slug flow) to clear from the process.

See Checking two-phase flow (slug flow).

A106
Function block

is in simulation

mode

Disable function block simulation.

A107
Power reset
occurred

No action is necessary.

A116
API temperature

Verify process.
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Table 9-3: Status alerts and remedies (continued)

Display

code

Description Possible remedies

outside

standard range

Verify API reference table and temperature.

A117
API density

out of limits

Verify process.

Verify API reference table and temperature.

A120
Concentration

measurement:

unable to fit curve
data

Verify enhanced density configuration.

A121
Concentration

measurement:

extrapolation

alert

Verify process temperature.

Verify process density.

Verify enhanced density configuration.

A131
Smart Meter

Verification

in progress

Allow the procedure to complete.

If desired, abort the procedure and restart with outputs set
to Fault.

A132
Simulation mode

active

Disable sensor simulation mode. See Using sensor
simulation mode.
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9.8 Diagnosing wiring problems
Use the procedures in this section to check the transmitter installation for wiring
problems. Installation procedures are provided in the manual entitled Model 2700
Transmitters: Installation Manual.

  WARNING
Removing the wiring compartment covers in explosive atmospheres while the power
is on can cause an explosion. Before removing the field wiring compartment cover in
explosive atmospheres, shut off the power and wait five minutes.

Checking the power-supply wiring

To check the power-supply wiring:

1. Verify that the correct external fuse is used. An incorrect fuse can limit current to
the transmitter and keep it from initializing.

2. Power down the transmitter.
3. If the transmitter is in a hazardous area, wait five minutes.
4. Ensure that the power supply wires are connected to the correct terminals. Refer to

the installation manual.
5. Verify that the power-supply wires are making good contact and are not clamped to

the wire insulation.
6. Inspect the voltage label on the inside of the field-wiring compartment. Verify that

the voltage supplied to the transmitter matches the voltage specified on the label.
7. Use a voltmeter to test the voltage at the transmitter’s power supply terminals.

Verify that it is within specified limits. For DC power, you may need to size the cable.
Refer to the installation manual for information about the transmitter power
supply.

Checking the sensor-to-transmitter wiring

Note
This does not apply to flow meters with an integrally-mounted transmitter.

To check the sensor-to-transmitter wiring, verify that:

• The transmitter is connected to the sensor according to the wiring information
provided in the installation manual.

• The wires are making good contact with the terminals.
• For 4-wire connections, the mating connector between the core processor and the

transmitter is securely plugged into its socket.

If the wires are incorrectly connected:

1. Power down the transmitter.
2. Wait five minutes before opening the transmitter compartment if the transmitter is

in a hazardous area.
3. Correct the wiring.
4. Restore power to the transmitter.
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Checking the grounding

The sensor and the transmitter must be grounded. If the core processor is installed as part
of the transmitter or the sensor, it is grounded automatically. If the core processor is
installed separately, it must be grounded separately. Refer to the installation manual.

Checking the communication wiring

To check the communication wiring, verify that:

• Communication wires and connections meet PROFIBUS wiring standards.
• Wires are connected according to instructions provided in the installation manual.
• Wires are making good contact with the terminals.

9.9 Checking two-phase flow (slug flow)
The dynamics of two-phase flow are described in Changing two-phase flow (slug flow)
limits and duration. If the transmitter is reporting a two-phase (slug flow) alert, first check
the process and possible mechanical causes for the alert:

• Actual changes in process density
• Cavitation or flashing
• Leaks
• Sensor orientation — sensor tubes should normally be down when measuring liquids,

and up when measuring gases. Refer to the sensor documentation for more
information about orientation.

If there are no mechanical causes for the two-phase (slug flow) alert, the slow flow limits
and duration may be set too high or too low. The high limit is set by default to 5.0 g/cm3,
and the low limit is set by default to 0.0 g/cm3. Lowering the high limit or raising the low
limit will cause the transmitter to be more sensitive to changes in density. If you expect
occasional two-phase flow in your process, you may need to increase the two-phase flow
duration. A longer two-phase flow duration will make the transmitter more tolerant of
two-phase flow.

9.10 Obtaining and checking the diagnostic
variables
You can diagnose sensor failure or overrange status alerts by checking the flowmeter
diagnostic variables. The diagnostic variables include left and right pickoff voltages, drive
gain, and tube frequency. You can obtain the diagnostic variables with the PROFIBUS EDD,
the PROFIBUS bus parameters, or ProLink III.

With PROFIBUS EDD

To obtain the diagnostic variables, select View > Diagnostics > Meter Diagnostic. Record
the LPO AMplitude, RPO AMplitude, Drive Gain, and Tube Frequency values.

With PROFIBUS bus parameters

To obtain the diagnostic variables, examine the indices listed in the following table.
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Table 9-4: Bus parameter diagnostic variables

Slot Index Description

11 160 Drive gain

11 161 Tube frequency

11 163 LPO amplitude

11 164 RPO amplitude

With ProLink III

To obtain the diagnostic variables with ProLink III, enter the main window or select Device
Tools > Diagnostic > Core Processor Diagnostics. Record the Left Pickoff, Right Pickoff,
Drive Gain, and Tube Frequency values.

Evaluating the diagnostic variables

Use the following guidelines to evaluate the diagnostic variables:

• If the drive gain is at 100%, refer to Excessive drive gain.
• If the drive gain is unstable, refer to Erratic drive gain.
• If the value for the left or right pickoff does not equal the appropriate value from Table

9-5, based on the sensor flow tube frequency, refer to Low pickoff voltage.
• If the values for the left and right pickoffs equal the appropriate values from the

following table, based on the sensor flow tube frequency, contact customer service for
assistance.

Table 9-5: Sensor pickoff values

Sensor model (1) Pickoff value

ELITE Model CMF sensors 3.4 m peak to peak per Hz based on flow tube frequency

Model CMF 400 I.S 2.7 m peak to peak per Hz based on flow tube frequency

Model CMF 400

with booster amplifier

3.4 m peak to peak per Hz based on flow tube frequency

Model D, DL,

and DT sensors

3.4 m peak to peak per Hz based on flow tube frequency

Model F025, F050,

and F100 sensors

3.4 m peak to peak per Hz based on flow tube frequency

Model F200 sensors 2.0 m peak to peak per Hz based on flow tube frequency

Model H025, H050,

or H100 sensor

3.4 m peak to peak per Hz based on flow tube frequency
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Table 9-5: Sensor pickoff values (continued)

Sensor model (1) Pickoff value

Model H200 sensor 2.0 m peak to peak per Hz based on flow tube frequency

Model R025, R050,

or R100 sensor

3.4 m peak to peak per Hz based on flow tube frequency

Model R200 sensor 2.0 m peak to peak per Hz based on flow tube frequency

Micro Motion T-Series Sensors 0.5 m peak to peak per Hz based on flow tube frequency

(1) If your sensor model is not listed, contact customer service.

Excessive drive gain

The causes and possible solutions of excessive drive gain are listed in the following table.

Table 9-6: Excessive drive gain causes and solutions

Cause Solution

Gas bubbles in a liquid flow or
slugs of liquid in a gas flow.

Check for gas in a liquid flow.

Plugged flow tube Purge the flow tubes. Sensor may need to be replaced.

Excessive two-phase flow Eliminate slugs.

Change the sensor orientation.

Cavitation or flashing Increase inlet or back pressure at the sensor.

If a pump is located upstream from the sensor, increase the
distance between the pump and sensor.

Drive board or module
failure,

cracked flow tube,

or sensor imbalance

Contact customer service.

Mechanical binding

at the sensor

Ensure sensor is free to vibrate.

Open drive or left pickoff

sensor coil

Contact customer service.

Flow rate out of range Ensure flow rate is within sensor limits.

Incorrect sensor

characterization

Verify characterization.
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Erratic drive gain

The causes and possible solutions of erratic drive gain are listed in the following table.

Table 9-7: Erratic drive gain causes and solutions

Cause Solution

Wrong K1 characterization

constant

for sensor

Re-enter the K1 characterization constant.

Polarity of pick-off reversed

or polarity

of drive reversed

Contact customer service.

two-phase flow Verify flow tubes are completely filled with process fluid, and
that two-phase flow limits and duration are properly
configured. See Changing two-phase flow (slug flow) limits
and duration.

Foreign material

caught in flow tubes

Purge flow tubes. Sensor may need to be replaced.

Low pickoff voltage

The causes and possible solutions of low pickoff voltage are listed in the following table,

Table 9-8: Low pickoff voltage causes and solutions

Cause Solution

Faulty wiring runs between

the sensor and core processor

Refer to the sensor manual and transmitter installation manual.

Two-phase flow Verify the flow tubes are completely filled with process fluid, and
that two-phase flow limits and duration are properly configured.
See Changing two-phase flow (slug flow) limits and duration.

No tube vibration in sensor Check for plugging.

Ensure sensor is free to vibrate (no mechanical binding).

Verify the wiring.

Test coils at sensor. See Checking sensor coils and RTD.

Moisture in

the sensor electronics

Eliminate the moisture in the sensor electronics.

The sensor is damaged Contact customer service.

9.11 Checking the core processor
Two core processor procedures are available:
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• You can check the core processor LED. The core processor has an LED that indicates
different flowmeter conditions.

• You can perform the core processor resistance test to check for a damaged standard
core processor. The resistance test does not apply to the enhanced core processor.

For both tests you will need to expose the core processor.

Exposing the core processor

Follow these procedures to expose the core processor

1. Determine your installation type. Refer to Flow meter installation types and
components.

2. If you have a 4-wire remote installation or a remote core processor with remote
transmitter installation, remove the core processor lid. The core processor is
intrinsically safe and can be opened in all environments.

3. If you have an integral installation:
a. Loosen the four cap screws that fasten the transmitter to the base (Figure

9-1).
b. Rotate the transmitter counter-clockwise so that the cap screws are in the

unlocked position.
c. Gently lift the transmitter straight up, disengaging it from the cap screws. Do

not disconnect or damage the wires that connect the transmitter to the core
processor.

4. If you have a 9-wire remote installation:
a. Remove the end-cap.
b. Inside the core processor housing, loosen the three screws that hold the core

processor mounting plate in place. Do not remove the screws. Rotate the
mounting plate so that the screws are in the unlocked position.

c. Holding the tab on the mounting plate, slowly lower the mounting plate so
that the top of the core processor is visible. Do not disconnect or damage the
wires that connect the core processor to the transmitter.
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Figure 9-1: Integral installation components

A. Core processor
B. 4 x cap screws
C. Transmitter

When reassembling components, take care not to pinch or stress the wires. Grease all O-
rings.

Checking the core processor LED

Do not shut off power to the transmitter when checking the core processor LED. To check
the core processor LED:

1. Expose the core processor according to the instructions in Exposing the core
processor.

2. Check the core processor LED against the conditions listed in Table 9-9 or Table
9-10.

Table 9-9: Standard core processor LED behavior, flowmeter conditions, and
remedies

LED behavior Condition Possible remedy

1 flash per second

(75% off, 25% on)

Normal operation No action required

1 flash per second

(25% off, 75% on)

Two-phase flow
(Slug flow)

See Restoring a working configuration.

Solid on Zero or calibration
in progress

If zero or calibration procedure is in progress, no
action is required. If these procedures are not in
progress, contact customer service.
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Table 9-9: Standard core processor LED behavior, flowmeter conditions, and
remedies (continued)

LED behavior Condition Possible remedy

Core processor

receiving

between

11.5 and 5 volts

Check power supply to transmitter. See Checking
the power-supply wiring.

3 rapid flashes

followed by a pause

Sensor

not recognized

Check wiring between transmitter and sensor (9-
wire remote installation or remote core processor
with remote transmitter installation). Refer to the
installation manual.

Improper

configuration

Verify characterization.

Broken pin

between

sensor and

core processor

Contact customer service.

4 flashes per second Fault condition Check alert status.

OFF
Core processor

receiving less

than 5 volts

Verify power supply wiring to core processor.
Refer to the installation manual.

If status LED is lit, transmitter is receiving power.
Check voltage across terminals 1 (VDC+) and 2
(VDC–) in core processor. Normal reading is
approximately 14 VDC.

• If reading is normal, internal core processor
failure is possible — contact customer service.

• If reading is 0, internal transmitter failure is
possible — contact customer service.

• If reading is less than 1 VDC, verify power
supply wiring to core processor. Wires may be
switched. Refer to the installation manual.

If status LED is not lit, transmitter is not receiving
power. Check power supply. If power supply is
operational, internal transmitter, display, or LED
failure is possible. Contact customer service.

Core processor

internal failure

Contact customer service.
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Table 9-10: Enhanced core processor LED behavior, flowmeter conditions, and
remedies

LED behavior Condition Possible remedy

Solid green Normal operation. No action required.

Flashing yellow Zero in progress No action required If calibration is in progress, no
action required. If no calibration is in progress,
contact Micro Motion.

Solid yellow Low severity alert Check alert status.

Solid red High severity alert Check alert status.

Flashing red

(80% on, 20% off)

Tubes not full If alert A105 (two-phase (slug flow)) is active, see
Checking two-phase flow (slug flow).

If alert A033 (tubes not full) is active, verify process.
Check for air in the flow tubes, tubes not filled,
foreign material in tubes, or coating in tubes.

Flashing red

(50% on, 50% off)

Electronics failed Contact customer service.

Flashing red

(50% on, 50% off,
skips every 4th)

Sensor failed The LPO, RPO, or drive circuit wires might not be
connected.

Refer to Diagnosing wiring problems.

Solid red High severity alert Check alert status.

Performing the core processor resistance test

To perform the core processor resistance test:

1. Disconnect power to the transmitter and core processor.
2. Expose the core processor according to the instructions in Exposing the core

processor.
3. Measure the resistance across the following terminal pairs (standard core processor

only):
• The resistance across terminals 3 and 4 (RS-485A and RS-485B) should be 40–50

kilo-ohms.
• The resistance across terminals 2 and 3 (VDC– and RS-485A) should be 20–25

kilo-ohms.
• The resistance across terminals 2 and 4 (VDC– and RS-485B) should be 20–25

kilo-ohms.
If any of the resistance measurements are lower than specified, the core processor
may not be able to communicate with a transmitter or remote host.
Contact customer service.
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9.12 Checking sensor coils and RTD
Problems with sensor coils can cause several alerts, including sensor failure and a variety of
out-of-range conditions. Checking the sensor coils involves testing the terminal pairs and
testing for shorts to the case.

9-wire remote or remote core processor with remote transmitter installation

If you have a 9-wire remote or a remote core processor with remote transmitter
installation:

1. Power down the transmitter.
2. If the transmitter is in a hazardous area, wait five minutes.
3. Remove the end-cap from the core processor housing.
4. Unplug the terminal blocks from the terminal board.
5. Using a digital multimeter (DMM), check the circuits listed in Table 9-11 by placing

the DMM leads on the unplugged terminal blocks for each terminal pair.
6. There should be no open circuits (that is, no infinite resistance readings). The LPO

and RPO readings should be the same or very close (±5 ohms). If there are any
unusual readings, repeat the coil measurement tests at the sensor junction box to
eliminate the possibility of faulty cable. The readings for each coil pair should match
at both ends.

7. If the cable is faulty, replace the cable.
8. Leave the core processor terminal blocks disconnected. At the sensor, remove the

lid of the junction box and test each sensor terminal for a short to case by placing
one DMM lead on the terminal and the other lead on the sensor case. With the
DMM set to its highest range, there should be infinite resistance on each lead. If
there is any resistance at all, there is a short to the case.

9. Test the terminal pairs as follows:
• Brown against all other terminals except Red
• Red against all other terminals except Brown
• Green against all other terminals except White
• White against all other terminals except Green
• Blue against all other terminals except Gray
• Gray against all other terminals except Blue
• Orange against all other terminals except Yellow and Violet
• Yellow against all other terminals except Orange and Violet
• Violet against all other terminals except Yellow and Orange

Note
D600 sensors and CMF400 sensors with booster amplifiers have different terminal
pairs. Contact customer service for assistance.

There should be infinite resistance for each pair. If there is any resistance at all,
there is a short between terminals.

10. See Table 9-12 for possible causes and solutions.
11. If the problem is not resolved, contact customer service.

Note
When reassembling the meter components, be sure to grease all O-rings.
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Table 9-11: Circuit terminal pairs

Circuit Test terminal pair

Drive coil Brown to red

Left pickoff coil (LPO) Green to white

Right pickoff coil (RPO) Blue to gray

Resistance temperature detector (RTD) Yellow to violet

Lead length compensator (LLC)

(All sensors except CMF400 IS and T-Series)

Composite RTD (T-Series only)

Fixed resistor (CMF400 IS only)

Yellow to orange

Table 9-12: Sensor and cable short to case possible causes and remedies

Possible cause Solution

Moisture inside the sensor junction box Make sure that the junction box is dry and no
corrosion is present.

Liquid or moisture inside the sensor case Contact customer service.

Internally shorted feedthrough (sealed passage
for wiring from sensor to sensor junction box)

Contact customer service.

Faulty cable Replace cable.

Improper wire termination Verify wire terminations inside sensor junction
box. See either the Micro Motion 9-Wire
Flowmeter Cable Preparation and Installation
Guide or the sensor documentation.

9.12.1 4-wire remote or integral installation
About this task

If you have a 4-wire remote installation or an integral installation, use the following
procedure

Procedure

1. Power down the transmitter.

Note
If the transmitter is in a hazardous environment, wait five minutes.

2. If you have a 4-wire remote installation, remove the core processor lid.

3. If you have an integral installation:

a) Loosen the four cap screws that fasten the transmitter to the base (refer to
Figure 6-1).
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b) Rotate the transmitter counter-clockwise so that the cap screws are in the
unlocked position.

c) Gently lift the transmitter straight up, disengaging it from the base.

Note
You have the option of disconnecting the 4-wire cable or leaving it connected.

4. Determine whether you have a standard or an enhanced core processor:.
• If you have a standard core processor, loosen the captive screw (2,5 mm) at the

center of the core processor. Carefully remove the core processor from the
sensor by grasping it and lifting it straight up.

  CAUTION
Do not twist or rotate the core processor.

• If you have an enhanced core processor, loosen the two captive screws (2,5 mm)
that hold the core processor in the housing. Gently lift the core processor out of
the housing, then disconnect the sensor cable from the feedthrough pins.

  CAUTION
Do not damage the feedthrough pins.

  CAUTION
If the core processor (feedthrough) pins are bent, broken, or damaged in
any way, the core processor will not operate. Do not twist or rotate the core
processor when lifting it. When replacing the core processor (or sensor
cable) on the pins, be sure to align the guide pins and mount the core
processor (or sensor cable) carefully.

5. Use a digital multimeter (DMM) to check the resistance across the right and left
pickoff coils. See Figure 9-2. Neither pair should be an open circuit (infinite
resistance). The resistance values should be the same or very close (±5 ohms).

6. Use the DMM to check the resistance across the RTD and LLC (lead length
compensation) circuits. See Figure 9-2. Neither pair should be an open circuit
(infinite resistance).

7. Test for a ground to case by checking the resistance between each pin and the
sensor case. With the DMM set to its highest range, there should be infinite
resistance on each lead. If there is any resistance at all, there is a short to case.

If a short to case is indicated, check for moisture or corrosion. If you are unable to
determine the source of the problem, contact customer service.

8. Test for shorts across terminals by testing resistance across the following terminal
pairs (see Figure 9-2 and Figure 9-3). There should be infinite resistance in each
case. If there is any resistance at all, there is a short between the terminals.

• Brown against all other terminals except Red
• Red against all other terminals except Brown
• Green against all other terminals except White
• White against all other terminals except Green
• Blue against all other terminals except Gray
• Gray against all other terminals except Blue
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• Orange against all other terminals except Yellow and Violet
• Yellow against all other terminals except Orange and Violet
• Violet against all other terminals except Yellow and Orange

Figure 9-2: Sensor pins -- Standard core processor

A. Right pickoff (negative)
B. Right pickoff (positive)
C. Left pickoff (negative)
D. Left pickoff (positive)
E. Drive (negative)
F. Drive (positive)
G. Resistance temperature detector (positive)
H. Resistance temperature detector return / Lead length compensator (common)

I. Lead length compensator (1)

Note
D600 sensors and CMF400 sensors with booster amplifiers have different terminal
pairs. If a short between terminals is indicated, contact customer service.

(1 ) LLC for all sensors except T-Series and CMF400 I.S. For T-Series sensors, functions as composite RTD. For CMF400 I. sensors,
functions as fixed resistor.
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Figure 9-3: Sensor pins -- Enhanced core processor

A. Drive (positive)
B. LLC / composite RTD / Fixed resistor (2)

C. Right pickoff (positive)
D. Right pickoff (negative)
E. Left pickoff (positive)
F. Left pickoff (negative)
G. Resistance temperature detector (positive)
H. Resistance temperature detector return / Lead length compensator (common) /

composite RTD / fixed resistor
I. Drive (negative)

Note
The pins are shown as they appear while looking at the feedthrough on the sensor.

Reinstalling the core processor

About this task

If you removed the core processor, replace the core processor using the instructions
below.

Procedure

1. Determine whether you have a standard core processor or an enhanced core
processor:
• If you have a standard core processor, go to Step 2.
• If you have an enhanced core processor, go to Step 4.

2. Align the three guide pins on the bottom of the core processor with the
corresponding holes in the base of the core processor housing.

(2 ) LLC for all sensors except T-Series and CMF400 I.S, and F300. For T-Series sensors, functions as composite RTD. For CMF400
I. S. and F300 sensors, functions as fixed resistor.
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3. Carefully mount the core processor on the pins, taking care not to bend any pins,
then go to Step 6.

4. Plug the sensor cable onto the feedthrough pins, being careful not to bend or
damage any pins.

5. Replace the core processor in the housing. then go to step 6.

6. Note
When reassembling the flowmeter components, grease all O-rings.

Tighten the captive screw(s) to 6 to 8 in-lbs (0,7 to 0,9 N-m) of torque.

7. If you have a 4-wire remote installation, replace the core processor lid.

8. If you have an integral installation:

a) Gently lower the transmitter onto the base, inserting the cap screws into the
slots. Do not pinch or stress the wires.

b) Rotate the transmitter clockwise so that the cap screws are in the locked
position.

c) Tighten the cap screws, torquing to 20 to 30 in-lbs (2,3 to 3,4 N-m).
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A Flow meter installation types and
components
This appendix provides illustrations of different flow meter installations and components
for the Model 2700 transmitter.

Installation diagrams

Model 2700 transmitters can be installed in four different ways:

• Integral

Figure A-1: Integral installation

A. Core processor (standard only)
B. Sensor

• 4-wire remote

Figure A-2: 4-wire remote installation

A. Sensor
B. Core processor (standard or enhanced)
C. 4-wire cable
D. Transmitter

• 9-wire remote
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Figure A-3: 9-wire remote installation

A. Sensor
B. Junction box
C. Transmitter
D. Core processor (standard only)
E. 9-wire cable

• Remote core processor with remote transmitter

Figure A-4: Remote core processor with remote transmitter

A. Sensor
B. Junction box
C. 9-wire cable
D. Transmitter
E. 4-wire cable
F. Core processor (standard or enhanced)
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Component diagrams

The following figure shows the transmitter and core processor components in integral
installations.

Figure A-5: Transmitter and core processor components -- integral installations

A. Transmitter
B. Transition ring
C. 4 x cap screws (4mm)
D. Base
E. Core processor
F. Sensor

The following figure shows the transmitter components in 4-wire remote installations and
remote core processor with remote transmitter installations.
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Figure A-6: Transmitter and core processor components -- 4-wire installations

A. Ground lug
B. Main enclosure
C. Conduit operating for 4-wire cable
D. Junction housing
E. Mating connector socket
F. Mating connector
G. Junction end cap
H. 4 x cap screws (4mm)

I. Mounting bracket

The following figure shows the transmitter/core processor assembly in 9-wire remote
installations. In remote core processor with remote transmitter installations, the core
processor is installed stand-alone.
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Figure A-7: Transmitter and core processor components -- 9-wire installations

A. Transmitter
B. 4 x cap screws (4mm)
C. End cap
D. Mounting bracket
E. Conduit opening for 9-wire cable
F. Core processor housing
G. Core processor

The following figure shows the remote core processor components for a remote
installation.
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Figure A-8: Transmitter and standard core processor components -- remote
installations

A. Core processor lid
B. 4 x cap screws (4mm)
C. Core processor housing
D. End cap
E. Mounting bracket
F. Conduit opening for 9-wire cable

G. Conduit opening for 4-wire cable
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Wiring and terminal diagrams

In 4-wire remote and remote core processor with remote transmitter installations, a 4-
wire cable is used to connect the core processor to the transmitter’s mating connector.

Figure A-9: 4-wire cable between Model 2700 Transmitter and standard core
processor

A. Core processor terminals
B. User-supplied or factory-supplied 4-wire cable
C. Mating connector (transmitter)
D. VDC+ (red)
E. RS-485/B (green)
F. RS-485/A (white)
G. VDC- (black)

In 9-wire remote installations, a 9-wire cable is used to connect the junction box on the
sensor to the terminals on the transmitter/core processor assembly.
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Figure A-10: 4-wire cable between Model 2700 Transmitter and enhanced core
processor

A. Core processor terminals
B. User-supplied or factory-supplied 4-wire cable
C. Mating connector (transmitter)
D. RS-485/A (white)
E. RS-485/B (green)
F. VDC- (black)
G. VDC+ (red)

The following figures show the 9-wire connections for the sensor junction box and the
core processor:
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Figure A-11: 9-wire terminal connections to the sensor junction box for a Model 2700
Transmitter

A. To the junction box
B. Black (drains from all wire sets)
C. Green
D. White
E. Brown
F. Red

G. Blue
H. Gray

I. Orange
J. Violet

K. Yellow
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Figure A-12: 9-wire terminal connections to the core processor for a Model 2700
Transmitter

A. Ground screw
B. Red
C. Green
D. White
E. Blue
F. Gray
G. Orange
H. Mounting screw

I. Plug and socket
J. Yellow

K. Violet
L. Brown

M. Black

The following figure shows the Model 2700 transmitter’s power supply terminals.
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Figure A-13: Output and power supply terminals for a Model 2700 Transmitter

A. 9 (-,N)
B. 10 (+,L)
C. Equipment ground
D. Service port 8 (+)
E. Service port 7 (-)
F. PROFIBUS terminal 2
G. PROFIBUS terminal 1
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B Using the transmitter display
This section explains how to use the Model 5700 display. Using the display, you can move
through the menus, configure the application, monitor and control the application, and
perform maintenance and diagnostic tasks.

B.1 Components of the transmitter interface
The transmitter interface includes the status LED, the display (LCD panel), and two optical
switches.

B.2 Use the optical switches
Use the optical switches on the transmitter interface to control the transmitter display.
The transmitter has two optical switches: Scroll and Select.

About this task

Procedure

To activate an optical switch, block the light by holding your thumb or finger in front of the
opening.

Tip
You can activate the optical switch through the lens. Do not remove the transmitter
housing cover.

The optical switch indicator lights up when the transmitter senses that an optical switch
has been activated.

Results

Table B-1: Optical switch indicator and optical switch states

Optical switch indicator State of optical switches

Solid red One optical switch is activated.

Flickering red Both optical switches are activated.

B.3 Access and use the display menu system
The display menu system is used to perform various configuration, administrative, and
maintenance tasks.

Prerequisites

To access the display menu system, operator access to either the Off-Line menu or the
Alert menu must be enabled. To access the complete menu system, operator access must
be enabled for both the Off-Line menu and the Alert menu.
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About this task

Tip
The display menu system does not provide complete configuration, administrative, or
maintenance functions. For complete transmitter management, you must use another
communications tool.

Procedure

1. At the transmitter display, activate theScroll and Select optical switches
simultaneously until the display changes.
You will enter the Off-Line menu at any of several locations, depending on several
factors.

• If an alert is active and access to the Alert menu is enabled, you will see SEE
ALERT.

2. If CODE? appears on the display when you make a choice, enter the value that is
configured for Off-Line Password.

a) With the cursor flashing on the first digit, activate Scroll until the correct
digit is displayed, then activate Select.

b) Repeat this process for the second, third, and fourth digits.

Tip
If you do not know the correct value for Off-Line Password, wait 30 seconds. The
password screen will time out automatically and you will be returned to the
previous screen.

3. Use the Scroll and Select optical switches to navigate to your destination in the
display menu system.
• Use Scroll to move through a list of options.
• Use Select to choose the current option.

4. If Scroll flashes on the display, activate the Scroll optical switch, then the Select
optical switch, and then the Scroll optical switch again.

The display will prompt you through this sequence. The Scroll-Select-Scroll
sequence is designed to guard against accidental activation of the off-line menu. It
is not designed as a security measure.

5. To exit a display menu and return to a higher-level menu:
• Activate Scroll until the EXIT option is displayed, then activate Select.
• If the EXIT option is not available, activate Scroll and Select simultaneously and

hold until the screen returns to the previous display.

6. To exit the display menu system, you can use either of the following methods:
• Exit each menu separately, working your way back to the top of the menu

system.
• Wait two minutes until the display times out and returns to displaying process

variable data.

Using the transmitter display Configuration and Use Manual
October 2018 20000327

160  Micro Motion Model 2700 Transmitters with PROFIBUS-PA



B.3.1 Enter a floating-point value using the display
Certain configuration values (for example, Lower Range Value and Upper Range Value)
are entered as floating-point values. The display supports both decimal notation and
exponential notation for floating-point values.

About this task

The display allows you to enter a maximum of 8 characters, including the sign. The
decimal point is not counted as a character. Exponential notation is used to enter values
that require more than 8 characters.

B.3.1 Enter a floating-point value using decimal notation
Decimal notation allows you to enter values between –9999999 and 99999999. You can
use the decimal point to enter values with a precision of 0 through 4 (4 characters to the
right of the decimal point).

About this task

Decimal values entered via the display must meet the following requirements:

• They can contain a maximum of 8 digits, or 7 digits plus a minus sign (−) to indicate a
negative number.

• They can contain a decimal point. The decimal point does not count as a digit. The
decimal point must be positioned so that the precision of the value does not exceed 4.

When you first enter the configuration screen, the current configuration value is displayed
in decimal notation, and the active character is flashing. If the value is positive, no sign is
displayed. If the value is negative, a minus sign is displayed.

Procedure

• To change the value:

a) Activate Select until the digit you want to change is active (flashing).

Select moves the cursor one position to the left. From the leftmost position,
Select moves the cursor to the rightmost digit.

b) Activate Scroll to change the value of the active digit.
c) Repeat until all digits are set as desired.

• To change the sign of the value:
• If the current value is negative, activate Select until the minus sign is flashing, then

activate Scroll until the space is blank.
• If the current value is positive and there is a blank space at the left of the value,

activate Select until the cursor is flashing under the blank space, then activate
Scroll until the minus sign appears.

• If the current value is positive and there is no blank space at the left of the value,
activate Select until the cursor is flashing under the leftmost digit, then activate
Scroll until the minus sign appears.

• To move the decimal point:

a) Activate Select until the decimal point is flashing.
b) Activate Scroll.

The decimal point is removed from its current position.
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c) Activate Select and watch the position of the decimal point.

As the cursor moves to the left, the decimal point will flash between each pair of
digits, up to a maximum precision of four (four digits to the right of the decimal
point).

Tip
If the position is not valid, the decimal point is not displayed. Continue to
activate Select until the decimal point appears at the right of the displayed
value.

d) When the decimal point is in the desired position, activate Scroll.
The decimal point is inserted at its current position.

• To save the displayed value to transmitter memory, activate Scroll and Select
simultaneously and hold until the display changes.
• If the displayed value is the same as the value in transmitter memory, you will be

returned to the previous screen.
• If the displayed value is not the same as the value in transmitter memory, SAVE/

YES? flashes on the display. Activate Select.
• To exit the menu without saving the displayed value to transmitter memory, activate

Scroll and Select simultaneously and hold until the display changes.
• If the displayed value is the same as the value in transmitter memory, you will be

returned to the previous screen.
• If the displayed value is not the same as the value in transmitter memory, SAVE/

YES? flashes on the display. Activate Scroll.

B.3.1 Enter a floating-point value using exponential
notation
Exponential notation is used to enter values that are larger than 99999999 or smaller than
−9999999.

About this task

Exponential values entered via the display must be in the following form: SX.XXXEYY. In
this string:

• S = Sign. A minus sign (−) indicates a negative number. A blank indicates a positive
number.

• X.XXX = The 4-digit mantissa.
• E = The exponent indicator.
• YY = The 2-digit exponent.

Procedure

1. Switch from decimal notation to exponential notation.

a) Activate Select as required until the rightmost digit is flashing.
b) Activate Scroll until E is displayed.

c) Activate Select.
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Tip
If you have modified the value in decimal notation without saving the changes to
transmitter memory, the changes will be lost when you switch to exponential
notation. Save the decimal value before switching to exponential notation.

2. Enter the exponent.

The first character may be a minus sign or any digit between 0 and 3. The second
character may be any digit between 0 and 9.

a) Activate Select to move the cursor to the rightmost character on the display.
b) Activate Scroll until the desired character is displayed.
c) Activate Select to move the cursor one position to the left.
d) Activate Scroll until the desired character is displayed.

3. Enter the mantissa.

The mantissa must be a 4-digit value with a precision of 3 (that is, all values
between 0.000 and 9.999).

a) Activate Select to move the cursor to the rightmost digit in the mantissa.
b) Activate Scroll until the desired character is displayed.
c) Activate Select to move the cursor one digit to the left.
d) Activate Scroll until the desired character is displayed.
e) Activate Select to move the cursor one digit to the left.
f) Activate Scroll until the desired character is displayed.

g) Activate Select to move the cursor one digit to the left.
h) Activate Scroll until the desired character is displayed.

4. Enter the sign.

a) Activate Select to move the cursor one digit to the left.
b) Activate Scroll until the desired character is displayed.

For positive numbers, select a blank space.

5. To save the displayed value to transmitter memory, activate Scroll and Select
simultaneously and hold until the display changes.
• If the displayed value is the same as the value in transmitter memory, you will be

returned to the previous screen.
• If the displayed value is not the same as the value in transmitter memory, SAVE/

YES? flashes on the display. Activate Select.

6. Switch back from exponential notation to decimal notation.

a) Activate Select until the E is flashing.

b) Activate Select until d is displayed.

c) Activate Select.
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B.4 Display codes for process variables
Table B-2: Display codes for process variables

Code Definition Comment or reference

AVE_D Average density Petroleum measurement application only

AVE_T Average temperature Petroleum measurement application only

BRD_T Board temperature

CONC Concentration Concentration measurement application only

DRIVE% Drive gain

EXT_P External pressure

EXT_T External temperature

GSV F Gas standard volume flow

GSV I Gas standard volume inventory

GSV T Gas standard volume total

LPO_A Left pickoff amplitude

LVOLI Volume inventory

LZERO Live zero flow

MASSI Mass inventory

MTR_T Case temperature (T-Series sensors only)

NET M Net mass flow rate Concentration measurement application only

NET V Net volume flow rate Concentration measurement application only

NETMI Net mass inventory Concentration measurement application only

NETVI Net volume inventory Concentration measurement application only

PWRIN Input voltage Refers to power input to the core processor

RDENS Density at reference temperature Concentration measurement application only

RPO_A Right pickoff amplitude

SGU Specific gravity units

STD V Standard volume flow rate Concentration measurement application only

STDVI Standard volume inventory Concentration measurement application only

TCDENS Temperature-corrected density Petroleum measurement application only

TCORI Temperature-corrected inventory Petroleum measurement application only

TCORR Temperature-corrected total Petroleum measurement application only

TCVOL Temperature-corrected volume Petroleum measurement application only

TUBEF Raw tube frequency

WTAVE Weighted average
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B.5 Codes and abbreviations used in display menus
Table B-3: Codes and abbreviations used in display menus

Code or
abbreviation Definition Comment or reference

ACK ALERT Acknowledge alert

ACK ALL Acknowledge all alerts

ACT Action

ADDR Address

AO1
Analog output 1

(primary mA Output)

AO 1 SRC
Fixed to the process variable

assigned to the primary output

AO2
Analog output 2

(secondary mA Output)

AUTO SCRLL Auto Scroll

BKLT

B LIGHT

Backlight

CAL Calibrate

CH A Channel A

CHANGE PASSW

CHANGE CODE
Change password

or passcode

Change the password or passcode required for
access to display functions

CH B Channel B

CH C Channel C

CONFG Configuration

CORE Core processor

CUR Z Current zero

CUSTODY XFER Custody transfer

DENS Density

D EV Discrete event Events configured using the enhanced event
model

DGAIN, DRIVE % Drive gain

DISBL Disable Select to disable
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Table B-3: Codes and abbreviations used in display menus (continued)

Code or
abbreviation Definition Comment or reference

DO1 Discrete Output 1

DO2 Discrete Output 2

DSPLY Display

E1OR2 Event 1 or Event 2 Events configured using the basic event model

ENABL Enable Select to enable

ENABLE ACK Enable acknowledge all Enable or disable the ACK ALL function

ENABLE ALERTS Enable alert menu Access to alert menu from display

ENABLE AUTO Enable Auto Scroll Enable or disable the Auto Scroll function

ENABLE OFFLN Enable off-line Access to off-line menu from display

ENABLE PASSW Enable password Enable or disable password protection for display
functions

ENABLE RESET Enable totalizer reset Enable or disable totalizer reset from display

ENABLE START Enable totalizer start Enable or disable totalizer start/stop from display

EVNT1 Event 1 Event configured using the basic event model
only

EVNT2 Event 2 Event configured using the basic event model
only

EXTRN External

FAC Z Factory zero

FCF Flow calibration factor

FLDIR Flow direction

FL SW

FLSWT

Flow switch

FO Frequency Output

FO FREQ Frequency factor

FO RATE Rate factor

FREQ Frequency

FR FL Frequency=Flow

GSV Gas standard volume

HYSTRSIS Hysteresis

INTERN Internal

IO Input/output

LANG Language

LOCK Write-protect
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Table B-3: Codes and abbreviations used in display menus (continued)

Code or
abbreviation Definition Comment or reference

LOOP CUR Loop current

M_ASC Modbus ASCII

M_RTU Modbus RTU

MAO1
mA Output 1

(primary mA Output)

MAO2
mA Output 2

(secondary mA Output)

MASS Mass flow

MBUS Modbus

MFLOW Mass flow

MSMT Measurement

MTR F Meter factor

OFF-LINE MAINT Off-line maintenance

OFFLN Off-line

P/UNT Pulses/unit

POLAR Polarity

PRESS Pressure

QUAD Quadrature

r. Revision

SCALE Scaling method

SIM Simulation Used for loop testing, not simulation mode.
Simulation mode is not accessible through the
display.

SPECL Special

SRC Source Variable assignment

TEMP, TEMPR Temperature

UNT/P Units/pulse

VAR 1 Display Variable 1

VER Version

VERFY Verify

VFLOW Volume flow

VOL Volume, volume flow
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Table B-3: Codes and abbreviations used in display menus (continued)

Code or
abbreviation Definition Comment or reference

WRPRO Write protect PVR applications only

XMTR Transmitter

B.6 Display menus
These figures show the commands accessible through the display for specific
configuration and maintenance tasks.

Main Display menu

Figure B-1: Display menu -- Main

Alerts (alarms) from the Display menu

Figure B-2: Display menu -- Alerts
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Off-line maintenance from the Display menu

Figure B-3: Display menu -- Off-line maintenance: configuration

OFF-LINE MAINT

SWREV CONFG ZERO SENSOR VERFYScroll Scroll Scroll

Select

Select

UNITS MTR F DISPLAYScroll Scroll

ADDRESS PBUS IDENT SEL CONFIG AIScroll Scroll

CONFIG AO CONFIG TOTScroll

Scroll

Scroll

Figure B-4: Display menu -- Off-line maintenance: configuration -- units

UNITS

Select

MASS VOL GSVScroll Scroll

DENS TEMP PRESSScroll ScrollScroll

These are the Transducer block engineering units.

Important
The Transducer block engineeering units must match the AI function block engineering
units (Figure B-7) or it results in a configuration error.

Figure B-5: Display menu -- Off-line maintenance: configuration -- meter factors

MTR F

Select

MASS VOL DENSScroll Scroll
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Figure B-6: Display menu -- Off-line maintenance: configuration -- Display
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Figure B-7: Display menu -- Off-line maintenance: configuration -- Analog Input
blocks

CONFG AI

Select

AI1 CHAN Scroll AI1 UNITS

AI4 CHAN Scroll AI4 UNITS

AI3 CHAN Scroll AI3 UNITS

AI2 CHAN Scroll AI2 UNITSScroll

Scroll

Scroll

These are the Analog Input block engineering units.

Important
The Analog Input function block engineeering units must match the Transducer block
engineering units (Figure B-4) or it results in a configuration error.
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Figure B-8: Display menu -- Off-line maintenance: configuration -- Analog Output
blocks

CONFG AO

Select

AO1 INCH Scroll AO1 PV UNITS

AO2 OUTCH Scroll AO2 OUT UNITS

AO2 INCH Scroll AO2 PV UNITS

AO1 OUTCH Scroll AO1 OUT UNITSScroll

Scroll

Scroll

These are the Analog Output block engineering units.

Important
The Analog Output block engineering units must match the Transducer block engineering
units (Figure B-4) or it results in a configuration error.

Figure B-9: Display menu -- Off-line maintenance: configuration -- Totalizers

CONFG TOT

Select

TOT1 MODE Scroll TOT1 CHAN

TOT3 MODE Scroll TOT3 CHAN

TOT2 CHAN Scroll TOT2 UNITS

TOT1 UNITS

Scroll TOT2 MODE

Scroll

Scroll

Scroll

TOT3 UNITS

Scroll TOT4 MODE TOT3 CHAN Scroll TOT4 UNITS

Scroll

Scroll
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Figure B-10: Display menu -- Off-line maintenance: Zeroing

OFF-LINE MAINT

SWREV CONFG ZERO SENSOR VERFYScroll Scroll Scroll

Select

Select

………………….

ZERO/YES?
CAL PASSCAL FAIL

CAL ZERO

Select

Select
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Figure B-11: Display menu -- Off-line maintenance: LD optimization

OFF-LINE MAINT

Scroll and Select simultaneously 
for 4 seconds

Scroll

Select

Select

Scroll

CONFG

Select

Scroll

MTR F

FACTOR LD

Scroll

LD OPT

Select
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C Using ProLink III with the transmitter

C.1 Basic information about ProLink III
ProLink III is a configuration and service tool available from Micro Motion. ProLink III runs
on a Windows platform and provides complete access to transmitter functions and data.

Version requirements

To support all the latest firmware features, device firmware v8.0, ProLink III v4.0 or later is
required. For details about ProLink III device support, refer to the ProLink III
ChangeLog.txt file.

ProLink III requirements

To install ProLink III, you must have:

• The ProLink III installation media
• The ProLink III installation kit for your connection type:

To obtain ProLink III and the appropriate installation kit, contact customer support.

ProLink III documentation

Most of the instructions in this manual assume that you are already familiar with ProLink III
or that you have a general familiarity with Windows programs. If you need more
information than this manual provides, see the ProLink® III Configuration and Service Tool for
Micro Motion®  Transmitters: User Manual.

In most ProLink III installations, the manual is installed with the ProLink III program.
Additionally, the ProLink III manual is available on the documentation CD or at .

ProLink III features and functions

ProLink III offers complete transmitter configuration and operation functions. ProLink III
also offers a number of additional features and functions, including:

• A Professional version with expanded features not available on the Basic version.
• The ability to save the transmitter configuration set to a file on the PC, and reload it or

propagate it to other transmitters
• The ability to log specific types of data to a file on the PC
• The ability to view performance trends for various types of data on the PC
• The ability to connect to and view information for more than one device
• A guided connection wizard

These features are documented in the ProLink III manual. They are not documented in the
current manual.

ProLink III messages

As you use ProLink III with a Micro Motion transmitter, you will see a number of messages
and notes. This manual does not document all of these messages and notes.
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Important
The user is responsible for responding to messages and notes and complying with all
safety messages.

C.2 Connect with ProLink III
A connection from ProLink III to your transmitter allows you to read process data,
configure the transmitter, and perform maintenance and troubleshooting tasks.

C.2.1 Connection types supported by ProLink III
Different connection types are available for connecting from ProLink III to the transmitter.
Choose the connection type appropriate to your network and the tasks you intend to
perform.

The transmitter supports the following ProLink III connection types:

• Service port connections

C.2.2 Connect with ProLink III to the service port
Prerequisites

• ProLink III is installed and licensed on your PC
• One of the following:

— RS-232 to RS-485 signal converter
— USB to RS-485 signal converter

• An available serial port or USB port
• Adapters as required (for example, 9-pin to 25-pin)

About this task

Procedure

1. Attach the signal converter to the serial port or USB port on your PC.

2. Access the service port terminals:

a) Remove the transmitter end-cap to access the wiring compartment.
b) Loosen the screw on the Warning flap and open the power supply

compartment.

3. Start ProLink III.

4. Choose Connect to Physical Device.

5. Set Protocol to Service Port.

Tip
Service port connections use standard connection parameters and a standard
address. You do not need to configure them here.

6. Set the PC Port value to the PC COM port that you are using for this connection.

7. Click Connect.
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Need help?
If an error message appears:

• Switch the leads and try again.
• Ensure that you have specified the correct port on your PC.
• Check the wiring between the PC and the transmitter.
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D PROFIBUS-PA status byte
This appendix describes the status byte reported by the transmitter to a PROFIBUS host.
The output of each AI, AO, and totalizer function block is a 5-byte package: four bytes of
process information and one byte indicating measurement quality, also called the status
byte. The format of the status byte depends on whether the transmitter is configured for
classic mode or condensed mode.

Classic-mode status byte format

The following six tables describe the format of the status byte when the transmitter is
configured for classic mode. Refer to Section 3.7.3.6 of the PROFIBUS-PA Profile for
Process Control Devices v3.01 for more information.

Table D-1: Classic-mode status byte format

Status bits Meaning Comment

00 Bad The measurement is not useful.

01 Uncertain
The quality of the measurement is below normal,

but may still be useful.

10 Good - Non-cascade The quality of the measurement is good, but alerts
may be indicated by the sub-status.

11 Good - Cascade The measurement is good.

Table D-2: Sub-status format -- Bad status

Status bits Meaning Comment

0011 Device failure TRUE if the following alert codes are active:A001,
A002, A014, A029, or A030.

0100 Sensor failure TRUE if the following alert codes are active: A003,
A004, A005, A016, or A017.

0111 OOS See the profile specification for details.

Table D-3: Sub-status format -- Uncertain status

Status bits Meaning Comment

0000 Non-specific TRUE if the following alert codes are active: A005, A008,
A010, A011, A012, A013, A021, A033, or A102.

0011 Initial value TRUE if the following alert codes are active: A006 or
A120.

1000 Simulated value TRUE if the following alert codes are active: A132.

1001 Sensor calibration TRUE if the following alert codes are active: A104.
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Table D-4: Sub-status format -- Good status (non-cascade)

Status bits Meaning Comment

0001 Update event

0010 Active advisory alert

0011 Active critical alert

Table D-5: Sub-status format -- Good status (Cascade)

Status bits Meaning Comment

0000 OK This bit is set if no alerts are active.

Table D-6: Limit bits

Bits Meaning Comment

00 OK

01 Low limited

10 High limited

11 Constant
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Condensed-mode status byte format

The following table describes the format of the status byte when the transmitter is
configured for condensed mode. Refer to the PROFIBUS Specification Profile for Process
Control Devices Version v3.01 December 2004 and the PROFIBUS Specification June 2005
Amendment 2 to the PROFIBUS Profile for Process Control Devices v3.01, Condensed
Status and Diagnostic Messages v1.0 for additional information.

Table D-7: Condensed-mode status byte format

Expanded status Condensed status Alerts

BAD_DEVICE_FAIL

(0x0C)

C_BAD_MAINTENANCE_ALARM

(0x24…..0x27) (1) (2)

A001, A002, A014, A029,
A030

• A001-- EEPROM Checksum
Error

• A002-- RAM/ROM Test
Error

• A014-- Transmitter Failed
• A029-- Internal

communication failure
(PIC/daughterboard)

• A030-- Hardware/Software
incompatible (board type
missing)

BAD_SENSOR_FAIL

(0x10)

C_BAD_PROCESS_RELATED

(0x2B) (2)

A003, A004, A016, A017

• A003-- Sensor Not
Responding (No Tube
Interrupt)

• A004-- Temperature
Sensor Out-of-Range

• A016-- "Line RTD"
Temperature-Out-of-
Range

• A017-- "Meter RTD"
Temperature-Out-of-
Range

BAD_CFG_ERROR

(0x04)

C_BAD_FUNCTION_CHECK

(0x3C ……0x3F) (1) (2)

• A006-- Transmitter Not
Characterized

• A020-- Calibration Factors
Unentered

• A021-- Unrecognized/
Unentered Sensor

BAD_NON_SPECIFIC

(0x00)

BAD_NON_SPECIFIC

(0x00)
All the remaining

fault alerts

are under this category.
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Table D-7: Condensed-mode status byte format (continued)

Expanded status Condensed status Alerts

UC_SIMULATED_VALUE

(0x60)

C_UNCERTAIN_SIMULATED_VALUE_
START

(0x73)

• A132-- Simulation Mode
Active

UC_SENSOR_CAL

(0x64)

C_BAD_FUNCTION_CHECK

(0x3C ……0x3F) (1) (2)

• A104-- Calibration-In-
Progress

UC_CFG_ERROR

(0x5C)

C_BAD_FUNCTION_CHECK

(0x3C……0x3F) (1) (2)

• A006-- Transmitter Not
Characterized

• A020-- Calibration Factors
Unentered

• A021-- Unrecognized/
Unentered Sensor

UC_NON_SPECIFIC

(0x40)

C_UNCERTAIN_PROCESS_RELATED

(0x78.. …0x7B) (1)

• A005 -- Input Over Range
• A008-- Density Outside

Limits
• A010-- Calibration Failure
• A011-- Excess Calibration

Correction
• A012-- Excess Calibration

Correction
• A013-- Process too Noisy

to Perform Auto
• A033-- Tube Not Full
• A102-- Drive Over Range

GOOD_NC_ADV_ALARM

(0x88)

C_GOOD_ACTIVE_ADVISORY_ALAR
M

(0x88…..0x91) (1)

All informational alerts.

GOOD_NC_UPDATE_EVT

(0x84)

C_GOOD_UPDATE_EVENT

(0x84)
ST REV update

for transducer blocks.

GOOD_CAS_OK

(0xC0)

C_GOOD_CAS_OK

(0xC0)
None of the alerts

stated above

are active.

BAD_OUT_OF_SERVICE |

LIMIT_CONSTANT

(0x1C)

C_BAD_PASSIVATED (0x23) When the Actual mode of AI,
AO, or Totalizer blocks are Out
of Service.

Totalizer Fail Safe:

UC_NON_SPECIFIC

(0x40)

C_UNCERTAINC_SUBSTITUTE_SET
(0x4B)

Failsafe – RUN mode
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Table D-7: Condensed-mode status byte format (continued)

Expanded status Condensed status Alerts

Totalizer Fail Safe:

UC_LUV

(0x44)

C_UNCERTAINC_PROCESS_RELATED
(0x78….0x7B) (1)

Failsafe – HOLD_LUV mode

Totalizer Fail Safe:

UC_NON_SPECIFIC

(0x40)

C_UNCERTAINC_SUBSTITUTE_SET

(0x4B)

Failsafe – MEMORY mode

UC_INITIAL_VAL

(0x4C)

C_UNCERTAIN_INITIAL_VALUE

(0x4F)

When reset or preset totals.

UC_SUBSTITUTE_VAL

(0x48)

C_UNCERTAIN_SUBSTITUTE_SET

(0x4B)

AO failsafe active.

(1) Limits status as applicable.
(2) AI function block FB behaves like FSAFE_TYPE = 1 as per Section 3.3.1 (Table 19) of the PROFIBUS

Specification June2005, Order no. 3.042, Amendment2 to the PROFIBUS Profile for Process
Control Devices v3.01, Condensed Status and Diagnostic Messages v1.0.
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E Slave diagnostic response bytes
This appendix describes the diagnostic bytes reported by the transmitter to a PROFIBUS
host.

Overview

There are two sets of diagnostic bytes sent:

• Bytes 1–6 conform to the standard PROFIBUS specification.
• Byte 7 is the extended diagnostic header byte.
• Bytes 8–15 are extended diagnostic bytes that conform to the Profile 3.01 specification

and the Diagnosis, Alerts, and Time-stamping Profile Guidelines.
• The final 10 bytes are extended diagnostic bytes that correspond to alerts in the

transmitter. Alert codes referenced in these bytes are the codes shown on the
transmitter display. Refer to Status alerts for more information about alert codes.

Note
AI, AO, and totalizer function blocks will go into OOS mode when any of the following
diagnostics bits are set: 24 (hardware failure), 28 (memory error), or 29 (measurement
failure). There can be as many as 62 device-related diagnostic bytes.

PROFIBUS specification diagnostic bytes

The following 22 tables describe the PROFIBUS diagnostic response bytes.

Table E-1: Byte 1

Bit Indication

0 Station not existent (this is set by the master if the slave does not respond)

1 Station not ready for data exchange

2 Configuration fault: slave did not accept last configuration data

3 Slave has extended diagnostic data to report

4 Slave does not support requested parameter function

5 Invalid slave response (this is set by the master)

6 Parameter fault: slave did not accept last parameterization data

7 Slave is locked or controlled by another master (this is set by the master)

Table E-2: Byte 2

Bit Indication

0 Slave must be parameterized

1 Static diagnostic: master requesting diagnostics until bit is reset

2 This bit is always set to 1
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Table E-2: Byte 2 (continued)

Bit Indication

3 Response monitoring/watchdog (1 = ON; 0 = OFF)

4 Slave is in freeze mode (1 = ON; 0 = OFF)

5 Slave is in sync mode (1 = ON; 0 = OFF)

6 Reserved

7 Slave is deactivated in master parameter set (this is set by the master)

Table E-3: Byte 3

Bit Indication

0 Reserved (always set to 0)

1 Reserved (always set to 0)

2 Reserved (always set to 0)

3 Reserved (always set to 0)

4 Reserved (always set to 0)

5 Reserved (always set to 0)

6 Reserved (always set to 0)

7 Diagnostic overflow—transmitter has more diagnostic data than it can report

Table E-4: Byte 4

Bit Indication

0 Master station address

An address in the range of 0–125 decimal (0x0–0x7D hex) is the address of the
controlling master.

An address of 255 decimal (0xFF hex) means the slave is not controlled or
parameterized by a master.

1

2

3

4

5

6

7

Table E-5: Byte 5

Bit Indication

0 Ident number (MSB) (1)
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Table E-5: Byte 5 (continued)

Bit Indication

1

2

3

4

5

6

7

(1) The identification number will be 0x9742 when in profile-specific I/O mode and 0x057A when in
manufacturing-specific I/O mode. Refer to Section 2.5 for information about I/O modes.

Table E-6: Byte 6

Bit Indication

0 Ident number (LSB)

1

2

3

4

5

6

7

Table E-7: Byte 7 -- Extended diagnostic header byte

Bit Indication

0 Number of extended diagnostic bytes (including this header byte)

1

2

3

4

5

6 Identifier for device-related diagnostics status model (0x00)

7
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Table E-8: Byte 8 -- Status Type = 0XFE

Bit Indication

8 Status type = manufacturer-specific (32 decimal, 0x20 hex)

9

10

11

12

13

14

15 Identifier for status—always set to 1

Table E-9: Byte 9 -- Slot Number = 0X00

Bit Indication

8 Slot number of physical block (per Profile 3.01 this is 0)

9

10

11

12

13

14

15

Table E-10: Byte 10 -- Status Specifier

Bit Indication

16 Error appears (when any new alert is activated)

17 Error disappears (when an alert is deactivated)

18 Reserved

19 Reserved

20 Reserved

21 Reserved

22 Reserved

23 Reserved
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Table E-11: Byte 11 -- User Diagnostics

Bit Indication

24 Reserved (always set to 0)

25 Reserved (always set to 0)

26 Reserved (always set to 0) -- Not used

27 Reserved (always set to 0)

28 Reserved (always set to 0)

29 Reserved (always set to 0)

30 Reserved (always set to 0)

31 Reserved (always set to 0)

Table E-12: Byte 12 -- User Diagnostics

Bit Indication

32 Reserved

33 Reserved

34 Reserved

35 Restart (A107)

36 Cold start (A107)

37 Maintenance required—Not used

38 Reserved

39 Ident_Number violation

Table E-13: Byte 13 -- User Diagnostics = 0X00

Bit Indication

40 Maintenance alert (A014, A001, A002, A003, A022, A023, A024, A026

41 Maintenance demanded (A103)

42 Function check (A106 if any function block is in simulation mode)

43 PRO_COND (not used)

44 Reserved (always set to 0)

45 Reserved (always set to 0)

46 Reserved (always set to 0)

47 Reserved (always set to 0)
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Table E-14: Byte 14 -- User Diagnostics

Bit Indication

48 Reserved (always set to 0)

49 Reserved (always set to 0)

50 Reserved (always set to 0)

51 Reserved (always set to 0)

52 Reserved (always set to 0)

53 Reserved (always set to 0)

54 Reserved (always set to 0)

55 Extension available

Table E-15: Byte 15 -- User Diagnostics

Bit Indication

56 Undefined (A000)

57 Core EEPROM checksum error (A001)

58 RAM test error (A002)

59 Sensor not responding (no tube interrupt) (A003)

60 Temperature sensor out-of-range (A004)

61 Input over-range (A005)

62 Transmitter not characterized (A006)

63 Reserved (A037)

Table E-16: Byte 16 -- User Diagnostics

Bit Indication

64 Density outside limits (A008)

65 Transmitter initializing/warming up (A009)

66 Calibration failure (A010)

67 Excess calibration correction, zero too low (A011)

68 Excess calibration correction, zero too high (A012)

69 Process too noisy to perform auto zero (A013)

70 Transmitter failed (A014)

71 Reserved (A015)
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Table E-17: Byte 17 -- User Diagnostics

Bit Indication

72 Line RTD temperature out-of-range (A016)

73 Meter RTD temperature out-of-range (A017)

74 Reserved (A018)

75 Reserved (A019)

76 Calibration factors unentered (A020)

77 Unrecognized/unentered sensor type (A021)

78 Reserved (A022)

79 Reserved (A023)

Table E-18: Byte 18 -- User Diagnostics

Bit Indication

80 Reserved (A024)

81 Reserved (A025)

82 Sensor/xmtr communication failure (A026)

83 Reserved (A027)

84 Sensor/xmtr write failure (A028)

85 Internal communication failure (A029)

86 Hardware/software incompatible (A030)

87 Low power (A031)

Table E-19: Byte 19 -- User Diagnostics

Bit Indication

88 Meter verification fault alert (A032)

89 Sensor OK/tubes stopped by process (A033)

90 Undefined (A034)

91 Meter Verification aborted (A035)

92 Undefined(A036)

93 Undefined (A037)

94 Undefined (A038)

95 Undefined(A039)
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Table E-20: Byte 20 -- User Diagnostics

Bit Indication

96 Reserved (A100)

97 Reserved (A101)

98 Drive over range/partially full tube (A102)

99 Data loss possible (A103)

100 Calibration in progress (A104)

101 Two-phase (slug flow) (A105)

102 Reserved (A106)

103 Power reset occurred (A107)

Table E-21: Byte 21 -- User Diagnostics

Bit Indication

104 Reserved (A108)

105 Reserved (A109)

106 Reserved (A110)

107 Reserved (A111)

108 Reserved (A112)

109 Reserved (A113)

110 Reserved (A114)

111 Reserved (A115)

Table E-22: Byte 22 -- User Diagnostics

Bit Indication

112 Petroleum measurement: temperature out-of-limits (A116)

113 Petroleum measurement: density out-of-limits (A117)

114 Reserved (118)

115 Reserved (119)

116 Concentration measurement: Unable to fit curve data (A120)

117 Concentration measurement: Extrapolation alert (A121)

118 Reserved (122)

119 Reserved (123)
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Table E-23: Byte 23 -- User Diagnostics

Bit Indication

120 Reserved (A124)

121 Reserved (A125)

122 Reserved (A126)

123 Reserved (A127)

124 Reserved (A128)

125 Undefined (A129)

126 Reserved (A130)

127 Meter Verification Info Alert (A131)

Table E-24: Byte 24 -- User Diagnostics

Bit Indication

128 Simulation Mode Active (A132)

129 Undefined (A133)

130 Undefined (A134)

131 Undefined (A135)

132 Undefined (A136)

133 Undefined (A137)

134 Undefined (A138)

135 Undefined (A139)
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F Model 2700 PROFIBUS block
parameters
This appendix describes the block parameters of the Model 2700 transmitter with
PROFIBUS-PA.

The tables in this appendix have been split in two to clarify the display.

The first table contains the folliowing columns:

Column name Definition

Index Index of the parameter within the block.

Parameter mnemonic Name of the parameter used in the code.

Definition Description of the parameter.

Default (initial) value The value the parrameter takes when a master reset occurs. For
some parameters, the value is calculated based on the sensor
type and conditions. These values are represented with the
Calculation in the field.

Enumerated list of values / range The list of valid values to write to an enumerated parameter.
This field is not applicable for read-only parameters. Valid value
ranges for variable type parameters variable type parameters
are not specified.

The second table contains the following columns

Column name Definition

Index Index of the parameter within the block.

Parameter mnemonic Name of the parameter used in the code.

Message types: Below are the seven types of messages.

Variable: Some value.

Enum: A value from a discrete list.

Method: The parameter initiates some action within the device.

String: A set of ASCII characters.

Array: A set of values.

Record: A data structure defined by the Profibus PA Profile v3.01.

Simple: A single variable that is characterized by a defined data type.

Data type/structure The data type.

Size The size of data in bytes.
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Column name Definition

Store / rate (hz) The class of memory required or the update rate of the variable, if
applicable:

D (dynamic store): The parameter is updated periodically (Cyclic Data)

S (static): Non-volatile data. Changing the parameter increases the
static revision counter (ST_REV).

N (non-volatile): The non-volatile parameter must be remembered
through a power cycle, but it is not part of the static update code.

N-CP (non-volatile): The non-volatile code resides in the core processor.

Cst (constant): The parameter does not change in the device.

Access The ability to read/write (R/W) or just read a parameter. If the parameter
is read/write, the Mode that the Transducer Block requires is in
parentheses. For example, 'R/W (Out of service)' indicates that the
parameter is writable, but the MODE_BLK parameter must be OOS for
changes to take effect.

Modbus register / coil The associated Modbus register or coil. If there is a preceding 'R', the
number is a register, while a preceding 'C' indicates a coil.

F.1 Slot identification
The following table shows the slot assignment for blocks.

Table F-1: Block slot assignment

Slot Assigned block

0 Physical block

1 Analog input block 1 -- Composite Directory

2 Analog input block 2

3 Analog input block 3

4 Totalizer block 1

5 Analog input block 4

6 Totalizer block 2

7 Totalizer block 3

8 Totalizer block 4

9 Analog output block 1

10 Analog output block 2

11 Transducer block 1

12 Transducer block 2
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F.2 Physical block
The following tables show the parameters for the physical block, including the default
value. If an enumerated list of values or range is not cited, there is no value for the
parameter.

Physical block: standard parameters (16 through 23)

The first table focuses on definitions, default values, and the enumerated list of values
allowed for each parameter, while Table F-3 provides the Modbus register column and
other relevant values.

Table F-2: Physical block parameters -- standard parameters (16 through 23) --
definitions, defaults, and range of values

Index Parameter

Mnemonic

Standard

Parameters

Definition Default
value

Enumerated list
of values /range

16 BLOCK_OBJECT This object contains the characteristics
of the block.

---- NA

17 ST_REV A block has static block parameters
that are not changed by the process.
Values are assigned to this parameter
during the configuration of
optimization. The value of ST_REV
increases by 1 after every change of a
static block parameter.

0 NA

18 TAG_DESC Every block can be assigned a textual
TAG description. The TAG_DESC must
be unambiguous and unique in the
field bus system.

' ' NA

19 STRATEGY Grouping of function block. The
STRATEGY field can be used to group
blocks.

0 NA

20 ALERT_KEY This parameter contains the
identification number of the plant
unit.

0 NA

21 TARGET_MODE This parameter contains desired mode
normally set by a control application of
an operator. The modes are valid
alternatively only; for example,only
one mode can be set at one time. A
write access to this parameter with
more than one mode is out of the
range of the parameter and has to be
rejected.

AUTO
(*0x08)

AUTO (*0x08)
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Table F-2: Physical block parameters -- standard parameters (16 through 23) --
definitions, defaults, and range of values (continued)

Index Parameter

Mnemonic

Standard

Parameters

Definition Default
value

Enumerated list
of values /range

22 MODE_BLK This parameter contains the current
mode and the permitted and normal
mode of the block.

--- NA

23 ALARM_SUM This parameter contains the current
states of the block alarms.

0,0,0,0 NA

Table F-3: Physical block parameters -- standard parameters (16 through 23) -- size,
access, and Modbus register columns

Index Parameter

Mnemonic

Standard

Parameters

Message

type

Data type/
structure

Size Store/

rate

(hz)

Access Modbus
register /
coil

16 BLOCK_OBJECT RECORD DS-32 20 Cst R NA

17 ST_REV Simple Unsigned16 2 N R NA

18 TAG_DESC Simple Visible SIMP 32 S R/W NA

19 STRATEGY Simple Unsigned16 2 S R/W NA

20 ALERT_KEY Simple Unsigned8 1 S R/W NA

21 TARGET_MODE (1) Simple Unsigned8 1 S R/W NA

22 MODE_BLK RECORD DS-37 3 D R NA

23 ALARM_SUM RECORD DS-42 8 D R NA

(1) The enumerated list of values for this parameter is AUTO (0x8).

Physical block parameters (24 through 48)

The following tables show the physical block parameters for the physical block 24 through
48). The first table focuses on definitions, default values, and the enumerated list of values
allowed for each parameter, while Table F-5 provides the Modbus register column another
relevant values.
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Table F-4: Physical block parameters (24 through 48) -- definitions, defaults, and
range of values

Index Parameter

Mnemonic

Standard

Parameters

Definition Default
value

Enumerated list of values /range

24 SOFTWARE

_REVISION

(DD Name:

Software

Revision)

Revision-number of
the software of the
field device.

---- NA

25 HARDWARE

_REVISION

(DD Name:

Hardware

Revision)

Revision-number of
the hardware of the
field device.

1.0 NA

26 DEVICE_MAN_ID

(DD Name:

Manufacturing
ID)

Identification code
of the manufacturer
of the field device.

---- NA

27 DEVICE_ID

(DD Name:

Device ID)

Manufacturer
specific
identification of the
device.

---- NA

28 DEVICE_SER

_NUM

(DD Name:

PB Serial
Number)

Serial number of the
field device.

---- NA
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Table F-4: Physical block parameters (24 through 48) -- definitions, defaults, and
range of values (continued)

Index Parameter

Mnemonic

Standard

Parameters

Definition Default
value

Enumerated list of values /range

29 DIAGNOSIS

(DD Name:

Physical Block

Diagnosis)

Detailed
information of the
device, bitwise
coded. More than
one message
possible at once. If
MSB of byte 4 is set
to 1, then more
diagnostic
information is
available in the
DIAGNOSIS_EXTENS
ION parameter.

---- Refer byte 11 to 14 of Extended
Diagnostics bytes in Slave
diagnostic response bytes.

30 EMPTY

31 DIAGNOSIS

_MASK

(DD Name:

Diagnosis Mask)

Definition of
supported
DIAGNOSIS
information-bits.

----
Out of Mandatory Alarms

out of 4 Octets only

Ident No. violation

Alarm is supported.

Extension Available Alarm is
supported

0: not supported

1: supported

32 EMPTY

33 EMPTY

34 EMPTY

35 EMPTY

36 Reserved

37 Reserved
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Table F-4: Physical block parameters (24 through 48) -- definitions, defaults, and
range of values (continued)

Index Parameter

Mnemonic

Standard

Parameters

Definition Default
value

Enumerated list of values /range

38 DEVICE_INSTALL

_DATE

(DD name:-

Device Install
Date)

Device Installation
Date

Blank

40 IDENT_NUMBER

_SELECTOR

(DD Name:

Ident Number)

Each PROFIBUS-
DP /IEC 61158/
device shall have an
Ident_Number
provided by the
PNO. There are
profile specific
Ident_Numbers. A
device may have
profile-specific and
manufacturer-
specific ones. The
user is able to
choose one of these
using this
parameter.

----
0: profile specific

Ident_Number V3.01
(mandatory)

1: manufacturer specific

Ident_Number V3.01

42 FEATURE

(DD Name:

phys Feature)

Indicates optional
features
implemented in the
device and the
status of these
Features which
indicates whether
the feature is
supported or not
supported.

0x03

0x00

0x00

0x00

0x02

0x00

0x00

0x00

PROFIBUS Specification June
2005

Order No: 3.042 Amendment 2
to the Profibus Profile

for Process Control Devices

V 3.01 Condensed Status

and Diagnostic Messages V 1.0
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Table F-4: Physical block parameters (24 through 48) -- definitions, defaults, and
range of values (continued)

Index Parameter

Mnemonic

Standard

Parameters

Definition Default
value

Enumerated list of values /range

43
COND_STATUS

_DIAG

(DD Name:

Condensed
Status)

Condensed Status
Diagnostics

0
0: Status and Diagnosis is
provided as defined in

-PROFIBUS Profile:

“PROFIBUS-PA Profile

for Process Control Devices”

V3.01,December 2004.

PNO-Order-No. 3.042

1: Condensed Status and
Diagnosis information is
provided.

44 Reserved

45 Reserved

46 EMPTY

47 Reserved

48 Physical Block
Views

Table F-5: Physical block parameters (24 through 48) -- size, access, and Modbus
register columns

Index Parameter

Mnemonic

Standard

Parameters

Msg

type

Data type/
structure

Size Store/

rate

(hz)

Access Modbus
register /
coil

24 SOFTWARE_REVISION

(DD Name:

Software Revision)

Simple Visible
string

16 Cst R R-1200
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Table F-5: Physical block parameters (24 through 48) -- size, access, and Modbus
register columns (continued)

Index Parameter

Mnemonic

Standard

Parameters

Msg

type

Data type/
structure

Size Store/

rate

(hz)

Access Modbus
register /
coil

25 HARDWARE_REVISION

(DD Name:

Hardware Revision)

Simple Visible
string

16 Cst R Hard coded

26 DEVICE_MAN_ID

(DD Name:

Manufacturing ID)

Simple Unsigned16 2 Cst R R-121

27 DEVICE_ID

(DD Name: Device ID)

Simple Visible
string

16 Cst R 2545-2554

28 DEVICE_SER_NUM

(DD Name:

PB Serial Number)

Simple Visible
string

16 Cst R R48-49

29 DIAGNOSIS

(DD Name:

Physical Block

Diagnosis)

Simple Octet String
byte 4,
MSB=1
more

diagnosis

available

4 D R NA

30 EMPTY

31 DIAGNOSIS_MASK

(DD Name:

Diagnosis Mask)

Simple Octet string 4 Cst R Hard Coded

1. 0x0
0

2. 0x8
0

3. 0x0
0

4. 0x8
0

32 EMPTY

33 EMPTY

34 EMPTY
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Table F-5: Physical block parameters (24 through 48) -- size, access, and Modbus
register columns (continued)

Index Parameter

Mnemonic

Standard

Parameters

Msg

type

Data type/
structure

Size Store/

rate

(hz)

Access Modbus
register /
coil

35 EMPTY

36 Reserved

37 Reserved

38 DEVICE_INSTALL_DATE

(DD name:-

Device Install Date)

Simple Octet string 16 S R/W 2278-2285

40 IDENT_NUMBER

_SELECTOR

(DD Name:

Ident Number)

Simple Unsigned8 1 S R/W R2274

42 FEATURE

(DD Name:

phys Feature)

RECORD DS-68 8 N R NA

43
COND_STATUS_DIA
G

(DD Name:

Condensed Status)

Simple Unsigned8 1 S R/W NA

44 Reserved

45 Reserved

46 Reserved

47 Reserved

48 Reserved

49 Physical block views
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F.2.1 Physical block object and views
Physical block object

The following tables show the physical block object.

• Physical block object: Table F-6
• Physical block view #1: Table F-7
• Physical block view #2: Table F-8

Table F-6: Physical block object

Slot

/Index

Element name Data type Size

in bytes

Value

Slot 0

/Index 16

Reserved Unsigned 8 1 250 (default)

Block_Object Unsigned 8 1 01

Parent_Class Unsigned 8 1 01

Class Unsigned 8 1 250 (default)

DD_Reference Unsigned 32 4 00 ,00, 00, 00 (reserved)

DD_Revision Unsigned 16 2 00 ,00 (reserved)

Profile Octet string 2 64 02 (compact class B)

Profile_Revision Unsigned 16 2 03 01 (3.01)

Execution_Time Unsigned 8 1 00 (for future use)

Number-Of_Parameters Unsigned 16 2 00 26 ( Maximum number of
Physical Block Parameters)

Address_of_View_1 Unsigned 16 2 00 49 (slot, index)

Number_of_Views Unsigned 8 1 01 (1 view)

Physical block views

The following tables show the physical block views.

Table F-7: Physical block view #1

OD index Parameter mnemonic

-- standard parameters

View 1 View 2 View 3 View 4

16 BLOCK_OBJECT

17 ST_REV 2

18 TAG_DESC

19 STRATEGY

20 ALERT_KEY

Configuration and Use Manual  Model 2700 PROFIBUS block parameters
20000327 October 2018

Configuration and Use Manual  205



Table F-7: Physical block view #1 (continued)

OD index Parameter mnemonic

-- standard parameters

View 1 View 2 View 3 View 4

21 TARGET_MODE

22 MODE_BLK 3

23 ALARM_SUM 8

Overall sum of bytes in View Object 13

Table F-8: Physical block view #2

OD index Parameter mnemonic

-- standard parameters

View 1 View 2 View 3 View 4

29 DIAGNOSIS 4

Overall sum of bytes in View Object
(+ 13 Standard parameters bytes)

4 + 13

F.2.2 Transducer block 1 (measurement, calibration, and
diagnosis)
The following tables show the parameters for transducer block 1.

Transducer block 1 standard PA parameters (0-7)

The first table focuses on definitions, default values, and the enumerated list of values
allowed for each parameter (0-7), while Table F-10 provides the Modbus register column
and other relevant values.

Table F-9: Transducer block 1 standard PA parameters -- definitions, defaults, and
range of values

Index Parameter

Mnemonic

Standard

Parameters

Definition Default
value

Enumerated list
of values /range

0 BLOCK_OBJECT This object contains the
characteristics of the block.

---- NA

1 ST_REV A block has static block
parameters that are not changed
by the process. Values are
assigned to this parameter during
the configuration of optimization.
The value of ST_REV increases by
1 after every change of a static
block parameter.

0 NA
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Table F-9: Transducer block 1 standard PA parameters -- definitions, defaults, and
range of values (continued)

Index Parameter

Mnemonic

Standard

Parameters

Definition Default
value

Enumerated list
of values /range

2 TAG_DESC Every block can be assigned a
textual TAG description. The
TAG_DESC must be unambiguous
and unique in the field bus
system.

' ' NA

3 STRATEGY Grouping of function block. The
STRATEGY field can be used to
group blocks.

0 NA

4 ALERT_KEY This parameter contains the
identification number of the plant
unit.

0 NA

5 TARGET_MODE This parameter contains desired
mode normally set by a control
application of an operator. The
modes are valid alternatively only;
for example, only one mode can
be set at one time. A write access
to this parameter with more than
one mode is out of the range of
the parameter and has to be
rejected.

AUTO
(*0x08)

AUTO (0x8)

6 MODE_BLK This parameter contains the
current mode and the permitted
and normal mode of the block.

--- NA

7 ALARM_SUM This parameter contains the
current states of the block alarms.

0,0,0,0 NA

Table F-10: Transducer block 1 standard PA parameters -- size, access, and Modbus
register columns

Index Parameter

Mnemonic

Standard

Parameters

Message

type

Data type/
structure

Size Store/
rate
(hz)

Access Modbus

register /coil

0 BLOCK_OBJECT RECORD DS-32 20 Cst R NA

1 ST_REV Simple Unsigned16 2 N R NA

2 TAG_DESC Simple OCTET

STRING

32 S R/W NA
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Table F-10: Transducer block 1 standard PA parameters -- size, access, and Modbus
register columns (continued)

Index Parameter

Mnemonic

Standard

Parameters

Message

type

Data type/
structure

Size Store/
rate
(hz)

Access Modbus

register /coil

3 STRATEGY Simple Unsigned16 2 S R/W NA

4 ALERT_KEY Simple Unsigned8 1 S R/W NA

5 TARGET_MODE Simple Unsigned8 1 S R/W NA

6 MODE_BLK RECORD DS-37 3 D R NA

7 ALARM_SUM RECORD DS-42 8 D R NA

Transducer block 1: standard flow parameters (8-30)

The first table focuses on definitions, default values, and the enumerated list of values
allowed for each parameter (8-30), while Table F-12 provides the Modbus register column
and other relevant values.

Table F-11: Transducer block 1 standard flow transducer block parameters --
definitions, defaults, and range of values

Index Parameter

mnemonic

standard flow

transducer

block

parameters

Definition Default
value

Enumerated list of
values /range

8 CALIBR_FACTOR

(DD Name :

Flow Cal Factor)

Gain compensation value for the
flow sensor, so that flow
indication is accurate as specified
by the manufacturer.

--- NA

9 LOW_FLOW

_CUTOFF

(DD Name :

Mass Flow Cutoff)

Mass Flow can have an hysteresis.
If the value has a hysteresis, this
parameter defines the lower
switching point. The unit of this
value is the mass flow units

0 NA
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Table F-11: Transducer block 1 standard flow transducer block parameters --
definitions, defaults, and range of values (continued)

Index Parameter

mnemonic

standard flow

transducer

block

parameters

Definition Default
value

Enumerated list of
values /range

10 MEASUREMENT

_MODE

(DD Name:

Measurement
Mode)

Mode of flow measurement 0
0 = Forward Only

1 = Reverse Only

2 = Bi-Directional

3 = Absolute Value

4 = Negate/Forward
Only

5 = Negate

/Bi-Directional

11 FLOW_DIRECTION

(DD Name :

Flow Direction)

Assigns an arbitrary positive or
negative sign to the mass flow
value

0 0 = positive

1 = negative

12 ZERO_POINT

(DD Name:

Zero Point)

Offset compensation value for
the flow sensor, so that true zero
flow value can be indicated
during no flow condition

---- NA

13 ZERO_POINT

_ADJUST

(DD Name:

Zero Calibration)

Initiates a device specific
adjustment cycle that determines
the true ZERO_POINT value
during no flow process
conditions. The result is shown in
ZERO_POINT

0 0 = cancel

1 = execute

14 ZERO_POINT_UNIT

(DD Name:

Zero Point Unit)

Selected unit code for
ZERO_POINT parameter

1057 =
microse
conds

1057 = microseconds

15 NOMINAL_SIZE

(DD Name:

Nominal Size)

Ideal size of the measuring pipe
or process pipe size for insertion
type flow transmitter

---- NA
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Table F-11: Transducer block 1 standard flow transducer block parameters --
definitions, defaults, and range of values (continued)

Index Parameter

mnemonic

standard flow

transducer

block

parameters

Definition Default
value

Enumerated list of
values /range

16 NOMINAL_SIZE

_UNITS

(DD Name:

Nominal Size
Units)

Selects the units for the
NOMINAL_SIZE parameter

1019 1019 = inch

17 VOLUME_FLOW

(DD Name :

Volume Flow
Rate)

Measure volume flow. This is an
optional parameter for this device

---- NA
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Table F-11: Transducer block 1 standard flow transducer block parameters --
definitions, defaults, and range of values (continued)

Index Parameter

mnemonic

standard flow

transducer

block

parameters

Definition Default
value

Enumerated list of
values /range

18 VOLUME _FLOW

_UNITS

(DD Name :

Volume Flow
Units)

Selected unit code for
VOLUME_FLOW,
VOLUME_FLOW_LO_LIMIT and
VOLUME_FLOW_HI_LIMIT

1349
0000 = None

1347 = m3/s

1348 = m 3/min

1349 = m3/hr

1350 = m3/day

1351 = L/s

1352 = L/min

1353 = L/hr

1355 = Ml/day

1356 = CFS

1357 = CFM

1358 = CFH

1359 = ft3/day

1362 = gal/s

1363 = GPM

1364 = gal/hour

1365 = gal/day

1366 = Mgal/day

1367 = ImpGal/s

1368 = ImpGal/min

1369 = ImpGal/hr

1370 = Impgal/day

1371 = bbl/s

1372 = bbl/min
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Table F-11: Transducer block 1 standard flow transducer block parameters --
definitions, defaults, and range of values (continued)

Index Parameter

mnemonic

standard flow

transducer

block

parameters

Definition Default
value

Enumerated list of
values /range

1373 = bbl/hr

1374 = bbl/day

1642 = beer bbl/s

1643 = beer
bbl/min

1644 = beer bbl/hr

1645 = beer bbl/day

19 PA_VOLUME

FLOW_LO_LIMIT

(DD Name :

Volume Flow

Low Limit)

Absolute value of the lower range
volume flow of the sensor

---

20 PA_VOLUME

FLOW_HI_LIMIT

(DD Name :

Volume Flow

High Limit)

Absolute value of the upper range
volume flow of the sensor

----

21 MASS_FLOW

(DD Name :

Mass Flow Rate)

Measure mass flow. This is the
Primary Variable (PV ) for this
device

---- NA
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Table F-11: Transducer block 1 standard flow transducer block parameters --
definitions, defaults, and range of values (continued)

Index Parameter

mnemonic

standard flow

transducer

block

parameters

Definition Default
value

Enumerated list of
values /range

22 MASS_FLOW

_UNITS

(DD Name :

Mass Flow Units)

Selected unit code for
MASS_FLOW, MASS
_FLOW_LO_LIMIT and MASS
_FLOW_HI_LIMIT

1322
1318 = g/s

1319 = g/min

1320 = g/hr

1322 = kg/s

1323 = kg/min

1324 = kg/hr

1325 = kg/day

1327 = t/min

1328 = t/h

1329 = t/d

1330 = lb/s

1331 = lb/min

1332 = lb/hr

1333 = lb/day

1335 = Ston/min

1336 = Ston/hr

1337 = Ston/day

1340 = Lton/hr

1341 = Lton/day

23 PA_MASS_FLOW

_LO_LIMIT

(DD Name :

Mass Flow

Low Limit)

Absolute value of the lower range
mass flow of the sensor

---
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Table F-11: Transducer block 1 standard flow transducer block parameters --
definitions, defaults, and range of values (continued)

Index Parameter

mnemonic

standard flow

transducer

block

parameters

Definition Default
value

Enumerated list of
values /range

24 PA_MASS_FLOW

_HI_LIMIT

(DD Name :

Mass Flow

High Limit)

Absolute value of the upper range
mass flow of the sensor

---

25 DENSITY

(DD Name :

Density)

Measure density. This is the
Secondary Variable (SV ) for this
device.

----

26 DENSITY_UNITS

(DD Name :

Density Units)

Selected unit code for DENSITY,
DENSITY _LO_LIMIT and DENSITY
_HI_LIMIT

1103
0000 = None

1097 = kg/m3

1100 = g/cm3

1103 = kg/L

1104 = g/m

l1105 = g/L

1106 = lb/in3

1107 = lb/ft3

1108 = lb/gal

1109 = Ston/yd3

31113 = DegAPI

1114 = SGU

Model 2700 PROFIBUS block parameters Configuration and Use Manual
October 2018 20000327

214  Micro Motion Model 2700 Transmitters with PROFIBUS-PA



Table F-11: Transducer block 1 standard flow transducer block parameters --
definitions, defaults, and range of values (continued)

Index Parameter

mnemonic

standard flow

transducer

block

parameters

Definition Default
value

Enumerated list of
values /range

27 PA_DENSITY

_LOW_LIMIT

(DD Name :

Density

Low Limit)

Absolute value of the lower range
density of the sensor

----

28 PA_DENSITY

_HI_LIMIT

(DD Name :

Density

High Limit)

Absolute value of the upper range
density of the sensor

----

29 TEMPERATURE

(DD Name :

Temperature)

Measure temperature. This is the
Tertiary Variable (TV ) for this
device

----

30 TEMPERATURE

_UNITS

(DD Name :

Temperature
Units)

Selected unit code for
TEMPERATURE, TEMPERATURE
_LO_LIMIT and TEMPERATURE
_HI_LIMIT

1000
0000 = None

1000 = K

1001 = Deg C

1002 = Deg F

1003 = Deg R

31 PA_TEMPERATURE

_LOW_LIMIT

(DD Name :

Temperature Low
Limit)

Absolute value of the lower range
temperature of the sensor

----
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Table F-11: Transducer block 1 standard flow transducer block parameters --
definitions, defaults, and range of values (continued)

Index Parameter

mnemonic

standard flow

transducer

block

parameters

Definition Default
value

Enumerated list of
values /range

32 PA_TEMPERATURE

_HI_LIMIT

(DD Name :

Temperature
High Limit)

Absolute value of the upper range
temperature of the sensor

----

Table F-12: Transducer block 1 standard flow transducer block parameters -- size,
access, and Modbus register columns

Index Parameter

mnemonic

standard flow

transducer

block

parameters

Message

type

Data type/
structure

Size Store/
rate
(hz)

Access Modbus

register / coil

8 CALIBR_FACTOR

(DD Name :

Flow Cal Factor)

Simple Float 4 S R/W R-0407

9 LOW_FLOW

_CUTOFF

(DD Name :

Mass Flow
Cutoff)

Simple Float 4 S R/W R-0195

10 MEASUREMENT

_MODE

(DD Name:
Measurement
Mode)

Simple Unsigned8 1 S R/W R-0017
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Table F-12: Transducer block 1 standard flow transducer block parameters -- size,
access, and Modbus register columns (continued)

Index Parameter

mnemonic

standard flow

transducer

block

parameters

Message

type

Data type/
structure

Size Store/
rate
(hz)

Access Modbus

register / coil

11 FLOW_DIRECTIO
N

(DD Name :

Flow Direction)

Simple Unsigned8 1 S R/W NA

12 ZERO_POINT

(DD Name:

Zero Point)

Simple Float 4 S R/W R-0233

13 ZERO_POINT

_ADJUST

(DD Name:

Zero
Calibration)

Simple Unsigned8 1 N R/W NA

14 ZERO_POINT_UN
IT

(DD Name:

Zero Point Unit)

Simple Unsigned16 2 S R/W NA

15 NOMINAL_SIZE

(DD Name:

Nominal Size)

Simple Float 4 S R/W NA

16 NOMINAL_SIZE

_UNITS

(DD Name:

Nominal Size
Units)

Simple Unsigned16 2 S R/W NA
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Table F-12: Transducer block 1 standard flow transducer block parameters -- size,
access, and Modbus register columns (continued)

Index Parameter

mnemonic

standard flow

transducer

block

parameters

Message

type

Data type/
structure

Size Store/
rate
(hz)

Access Modbus

register / coil

17 VOLUME_FLOW

(DD Name :

Volume Flow
Rate)

RECORD 101 5 D R/W NA

18 VOLUME _FLOW

_UNITS

(DD Name :

Volume Flow
Units)

Simple Unsigned16 2 S R/W R-0042

19 PA_VOLUME_FLO
W

_LO_LIMIT

(DD Name :

Volume Flow

Low Limit)

Simple Float 4 S R/W

20 PA_VOLUME_FLO
W

_HI_LIMIT

(DD Name :

Volume Flow

High Limit)

Simple Float 4 S R/W

21 MASS_FLOW

(DD Name :

Mass Flow Rate)

RECORD 101 5 D R R-0247
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Table F-12: Transducer block 1 standard flow transducer block parameters -- size,
access, and Modbus register columns (continued)

Index Parameter

mnemonic

standard flow

transducer

block

parameters

Message

type

Data type/
structure

Size Store/
rate
(hz)

Access Modbus

register / coil

22 MASS_FLOW

_UNITS

(DD Name :

Mass Flow
Units)

Simple Unsigned16 2 S R/W R-0039

23 PA_MASS_FLOW

_LOW_LIMIT

(DD Name :

Mass Flow

Low Limit)

Simple Float 4 S R/W

24 PA_MASS_FLOW

_HI_LIMIT

(DD Name :

Mass Flow

High Limit)

Simple Float 4 S R/W

25 DENSITY

(DD Name :

Density)

RECORD 101 5 D R R-0003

26 DENSITY_UNITS

(DD Name :

Density Units)

Simple Unsigned16 2 S R/W R-0040
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Table F-12: Transducer block 1 standard flow transducer block parameters -- size,
access, and Modbus register columns (continued)

Index Parameter

mnemonic

standard flow

transducer

block

parameters

Message

type

Data type/
structure

Size Store/
rate
(hz)

Access Modbus

register / coil

27 PA_DENSITY

_LOW_LIMIT

(DD Name :

Density

Low Limit)

Simple Float 4 S R/W

28 PA_DENSITY

_HI_LIMIT

(DD Name :

Density

High Limit)

Simple Float 4 S R/W

29 TEMPERATURE

(DD Name :

Temperature)

RECORD 101 5 D R R-251

30 TEMPERATURE

_UNITS

(DD Name :

Temperature
Units)

Simple Unsigned16 2 S R/W R-0041

31 PA_TEMPERATUR
E

_LO_LIMIT

(DD Name :

Temperature

Low Limit)

Simple Float 4 S R/W
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Table F-12: Transducer block 1 standard flow transducer block parameters -- size,
access, and Modbus register columns (continued)

Index Parameter

mnemonic

standard flow

transducer

block

parameters

Message

type

Data type/
structure

Size Store/
rate
(hz)

Access Modbus

register / coil

32 PA_TEMPERATUR
E

_HI_LIMIT

(DD Name :

Temperature

High Limit)

Simple Float 4 S R/W

Transducer block 1: manufacturer-specific variables (33-48)

The first table focuses on definitions, default values, and the enumerated list of values
allowed for each parameter (33-48), while Table F-14 provides the Modbus register
column and other relevant values.

Table F-13: Transducer block 1 manufacturer-specific parameters -- definitions,
defaults, and range of values

Index Parameter

mnemonic

manufacturer

specific

parameters

Definition Default
value

Enumerated

list of

values /range

33 SNS_Damping

FlowRate

(DD Name :

Flow Damping)

Flow rate (Mass and Volume) internal
damping (seconds)

0.8 0.0 to 60.0 sec

34 SNS_DampingTemp

(DD Name :

Temperature

Damping)

Temperature internal damping
(seconds)

4.8 0.0 to 80.0 sec
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Table F-13: Transducer block 1 manufacturer-specific parameters -- definitions,
defaults, and range of values (continued)

Index Parameter

mnemonic

manufacturer

specific

parameters

Definition Default
value

Enumerated

list of

values /range

35 SNS_Damping

Density

(DD Name :

Density Damping)

Density internal damping (seconds) 1.6 N/A0.0 to 60.0
sec

36 SNS_MassMeter

Factor

(DD Name :

Mass Factor)

Mass Rate Factor 1.0 0.8 to 1.2

37 SNS_DensMeter

Factor

(DD Name :

Density Factor)

Density Factor 1.0 0.8 to 1.2

38 SNS_VolMeter

Factor

(DD Name :

Volume Factor)

Volume Rate Factor 1.0 0.8 to 1.2

39 SNS_VolumeFlow

Cutoff

(DD Name :

Volume Cutoff)

Volume flow cutoff for internal
totalizers

0.0- 0 to sensor
limit

40 SNS_LowDensity

Cutoff

(DD Name :

Density Cutoff)

Density cutoff for internal totalizers 0.0- 0.0 to 0.5

41 EMPTY

Model 2700 PROFIBUS block parameters Configuration and Use Manual
October 2018 20000327

222  Micro Motion Model 2700 Transmitters with PROFIBUS-PA



Table F-13: Transducer block 1 manufacturer-specific parameters -- definitions,
defaults, and range of values (continued)

Index Parameter

mnemonic

manufacturer

specific

parameters

Definition Default
value

Enumerated

list of

values /range

42 EMPTY

43 EMPTY

44 EMPTY

45 EMPTY

46 EMPTY

47 EMPTY

48 EMPTY

Table F-14: Transducer block 1 manufacturer-specific parameters -- size, access, and
Modbus register columns

Index Parameter

mnemonic

manufacturer

specific

parameters

Message

type

Data type/
structure

Size Store/
rate (hz)

Access Modbus

register /
coil

33 SNS_Damping

FlowRate

(DD Name :

Flow Damping)

VARIABLE Float 4 N-CP R/W R-189-190

34 SNS_Damping

Temp

(DD Name :

Temperature
Damping)

VARIABLE Float 4 N-CP R/W R-191-192
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Table F-14: Transducer block 1 manufacturer-specific parameters -- size, access, and
Modbus register columns (continued)

Index Parameter

mnemonic

manufacturer

specific

parameters

Message

type

Data type/
structure

Size Store/
rate (hz)

Access Modbus

register /
coil

35 SNS_Damping

Density

(DD Name :

Density
Damping)

VARIABLE Float 4 N-CP R/W R-193-194

36 SNS_MassMeter

Factor

(DD Name :

Mass Factor)

VARIABLE Float 4 N-CP R/W R-279-280

37 SNS_DensMeter

Factor

(DD Name :

Density Factor)

VARIABLE Float 4 N-CP R/W R-283-284

38 SNS_VolMeter

Factor

(DD Name :

Volume Factor)

VARIABLE Float 4 N-CP R/W R-281-282

39 SNS_VolumeFlow

Cutoff

(DD Name :

Volume Cutoff)

VARIABLE Float 4 N-CP R/W R-197-198

40 SNS_LowDensity

Cutoff

(DD Name :

Density Cutoff)

VARIABLE Float 4 N-CP R/W R-149-150

41 EMPTY
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Table F-14: Transducer block 1 manufacturer-specific parameters -- size, access, and
Modbus register columns (continued)

Index Parameter

mnemonic

manufacturer

specific

parameters

Message

type

Data type/
structure

Size Store/
rate (hz)

Access Modbus

register /
coil

42 EMPTY

43 EMPTY

44 EMPTY

45 EMPTY

46 EMPTY

47 EMPTY

48 EMPTY

Transducer block 1: totalizers (49-61)

The first table focuses on definitions, default values, and the enumerated list of values
allowed for each parameter (49-61), while Table F-16 provides the Modbus register
column and other relevant values.

Table F-15: Transducer block 1 totalizers -- definitions, defaults, and range of values

Index Parameter

mnemonic

totalizer-specific

parameters

Definition Default
value

Enumerated list
of values /range

49 EMPTY

50 EMPTY

51 EMPTY

52 EMPTY

53 EMPTY

54 SNS_MassTotal

(DD Name :

Mass Total)

Mass Total 0 N/A
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Table F-15: Transducer block 1 totalizers -- definitions, defaults, and range of values
(continued)

Index Parameter

mnemonic

totalizer-specific

parameters

Definition Default
value

Enumerated list
of values /range

55 SSNS_VolTotal

(DD Name :

Volume Total)

Volume Total 0 N/A

56 SNS_MassInventory

(DD Name :

Mass Inventory)

Mass Inventory 0 N/A

57 SNS_VolInventory

(DD Name :

Volume Inventory)

Volume Inventory 0 N/A

58 SNS_MassTotalUnits

(DD Name:

Mass Total/Inv Units)

Standard or special mass total and
mass inventory unit

g/s
0000 = None

1088 = Kg

1089 = g

1092 = metric
tons

1094 = lbs

1095 = short
tons

1096 = long
tons
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Table F-15: Transducer block 1 totalizers -- definitions, defaults, and range of values
(continued)

Index Parameter

mnemonic

totalizer-specific

parameters

Definition Default
value

Enumerated list
of values /range

59 SNS_VolTotalUnits

(DD Name:

Volume Total/Inv
Units)

Standard or special volume total
or mass inventory unit

l/s
0000 = None

1034 = m3

1036 = cm3

1038 = l

1043 = ft3

1048 = gal

1049 = ImpGal

1051 = bbl

1641 = Beer bbl

60 SNS_ResetMassInv

(DD Name:

Reset Mass
Inventory)

Reset Mass Inventory (“On” =
Reset, “Off” = N/A)

- 0X00 = None

0X01 = Reset

61 SNS_ResetVolInv

(DD Name:

Reset

Volume Inventory)

Reset Volume Inventory (“On” =
Reset, “Off” = N/A)

- 0x00 = None

0X01 = Reset

Table F-16: Transducer block 1 totalizers -- size, access, and Modbus register columns

Index Parameter

mnemonic

totalizer-specific

parameters

Message

type

Data type/
structure

Size Store/
rate
(hz)

Access Modbus

register / coil

49 EMPTY

50 EMPTY

51 EMPTY

52 EMPTY

Configuration and Use Manual  Model 2700 PROFIBUS block parameters
20000327 October 2018

Configuration and Use Manual  227



Table F-16: Transducer block 1 totalizers -- size, access, and Modbus register columns
(continued)

Index Parameter

mnemonic

totalizer-specific

parameters

Message

type

Data type/
structure

Size Store/
rate
(hz)

Access Modbus

register / coil

53 EMPTY

54 SNS_MassTotal

(DD Name :

Mass Total)

VARIABLE 101 5 D/20 R R-0259-0260

55 SSNS_VolTotal

(DD Name :

Volume Total)

VARIABLE 101 5 D/20 R R-0261-0262

56 SNS_MassInventory

(DD Name :

Mass Inventory)

VARIABLE 101 5 D/20 R R-263-264

57 SNS_VolInventory

(DD Name :

Volume
Inventory)

VARIABLE 101 5 D/20 R R-0265-0266

58 SNS_MassTotal

Units

(DD Name:

Mass Total/Inv
Units)

ENUM Unsigned16 2 N R R-0045

59 SNS_VolTotalUnits

(DD Name:

Volume Total/Inv
Units)

ENUM Unsigned16 2 N R R-0046
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Table F-16: Transducer block 1 totalizers -- size, access, and Modbus register columns
(continued)

Index Parameter

mnemonic

totalizer-specific

parameters

Message

type

Data type/
structure

Size Store/
rate
(hz)

Access Modbus

register / coil

60 SNS_ResetMassInv

(DD Name:

Reset Mass

Inventory)

METHOD Unsigned8 1 D R/W Coil – 0192

61 SNS_ResetVolInv

(DD Name:

Reset Volume

Inventory)

METHOD Unsigned8 1 D R/W Coil – 0193

Transducer block 1: gas process variables (62-81)

The first table focuses on definitions, default values, and the enumerated list of values
allowed for each parameter (62-81), while Table F-18 provides the Modbus register
column and other relevant values.

Table F-17: Transducer block 1 gas process variables -- definitions, defaults, and
range of values

Index Parameter

mnemonic

gas process

parameters

Definition Default

value

Enumerated list

of values /range

62 SNS_EnableGSV

(DD Name:

Enable Gas

Std Volume

Flow And Total)

Enable/Disable Gas Standard
Volume Flow and Totals

0x00
0x00 = disabled

0x01 = enabled

63 SNS_GSV_GasDens

(DD Name:

Gas Std Density)

Gas Density used to calculate
Reference Volume Gas Flow and
Totals

0.0752
lb/ft3 Density Sensor

limits
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Table F-17: Transducer block 1 gas process variables -- definitions, defaults, and
range of values (continued)

Index Parameter

mnemonic

gas process

parameters

Definition Default

value

Enumerated list

of values /range

64 SNS_GSV_VolFlow

(DD Name:

Gas Std

Volume Flow Rate)

Reference Volume Gas Flow
Rate (not valid when API or ED is
enabled)

0 N/A

65 SNS_GSV_VolTot

(DD Name:

GSV Total)

Reference Volume Gas Total
(not valid when API or ED is
enabled)

0 N/A

66 SNS_GSV_VolInv

(DD Name:

GSV Inventory)

Reference Volume Gas
Inventory (not valid when API or
ED is enabled)

0 N/A

Model 2700 PROFIBUS block parameters Configuration and Use Manual
October 2018 20000327

230  Micro Motion Model 2700 Transmitters with PROFIBUS-PA



Table F-17: Transducer block 1 gas process variables -- definitions, defaults, and
range of values (continued)

Index Parameter

mnemonic

gas process

parameters

Definition Default

value

Enumerated list

of values /range

67 SNS_GSV_FlowUnits Gas Standard Volume Flow
Engineering Units

SCFM
1360 = SCFM

1361 = SCFH

1522 = Nm3/s

1523 = Nm3/m

1524 = Nm3/h

1525 = Nm3/d

1527 = Sm3/s

1528 = Sm3/m

1529 = Sm3/h

1530 = Sm3/d

1532 = NL/s

1533 = NL/m

1534 = NL/h

1535 = NL/d

1537 = SL/s

1538 = SL/m

1539 = SL/h

1540 = SL/d

1604 = SCFS

1605 = SCFD
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Table F-17: Transducer block 1 gas process variables -- definitions, defaults, and
range of values (continued)

Index Parameter

mnemonic

gas process

parameters

Definition Default

value

Enumerated list

of values /range

68 SNS_GSV_TotalUnits

(DD Name:

GSV Total /Inv Units)

Gas Standard Volume Total and
Inventory Engineering Unit

SCF
0000 = None

1053 = SCF

1521 = Nm3

1526 = Sm3

1531 = NL

1536 = SL

69 SNS_GSV_FlowCutoff

(DD Name:

Gas Std Vol
Flow Cutoff)

Gas Standard Volume Low Flow
Cutoff

--- Must be >= 0.0

70 SNS_ResetGSVolTotal

(DD Name:

Reset Gas Std

Volume Total)

Reset Gas Standard Volume
Total (“On” = Reset, “Off” = N/A)

---
0x00 = No Effect

0x01 = Reset

71 SNS_ResetAPIGSVInv

(DD Name:

Reset Gas Std

Volume Inventory)

Reset API/GSV Inventory (“On”
= Reset, “Off” = N/A)

0x00
0x00 = No Effect

0x01 = Reset

72 FRF_StartMeterVer

(DD Name:

Start On-Line

Meter Verification)

Start On-Line Meter Verification 0x00
0x00 = No Effect

0x01 = Start

On-Line Meter

Verification

73 FRF_MV_Index FCF Datalog Index 0x00 (0-19, 0 = most

recent run)

74 FRF_MV_Counter FCF Datalog Item 1: Run
Number

0x00
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Table F-17: Transducer block 1 gas process variables -- definitions, defaults, and
range of values (continued)

Index Parameter

mnemonic

gas process

parameters

Definition Default

value

Enumerated list

of values /range

75 FRF_MV_Status FCF Datalog Item 5: Status
Abort States are compressed to
fit in 3 bits

0x00
Bit7 = FCF pass/
fail

Bits6-4 = state,

Bits3-0 = Abort
code

76 FRF_MV_Time FCF Datalog Item 2: Time
Initiated (in running seconds)

0x00 N/A

77 FRF_MV_LPO_Norm FCF Datalog Item 3: LPO
Normalized Data

0x00 N/A

78 FRF_MV_RPO_Norm FCF Datalog Item 4: RPO
Normalized Data

0x00 N/A

79 FRF_MV_FirstRun_Time MV Timers: Time Until First Run
in Hours

0x00 N/A

80 FRF_MV_Elapse_Time MV Timers: Time between each
run after the first run initiated in
hours

0x00 N/A

81 FRF_MV_Time_Left MV Timers: Time left until next
run in hours

0x00 N/A

Table F-18: Transducer block 1 gas process variables -- size, access, and Modbus
register columns

Index Parameter

mnemonic

gas process

parameters

Message

type

Data type/

structure

Size Store/
rate

(hz)

Access Modbus

register / coil

62 SNS_EnableGSV

(DD Name:

Enable Gas Std

Volume Flow
And Total)

ENUM Unsigned8 1 S R/W coil-0078
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Table F-18: Transducer block 1 gas process variables -- size, access, and Modbus
register columns (continued)

Index Parameter

mnemonic

gas process

parameters

Message

type

Data type/

structure

Size Store/
rate

(hz)

Access Modbus

register / coil

63 SNS_GSV

_GasDens

(DD Name:

Gas Std
Density)

VARIABLE Float 4 N-CP R/W R-0453-0454

64 SNS_GSV

_VolFlow

(DD Name:

Gas Std Volume

Flow Rate)

VARIABLE 101 5 D/20 R R-0455-0456

65 SNS_GSV_VolTot

(DD Name:

GSV Total)

VARIABLE 101 5 D/20 R R-0457-0458

66 SNS_GSV_VolInv

(DD Name:

GSV Inventory)

VARIABLE 101 5 D/20 R R-0459-0460

67 SNS_GSV

_FlowUnits

ENUM Unsigned16 2 S R/W R-2601

68 SNS_GSV

_TotalUnits

ENUM Unsigned16 2 S R R-2602

69 SNS_GSV

_FlowCutoff

VARIABLE Float 4 N-CP R/W R-461-462

70 SNS_Reset

GSVolTotal

(DD Name:

Reset Gas Std

Volume Total)

METHOD Unsigned8 1 D R/W Coil-0063
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Table F-18: Transducer block 1 gas process variables -- size, access, and Modbus
register columns (continued)

Index Parameter

mnemonic

gas process

parameters

Message

type

Data type/

structure

Size Store/
rate

(hz)

Access Modbus

register / coil

71 SNS_ResetAPI

GSVInv

(DD Name:

Reset Gas Std

Volume

Inventory)

METHOD Unsigned8 1 D R/W Coil-0194

72 FRF_Start

MeterVer

(DD Name:

Start On-Line

Meter

Verification)

VARIABLE Unsigned8 1 D R/W Coil – 0190

73 FRF_MV_Index VARIABLE Unsigned16 2 D R/W R-2984

74 FRF_MV_Counter VARIABLE Unsigned16 2 N-CP R R-2985

75 FRF_MV_Status VARIABLE Unsigned16 2 N-CP R R-2986

76 FRF_MV_Time VARIABLE Unsigned32 4 N-CP R R-2987–2988

77 FRF_MV

_LPO_Norm

VARIABLE Float 4 N-CP R R-2989–2990

78 FRF_MV

_RPO_Norm

VARIABLE Float 4 N-CP R R-2991–2992

79 FRF_MV

_FirstRun_Time

VARIABLE Float 4 N-CP R/W R-2993–2994

80 FRF_MV

_Elapse_Time

VARIABLE Float 4 N-CP R/W R-2995–2996

81 FRF_MV

_Time_Left

VARIABLE Float 4 D R R-2997–2998
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Transducer block 1: calibration block variables (82-109)

The first table focuses on definitions, default values, and the enumerated list of values
allowed for each parameter (82-109), while Table F-20 provides the Modbus register
column and other relevant values.

Table F-19: Transducer block 1 calibration block variables -- definitions, defaults, and
range of values

Index Parameter

mnemonic

calibration

block

variables

Definition Default
value

Enumerated list
of values /range

82 SNS_FlowCalTempCoeff

(DD Name: Flow Temp
Coeff (FT))

Temperature coefficient for
flow

5.13
>= 0.0

83 SNS_MaxZeroingTime

(DD Name: Zero Time)

Maximum zeroing time 20 5 to 300

84 SNS_AutoZeroStdDev

(DD Name: Zero Std Dev)

Standard deviation of auto zero -- N/A

85 SNS_AutoZeroValue

(DD Name: Zero Offset)

Present flow signal offset at
zero flow in μsec

-- -5.0 to 5.0

86 SNS_FailedCal

(DD Name:

Zero Failed Value)

Value of the zero if the zero cal
failed

-- N/A

87 SNS_K1Cal

(DD Name:

Low Density Cal)

Perform low-density calibration -
0x00= None

0x01 = Start Cal

88 SNS_K2Cal

(DD Name:

High Density Cal)

Perform high-density
calibration

-
0x00= None

0x01 = Start Cal

89 SNS_FdCal

(DD Name: Flowing
Density Cal)

Perform flowing-density
calibration

-
0x00= None

0x01 = Start Cal
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Table F-19: Transducer block 1 calibration block variables -- definitions, defaults, and
range of values (continued)

Index Parameter

mnemonic

calibration

block

variables

Definition Default
value

Enumerated list
of values /range

90 SNS_Tseries

D3Cal

(DD Name: D3 Density
Cal)

Perform third point calibration -
0x00= None

0x01 = Start Cal

91 NS_Tseries

D4Cal

(DD Name: D4 Density
Cal)

Perform fourth point
calibration

-
0x00= None

0x01 = Start Cal

92 SNS_K1

(DD Name: K1)

Density calibration constant 1
(μsec)

1000.0
1000 to 50000

93 SNS_K2

(DD Name: K2)

Density calibration constant 2
(μsec)

50000.0
1000 to 50000

94 SNS_FD

(DD Name: FD)

Flowing Density calibration
constant

- >= 0.0

95 SNS_TseriesK3

(DD Name: K3)

Density calibration constant 3
(μsec)

-
0, or 1000 to
50000

96 SNS_TseriesK4

(DD Name: K4)

Density calibration constant 4
(μsec)

-
0, or 1000 to
50000

97 SNS_D1

(DD Name: D1)

Density 1 (g/cc) - Density Limits
(and < 0.05 if T-
series)

98 SNS_D2

(DD Name: D2)

Density 2 (g/cc) 1.0 Density Limits,
and must be 1.0
+/-0.1 for T-series

99 SNS_CalValForFD

(DD Name: FD Value)

Flowing Density (g/cc) - >= 0

100 SNS_TSeriesD3

(DD Name: D3)

Density 3 (g/cc) - Density Limits,
and must be at
least +/- 0.1 away
from D2 and d3 >
0.6 g/cc
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Table F-19: Transducer block 1 calibration block variables -- definitions, defaults, and
range of values (continued)

Index Parameter

mnemonic

calibration

block

variables

Definition Default
value

Enumerated list
of values /range

101 SNS_TSeriesD4

(DD Name: D4)

Density 4 (g/cc) - Density Limits,
and must be at
least +/-0.1 away
from D2 and D3
And d3 < > 0 and
d4 > 0.6 g/cc

102 SNS_DensityTempCoeff

(DD Name:

Density Temp Coeff
(DT))

Density temperature
coefficient

4.44 -20.0 to 20.0

103 SNS_TSeriesFlowTGCO

(DD Name: FTG)

T-Series: Flow TG Coefficient
(FTG)

0.0 N/A

104 SNS_TSeriesFlowFQCO

(DD Name: FFQ)

T-Series : Flow FQ Coefficient
(FFQ)

0.0 N/A

105 SNS_TSeriesDensTGCO

(DD Name: DTG)

T-Series: Density TG Coefficient
(DTG)

0.0 N/A

106 SNS_TSeriesDensFQCO1

(DD Name: DFQ1)

T-Series: Density FQ Coefficient
#1 (DFQ1)

0.0 N/A

107 SNS_TSeriesDensFQCO2

(DD Name: DFQ2)

T-Series: Density FQ Coefficient
#2 (DFQ2)

0.0 N/A

108 SNS_TempCalOffset

(DD Name: Temperature
Offset)

Temperature calibration offset 0.0 N/A

109 SNS_TempCalSlope

(DD Name:

Temperature Slope)

Temperature calibration slope 1.0 N/A
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Table F-20: Transducer block 1 calibration block variables -- size, access, and Modbus
register columns

Index Parameter

mnemonic

calibration

block

variables

Message

type

Data type/

structure

Size Store

/rate

(hz)

Access Modbus

register

/ coil

82 SNS_FlowCal

TempCoeff

(DD Name: Flow
Temp Coeff (FT))

VARIABLE Float 4 N-CP R/W R-409-410

83 SNS_Max

ZeroingTime

(DD Name: Zero
Time)

VARIABLE Unsigned16 2 N-CP R/W R-0136

84 SNS_Auto

ZeroStdDev

(DD Name: Zero
Std Dev)

VARIABLE Float 4 D R R-0231-232

85 SNS_Auto

ZeroValue

(DD Name:

Zero Offset)

VARIABLE Float 4 N-CP R/W R-233-234

86 SNS_FailedCal

(DD Name: Zero
Failed Value)

VARIABLE Float 4 S R R-0235-236

87 SNS_K1Cal

(DD Name:

Low Density Cal)

METHOD Unsigned8 1 D R/W Coil-0013

88 SNS_K2Cal

(DD Name:

High Density Cal)

METHOD Unsigned8 1 D R/W Coil-0014

89 SNS_FdCal

(DD Name:

Flowing Density
Cal)

METHOD Unsigned8 1 D R/W Coil-0018
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Table F-20: Transducer block 1 calibration block variables -- size, access, and Modbus
register columns (continued)

Index Parameter

mnemonic

calibration

block

variables

Message

type

Data type/

structure

Size Store

/rate

(hz)

Access Modbus

register

/ coil

90 SNS_Tseries

D3Cal

(DD Name:

D3 Density Cal)

METHOD Unsigned8 1 D R/W Coil-0044

91 SNS_Tseries

D4Cal

(DD Name:

D4 Density Cal)

METHOD Unsigned8 1 D R/W Coil-0045

92 SNS_K1

(DD Name: K1)

VARIABLE Float 1 N-CP R/W R-159-160

93 SNS_K2

(DD Name: K2)

VARIABLE Float 2 N-CP R/W R-161-162

94 SNS_FD

(DD Name: FD)

VARIABLE Float 2 N-CP R/W R303-304

95 NS_TseriesK3

(DD Name: K3

VARIABLE Float 2 N-CP R/W R-0503

96 SNS_TseriesK4

(DD Name: K4)

VARIABLE Float 4 N-CP R/W R-0519

97 SNS_D1

(DD Name: D1)

VARIABLE Float 4 N-CP R/W R-0155-0156

98 SNS_D2

(DD Name: D2)

VARIABLE Float 4 N-CP R/W R-0157-0158

99 SNS_CalValForFD

(DD Name:

FD Value)

VARIABLE Float 4 D R/W R277-278

100 SNS_TSeriesD3

(DD Name: D3)

VARIABLE Float 4 N-CP R/W R-509
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Table F-20: Transducer block 1 calibration block variables -- size, access, and Modbus
register columns (continued)

Index Parameter

mnemonic

calibration

block

variables

Message

type

Data type/

structure

Size Store

/rate

(hz)

Access Modbus

register

/ coil

101 SNS_TSeriesD4

(DD Name: D4)

VARIABLE Float 4 N-CP R/W R-511

102 SNS_DensityTem
pCoeff

(DD Name:

Density Temp

Coeff (DT))

VARIABLE Float 4 N-CP R/W R-0163-164

103 SNS_TSeriesFlow
TGCO

(DD Name: FTG)

VARIABLE Float 4 N-CP R/W R-505

104 SNS_TSeriesFlow
FQCO

(DD Name: FFQ)

VARIABLE Float 4 N-CP R/W R-507

105 SNS_TSeriesDens
TGCO

(DD Name: DTG)

VARIABLE Float 4 N-CP R/W R-513

106 SNS_TSeriesDens
FQCO1

(DD Name:
DFQ1)

VARIABLE Float 4 N-CP R/W R-515

107 SNS_TSeriesDens
FQCO2

(DD Name:
DFQ2)

VARIABLE Float 4 N-CP R/W R-517

108 SNS_Temp

CalOffset

(DD Name:

Temperature

Offset)

VARIABLE Float 4 N-CP R/W R-0413-0414
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Table F-20: Transducer block 1 calibration block variables -- size, access, and Modbus
register columns (continued)

Index Parameter

mnemonic

calibration

block

variables

Message

type

Data type/

structure

Size Store

/rate

(hz)

Access Modbus

register

/ coil

109 SNS_Temp

CalSlope

(DD Name:

Temperature

Slope)

VARIABLE Float 4 N-CP R/W R-0411-0412

Transducer block 1: temperature compensation values (110-111)

The first table focuses on definitions, default values, and the enumerated list of values
allowed for each parameter (110-111), while Table F-22 provides the Modbus register
column and other relevant values.

Table F-21: Transducer block 1 temperature compensation variables -- definitions,
defaults, and range of values

Index Parameter

mnemonic

temperature

compensation

variables

Definition Default
value

Enumerated list
of values /range

110 SNS_Enable

ExtTemp

(DD Name:

Enable Disable

Ext Temp)

Enable/Disable External Temp for
API/ED (See 449/450)

0x00
0x00 = Disable

0x01 = Enable
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Table F-21: Transducer block 1 temperature compensation variables -- definitions,
defaults, and range of values (continued)

Index Parameter

mnemonic

temperature

compensation

variables

Definition Default
value

Enumerated list
of values /range

111 SNS_External

TempInput

(The data base item is

the same as

TEMPERATURE –

index 29 parameter)

(DD Name:

External Temp

calibration input)

External temperature calibration
input

--- Temp. sensor
limits

Table F-22: Transducer block 1 temperature compensation variables -- size, access,
and Modbus register columns

Index Parameter

mnemonic

temperature

compensation

variables

Msg
type

Data type/
structure

Size Store/
rate

(hz)

Access Modbus

register / coil

110 SNS_Enable

ExtTemp

(DD Name:

Enable Disable

Ext Temp)

METHOD Unsigned8 1 D R/W Coil-0086
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Table F-22: Transducer block 1 temperature compensation variables -- size, access,
and Modbus register columns (continued)

Index Parameter

mnemonic

temperature

compensation

variables

Msg
type

Data type/
structure

Size Store/
rate

(hz)

Access Modbus

register / coil

111 SNS_External

TempInput

(The data base

item is the same as

TEMPERATURE –

index 29

parameter)

(DD Name:

External Temp

calibration input)

RECORD 101 5 D R/W R-0449-0450

Transducer block 1: pressure compensation values (112-129)

The first table focuses on definitions, default values, and the enumerated list of values
allowed for each parameter (112-129), while Table F-24 provides the Modbus register
column and other relevant values.

Table F-23: Transducer block 1 pressure compensation variables -- definitions,
defaults, and range of values

Index Parameter

mnemonic

pressure

compensation

variables

Definition Default value Enumerated list

of values /range

112 SNS_Enable

PresComp

(DD Name:

Pressure

Compensation

Enable /Disable)

Enable/Disable Pressure
Compensation

0
0x00 = Disable

0x01 = Enable
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Table F-23: Transducer block 1 pressure compensation variables -- definitions,
defaults, and range of values (continued)

Index Parameter

mnemonic

pressure

compensation

variables

Definition Default value Enumerated list

of values /range

113 SNS_External

PresInput

(DD Name :

External Pressure

calibration input)

Pressure --- 0 to 10,000 bar

114 SNS_Pressure

(The data base item

is same as
SNS_ExternalPres

Inputparameter)

(DD Name :

External Read

Pressure)

Pressure ----
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Table F-23: Transducer block 1 pressure compensation variables -- definitions,
defaults, and range of values (continued)

Index Parameter

mnemonic

pressure

compensation

variables

Definition Default value Enumerated list

of values /range

115 SNS_PressureUnits

(DD Name :

Pressure Units)

Pressure Unit g/cm3
0000 = None

1148 = inch
water @ 68F

1146 = inch
water

@ 60F

1156 = inch HG

@ 0C

1154 = ft water

@ 68F

1151 = mm
water @ 68F

1158 = mm HG

@ 0C

1141 = psi

1137 = bar

1138 = millibar

1144 = g/cm2

1145 = kg/cm2

1130 = pascals

1133 = kilo
pascals

1139 = torr @ 0C

1140

= atmospheres

1147 =
InH2O(4C)
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Table F-23: Transducer block 1 pressure compensation variables -- definitions,
defaults, and range of values (continued)

Index Parameter

mnemonic

pressure

compensation

variables

Definition Default value Enumerated list

of values /range

1150

= mmH2O(4C)

1132 = MPA

116 SNS_FlowPresComp

(DD Name:

Flow Factor)

Pressure correction factor
for flow

0.0 -0.1 to 0.1

117 SNS_DensPresComp

(DD Name:

Density factor

Pressure correction factor
for density

0.0 -0.1 to 0.1

118 SNS_FlowCalPres

(DD Name:

Cal Pressure)

Flow calibration pressure 0.0 >= 0.0

119 SNS_FlowZero

RestoreFactory

(DD Name: Restore
Factory Zero)

Restore Factory Zero 0x00 = None

0x01 = Restore

120 DB_SNS_Auto

ZeroFactory

Factory flow signal offset
at zero flow (units of uSec)

--- N/A

121 AO_BLK_COMP

(DD: Name:

AO Compensation)

The Pressure / Temp.
compensation selector
parameter that decides
the Temp. / Pressure
compensation to be done
using AO block or using
Modbus or Transducer
Block.

---
0 – Temp /

Pressure

Compensation

through
Modbus /
Transducer Block

1 – Temp /

Pressure through

AO Block
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Table F-23: Transducer block 1 pressure compensation variables -- definitions,
defaults, and range of values (continued)

Index Parameter

mnemonic

pressure

compensation

variables

Definition Default value Enumerated list

of values /range

122 SNS_MflowBaseUnit Base mass unit for special
mass unit

Unit_gm = 60
UNIT_gm = 60

UNIT_kg = 61

UNIT_MetTon =
62

UNIT_lb = 63

UNIT_ShTon = 64

UNIT_LTon = 65

123 SNS_MflowBaseTime Base time unit for special
mass unit

Unit_sec = 51
UNIT_min = 50

UNIT_sec = 51

UNIT_hr = 52

UNIT_day = 53

124 SNS_VflowBaseUnit Base volume unit for
special volume unit

Unit_liter = 41
UNIT_gal = 40

UNIT_liter = 41

UNIT_ImpGal =
42

UNIT_CuMtr = 43

UNIT_bbl = 46

UNIT_CuFt = 112

UNIT_beer_bbl

= 170

125 SNS_VflowBaseTime Base time unit for special
volume unit

Unit_sec = 51
UNIT_min = 50

UNIT_sec = 51

UNIT_hr = 52

UNIT_day = 53
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Table F-23: Transducer block 1 pressure compensation variables -- definitions,
defaults, and range of values (continued)

Index Parameter

mnemonic

pressure

compensation

variables

Definition Default value Enumerated list

of values /range

126 SNS_GSVflow

BaseUnit

Base gas standard volume
unit

UNIT_Std

CuFt = 168
UNIT_StdLiter

= 171

UNIT_NormLiter

= 167

UNIT_StdCuMtr

= 172

UNIT_NormCuMt
r

= 166

UNIT_StdCuFt

= 168

127 SNS_GSVflow

BaseTime

Base time unit for special
gas standard volume unit

Unit_sec = 51
UNIT_min = 50

UNIT_sec = 51

UNIT_hr = 52

UNIT_day = 53

128 SYS_MasterReset Master reset false 0x00 = None

0x01 = Master

reset

129 EMPTY
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Table F-24: Transducer block 1 pressure compensation variables -- size, access, and
Modbus register columns

Index Parameter

mnemonic

pressure

compensation

variables

Data Type

/Structure

Size Store/

rate

(hz)

Msg type Access Modbus

register

/ coil

112 SNS_Enable

PresComp

(DD Name:

Pressure

Compensation

Enable /Disable)

Unsigned8 1 D ENUM R/W Coil-0082

113 SNS_External

PresInput

(DD Name :

External Pressure

calibration input)

101 5 D RECORD R/W R-0451-452

114 SNS_Pressure

(The data base item
is the same as

SNS_ExternalPres

Inputparameter)

(DD Name :

External Read

Pressure)

101 5 D RECORD R R-0451-452

115 SNS_PressureUnits

(DD Name :

Pressure Units)

Unsigned16 2 S ENUM R/W R-0044

116 SNS_FlowPresComp

(DD Name:

Flow Factor)

Float 4 N-CP VARIABLE R/W R-267-268
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Table F-24: Transducer block 1 pressure compensation variables -- size, access, and
Modbus register columns (continued)

Index Parameter

mnemonic

pressure

compensation

variables

Data Type

/Structure

Size Store/

rate

(hz)

Msg type Access Modbus

register

/ coil

117 SNS_DensPresComp

(DD Name:

Density factor

Float 4 N-CP VARIABLE R/W R-269-270

118 SNS_FlowCalPres

(DD Name:

Cal Pressure)

Float 4 N-CP VARIABLE R/W R-271-272

119 SNS_FlowZero

RestoreFactory

(DD Name:

Restore Factory
Zero)

Unsigned8 1 D METHOD R/W Coil-0243

120 DB_SNS_Auto

ZeroFactory

Float 4 N VARIABLE R R-2673

121 AO_BLK_COMP

(DD: Name:

AO Compensation)

U8 1 D VARIABLE R/W R-2276

122 SNS_MflowBaseUnit Unsigned8 1 N ENUM R/W R-132

123 SNS_MflowBaseTime Unsigned8 1 N ENUM R/W R-133

124 SNS_VflowBaseUnit Unsigned8 1 N ENUM R/W R-134

125 SNS_VflowBaseTime Unsigned8 1 N ENUM R/W R-135

126 SNS_GSVflow

BaseUnit

Unsigned8 1 N ENUM R/W R2603

127 SNS_GSVflow

BaseTime

Unsigned8 1 N ENUM R/W R-2604

128 SYS_MasterReset Unsigned8 1 D METHOD R/W Coil- 42

129 EMPTY
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F.2.3 Transducer block 1: diagnostic block
The following tables show the parameters for transducer block 1, the diagnostic block.

Diagnostic block slug flow parameters (130-132)

The first table focuses on definitions, default values, and the enumerated list of values
allowed for each parameter, while Table F-26 provides the Modbus register column and
other relevant values.

Table F-25: Diagnostic block slug flow setup parameters -- definitions, defaults, and
range of values

Index Parameter

mnemonic

slug flow setup

parameters

Definition Default
value

Enumerated list
of values /range

130 SNS_SlugDuration

(DD Name:

Slug Duration)

Slug duration (seconds) 1.0 0 to 60

131 SNS_SlugLo

(DD Name :

Slug Low Limit)

Low Density limit (g/cc). 0.0 Density limits

132 SNS_SlugHi

(DD Name :

Slug High Limit)

High Density limit (g/cc) 5.0 Density limits

Table F-26: Diagnostic block slug flow setup parameters -- size, access, and Modbus
register columns

Index Parameter

mnemonic

slug flow setup

parameters

Message

type

Data
type/
structure

Size Store/
rate
(hz)

Access Modbus

register / coil

130 SNS_SlugDuration

(DD Name:

Slug Duration)

VARIABLE Float 4 N-CP R/W R-0141-142
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Table F-26: Diagnostic block slug flow setup parameters -- size, access, and Modbus
register columns (continued)

Index Parameter

mnemonic

slug flow setup

parameters

Message

type

Data
type/
structure

Size Store/
rate
(hz)

Access Modbus

register / coil

131 SNS_SlugLo

(DD Name :

Slug Low Limit)

VARIABLE Float 4 N-CP R/W R-201-202

132 SNS_SlugHi

(DD Name :

Slug High Limit)

VARIABLE Float 4 N-CP R/W R-199-200

Diagnostic block discrete event variables (133-138)

The first table focuses on definitions, default values, and the enumerated list of values
allowed for each parameter, while Table F-28 provides the Modbus register column and
other relevant values.

Table F-27: Diagnostic block discrete event variables -- definitions, defaults, and
range of values

Index Parameter

mnemonic

discrete event

variables

Definition Default
value

Enumerated list
of values /range

133 DB_SNS_

MflowFactor

Special mass unit conversion factor 1.0 R/W

134 DB_SNS

_VflowFactor

Special volume unit conversion factor 1.0 R/W

135 DB_SNS_GSV

flowFactor

Special gas standard volume unit
conversion factor

1.0 R/W

136 EMPTY

137 EMPTY

138 EMPTY
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Table F-28: Diagnostic block discrete event variables -- size, access, and Modbus
register columns

Index Parameter

mnemonic

discrete event

variables

Message

type

Data type/
structure

Size Store/
rate
(hz)

Access Modbus

register / coil

133 DB_SNS

_MflowFactor

VARIABLE Float 4 N R/W R-237-238

134 DB_SNS

_VflowFactor

VARIABLE Float 4 N R/W R-239-240

135 DB_SNS

_GSVflowFactor

VARIABLE Float 4 N R/W R-2605-2606

136 EMPTY

137 EMPTY

138 EMPTY

Diagnostic block alarm status variables (139-159)

The first table focuses on definitions, default values, and the enumerated list of values
allowed for each parameter, while Table F-30 provides the Modbus register column and
other relevant values.

Model 2700 PROFIBUS block parameters Configuration and Use Manual
October 2018 20000327

254  Micro Motion Model 2700 Transmitters with PROFIBUS-PA



Table F-29: Diagnostic block alarm status variables -- definitions, defaults, and range
of values

Index Parameter

mnemonic

alarm status

variables

Definition Default
value

Enumerated list of values /
range

139 PA_StatusWords1

(DD Name:

Alarm One
Status)

Status Word 1 -
0x0001 = Core EEPROM

Checksum Error

0x0002 = Core RAM

Test Error

0x0004 = Not Used

0x0008 = Sensor Failure

0x0010 = Temp OOR

0x0020 = Cal Failed

0x0040 = Other Failure

0x0080 = Xmitter Init

0x0100 = Not Used

0x0200 = Not Used

0x0400 = Simulation Mode

Active (A132)

0x0800 = Not Used

0x1000 = Not Used

0x2000 = Not Used

0x4000 = Not Used

0x8000 = Fault
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Table F-29: Diagnostic block alarm status variables -- definitions, defaults, and range
of values (continued)

Index Parameter

mnemonic

alarm status

variables

Definition Default
value

Enumerated list of values /
range

140 PA_StatusWords2

(DD Name:

Alarm Two
Status)

Status Word 2 -
0x0001 = Not Used

0x0002 = Not Used

0x0004 = Not Used

0x0008 = Not Used

0x0010 = Density OOR

0x0020 = Drive OOR

0x0040 = Not used

0x0080 = Not Used

0x0100 = NV err (CP)

0x0200 = RAM err (CP)

0x0400 = Sensor Failure

0x0800 = Temp OOR

0x1000 = Input OOR

0x2000 = Not Used

0x4000 = Xmitter not Char

0x8000 = Not Used
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Table F-29: Diagnostic block alarm status variables -- definitions, defaults, and range
of values (continued)

Index Parameter

mnemonic

alarm status

variables

Definition Default
value

Enumerated list of values /
range

141 PA_StatusWords3

(DD Name:

Alarm Three

Status)

Status Word 3 -
0x0001 = Simulation
Enabled

0x0002 = Power Reset

0x0004 = Xmitter Init

0x0008 = Sensor/Xmtr

Write Failure omm (A28)

0x0010 = Not Used

0x0020 = Not Used

0x0040 = Not Used

0x0080 = Sensor/Xmtr

Communication Failure
(A26)

0x0100 = Cal Failed

0x0200 = Cal Fail: Low

0x0400 = Cal Fail: High

0x0800 = Cal Fail: Noisy

0x1000 = Xmtr Failed

0x2000 = Data Loss
Possible

0x4000 = Cal in Progress

0x8000 = Slug Flow
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Table F-29: Diagnostic block alarm status variables -- definitions, defaults, and range
of values (continued)

Index Parameter

mnemonic

alarm status

variables

Definition Default
value

Enumerated list of values /
range

142 PA_StatusWords4

(DD Name:

Alarm Four

Status)

Status Word 4 -
0x0001 = API: Temp OOR

0x0002 = API: Dens OOR

0x0004 = Line RTD OOR

0x0008 = Meter RTD OOR

0x0010= Reverse Flow

0x0020 = Factory Config.

Data Invalid

0x0040 = ED: bad curve

0x0080 = LMV Override
Active

0x0100 = ED: Extrap error

0x0200 = Need cal factor

0x0400 = EEPROM
Checksum Error

0x0800 = RAM Test Error

0x1000= Xmitter not Char

0x2000 = Core
configuration

database corrupt (CP)

0x4000 = Core powerdown

totals corrupt

0x8000 = Core program

corrupt
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Table F-29: Diagnostic block alarm status variables -- definitions, defaults, and range
of values (continued)

Index Parameter

mnemonic

alarm status

variables

Definition Default
value

Enumerated list of values /
range

143 PA_StatusWords5

(DD Name:

Alarm Five
Status)

Status Word 5 -
0x0001 = Core Protected

Boot Sector Fault

0x0002 = Not Used

0x0004 = Not Used

0x0008 = Not Used

0x0010 = Not Used

0x0020 = Not Used

0x0040 = D3 in progress

0x0080 = D4 in progress

0x0100 = Not Used

0x0200 = Not Used

0x0400 = Temp slope

in progress

0x0800 = Temp offset

in progress

0x1000 = FD in progress

0x2000 = D2 in progress

0x4000 = D1 in progress

0x8000 = Zero in progress
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Table F-29: Diagnostic block alarm status variables -- definitions, defaults, and range
of values (continued)

Index Parameter

mnemonic

alarm status

variables

Definition Default
value

Enumerated list of values /
range

144 PA_StatusWords6

(DD Name:

Alarm Six
Status)

Status Word 6 -
0x0001 = Not Used

0x0002 = Not Used

0x0004 = Not Used

0x0008 = Not Used

0x0010 = Not Used

0x0020 = Not Used

0x0040 = Not Used

0x0080 = Not Used

0x0100 = Not Used

0x0200 = Not Used

0x0400 = Not Used

0x0800 = Not Used

0x1000 = Not Used

0x2000 = Not Used

0x4000 = Not Used

0x8000 = Incorrect Board

Type (A30)
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Table F-29: Diagnostic block alarm status variables -- definitions, defaults, and range
of values (continued)

Index Parameter

mnemonic

alarm status

variables

Definition Default
value

Enumerated list of values /
range

145 PA_StatusWords7

(DD Name:

Alarm Seven

Status)

Status Word 7 -
0x0001 = K1/FCF
combination
Unrecognized.

0x0002 = Warming Up

0x0004 = Low Power (A31)

0x0008 = Tube Not Full
(A33)

0x0010 = Meter
Verification / Outputs in
fault (A32)

0x0020 = Meter
Verification / Outputs at
last value (A131)

0x0040 = Not Used

0x0080 = NVM Initialized
(transmitter)

x0100 = Not Used

0x0200 = Not Used

0x0400 = Not Used

0x0800 = Not Used

0x1000 = Not Used

0x2000 = Not Used

0x4000 = Not Used

0x8000 = Meter Verification

aborted (A35)
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Table F-29: Diagnostic block alarm status variables -- definitions, defaults, and range
of values (continued)

Index Parameter

mnemonic

alarm status

variables

Definition Default
value

Enumerated list of values /
range

146 PA_StatusWords8

(DD Name:

Alarm Eight

Status)

Status Word 8 -
0x0001 = Not used

0x0002 = Not Used

0x0004 = Not Used

0x0008 = Not Used

0x0010 = Not Used

0x0020 = Not Used

0x0040 = Not Used

0x0080 = Not Used

0x0100 = Not Used

0x0200 = Not Used

0x0400 = Not Used

0x0800 = Not Used

0x1000 = Not Used

0x2000 = Not Used

0x4000 = Not Used

0x8000 = Not Used

147 SYS_DigComm

FaultAction

Code

(DD Name

Digital Comm

Fault Action

Fault Limit Code 0
0 = Upscale

1 = Downscale

2 = Zero

3 = NAN

4 = Flow goes to zero

5 = None
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Table F-29: Diagnostic block alarm status variables -- definitions, defaults, and range
of values (continued)

Index Parameter

mnemonic

alarm status

variables

Definition Default
value

Enumerated list of values /
range

148 DB_SYS_Timeout

ValueLMV

(DD Name :

Last Measured

Value Timeout)

Last Measure Value Fault
Timeout

0
0 to 60
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Table F-29: Diagnostic block alarm status variables -- definitions, defaults, and range
of values (continued)

Index Parameter

mnemonic

alarm status

variables

Definition Default
value

Enumerated list of values /
range

149 UNI_Alarm_Index

(DD Name:

Alarm N Index)

Alarm Index 0
0 = Reserved1 = NVM
Failure

2 = RAM error /ROM error

3 = Sensor Fail

4 = Temp. Overrange

5 = Input Overrange

6 = Transmitter not

characterized

7 = Reserved

8 = Dens. Overrange

9 = Xmitter Init

10= Cal Failed

11= Cal Fail: Low

12= Cal Fail: High

13= Cal Fail: Noisy

14= Transmitter Fail

15= Reserved

16= Line RTD Over Range

17= Meter RTD Over Range

18= EEPROM Error

(Transmitter)

19= RAM Error
(Transmitter)

20= Uncofig – K1

21 = Unrecognized /

Unentered sensor type
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Index Parameter

mnemonic

alarm status

variables

Definition Default
value

Enumerated list of values /
range

22 = NV Err (CP)

23= NV Err (CP)

24= NV Err (CP)

25= Boot Fail (CP)

26= Sensor/Xmtr

Communication

Failure (A26)

27= Security Breach

28= Sensor/Xmtr Write

Failure (A28)

29= Internal
Communication Failure

30= Hardware / Software

Incompatible

31 = Low power

32 = Meter Verification
Fault Alarm

33 = Tube not full

34-41 = Undefined

42= Drive Overrange

43 = Data Loss Possible

44= Cal in Progress

45= Slug Flow

46= Undefined

47= Power Reset4

48-55= Reserved

56= API: Temp OOL

57= API:Density OOL
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Table F-29: Diagnostic block alarm status variables -- definitions, defaults, and range
of values (continued)

Index Parameter

mnemonic

alarm status

variables

Definition Default
value

Enumerated list of values /
range

58-59= Reserved

60= ED: Unable to fit

curve data

61= ED: Extrapolation alarm

62-70= Reserved

71 = Meter Verification Info
Alarm

72 = Simulation Mode.

73- 139 = Undefined

150 SYS_Alarm

Severity

(DD Name :

Alarm Severity)

Alarm Severity 0
0 = Ignore

1 = Info

2 = Fault

151 SYS_AlarmStatus

(DD Name :

Alarm Status)

Alarm Status (write 0 to
acknowledge alarm)

bit #0 = active (0=no,
1=yes)

bit #1 =
unacknowledged
(0=no, 1=yes)

--
Between 0 to 3

152 SYS_AlarmCount

(DD Name :

Alarm N Count)

Alarm n count(inactive to
active transition)

----
N/A

153 SYS_AlarmPosted

(DD Name :

Alarm N

Last Posted)

Alarm Last Posted
(seconds since January 1,
1996)

----
N/A
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Table F-29: Diagnostic block alarm status variables -- definitions, defaults, and range
of values (continued)

Index Parameter

mnemonic

alarm status

variables

Definition Default
value

Enumerated list of values /
range

154 SYS_Alarm

Cleared

(DD Name :

Alarm N

Last Cleared)

Alarm Last cleared
(seconds since January 1,
1996)

----
N/A

155 SYS_AckAlarm

(DD Name :

Acknowledge)

Acknowledge alarm

(write alarm index to
acknowledge the alarm)

1=A1,…, 39=A39,
40=A100, …, 70=A130)

----
Enum list is same as Alarm
Index – R1237

156 SYS_AckAllAlarms

(DD Name :

Acknowledge
All)

Acknowledge All Alarms ----
0x00 = Not used

0x01 = Acknowledge

157 SYS_Clear

AlarmHistory

(DD Name:

Reset

Alarm History)

Reset Alarm History (“On”
= reset, “Off” = N/A)

----
0x00 = Not used

0x01 = Reset

158 EMPTY

159 EMPTY
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Table F-30: Diagnostic block alarm status variables -- size, access, and Modbus
register columns

Index Parameter

mnemonic

alarm status

variables

Message

type

Data type/
structure

Size Store/
rate

(hz)

Access Modbus

register /
coil

139 PA_StatusWords1

(DD Name:

Alarm One
Status)

ENUM BIT

_ENUMERAT
ED

2 D/20 R R-419

140 PA_StatusWords2

(DD Name:

Alarm Two
Status)

ENUM BIT

_ENUMERAT
ED

2 D/20 R R-420

141 PA_StatusWords3

(DD Name:

Alarm Three

Status)

ENUM BIT

_ENUMERAT
ED

2 D/20 R R-421

142 PA_StatusWords4

(DD Name:

Alarm Four
Status)

ENUM BIT

_ENUMERAT
ED

2 D/20 R R-422

143 PA_StatusWords5

(DD Name:

Alarm Five
Status)

ENUM BIT

_ENUMERAT
ED

2 D/20 R R-423

144 PA_StatusWords6

(DD Name:

Alarm Six Status)

ENUM BIT

_ENUMERAT
ED

2 D/20 R R-424

145 PA_StatusWords7

(DD Name:

Alarm Seven
Status)

ENUM BIT

_ENUMERAT
ED

2 D/20 R R-433
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Table F-30: Diagnostic block alarm status variables -- size, access, and Modbus
register columns (continued)

Index Parameter

mnemonic

alarm status

variables

Message

type

Data type/
structure

Size Store/
rate

(hz)

Access Modbus

register /
coil

146 PA_StatusWords8

(DD Name:

Alarm Eight
Status)

ENUM BIT

_ENUMERAT
ED

2 D/20 R R-434

147 SYS_DigComm

FaultActionCode

(DD Name

Digital Comm

Fault Action)

ENUM Unsigned16 2 S R/W R-124

148 DB_SYS_

TimeoutValueLMV

(DD Name :

Last Measured

Value Timeout)

VARIABLE Unsigned16 2 N-CP R/W R-314

149 UNI_Alarm_Index

(DD Name:

Alarm N Index)

ENUM Unsigned8 1 D R/W R-1237

150 SYS_Alarm

Severity

(DD Name :

Alarm Severity)

ENUM Unsigned8 1 S R/W R-1238

151 SYS_AlarmStatus

(DD Name :

Alarm Status)

Unsigned
8

BIT

_ENUMERAT
ED

1 D20 R/W R-1239
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Table F-30: Diagnostic block alarm status variables -- size, access, and Modbus
register columns (continued)

Index Parameter

mnemonic

alarm status

variables

Message

type

Data type/
structure

Size Store/
rate

(hz)

Access Modbus

register /
coil

152 SYS_AlarmCount

(DD Name :

Alarm N Count)

VARIABLE Unsigned16 2 N R R-1240

153 SYS_AlarmPosted

(DD Name :

Alarm N

Last Posted)

VARIABLE Unsigned32 4 N R R1241-1242

154 SYS_Alarm

Cleared

(DD Name :

Alarm N

Last Cleared)

VARIABLE Unsigned32 4 N R R1243-1244

155 SYS_AckAlarm

(DD Name :

Acknowledge)

VARIABLE Unsigned16 2 D R/W R-2623

156 SYS_AckAllAlarms

(DD Name :

Acknowledge
All)

METHOD Unsigned8 1 D R/W Coil-0241

157 SYS_Clear

AlarmHistory

(DD Name:

Reset

Alarm History)

METHOD Unsigned8 1 D R/W Coil-0053

158 EMPTY

159 EMPTY
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Diagnostic block diagnostic variables (160-219)

The first table focuses on definitions, default values, and the enumerated list of values
allowed for each parameter, while Table F-32 provides the Modbus register column and
other relevant values.

Table F-31: Diagnostic block diagnostic variables -- definitions, defaults, and range of
values

Index Parameter

mnemonic

diagnostic

variables

Definition Default
value

Enumerated list of
values /range

160 SNS_DriveGain

(DD Name: Drive Gain)

Drive Gain ----

161 SNS_RawTubeFreq

(DD Name:

Tube Frequency)

Raw Tube Period 0 N/A

162 SNS_LiveZeroFlow

(DD Name :

Live Zero Flow)

Live Zero (Mass Flow) 0 N/A

163 SNS_LPOamplitude

(DD Name :

LPO Amplitude)

Left Pickoff Voltage 0 N/A

164 SNS_RPOamplitude

(DD Name :

RPO Amplitude)

Right Pickoff Voltage 0 N/A

165 SNS_BoardTemp

(DD Name :

Board Temperature)

Board Temperature (degC) 0 N/A

166 SNS_MaxBoardTemp

(DD Name:

Maximum electronic

temperature)

Maximum electronics
temperature

0 N/A
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Table F-31: Diagnostic block diagnostic variables -- definitions, defaults, and range of
values (continued)

Index Parameter

mnemonic

diagnostic

variables

Definition Default
value

Enumerated list of
values /range

167 SNS_MinBoardTemp

(DD Name:

Minimum electronic

temperature)

Minimum electronics
temperature

0 N/A

168 SNS_AveBoardTemp

(DD Name:

Average

board temperature)

Average electronics
temperature

0 N/A

169 SNS_MaxSensorTemp

(DD Name:

Maximum

Sensor temperature)

Maximum sensor
temperature

0 N/A

170 SNS_MinSensorTemp

(DD Name:

Minimum

Sensor temperature)

Minimum sensor
temperature

0 N/A

171 SNS_AveSensorTemp

(DD Name:

Average

Sensor temperature)

Average sensor
temperature

0 N/A

172 SNS_WireRTDRes

(DD Name:

9 wire cable RTD)

9-wire cable RTD
Resistance (ohms)

0 N/A
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Table F-31: Diagnostic block diagnostic variables -- definitions, defaults, and range of
values (continued)

Index Parameter

mnemonic

diagnostic

variables

Definition Default
value

Enumerated list of
values /range

173 SNS_LineRTDRes

(DD Name:

Meter RTD

Resistance)

Meter RTD Resistance
(ohms)

0 N/A

174 SYS_PowerCycleCount

(DD Name:

Power Cycle Count)

Number of core processor
power cycles

0 N/A

175 SYS_PowerOnTimeSec

(DD Name:

Power On Time)

Power on time(Seconds
since last reset)

--- N/A

176 SNS_InputVoltage

(DD Name:

Input_Voltage)

Input Voltage(Volts) --- N/A

177 SNS_TargetAmplitude

(DD Name:

Target Amplitude)

Actual Target Amplitude
(mV/Hz)

(Pre 700 2.1, Actual &
Override)

--- N/A

178 SNS_CaseRTDRes

(DD Name:

Case RTD Resistance)

Case RTD Resistance
(ohms)

--- N/A

179 SYS_Restore

FactoryConfig

(DD Name:

Restore Factory

Configuration)

Restore Factory
Configuration
(“On”=restore, “Off”=N/A)

---
0x00 = no action

0x01 = Restore
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Table F-31: Diagnostic block diagnostic variables -- definitions, defaults, and range of
values (continued)

Index Parameter

mnemonic

diagnostic

variables

Definition Default
value

Enumerated list of
values /range

180 SYS_ResetPowerOnTime

(DD Name:

Reset

Power On Time)

Reset power-on time ---
0x00 = no action

0x01 = Reset

181 FRF_EnableFCFValidation

(DD Name:

FCF Verification)

Enable FCF Verification

0=disable

1=normal enable

2=Factory Verification
of Air

3=Factory Verification
of Water

4=debug

---
0x0000 = Disable

0x0001 =

Normal Enable

0x0002 = Factory

Verification of Air

0x0003 = Factory

Verification of
Water

0x0004 = Debug

182 FRF_FaultAlarm

(DD Name: FCF

Verification Alarm)

Output state during FCF
Verification

0=Last Value

1=Fault

---
N/A

183 DB_FRF_StiffnessLimit

(DD Name:

Stiffness limit

Set point)

Stiffness Limit Set point 0.04
0 < Stiffness limit <=
1

184 FRF_AlgoState

(DD Name:

Algorithm State)

Algorithm State (1 through
18)

---
N/A

Model 2700 PROFIBUS block parameters Configuration and Use Manual
October 2018 20000327

274  Micro Motion Model 2700 Transmitters with PROFIBUS-PA



Table F-31: Diagnostic block diagnostic variables -- definitions, defaults, and range of
values (continued)

Index Parameter

mnemonic

diagnostic

variables

Definition Default
value

Enumerated list of
values /range

185 FRF_AbortCode

(DD Name: Abort
Code)

Abort Code ---
0=No error

1=Manual Abort

2=Watchdog
Timeout

3=Frequency Drift

4=High Peak Drive
Voltage

5=High Drive
Current Standard
Deviation

6=High Drive
Current Mean Value

7=Drive loop
reported error

8=High Delta T
Standard Deviation

9=High Delta T
Value

10=State Running

186 FRF_StateAtAbort

(DD Name:

State At Abort)

State at Abort ---
N/A

187 DB_FRF_StiffOutLimLpo

(DD Name: LPO

Stiffness out of limit)

Stiffness out of limits LPO

0=No

1=Yes

---
N/A

188 DB_FRF_StiffOutLimRpo

(DD Name: RPO

Stiffness out of limit)

Stiffness out of limits RPO

0=No

1=Yes

---
N/A
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Table F-31: Diagnostic block diagnostic variables -- definitions, defaults, and range of
values (continued)

Index Parameter

mnemonic

diagnostic

variables

Definition Default
value

Enumerated list of
values /range

189 FRF_Progress

(DD Name: Progress)

Progress (% Complete) ---
N/A

190 FRF_AbortCodDB_FRF

_StiffnessLpo _Mean

(DD Name: Stiffness LPO)

Stiffness LPO – current
data means

---
N/A

191 DB_FRF_Stiffness

Rpo_Mean

(DD Name:

Stiffness RPO)

Stiffness RPO – current
data means

---
N/A

192 DB_FRF_Damping_Mean

(DD Name:

Mean Damping)

Damping – current data
means

---
N/A

193 DB_FRF_MassLpo_Mean

(DD Name:

Mean Mass LPO)

Mass LPO – current data
means

---
N/A

194 DB_FRF_MassRpo_Mean

(DD Name:

Mean Mass RPO)

Mass RPO – current data
means

---
N/A

195 DB_FRF_StiffnessLpo

_StdDev

(DD Name:

Stiffness LPO)

Stiffness LPO – current
data std dev

---
N/A

196 DB_FRF_Stiffness

Rpo_StdDev

(DD Name:

Stiffness RPO)

Stiffness RPO – current
data std dev

---
N/A
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Table F-31: Diagnostic block diagnostic variables -- definitions, defaults, and range of
values (continued)

Index Parameter

mnemonic

diagnostic

variables

Definition Default
value

Enumerated list of
values /range

197 DB_FRF_Damping

_StdDev

(DD Name:

Std Deviation
Damping)

Damping – current data
std dev

---
N/A

198 DB_FRF_MassLpo_StdDev

(DD Name:

Std Deviation Mass
LPO)

Mass LPO – current data
std dev

---
N/A

199 DB_FRF_MassRpo

_StdDev

(DD Name: Std Deviation

Mass RPO)

Mass RPO – current data
std dev

---
N/A

200 DB_FRF_StiffnessLpo

_AirCal

(DD Name: Factory Cal

Stiffness LPO)

Stiffness LPO – factory cal
air means

---
N/A

201 DB_FRF_Stiffness

Rpo_AirCal

(DD Name: Factory Cal

Stiffness RPO)

Stiffness RPO – factory cal
air means

---
N/A

202 DB_FRF_Damping_AirCal

(DD Name: Damping

Factory Cal Air)

Damping – factory cal air
means

---
N/A

203 DB_FRF_MassLpo_AirCal

(DD Name:

Mass LPO Air Cal)

Mass LPO – factory cal air
means

---
N/A
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Table F-31: Diagnostic block diagnostic variables -- definitions, defaults, and range of
values (continued)

Index Parameter

mnemonic

diagnostic

variables

Definition Default
value

Enumerated list of
values /range

204 DB_FRF_MassRpo_AirCal

(DD Name:

Mass RPO Air Cal)

Mass RPO – factory cal air
means

---
N/A

205 DB_FRF_Stiffness

Lpo_WaterCal

(DD Name:

Stiffness LPO Water
Cal)

Stiffness LPO – cal water
means

---
N/A

206 DB_FRF_Stiffness

Rpo_WaterCal

(DD Name:

Stiffness RPO Water
Cal)

Stiffness RPO – cal water
means

---
N/A

207 DB_FRF_Damping

_WaterCal

(DD Name:

Damping Water Cal)

Damping – factory cal
water means

---
N/A

208 DB_FRF_MassLpo

_WaterCal

(DD Name:

Mass LPO Water Cal)

Mass LPO – factory cal
water means

---
N/A

209 DB_FRF_MassRpo

_WaterCal

(DD Name:

Mass RPO Water Cal)

Mass RPO – factory cal air
means

---
N/A

210 SNS_DriveCurrent

(DD Name: Drive Current)

Drive Current (mA) ---
N/A
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Table F-31: Diagnostic block diagnostic variables -- definitions, defaults, and range of
values (continued)

Index Parameter

mnemonic

diagnostic

variables

Definition Default
value

Enumerated list of
values /range

211 SNS_SensorFailure

TimeoutTime

(DD Name:

Sensor Failure Time
Out)

Sensor Failure Time out
(1/16sec units)

---
N/A

212 SNS_MassFlowHiLim Absolute value of the
upper range mass flow of
the sensor

---
N/A

213 SNS_TempFlowHiLim Absolute value of the
upper range temperature
of the sensor

---
N/A

214 SNS_DensityHiLim Absolute value of the
upper range density of the
sensor

---
N/A

215 SNS_VolumeFlowHiLim Absolute value of the
upper range volume flow
of the sensor

---
N/A

216 SNS_MassFlowLoLim Absolute value of the
lower range mass flow of
the sensor

---
N/A

217 SNS_TempFlowLoLim Absolute value of the
lower range temperature
of the sensor

---
N/A

218 SNS_DensityLoLim Absolute value of the
lower range density of the
sensor

---
N/A

219 SNS_VolumeFlowLoLim Absolute value of the
lower range volume flow
of the sensor

---
N/A
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Table F-32: Diagnostic block diagnostic variables -- -- size, access, and Modbus
register columns

Index Parameter

mnemonic

diagnostic

variables

Message

type

Data type/
structure

Size Store/
rate

(hz)

Access Modbus

register

/ coil

160 SNS_DriveGain

(DD Name :

Drive Gain)

RECORD 101 5 D R R-291-292

161 SNS_RawTubeFreq

(DD Name:

Tube Frequency)

VARIABLE Float 4 D20 R R-285-286

162 SNS_LiveZeroFlow

(DD Name :

Live Zero Flow)

VARIABLE Float 4 D20 R R-293-294

163 SNS_LPOamplitude

(DD Name :

LPO Amplitude)

VARIABLE Float 4 D20 R R-287-288

164 SNS_RPOamplitude

(DD Name :

RPO Amplitude)

VARIABLE Float 4 D20 R R-289-290

165 SNS_BoardTemp

(DD Name :

Board

Temperature)

VARIABLE Float 4 D20 R R-383-384

166 SNS_Max

BoardTemp

(DD Name:

Maximum

electronic

temperature)

VARIABLE Float 4 D20 R R-463
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Table F-32: Diagnostic block diagnostic variables -- -- size, access, and Modbus
register columns (continued)

Index Parameter

mnemonic

diagnostic

variables

Message

type

Data type/
structure

Size Store/
rate

(hz)

Access Modbus

register

/ coil

167 SNS_Min

BoardTemp

(DD Name:

Minimum

electronic

temperature)

VARIABLE Float 4 D20 R R-465

168 SNS_Ave

BoardTemp

(DD Name:

Average

board
temperature)

VARIABLE Float 4 D20 R R-467

169 SNS_Max

SensorTemp

(DD Name:

Maximum

Sensor

temperature)

VARIABLE Float 4 D20 R R-435-436

170 SNS_MinSensorTem
p

(DD Name:

Minimum Sensor

temperature)

VARIABLE Float 4 D20 R R-437-438
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Table F-32: Diagnostic block diagnostic variables -- -- size, access, and Modbus
register columns (continued)

Index Parameter

mnemonic

diagnostic

variables

Message

type

Data type/
structure

Size Store/
rate

(hz)

Access Modbus

register

/ coil

171 SNS_Ave

SensorTemp

(DD Name:

Average Sensor

temperature)

VARIABLE Float 4 D20 R R-439-440

172 SNS_WireRTDRes

(DD Name:

9 wire cable RTD)

VARIABLE Float 4 D20 R R-469

173 SNS_LineRTDRes

(DD Name:

Meter RTD

Resistance)

VARIABLE Float 4 D20 R R-475

174 SYS_Power

CycleCount

(DD Name:

Power Cycle
Count)

VARIABLE Unsigned16 2 D R R-497

175 SYS_PowerOn

TimeSec

(DD Name:

Power On Time)

VARIABLE Unsigned32 4 N R R-2625-2626

176 SNS_InputVoltage

(DD Name:

Input_Voltage)

VARIABLE Float 4 D R R0385-0386

Model 2700 PROFIBUS block parameters Configuration and Use Manual
October 2018 20000327

282  Micro Motion Model 2700 Transmitters with PROFIBUS-PA



Table F-32: Diagnostic block diagnostic variables -- -- size, access, and Modbus
register columns (continued)

Index Parameter

mnemonic

diagnostic

variables

Message

type

Data type/
structure

Size Store/
rate

(hz)

Access Modbus

register

/ coil

177 SNS_Target

Amplitude

(DD Name:

Target
Amplitude)

VARIABLE Float 4 D R R-395-396

178 SNS_CaseRTDRes

(DD Name:

Case RTD

Resistance)

VARIABLE Float 4 D R R-473-474

179 SYS_Restore

FactoryConfig

(DD Name:

Restore Factory
Configuration)

METHOD Unsigned8 1 D R/W Coil-0247

180 SYS_ResetPower

OnTime

(DD Name:

Reset Power

On Time)

METHOD Unsigned8 1 D R/W Coil-242

181 FRF_Enable

FCFValidation

(DD Name:

FCF Verification)

ENUM Unsigned16 2 D R/W R-3000

182 FRF_FaultAlarm

(DD Name:

FCF Verification
Alarm)

VARIABLE Unsigned16 1 D R/W R-3093
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Table F-32: Diagnostic block diagnostic variables -- -- size, access, and Modbus
register columns (continued)

Index Parameter

mnemonic

diagnostic

variables

Message

type

Data type/
structure

Size Store/
rate

(hz)

Access Modbus

register

/ coil

183 DB_FRF

_StiffnessLimit

(DD Name:

Stiffness limit

Set point)

VARIABLE Float 4 N-CP R/W R-3147

184 FRF_AlgoState

(DD Name:

Algorithm State)

VARIABLE Unsigned16 2 D R R-3001

185 FRF_AbortCode

(DD Name:

Abort Code)

ENUM Unsigned16 2 D R R-3002

186 FRF_StateAtAbort

(DD Name:

State At Abort)

VARIABLE Unsigned16 2 D R R-3003

187 DB_FRF_Stiff

OutLimLpo

(DD Name:

LPO Stiffness

out of limit)

VARIABLE Unsigned16 2 D R R-3004

188 DB_FRF_Stiff

OutLimRpo

(DD Name:

RPO Stiffness

out of limit)

VARIABLE Unsigned16 2 D R R-3005

189 FRF_Progress

(DD Name:

Progress)

VARIABLE Unsigned16 2 S R R-3020
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Table F-32: Diagnostic block diagnostic variables -- -- size, access, and Modbus
register columns (continued)

Index Parameter

mnemonic

diagnostic

variables

Message

type

Data type/
structure

Size Store/
rate

(hz)

Access Modbus

register

/ coil

190 FRF_AbortCodDB

_FRF_Stiffness

Lpo _Mean

(DD Name:

Stiffness LPO)

VARIABLE Float 4 D R R-3101,

R-3100

191 DB_FRF_Stiffness

Rpo_Mean

(DD Name:

Stiffness RPO)

VARIABLE Float 4 D R R-3103,

R-3100

192 DB_FRF

_Damping_Mean

(DD Name:

Mean Damping)

VARIABLE Float 4 D R R-3105,

R-3100

193 DB_FRF

_MassLpo_Mean

(DD Name:

Mean Mass LPO)

VARIABLE Float 4 D R R-3107,

R-3100

194 DB_FRF

_MassRpo_Mean

(DD Name:

Mean Mass RPO)

VARIABLE Float 4 D R R-3109,

R-3100

195 DB_FRF_Stiffness

Lpo_StdDev

(DD Name:

Stiffness LPO)

VARIABLE Float 4 D R R-3101,

R-3100

196 DB_FRF_Stiffness

Rpo_StdDev

(DD Name:

Stiffness RPO)

VARIABLE Float 4 D R R-3103,

R-3100
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Table F-32: Diagnostic block diagnostic variables -- -- size, access, and Modbus
register columns (continued)

Index Parameter

mnemonic

diagnostic

variables

Message

type

Data type/
structure

Size Store/
rate

(hz)

Access Modbus

register

/ coil

197 DB_FRF_Damping

_StdDev

(DD Name:

Std Deviation

Damping)

VARIABLE Float 4 D R R-3105,

R-3100

198 DB_FRF_Mass

Lpo_StdDev

(DD Name:

Std Deviation

Mass LPO)

VARIABLE Float 4 D R R-3107,

R-3100

199 DB_FRF_Mass

Rpo_StdDev

(DD Name:

Std Deviation

Mass RPO)

VARIABLE Float 4 D R R-3109,

R-3100

200 DB_FRF_Stiffness

Lpo_AirCal

(DD Name:

Factory Cal

Stiffness LPO)

VARIABLE Float 4 D R R-3101,

R-3100

201 DB_FRF_Stiffness

Rpo_AirCal

(DD Name:

Factory Cal

Stiffness RPO)

VARIABLE Float 4 D R R-3103,

R-3100

202 DB_FRF

_Damping_AirCal

(DD Name:

Damping Factory

Cal Air)

VARIABLE Float 4 D R R-3105,

R-3100
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Table F-32: Diagnostic block diagnostic variables -- -- size, access, and Modbus
register columns (continued)

Index Parameter

mnemonic

diagnostic

variables

Message

type

Data type/
structure

Size Store/
rate

(hz)

Access Modbus

register

/ coil

203 DB_FRF

_MassLpo_AirCal

(DD Name:

Mass LPO Air Cal)

VARIABLE Float 4 D R R-3107,

R-3100

204 DB_FRF

_MassRpo_AirCal

(DD Name:

Mass RPO Air Cal)

VARIABLE Float 4 D R R-3109,

R-3100

205 DB_FRF_Stiffness

Lpo_WaterCal

(DD Name:

Stiffness LPO
Water Cal)

VARIABLE Float 4 D R R-3101,

R-3100

206 DB_FRF_Stiffness

Rpo_WaterCal

(DD Name:

Stiffness RPO

Water Cal)

VARIABLE Float 4 D R R-3103,

R-3100

207 DB_FRF_Damping

_WaterCal

(DD Name:

Damping

Water Cal)

VARIABLE Float 4 D R R-3105,

R-3100
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Table F-32: Diagnostic block diagnostic variables -- -- size, access, and Modbus
register columns (continued)

Index Parameter

mnemonic

diagnostic

variables

Message

type

Data type/
structure

Size Store/
rate

(hz)

Access Modbus

register

/ coil

208 DB_FRF_Mass

Lpo_WaterCal

(DD Name:

Mass LPO

Water Cal)

VARIABLE Float 4 D R R-3107,

R-3100

209 DB_FRF_Mass

Rpo_WaterCal

(DD Name:

Mass RPO

Water Cal)

VARIABLE Float 4 D R R-3109,

R-3100

210 SNS_DriveCurrent

(DD Name:

Drive Current)

VARIABLE Float 4 D/20 R R-0401

211 SNS_SensorFailure

TimeoutTime

(DD Name:

Sensor Failure

Time Out)

VARIABLE Unsigned16 2 N-CP R/W R-0399

212 SNS_MassFlow

HiLim

SIMPLE Float 4 N-CP R R-0165

213 SNS_TempFlow

HiLim

SIMPLE Float 4 N-CP R R-0167

214 SNS_DensityHiLim SIMPLE Float 4 N-CP R R-0169

215 SNS_VolumeFlow

HiLim

SIMPLE Float 4 N-CP R R-0171

216 SNS_MassFlow

LoLim

SIMPLE Float 4 N-CP R R-0173
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Table F-32: Diagnostic block diagnostic variables -- -- size, access, and Modbus
register columns (continued)

Index Parameter

mnemonic

diagnostic

variables

Message

type

Data type/
structure

Size Store/
rate

(hz)

Access Modbus

register

/ coil

217 SNS_TempFlow

LoLim

SIMPLE Float 4 N-CP R R-0175

218 SNS_DensityLoLim SIMPLE Float 4 N-CP R R-0177

219 SNS_VolumeFlow

LoLim

SIMPLE Float 4 N-CP R R-0179

Diagnostic block LDO variables (220-254)

The first table focuses on definitions, default values, and the enumerated list of values
allowed for each parameter, while Table F-34 provides the Modbus register column and
other relevant values.

Table F-33: Diagnostic block LDO variables -- definitions, defaults, and range of values

Index Parameter

mnemonic

LDO variables

Definition Default

value

Enumerated list of values /
range

220 UI_EnableLdo

TotalizerReset

(DD Name:

Totalizer Reset)

Enable/Disable LDO
Totalizer Reset

0x01
0x00 = disabled

0x01 = enabled

221 UI_EnableLdo

TotalizerStartStop

(DD Name:

Start/ Stop Totals)

Enable/Disable LDO
Totalizer Start/Stop
option

0x01
0x00 = disabled

0x01 = enabled

222 UI_EnableLdo

AutoScrol

(DD Name:

Auto Scroll)Y

Enable/Disable LDO
Auto Scroll Feature

0x00
0x00 = disabled

0x01 = enabled
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Table F-33: Diagnostic block LDO variables -- definitions, defaults, and range of
values (continued)

Index Parameter

mnemonic

LDO variables

Definition Default

value

Enumerated list of values /
range

223 UI_EnableSecurity

(DD Name:

Offline Password)

Enable/Disable LDO
Offline Menu Feature

0x01
0x00 = disabled

0x01 = enabled

224 UI_EnableSecurity

(DD Name:

Offline Password)

Enable/Disable LDO
Offline Password

0x00
0x00 = disabled

0x01 = enabled

225 UI_EnableLdo

AlarmMenu

(DD Name:

Alarm Menu)

Enable/Disable LDO
Alarm Menu

0x01
0x00 = disabled

0x01 = enabled

226 UI_EnableLdo

AckAllAlarms

(DD Name:

ACK All Alarms)

Enable/Disable LDO
Acknowledge All
alarms Feature

0x01
0x00 = disabled

0x01 = enabled

227 UI_OfflinePassword

(DD Name:

Enter Offline

Password)

LDO offline password 1234
0 – 9999

228 UI_AutoScrollRate

(DD Name:

ScrollPeriod)

LDO Scroll rate 10
Between 1 to 30

229 UI_BacklightOn

(DD Name:

BackLight)

LDO Backlight Control 0x01
0x00 = off

0x01 = on
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Table F-33: Diagnostic block LDO variables -- definitions, defaults, and range of
values (continued)

Index Parameter

mnemonic

LDO variables

Definition Default

value

Enumerated list of values /
range

230 UNI_UI_ProcVarIndex

(DD Name:

Display Variable

Process Variable Code
(n = 0…94)

---
0 = Mass Flow Rate

1 = Temperature

2 = Mass Total

3= Density

4= Mass Inventory

5= Line (Gross) Volume
Flow Rate

6= Line (Gross) Volume

Total

7= Line (Gross) Volume

Inventory

8-11 = Not used

12 = Status Word 1

13 = Status Word 2

14 = Status Word 3

15= API: Temp Corrected
Density

16= API: Temp

Corrected (Standard)

Volume Flow

17= API: Temp

Corrected (Standard)

Volume Total

18= API: Temp

Corrected (Standard)

Volume Inventory
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Index Parameter

mnemonic

LDO variables

Definition Default

value

Enumerated list of values /
range

19= API: Batch Weighted
Average Density

20= API: Batch Weighted
Average Temperature

21= Enhanced Density

At Reference

22= Enhanced Density
(Fixed SG Units)

23= Enhanced Density:

Standard Volume Flow
Rate

24= Enhanced Density:

Standard Volume Total

25= Enhanced Density:

Standard Volume
Inventory

26= Enhanced Density:

Net Mass Flow Rate

27= Enhanced Density:

Net Mass Total

28= Enhanced Density:

Net Mass Inventory

29= Enhanced Density:

Net Volume Flow Rate

30= Enhanced Density:

Net Volume Total

31= Enhanced Density:

Net Volume Inventory

32= Enhanced Density:
Concentration
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Index Parameter

mnemonic

LDO variables

Definition Default

value

Enumerated list of values /
range

33= API: CTL

34 = Raw Mass

Total, MSD (Double)

35 = Raw Mass

Total, LSD (Double)

36 = Raw API: Temp/

Pressure Corrected
Volume

Total, MSD (Double)

37= Raw Line (Gross)

Volume Total, LSD
(Double)

38 = Raw API: Temp/

Pressure Corrected
Volume

Total, MSD (Double)

39 = Raw API: Temp/

Pressure Corrected
Volume

Total, LSD (Double)

40 = Raw Enhanced

Density: Standard
Volume

Total, MSD (Double)

41 = Raw Enhanced

Density: Standard
Volume

Total, LSD (Double)

42 = Raw Enhanced

Density: Net Mass
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Index Parameter

mnemonic

LDO variables

Definition Default

value

Enumerated list of values /
range

Total, MSD (Double)

43 = Raw Enhanced

Density: Net Mass

Total, LSD (Double)

44 = Raw Enhanced

Density: Net Volume

Total MSD (Double)

46=Raw Tube Frequency

47= Drive Gain

48= Case Temperature

(T-Series)

49= LPO Amplitude

50= RPO Amplitude

51= Board Temperature

52= Input Voltage

53= Externally read
Pressure

54= Mechanical Zero

55= Externally read

Temperature

56= Enhanced Density:

Density

(Fixed Baume Units)/

Enhanced Density:

Density (Special Density
Units)

57 = Discrete Event

58 = Discrete Event 2

59 = Discrete Event 3
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Index Parameter

mnemonic

LDO variables

Definition Default

value

Enumerated list of values /
range

60 = Discrete Event 4

61 = Discrete Event 5

62= Gas Standard

Volume Flow Rate

63= Gas Standard

Volume Total

64= Gas Standard

Volume Inventory

65 = Status word 4

66 = Raw Gas Standard

Volume Total,

MSD (Double)

67 = Raw Gas Standard

Volume Total,

LSD (Double)

68 = Not used

69= Live Zero

70-101= Not used

102 = Forward/Reverse

Indication

103 = Calibration in

Progress

104 = Fault Condition

Indication

105-112 = Not used

113-156 = MF
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Table F-33: Diagnostic block LDO variables -- definitions, defaults, and range of
values (continued)

Index Parameter

mnemonic

LDO variables

Definition Default

value

Enumerated list of values /
range

157-255 = Not Used

231 UI_NumDecimals

(DD Name:

No. of Decimals)

For Totals, the number
of digits to the right of
the decimal point to
display on LDO

-
0 to 5
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Table F-33: Diagnostic block LDO variables -- definitions, defaults, and range of
values (continued)

Index Parameter

mnemonic

LDO variables

Definition Default

value

Enumerated list of values /
range

232 UI_ProcessVariables

(LDO_VAR_1_CODE)

(DD Name:

Display Variable 1)

Display the Variable
#1associated with the
code on the LDO

0
0 = Mass Flow Rate

1 = Temperature

2 = Mass Total

3 = Density

4 = Mass Inventory

5 = Volume Flow Rate

6 = Volume Total

7 = Volume Inventory

8 – 11 = Not used

12 = Status Word 1

13 = Status Word 2

14 = Status Word 3

15 = API: Corr Density

16 = API: Corr Vol Flow

17 = API: Corr Vol Total

18 = API: Corr Vol Inv

19 = API: Avg Density

20 = API: Avg Temp

21 = ED: Density At Ref

22 = ED: Density ( SGU)

23 = ED: Std Vol Flow
Rate

24 = ED: Std Vol Total

25 = ED: Std Vol
Inventory

26 = ED: Net Mass Flow

27 = ED: Net Mass Total

Configuration and Use Manual  Model 2700 PROFIBUS block parameters
20000327 October 2018

Configuration and Use Manual  297



Index Parameter

mnemonic

LDO variables

Definition Default

value

Enumerated list of values /
range

28 = ED: Net Mass Inv

29 = ED: Net Vol Flow
Rate

30 = ED: Net Vol Total

31 = ED: Net Vol
Inventory

32 = ED: Concentration

33 = API: CTL

34 = Raw Mass Total,

MSD (Double)

35 = Raw Mass Total,

LSD (Double)

36 = Raw API: Temp/

Pressure Corrected
Volume

Total MSD, (Double)

37 = Raw Line (Gross)

VolumeTotal

LSD, (Double)

38 = Raw API: Temp/

Pressure Corrected
Volume

Total MSD, (Double)

39 = Raw API: Temp/

Pressure Corrected
Volume

Total LSD, (Double)

40 = Raw Enhanced

Density: Standard
Volume
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Index Parameter

mnemonic

LDO variables

Definition Default

value

Enumerated list of values /
range

Total, MSD (Double)

41 = Raw Enhanced

Density: Standard
Volume

Total, LSD (Double)

42 = Raw Enhanced

Density: Net Mass

Total, MSD (Double)

43 = Raw Enhanced

Density: Net Mass

Total, LSD (Double)

44 = Raw Enhanced

Density: Net Volume

Total, MSD (Double)

45 = Raw Enhanced

Density: Net Volume

Total, LSD (Double)

46 = Raw Tube
Frequency

47 = Drive Gain

48 = Case Temperature

49 = LPO Amplitude

50 = RPO Amplitude

51 = Board Temperature

52 = Input Voltage

53 = Ext. Input Pressure

54 = Mechanical Zero

55 = Ext. Input Temp

56 = ED: Density (Baume)
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Index Parameter

mnemonic

LDO variables

Definition Default

value

Enumerated list of values /
range

57-61 = Not used

62 = Gas Std Vol Flow

63 = Gas Std Vol Total

64 = Gat Std Vol
Inventory

65-68 = Not used

69 = Live Zero

70 – 255 = Not used
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Table F-33: Diagnostic block LDO variables -- definitions, defaults, and range of
values (continued)

Index Parameter

mnemonic

LDO variables

Definition Default

value

Enumerated list of values /
range

233 UI_ProcessVariables

(LDO_VAR_2_CODE)

(DD Name:

Display Variable 2)

Display the Variable #2
associated with the
code on the LDO

2
0 = Mass Flow Rate

1 = Temperature

2 = Mass Total

3 = Density

4 = Mass Inventory

5 = Volume Flow Rate

6 = Volume Total

7 = Volume Inventory

8 – 11 = Not used

12 = Status Word 1

13 = Status Word 2

14 = Status Word 3

15 = API: Corr Density

16 = API: Corr Vol Flow

17 = API: Corr Vol Total

18 = API: Corr Vol Inv

19 = API: Avg Density

20 = API: Avg Temp

21 = ED: Density At Ref

22 = ED: Density ( SGU)

23 = ED: Std Vol Flow
Rate

24 = ED: Std Vol Total

25 = ED: Std Vol
Inventory

26 = ED: Net Mass Flow

27 = ED: Net Mass Total
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Index Parameter

mnemonic

LDO variables

Definition Default

value

Enumerated list of values /
range

28 = ED: Net Mass Inv

29 = ED: Net Vol Flow
Rate

30 = ED: Net Vol Total

31 = ED: Net Vol
Inventory

32 = ED: Concentration

33 = API: CTL

34 = Raw Mass Total,

MSD (Double)

35 = Raw Mass Total,

LSD (Double)

36 = Raw API: Temp/

Pressure Corrected
Volume

Total, MSD (Double)

37 = Raw Line (Gross)

Volume Total, LSD
(Double)

38 = Raw API: Temp/

Pressure Corrected
Volume

Total, MSD (Double)

39 = Raw API: Temp/

Pressure Corrected
Volume

Total, LSD (Double)

40 = Raw Enhanced

Density: Standard
Volume

Total, MSD (Double)
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Index Parameter

mnemonic

LDO variables

Definition Default

value

Enumerated list of values /
range

41 = Raw Enhanced

Density: Standard
Volume

Total, LSD (Double)

42 = Raw Enhanced

Density: Net Mass

Total, MSD (Double)

43 = Raw Enhanced

Density: Net Mass

Total, LSD (Double)

44 = Raw Enhanced

Density: Net Volume

Total, MSD (Double)

45 = Raw Enhanced

Density: Net Volume

Total, LSD (Double)

46 = Raw Tube
Frequency

47 = Drive Gain

48 = Case Temperature

49 = LPO Amplitude

50 = RPO Amplitude

51 = Board Temperature

52 = Input Voltage

53 = Ext. Input Pressure

54 = Mechanical Xero

55 = Ext. Input Temp

56 = ED: Density (Baume)

57 = Discrete Event 1
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Index Parameter

mnemonic

LDO variables

Definition Default

value

Enumerated list of values /
range

58 = Discrete Event 2

59 = Discrete Event 3

60 = Discrete Event 4

61 = Discrete Event 5

62 = Gas Std Vol Flow

63 = Gas Std Vol Total

64 = Gas Std Vol
Inventory

65 = Status word 4

66 = Raw Gas Standard

Volume Total,

MSD (Double)

67 = Raw Gas Standard

Volume Total, LSD
(Double)

68 = Not used

69 = Live Zero

70-101 = Not used

102 = Forward/Reverse

Indication

103 Calibration in
Progress

104 = Fault Condition

Indication

105-112 = Not used

113–156 = MF

157-255 = Not used
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Table F-33: Diagnostic block LDO variables -- definitions, defaults, and range of
values (continued)

Index Parameter

mnemonic

LDO variables

Definition Default

value

Enumerated list of values /
range

234 UI_ProcessVariables

(LDO_VAR_3_CODE)

(DD Name:

Display Variable 3)

Display the Variable #3
associated with the
code on the LDO

5
Same as
LDO_VAR_2_CODE

235 UI_ProcessVariables

(LDO_VAR_4_CODE)

(DD Name:

Display Variable 4)

Display the Variable #4
associated with the
code on the LDO

6
Same as
LDO_VAR_2_CODE

236 UI_ProcessVariables

(LDO_VAR_5_CODE)

(DD Name:

Display Variable 5)

Display the Variable #5
associated with the
code on the LDO

3
Same as
LDO_VAR_1_CODE

237 UI_ProcessVariables

(LDO_VAR_6_CODE)

(DD Name:

Display Variable 6)

Display the Variable #6
associated with the
code on the LDO

1
Same as
LDO_VAR_1_CODE

238 UI_ProcessVariables

(LDO_VAR_7_CODE)

(DD Name:

Display Variable 7)

Display the Variable #7
associated with the
code on the LDO

251
Same as
LDO_VAR_1_CODE

239 UI_ProcessVariables

(LDO_VAR_8_CODE)

(DD Name:

Display Variable 8)

Display the Variable #8
associated with the
code on the LDO

251
Same as
LDO_VAR_1_CODE
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Table F-33: Diagnostic block LDO variables -- definitions, defaults, and range of
values (continued)

Index Parameter

mnemonic

LDO variables

Definition Default

value

Enumerated list of values /
range

240 UI_ProcessVariables

(LDO_VAR_9_CODE)

(DD Name:

Display Variable 9)

Display the Variable #9
associated with the
code on the LDO

251
Same as
LDO_VAR_1_CODE

241 UI_ProcessVariables

(LDO_VAR_10_CODE
)

(DD Name:

Display Variable 10)

Display the Variable
#10 associated with the
code on the LDO

251
Same as
LDO_VAR_1_CODE

242 UI_ProcessVariables

(LDO_VAR_11_CODE
)

(DD Name:

Display Variable 11)

Display the Variable
#11 associated with the
code on the LDO

251
Same as
LDO_VAR_1_CODE

243 UI_ProcessVariables

(LDO_VAR_12_CODE
)

(DD Name:

Display Variable 12)

Display the Variable
#12 associated with the
code on the LDO

251
Same as
LDO_VAR_1_CODE

244 UI_ProcessVariables

(LDO_VAR_13_CODE
)

(DD Name:

Display Variable 13)

Display the Variable
#13 associated with the
code on the LDO

251
Same as
LDO_VAR_1_CODE

245 UI_ProcessVariables

(LDO_VAR_14_CODE
)

(DD Name:

Display Variable 14)

Display the Variable
#14 associated with the
code on the LDO

251
Same as
LDO_VAR_1_CODE
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Table F-33: Diagnostic block LDO variables -- definitions, defaults, and range of
values (continued)

Index Parameter

mnemonic

LDO variables

Definition Default

value

Enumerated list of values /
range

246 UI_ProcessVariables

(LDO_VAR_15_CODE
)

(DD Name:

Display Variable 15)

Display the Variable
#15 associated with the
code on the LDO

251
Same as
LDO_VAR_12_CODE

247 UI_Update Period

msec

(DD: Name:

Update Period)

Display update period
in milliseconds.

200ms
Between 100 to 10,000

248 EMPTY 251

249 UI_Language

(DD: Name:

Language)

Display language
selection

English
0 = English

1 = German

2 = French

3 = Not used

4 = Spanish

250 UI_FixStatusLED

(DD: Name:

Status LED)

Simulate the Status LED 0x0000
0 = unfix

1 = green

2 = red

3 = yellow

4 = off (add 4 to flash)

251 EMPTY

252 EMPTY

253 EMPTY

254 Transducer Block1
VIEW1
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Table F-34: Diagnostic block LDO variables -- -- size, access, and Modbus register
columns

Index Parameter

mnemonic

LDO variables

Message

type

Data type/
structure

Size Store/
rate
(hz)

Access Modbus

register

/ coil

220 UI_EnableLdo

TotalizerReset

(DD Name:

Totalizer Reset)

ENUM Unsigned8 1 S R/W Coil-0094

221 UI_EnableLdo

TotalizerStartStop

(DD Name:

Start/ Stop Totals)

ENUM Unsigned8 1 S R/W Coil-0091

222 UI_EnableLdo

AutoScrol

(DD Name:

Auto Scroll)

ENUM Unsigned8 1 S R/W Coil-0095

223 UI_EnableLdo

OfflineMenu

(DD Name:

Offline Menu)

ENUM Unsigned8 1 S R/W C-0096

224 UI_EnableSecurity

(DD Name:

Offline Password)

ENUM Unsigned8 1 S R/W C-0097

225 UI_EnableLdo

AlarmMenu

(DD Name:

Alarm Menu)

ENUM Unsigned8 1 S R/W C-0098

226 UI_EnabeLdo

AckAllAlarms

(DD Name:

Ack All Alarms)

ENUM Unsigned8 1 S R/W C-0099
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Table F-34: Diagnostic block LDO variables -- -- size, access, and Modbus register
columns (continued)

Index Parameter

mnemonic

LDO variables

Message

type

Data type/
structure

Size Store/
rate
(hz)

Access Modbus

register

/ coil

227 UI_OfflinePassword

(DD Name:

Enter Offline

Password)

VARIABLE Unsigned16 2 S R/W R-1115

228 UI_AutoScrollRate

(DD Name:

ScrollPeriod)

VARIABLE Unsigned16 2 S R/W R-1116

229 UI_BacklightOn

(DD Name:

BackLight

ENUM Unsigned8 1 S R/W Coil-0050

230 UNI_UI

_ProcVarIndex

(DD Name:

Display Variable

ENUM Unsigned8 1 D R/W R- 1367

231 UI_NumDecimals

(DD Name:

No. of Decimals

VARIABLE Unsigned8 1 S R/W R- 1368

232 UI_ProcessVariables

(LDO_VAR_1_CODE)

(DD Name:

Display Variable 1)

ENUM Unsigned16 2 S R/W R- 1117

233 UI_ProcessVariables

(LDO_VAR_2_CODE)

(DD Name:

Display Variable 2)

ENUM Unsigned16 2 S R/W R- 1118
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Table F-34: Diagnostic block LDO variables -- -- size, access, and Modbus register
columns (continued)

Index Parameter

mnemonic

LDO variables

Message

type

Data type/
structure

Size Store/
rate
(hz)

Access Modbus

register

/ coil

234 UI_ProcessVariables

(LDO_VAR_3_CODE)

(DD Name:

Display Variable 3)

ENUM Unsigned16 2 S R/W R- 1119

235 UI_ProcessVariables

(LDO_VAR_4_CODE)

(DD Name:

Display Variable 4)

ENUM Unsigned16 2 S R/W R- 1120

236 UI_ProcessVariables

(LDO_VAR_5_CODE)

(DD Name:

Display Variable 5)

ENUM Unsigned16 2 S R/W R- 1121

237 UI_ProcessVariables

(LDO_VAR_6_CODE)

(DD Name:

Display Variable 6)

ENUM Unsigned16 2 S R/W R-1122

238 UI_ProcessVariables

(LDO_VAR_7_CODE)

(DD Name:

Display Variable 7)

ENUM Unsigned16 2 S R/W R-1123

239 UI_ProcessVariables

(LDO_VAR_8_CODE)

(DD Name:

Display Variable 8)

ENUM Unsigned16 2 S R/W R-1124
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Table F-34: Diagnostic block LDO variables -- -- size, access, and Modbus register
columns (continued)

Index Parameter

mnemonic

LDO variables

Message

type

Data type/
structure

Size Store/
rate
(hz)

Access Modbus

register

/ coil

240 UI_ProcessVariables

(LDO_VAR_9_CODE)

(DD Name:

Display Variable 9)

ENUM Unsigned16 2 S R/W R-1125

241 UI_ProcessVariables

(LDO_VAR_10_COD
E)

(DD Name:

Display Variable
10)

ENUM Unsigned16 2 S R/W R-1126

242 UI_ProcessVariables

(LDO_VAR_11_COD
E)

(DD Name:

Display Variable
11)

ENUM Unsigned16 2 S R/W R-1127

243 UI_ProcessVariables

(LDO_VAR_12_COD
E)

(DD Name:

Display Variable
12)

ENUM Unsigned16 2 S R/W R-1128

244 UI_ProcessVariables

(LDO_VAR_13_COD
E)

(DD Name:

Display Variable
13)

ENUM Unsigned16 2 S R/W R-1129
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Table F-34: Diagnostic block LDO variables -- -- size, access, and Modbus register
columns (continued)

Index Parameter

mnemonic

LDO variables

Message

type

Data type/
structure

Size Store/
rate
(hz)

Access Modbus

register

/ coil

245 UI_ProcessVariables

(LDO_VAR_14_COD
E)

(DD Name:

Display Variable
14)

ENUM Unsigned16 2 S R/W R-1130

246 UI_ProcessVariables

(LDO_VAR_15_COD
E)

(DD Name:

Display Variable
15)

ENUM Unsigned16 2 S R/W R-1131

247 UI_Update Period

msec

DD Name

UPDATE PERIOD:

VARIABLE Unsigned16 2 S R/W R-2621

248 EMPTY

249 UI_Language

DD Name:

LANGUAGE

ENUM Unsigned16 2 S R/W R-1359

250 STATUS_LED_TEST

DD Name:

STATUS LED

ENUM Unsigned16 2 D R/W R-5006

251 EMPTY

252 EMPTY

253 EMPTY

254 Transducer Block1
VIEW1
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F.2.4 Transducer block 1 object and views
Transducer block 1 object

The following table shows the transducer block 1 object.

• Transducer block 1 object: Table F-35
• Transducer block view #1: Table F-36
• Transducer block view #2: Table F-37

Table F-35: Transducer block 1 object

Slot/
Index

Element name Data type Size in

bytes

Value

Slot 11/
Index 0

Reserved Unsigned 8 1 250 (default)

Block_Object Unsigned 8 1 03

Parent_Class Unsigned 8 1 03

Class Unsigned 8 1 03

DD_Reference Unsigned 32 4 00 ,00, 00, 00 (reserved)

DD_Revision Unsigned 16 2 00 ,00 (reserved)

Profile Octet string 2 64 02 (compact class B)

Profile_Revision Unsigned 16 2 03 01 (3.01)

Execution_Time Unsigned 8 1 00 (for future use)

Number-Of_Parameters Unsigned 16 2 00 254 ( Maximum number of
Transducer Block 1 Parameters)

Address_of_View_1 Unsigned 16 2 11 254 (slot, index)

Number_of_Views Unsigned 8 1 01 (1 view)

Transducer block 1 (measurement, calibration, and diagnosis) views

The following tables show the views for transducer block 1.

Table F-36: Transducer block view -- standard PA parameters

OD index Parameter mnemonic -- standard
PA parameters

View 1 View 2 View 3 View 4

0 BLOCK_OBJECT

1 ST_REV 2

2 TAG_DESC

3 STRATEGY

4 ALERT_KEY
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Table F-36: Transducer block view -- standard PA parameters (continued)

OD index Parameter mnemonic -- standard
PA parameters

View 1 View 2 View 3 View 4

5 TARGET_MODE

6 MODE_BLK 3

7 ALARM_SUM 8

Overall sum of bytes in View Object 13

Table F-37: Transducer block 1 view -- standard flow transducer block parameters

OD index Parameter mnemonic -- standard
parameters

View 1 View 2 View 3 View 4

21 MASS FLOW 5

25 DENSITY 5

29 TEMPERATURE 5

254
Overall sum of bytes in View
Object

(+ 13 Standard parameters
bytes)

15 + 13

F.2.5 Transducer block 2 (device information, API, CM)
parameters
The following tables show the parameters for transducer block 2.

Transducer block 2 standard PA parameters (0-7)

The first table focuses on definitions, default values, and the enumerated list of values
allowed for each parameter, while Table F-39 provides the Modbus register column and
other relevant values.

Table F-38: Transducer block 2 standard PA parameters -- definitions, defaults, and
range of values

Index Parameter

mnemonic

standard PA

parameters

Definition Default
value

Enumerated list
of values /range

0 BLOCK_OBJECT This object contains the characteristics
of the block.

---- NA
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Table F-38: Transducer block 2 standard PA parameters -- definitions, defaults, and
range of values (continued)

Index Parameter

mnemonic

standard PA

parameters

Definition Default
value

Enumerated list
of values /range

1 ST_REV A block has static block parameters
that are not changed by the process.
Values are assigned to this parameter
during the configuration of
optimization. The value of ST_REV
increases by 1 after every change of a
static block parameter.

0 NA

2 TAG_DESC Every block can be assigned a textual
TAG description. The TAG_DESC must
be unambiguous and unique in the
field bus system.

' ' NA

3 STRATEGY Grouping of function block. The
STRATEGY field can be used to group
blocks.

0 NA

4 ALERT_KEY This parameter contains the
identification number of the plant
unit.

0 NA

5 TARGET_MODE This parameter contains desired mode
normally set by a control application of
an operator. The modes are valid
alternatively only; for example,only
one mode can be set at one time. A
write access to this parameter with
more than one mode is out of the
range of the parameter and has to be
rejected.

AUTO
(*0x08)

AUTO (0x8)

6 MODE_BLK This parameter contains the current
mode and the permitted and normal
mode of the block.

---- NA

7 ALARM_SUM This parameter contains the current
states of the block alarms.

0,0,0,0 NA
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Table F-39: Transducer block 2 standard PA parameters -- size, access, and Modbus
register columns

Index Parameter

mnemonic

standard PA

parameters

Message

type

Data type/
structure

Size Store/
rate (hz)

Access Modbus

register

/ coil

0 BLOCK_OBJECT RECORD DS-32 20 S R NA

1 ST_REV SIMPLE Unsigned16 2 N R NA

2 TAG_DESC SIMPLE OCTET string 32 S R/W NA

3 STRATEGY SIMPLE Unsigned16 2 S R/W NA

4 ALERT_KEY SIMPLE Unsigned8 1 S R/W NA

5 TARGET_MODE SIMPLE Unsigned8 1 S R/W NA

6 MODE_BLK RECORD DS-37 3 D R NA

7 ALARM_SUM RECORD DS-42 8 D R NA

Transducer block 2 device information block: transmitter data (8-9)

The first table focuses on definitions, default values, and the enumerated list of values
allowed for each parameter, while Table F-41 provides the Modbus register column and
other relevant values.

Table F-40: Transducer block 2 device information block: transmitter data --
definitions, defaults, and range of values

Index Parameter

device

information block

transmitter data

Definition Default

value

Enumerated list of
values /range

8 SYS_FeatureKey

(DD Name:

Enabled Features)

Enabled Features -
0x0000 = standard

0x0800 = Meter

Verification

0x0008 = Enh. Density

0x0010 = API

9 SYS_CEQ_Number

(DD Name: CP
ETO)

Model 2700 Transmitter
CEQ Number

SW Rev NA
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Table F-41: Transducer block 2 device information block: transmitter data -- size,
access, and Modbus register columns

Index Parameter

device

information block

transmitter data

Message

type

Data type/
structure

Size Store/
rate (hz)

Access Modbus

register

/ coil

8 SYS_FeatureKey

(DD Name:

Enabled Features)

String
BIT

_ENUMERATE
D

2 N R R-5000

9 SYS_CEQ_Number

(DD Name: CP
ETO)

VARIABLE Unsigned16 2 N R/W R-5005

Transducer block 2 device information block: sensor data (10-28)

The first table focuses on definitions, default values, and the enumerated list of values
allowed for each parameter, while Table F-43 provides the Modbus register column and
other relevant values.

Table F-42: Transducer block 2 device information block: sensor data -- definitions,
defaults, and range of values

Index Parameter

device

information block

sensor data

Definition Default
value

Enumerated list
of values /range

10 SNS_Sensor

SerialNum

(DD Name : Sensor

Serial Number)

Sensor serial number 0
≥=0

≤=16777215.0f

11 SNS_SensorType

(DD Name: Sensor

Model Number)

Sensor type (i.e. F200,
CMF025)

"" NA

12 SNS_Sensor

TypeCode

(DD Name: Sensor

Type Code)

Sensor type code 0
0 = Curve Tube

1 = Straight Tube

Configuration and Use Manual  Model 2700 PROFIBUS block parameters
20000327 October 2018

Configuration and Use Manual  317



Table F-42: Transducer block 2 device information block: sensor data -- definitions,
defaults, and range of values (continued)

Index Parameter

device

information block

sensor data

Definition Default
value

Enumerated list
of values /range

13 NS_SensorMaterial

(DD Name :

Sensor Material)

Sensor Material 0
0 = None

3 = Hastelloy
C-22

4 = Monel

5 = Tantalum

6 = Titanium

19 = 316L

stainless steel

23 = Inconel

252 = Unknown

253 = Special

14 SNS_LinerMaterial

(DD Name :

Sensor Liner)

Liner Material 0
0 = None

10 = PTFE
(2larms)

11 = Halar

16 = Tefzel

251 = None

252 = Unknown

253 = Special
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Table F-42: Transducer block 2 device information block: sensor data -- definitions,
defaults, and range of values (continued)

Index Parameter

device

information block

sensor data

Definition Default
value

Enumerated list
of values /range

15 SNS_FlangeType

(DD Name :

Sensor Flange)

Flange Type 0
0 = ANSI 150

1 = ANSI 300

2 = ANSI 600

5 = PN 40

7 = JIS 10K

8 = JIS 20K

9 = ANSI 900

10 = Sanitary
Clamp Fitting

11 = Union

12 = PN 100

252 = Unknown

253 = Special

16 SNS_MassFlow

LoSpan

(DD Name:

Mass Minimum Span)

Mass flow minimum range Calc NA

17 SNS_TempFlow

LoSpan

(DD Name:

Temp Minimum Span)

Temperature minimum
range

Calc NA

18 SNS_DensityLoSpan

(DD Name:

Density Minimum
Span)

Density minimum range
(g/cc)

Calc NA
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Table F-42: Transducer block 2 device information block: sensor data -- definitions,
defaults, and range of values (continued)

Index Parameter

device

information block

sensor data

Definition Default
value

Enumerated list
of values /range

19 SNS_Volume

FlowLoSpan

(DD Name:

Volume Minimum

Span)

Volume flow minimum range Calc NA

20 SYS_BoardRevision Board Revision NA

21 SNS_Hart

DeviceID(0)

(DD Name:

Hart Device ID - 0)

Hart device ID. Mapped with
R122 of core

NA

22 SNS_Hart

DeviceID(1)

(DD Name:

Hart Device ID - 1)

Hart device ID. Mapped with
R122 of core

NA

23 PA_Preamble_Length Configures the device
preamble number

EIGHT_B
YTE = 3 ONE_BYTE = 0

TWO_BYTE = 1

FOUR_BYTE = 2

EIGHT_BYTE = 3

24 EMPTY

25 EMPTY

26 EMPTY

27 EMPTY

28 EMPTY
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Table F-43: Transducer block 2 device information block: sensor data - size, access,
and Modbus register columns

Index Parameter

device

information block

sensor data

Message

type

Data type/
structure

Size Store

/rate

(hz)

Access Modbus

register

/ coil

10 SNS_Sensor

SerialNum

(DD Name :
Sensor

Serial Number)

VARIABLE Unsigned32 4 N R/W R-0127-128

11 SNS_SensorType

(DD Name: Sensor

Model Number)

String OCTET

string

16 N-CP R/W R-0425

12 SNS_Sensor

TypeCode

(DD Name:

Sensor Type Code)

ENUM Unsigned16 2 N R/W R-1139

13 NS_SensorMaterial

(DD Name :

Sensor Material)

ENUM Unsigned16 2 N-CP R/W R-0130

14 SNS_LinerMaterial

(DD Name :

Sensor Liner)

ENUM Unsigned16 2 N-CP R/W R-0131

15 SNS_FlangeType

(DD Name :

Sensor Flange)

ENUM Unsigned16 2 N-CP R/W R-0129

16 SNS_MassFlow

LoSpan

(DD Name: Mass

Minimum Span)

VARIABLE Float 4 D R R-181-182
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Table F-43: Transducer block 2 device information block: sensor data - size, access,
and Modbus register columns (continued)

Index Parameter

device

information block

sensor data

Message

type

Data type/
structure

Size Store

/rate

(hz)

Access Modbus

register

/ coil

17 SNS_TempFlow

LoSpan

(DD Name: Temp

Minimum Span)

VARIABLE Float 4 D R R-183-184

18 SNS_DensityLoSpan

(DD Name:
Density

Minimum Span)

VARIABLE Float 4 D R R-185-186

19 SNS_VolumeFlow

LoSpan

(DD Name:
Volume

Minimum Span)

VARIABLE Float 4 D R R-187-188

20 SYS_BoardRevision VARIABLE Unsigned8 1 D R R-1163

21 SNS_Hart

DeviceID(0)

(DD Name:

Hart Device ID - 0)

VARIABLE Unsigned32 4 D R R-1187

22 SNS_Hart

DeviceID(1)

(DD Name:

Hart Device ID - 1)

VARIABLE Unsigned32 4 D R R-1188

23 PA_Preamble

_Length

Simple Unsigned8 1 N R/W R-7136

24 EMPTY 4

25 EMPTY 4

26 EMPTY 4
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Table F-43: Transducer block 2 device information block: sensor data - size, access,
and Modbus register columns (continued)

Index Parameter

device

information block

sensor data

Message

type

Data type/
structure

Size Store

/rate

(hz)

Access Modbus

register

/ coil

27 EMPTY 4

28 EMPTY 4

Transducer block 2 petroleum measurement: API process variables (29-37)

The first table focuses on definitions, default values, and the enumerated list of values
allowed for each parameter, while Table F-45 provides the Modbus register column and
other relevant values.

Table F-44: Transducer block 2 petroleum measurement: API process variables --
definitions, defaults, and range of values

Index Parameter

device

information

petroleum

measurement

API process

variables

Definition Default
value

Enumerated list
of values /range

29 SNS_API_CorrVolFlow

(DD Name :

PMI TC Volume Flow)

Temp Corrected Density ----

30 SNS_API_CorrVolFlow

(DD Name :

PMI TC Volume Flow)

Temp Corrected (Standard)
Volume Flow

---

31 SNS_API_Ave

CorrDensity

(DD Name : PM Batch

Weighted Average
Density)

Batch Weighted Average Density ---
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Table F-44: Transducer block 2 petroleum measurement: API process variables --
definitions, defaults, and range of values (continued)

Index Parameter

device

information

petroleum

measurement

API process

variables

Definition Default
value

Enumerated list
of values /range

32 SNS_API_AveCorrTemp

(DD Name : PM Batch

Weighted Average
Temperature)

Batch Weighted Average
Temperature

---

33 SNS_API_CTL

(DD Name :PM CTL)

CTL ---

34 SNS_API_CorrVolTotal

(DD Name :

PM TC Volume Total)

Temp Corrected (Standard)
Volume Total

0 N/A

35 SNS_API_CorrVolInv

(DD Name : PM TC

Volume Inventory)

Temp Corrected (Standard)
Volume Inventory

0 N/A

36 SNS_ResetApi

RefVolTotal

(DD Name : Reset PM

TC Volume Total)

Reset API Reference Volume Total -
0x00 = None

0x01 = Reset

37 SNS_Reset

APIGSVInv

(DD Name: Reset PM

Volume Inventory)

Reset API/GSV Inventory (“On” =
Reset, “Off” = N/A)

0x00
0x00 = No
effect

0x01 = Reset
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Table F-45: Transducer block 2 petroleum measurement: API process variables -- size,
access, and Modbus register columns

Index Parameter

device

information

petroleum

measurement

API process

variables

Message

type

Data type/
structure

Size Store/

rate

(hz)

Access Modbus

register

/ coil

29 SNS_API_

CorrDensity

(DD Name :

PMI TC Density)

RECORD 101 5 D R R-0325-326

30 SNS_API_

CorrVolFlow

(DD Name : PMI TC

Volume Flow)

RECORD 101 5 D R R-0331-332

31 SNS_API_

AveCorrDensity

(DD Name :

PM Batch

Weighted Average

Density)

RECORD 101 5 D R R-0337-338

32 SNS_API

_AveCorrTemp

(DD Name :

PM Batch

Weighted Average

Temperature)

RECORD 101 5 D R R-339-340

33 SNS_API_CTL

(DD Name : PM CTL)

RECORD 101 5 D R R-0329-330

34 SNS_API

_CorrVolTotal

(DD Name : PM TC

Volume Total)

VARIABLE 101 5 D/20 R R-0333-0334
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Table F-45: Transducer block 2 petroleum measurement: API process variables -- size,
access, and Modbus register columns (continued)

Index Parameter

device

information

petroleum

measurement

API process

variables

Message

type

Data type/
structure

Size Store/

rate

(hz)

Access Modbus

register

/ coil

35 SNS_API_CorrVolInv

(DD Name : PM TC

Volume Inventory)

VARIABLE 101 5 D/20 R R-0335-336

36 SNS_ResetApi

RefVolTotal

(DD Name : Reset

PM TC

Volume Total)

METHOD Unsigned8 1 D R/W Coil-0058

37 SNS_Reset

APIGSVInv

(DD Name: Rest
PM

Volume Inventory)

METHOD Unsigned8 1 D R/W Coil-0194

Transducer block 2 petroleum measurement: API setup data (38-46)

The first table focuses on definitions, default values, and the enumerated list of values
allowed for each parameter, while Table F-47 provides the Modbus register column and
other relevant values.
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Table F-46: Transducer block 2 petroleum measurement: API setup data -- definitions,
defaults, and range of values

Index Parameter

device

information

petroleum

measurement

API setup

data

Definition Default

value

Enumerated list

of values /range

38 SNS_APIRefTemp

(DD Name: PM

Reference Temp)

API Reference Temp 15.0
0 to 100

39 SNS_APITEC

(DD Name: PM

Thermal Expansion
Coeff)

API Thermal Expansion

Coeff

0.001 ≥ = 0.000485

40 SNS_API2540

TableType

(DD Name:
PM2540

CTL Table Type)

API 2540 CTLTable Type API_
TABLE_53A 17=Table 5A

18=Table 5B

19= Table 5D

36= Table 6C

49= Table 23A

50= Table 23B

51= Table 23D

68= Table 24C

81 = Table 53A

82 = Table 53B

83 = Table 53D

100 = Table 54C

41 EMPTY

42 EMPTY

43 EMPTY

44 EMPTY

45 EMPTY
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Table F-46: Transducer block 2 petroleum measurement: API setup data --
definitions, defaults, and range of values (continued)

Index Parameter

device

information

petroleum

measurement

API setup

data

Definition Default

value

Enumerated list

of values /range

46 EMPTY

Table F-47: Transducer block 2 petroleum measurement: API setup data -- size,
access, and Modbus register columns

Index Parameter

device

information

petroleum

measurement

API setup

data

Message

type

Data type/
structure

Size Store/

rate

(hz)

Access Modbus

register

/ coil

38 SNS_APIRefTemp

(DD Name: PM

Reference Temp)

VARIABLE Float 4 D R/W R-0319-0320

39 SNS_APITEC

(DD Name: PM

Thermal Expansion
Coeff)

VARIABLE Float 4 D R/W R-0323-0324

40 SNS_API2540

TableType

(DD Name:
PM2540

CTL Table Type)

ENUM Unsigned16 2 D R/W R-0351

41

42 EMPTY

43 EMPTY

44 EMPTY
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Table F-47: Transducer block 2 petroleum measurement: API setup data -- size,
access, and Modbus register columns (continued)

Index Parameter

device

information

petroleum

measurement

API setup

data

Message

type

Data type/
structure

Size Store/

rate

(hz)

Access Modbus

register

/ coil

45 EMPTY

46 EMPTY

Transducer block 2: concentration measurement -- CM process variables (47-53)

The first table focuses on definitions, default values, and the enumerated list of values
allowed for each parameter, while Table F-49 provides the Modbus register column and
other relevant values.

Table F-48: Transducer block 2: Concentration Measurement -- CM process variables
-- definitions, defaults, and range of values

Index Parameter

concentration

measurement

CM process

variables

Definition Default
value

Enumerated list

of values /range

47 SNS_ED_RefDens

(DD Name : CM Density

at Reference)

Density At Reference ----
RECORD

48 SNS_ED_SpecGrav

(DD Name :

CM Specific Gravity)

Density (Fixed SG Units) ----
RECORD

49 SNS_ED_StdVolFlow

(DD Name : CM TC

Volume Flow)

Standard Volume Flow Rate ----
RECORD

50 SNS_ED_NetMassFlow

(DD Name : CM Net

Mass Flow)

Net Mass Flow Rate ----
RECORD
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Table F-48: Transducer block 2: Concentration Measurement -- CM process variables
-- definitions, defaults, and range of values (continued)

Index Parameter

concentration

measurement

CM process

variables

Definition Default
value

Enumerated list

of values /range

51 SNS_ED_NetVolFlow

(DD Name : CM Net

Volume Flow)

Net Volume Flow Rate ----
RECORD

52 SNS_ED_Conc

(DD Name :

Concentration)

Concentration ----
RECORD

53 SNS_ED_SpecDens

(DD Name : CM Density
(Baume))

Density (Fixed Baume Units) ----
RECORD

Table F-49: Transducer block 2: Concentration Measurement -- CM process variables--
size, access, and Modbus register columns

Index Parameter

concentration

measurement

CM process

variables

Message

type

Data
type/
structure

Size Store

/rate

(hz)

Access Modbus

register

/ coil

47 SNS_ED_RefDens

(DD Name : CM Density

at Reference)

RECORD 101 5 D R R-0963

48 SNS_ED_SpecGrav

(DD Name :

CM Specific Gravity)

RECORD 101 5 D R R-0965

49 SNS_ED_StdVolFlow

(DD Name :

CM TC Volume Flow)

RECORD 101 5 D R R-0967

50 SNS_ED_NetMassFlow

(DD Name :

CM Net Mass Flow)

RECORD 101 5 D R R-0973
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Table F-49: Transducer block 2: Concentration Measurement -- CM process
variables-- size, access, and Modbus register columns (continued)

Index Parameter

concentration

measurement

CM process

variables

Message

type

Data
type/
structure

Size Store

/rate

(hz)

Access Modbus

register

/ coil

51 SNS_ED_NetVolFlow

(DD Name :

CM Net Volume Flow)

RECORD 101 5 D R R-0979

52 SNS_ED_Conc

(DD Name :

Concentration)

RECORD 101 5 D R R-0985

53 SNS_ED_SpecDens

(DD Name : CM Density

(Baume))

RECORD 101 5 D R R-0987

Transducer block 2: concentration measurement -- CM totals (54-65)

The first table focuses on definitions, default values, and the enumerated list of values
allowed for each parameter, while Table F-51 provides the Modbus register column and
other relevant values.

Table F-50: Transducer block 2: Concentration Measurement -- CM totals --
definitions, defaults, and range of values

Index Parameter

concentration

measurement

CM totals

Definition Default
value

Enumerated
list

of values /
range

54 SNS_ED_StdVolTotal

(DD Name : CM TC

Volume Total)

Standard Volume Total 0 NA

55 SNS_ED_StdVolInv

(DD Name : CM TC

Volume Inventory)

Standard Volume Inventory 0 NA

56 SNS_ED

_NetMassTotal

(DD Name : CM Net

Mass Total)

Net Mass Total 0 NA
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Table F-50: Transducer block 2: Concentration Measurement -- CM totals --
definitions, defaults, and range of values (continued)

Index Parameter

concentration

measurement

CM totals

Definition Default
value

Enumerated
list

of values /
range

57 SNS_ED_NetMassInv

(DD Name : CM Net

Mass Inventory)

Net Mass Inventory 0 NA

58 SNS_ED_NetVolTotal

(DD Name : CM Net

Volume Total)

Net Volume Total 0 NA

59 SNS_ED_NetVolInv
(DD Name : CM Net

Volume Inventory)

Net Volume Inventory 0 NA

60 SNS_Reset

EDRefVolTotal

(DD Name : Reset CM

TC Volume Total)

Reset ED Standard Volume
Total

-
0x00 = None

0x01 = Reset

61 SNS_Reset

EDNetMassTotal

(DD Name : Reset CM

Net Mass Total)

Reset ED Net Mass Total -
0x00 = None

0x01 = Reset

62 SNS_Reset

EDNetVolTotal

(DD Name : Reset CM

Net Volume Total)

Reset ED Net Volume Total -
0x00 = None

0x01 = Reset

63 SNS_ResetEDVolInv

(DD Name: Reset Volume

Inventory At Reference
Temp)

Reset ED Volume Inventory
(“On” = Reset, “Off” = N/A) 0x00 =

No Effect

0x01 = Reset

64 SNS_Reset

EDNetMassInv

(DD Name: Reset Net

Mass Inventory)

Reset ED Net Mass Inventory
(“On” = Reset, “Off” = N/A) 0x00 =

No Effect

0x01 = Reset
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Table F-50: Transducer block 2: Concentration Measurement -- CM totals --
definitions, defaults, and range of values (continued)

Index Parameter

concentration

measurement

CM totals

Definition Default
value

Enumerated
list

of values /
range

65 SNS_Reset

EDNetVolInv

(DD Name: Reset Net

Volume Inventory)

Reset ED Net Volume Inventory
(“On” = Reset, “Off” = N/A) 0x00 =

No Effect

0x01 = Reset

Table F-51: Transducer block 2: Concentration Measurement -- CM totals -- size,
access, and Modbus register columns

Index Parameter

concentration

measurement

CM totals

Message

type

Data type/
structure

Size Store/
rate (hz)

Access Modbus

register

/ coil

54 SNS_ED_StdVolTotal

(DD Name : CM TC

Volume Total)

VARIABLE Float 4 D/20 R R-0969

55 SNS_ED_StdVolInv

(DD Name : CM TC

Volume Inventory)

VARIABLE Float 4 D/20 R R-0971

56 SNS_ED

_NetMassTotal

(DD Name : CM Net

Mass Total)

VARIABLE Float 4 D/20 R R-0975

57 SNS_ED_NetMassInv

(DD Name : CM Net

Mass Inventory)

VARIABLE Float 4 D/20 R R-0977

58 SNS_ED_NetVolTotal

(DD Name : CM Net

Volume Total)

VARIABLE Float 4 D/20 R R-0981
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Table F-51: Transducer block 2: Concentration Measurement -- CM totals -- size,
access, and Modbus register columns (continued)

Index Parameter

concentration

measurement

CM totals

Message

type

Data type/
structure

Size Store/
rate (hz)

Access Modbus

register

/ coil

59 SNS_ED_NetVolInv

(DD Name : CM Net

Volume Inventory)

VARIABLE Float 4 D/20 R R-0983

60 SNS_Reset

EDRefVolTotal

(DD Name : Reset
CM

TC Volume Total)

METHOD Unsigned8 1 S R/W Coil-0059

61 SNS_Reset

EDNetMassTotal

(DD Name : Reset
CM

Net Mass Total)

METHOD Unsigned8 1 S R/W Coil-0060

62 SNS_Reset

EDNetVolTotal

(DD Name : Reset
CM

Net Volume Total)

METHOD Unsigned8 1 S R/W Coil-0060

63 SNS_ResetEDVolInv

(DD Name: Reset

Volume Inventory

At Reference
Temp)

METHOD Unsigned8 1 S R/W Coil-0195

64 SNS_Reset

EDNetMassInv

(DD Name: Reset
Net

Mass Inventory)

METHOD Unsigned8 1 S R/W Coil-0196
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Table F-51: Transducer block 2: Concentration Measurement -- CM totals -- size,
access, and Modbus register columns (continued)

Index Parameter

concentration

measurement

CM totals

Message

type

Data type/
structure

Size Store/
rate (hz)

Access Modbus

register

/ coil

65 SNS_Reset

EDNetVolInv

(DD Name: Reset
Net

Volume Inventory)

METHOD Unsigned8 1 S R/W Coil-0197

Transducer block 2: concentration measurement -- CM setup data (66-102)

The first table focuses on definitions, default values, and the enumerated list of values
allowed for each parameter, while Table F-53 provides the Modbus register column and
other relevant values.

Table F-52: Transducer block 2: Concentration Measurement -- CM setup data--
definitions, defaults, and range of values

Index Parameter

concentration

measurement

CM setup data

Definition Default

value

Enumerated list

of values /range

66 SNS_ED_CurveLock

(DD Name:

Lock/Unlock

ED Curves)

Lock Enhanced Density
Tables

1
0x00 = not locked

0x01 = locked
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Table F-52: Transducer block 2: Concentration Measurement -- CM setup data--
definitions, defaults, and range of values (continued)

Index Parameter

concentration

measurement

CM setup data

Definition Default

value

Enumerated list

of values /range

67 SNS_ED_Mode

(DD Name:

Derived Variable)

Enhanced Density Mode Mass Conc.
(Dens) 0 = None

1= Dens @ Ref
Temp

2= Specific Gravity

3= Mass Conc
(Dens)

4=Mass Conc (SG)

5= Volume Conc
(Dens)

6= Volume Conc
(SG)

7= Concentration
(Dens)

8 = Concentration
(SG)

68 SNS_ED_ActiveCurve

(DD Name: Active

Calculation Curve)

Active Calculation Curve 0
0 through 5

69 UNI_ED_CurveIndex

(DD Name:

Curve Configured)

Curve Configuration
Index (n)

---
0 through 5

70 UNI_ED_TempIndex

(DD Name:

Curve Temperature
Isotherm Index

(X-Axis))

Curven Temperature
Isotherm

Index (x-axis)

---
0 through 5
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Table F-52: Transducer block 2: Concentration Measurement -- CM setup data--
definitions, defaults, and range of values (continued)

Index Parameter

concentration

measurement

CM setup data

Definition Default

value

Enumerated list

of values /range

71 UNI_ED_ConcIndex

(DD Name:

Curve Concentration
Index (Y-Axis))

Curven Concentration
Index

(y-axis)

---
0 through 5

72 SNS_ED_TempISO

(DD Name:

Curve N (6*5)

Temp Isotherm X

Value (X-Axis))

Curven (6x5)

Temperature
Isothermx

Value (x-axis)

--- N/A

73 SNS_ED

_DensAtTempISO

(DD Name:

Curve N (6*5)

Density @ Temp

Isotherm X,

Concentration Y)

Curven (6x5)

Density @
Temperature
IsothermX,

ConcentrationY

--- N/A

74 SNS_ED

_DensAtTempCoeff

(DD Name:

Curve N (6*5)

Coeff @ Temp

Isotherm X,

Concentration Y)

Curven (6x5)

Coeff @ Temperature
IsothermX,

ConcentrationY

--- N/A

75 SNS_ED_ConcLabel55

(DD Name:

Curve N (6*5)

Concentration Y Value

(Label For Y-Axis))

Curven (6x5)

ConcentrationY Value

(Label for y-axis)

--- N/A
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Table F-52: Transducer block 2: Concentration Measurement -- CM setup data--
definitions, defaults, and range of values (continued)

Index Parameter

concentration

measurement

CM setup data

Definition Default

value

Enumerated list

of values /range

76 SNS_ED_DensAtConc

(DD Name:

Curve N (5*1) Density

@ Concentration Y

(At Ref Temp))

Curven (5x1) Density

at ConcentrationY (at
Ref Temp)

--- N/A

77 SNS_ED

_DensAtConcCoeff

(DD Name:

Curve N (5*1) Coeff

@ Concentration Y

(At Ref Temp))

Curven (5x1) Coeff

at ConcentrationY (at
Ref Temp)

--- N/A

78 SNS_ED_ConcLabel51

(DD Name:

Curve N (5*1)

Concentration Y

Value (Y-Axis))

Curven (5x1)
ConcentrationY Value (y-
axis))

--- N/A

79 SNS_ED_RefTemp

(DD Name: Curve N

Reference

Temperature)

Curven Reference
Temperature

--- Temp. sensor Limits

80 SNS_ED

_SGWaterRefTemp

(DD Name: Curve N

Water Reference

Temperature)

Curven SG Water
Reference Temperature

--- Temp. sensor Limits

81 SNS_ED

_SGWaterRefDens

(DD Name: Curve N

Water Reference

Density)

Curven SG Water
Reference Density

--- Density Limits
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Table F-52: Transducer block 2: Concentration Measurement -- CM setup data--
definitions, defaults, and range of values (continued)

Index Parameter

concentration

measurement

CM setup data

Definition Default

value

Enumerated list

of values /range

82 SNS_ED_SlopeTrim

(DD Name:

Curve N Trim Slope)

Curven Slope Trim --- 0.8 to 1.2

83 SNS_ED_OffsetTrim

(DD Name:

Curve N Trim Offset)

Curven Offset Trim --- None

84 SSNS_ED

_ExtrapAlarmLimit

(DD Name: Curve N

Alarm Limit (%))

Curven Extrapolation
Alarm Limit: %

--- 0 to 270

85 SNS_ED_CurveName

(DD Name: Curve N

Curve Name

Curven ASCII String –
Name of Curve

– 12 chars supported

--- N/A

86 SNS_ED_MaxFitOrder

(DD Name: Curve Fit

Max Order)

Maximum Fit Order for
5x5 curve

--- 2, 3, 4, 5

87 SNS_ED_FitResults

(DD Name: Curve N

Fit Results)

Curven Curve Fit Results ---
0 = Good

1 = Poor

2 = Failed

3 = Empty
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Table F-52: Transducer block 2: Concentration Measurement -- CM setup data--
definitions, defaults, and range of values (continued)

Index Parameter

concentration

measurement

CM setup data

Definition Default

value

Enumerated list

of values /range

88 SNS_ED

_ConcUnitCode

(DD Name: Curve N

Concentration Units)

Curven Concentration
Units Code

---
1110 = Degrees
Twaddell

1426= Degrees
Brix

1111= Deg Baume
(heavy)

1112= Deg Baume
(light)

1343=% sol/wt

1344=% sol/vol

1427= Degrees

Balling

1428= Proof

Per Volume

1429 = Proof

Per mass

1346 = Percent
Plato

89 SNS_ED_ExpectedAcc

(DD Name: Curve N

Curve Fit

Expected Accuracy)

Curven Curve Fit
Expected Accuracy

---

90 SNS_ED_ResetFlag

(DD Name: Reset

All Curve Information)

Reset All Enhanced
Density Curve
Information

1
0x00 = Not used

0x01 =Reset

91 SNS_ED_Enable

DensLowExtrap

(DD Name: Enable
Density Low)

Enable Dens Low
Extrap

(Enhanced Density
Extrap Alarm)

1
0x00 = Disable

0x01 = Enable
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Table F-52: Transducer block 2: Concentration Measurement -- CM setup data--
definitions, defaults, and range of values (continued)

Index Parameter

concentration

measurement

CM setup data

Definition Default

value

Enumerated list

of values /range

92 SNS_ED_Enable

DensHighExtrap

(DD Name: Enable
Density High)

Enable Dens High
Extrap

(Enhanced Density
Extrap Alarm)

1
0x00 = Disable

0x01 = Enable

93 SNS_ED_Enable

TempLowExtrap

(DD Name:

Enable Temperature
Low)

Enable Temp Low
Extrap

(Enhanced Denisty
Extrap Alarm)

1
0x00 = Disable

0x01 = Enable

94 SNS_ED_Enable

TempHighExtrap

(DD Name:

Enable Temperature
High)

Enable Temp High
Extrap

(Enhanced Denisty
Extrap Alarm)

1
0x00 = Disable

0x01 = Enable

95 DB_SNS_Puck

DeviceTypeCode

(DD Name: Puck

Device Type)

Device Type Code for
attached Core 40 = 700 CP

50 = 80 CP

96 SNS_ED_ConcUnits Curven Concentration
Units

{‘N’,’O’,’N’,’E’
,’ ‘,’ ‘,’ ‘,’ ‘}

N/A

97 SNS_MflowText Special unit massflow
text

{‘N’,’O’,’N’,’E’
,’ ‘,’ ‘,’ ‘,’ ‘}

N/A

98 SNS_MtotText Special unit massTotal
text

{‘N’,’O’,’N’,’E’
,’ ‘,’ ‘,’ ‘,’ ‘}

N/A

99 SNS_VflowText Special unit Volume Flow
text

{‘N’,’O’,’N’,’E’
,’ ‘,’ ‘,’ ‘,’ ‘}

N/A

100 SNS_VtotText Special unit Volume text {‘N’,’O’,’N’,’E’
,’ ‘,’ ‘,’ ‘,’ ‘}

N/A

101 SNS_GSVflowText Special unit GSV Volume
Flow text

{‘N’,’O’,’N’,’E’
,’ ‘,’ ‘,’ ‘,’ ‘}

N/A
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Table F-52: Transducer block 2: Concentration Measurement -- CM setup data--
definitions, defaults, and range of values (continued)

Index Parameter

concentration

measurement

CM setup data

Definition Default

value

Enumerated list

of values /range

102 SNS_GSVtotText Special unit Volume
Total text

{‘N’,’O’,’N’,’E’
,’ ‘,’ ‘,’ ‘,’ ‘}

N/A

103 SNS_StartStopTotals

(DD Name:

Start/Stop

All Totalizers)

Start/Stop all Totalizers 0x01
0x00 = Stop Totals

0x01 = Start Totals

104 SNS_ResetAllTotal Reset all totals -
0x00 = None

0x01 = Reset

105 SNS_Reset

AllInventories

Reset all Inventories -
0x00 = None

0x01 = Reset

106 SNS_ResetMassTotal

(DD Name:

Reset Mass Total)

Reset Mass Total -
0x00 = None

0x01 = Reset

107 SNS_ResetLineVolTotal

(DD Name:

Reset Volume Total)

Reset Volume Total -
0x00 = None

0x01 = Reset

108 EMPTY

109 Transducer Block 2

View 1
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Table F-53: Transducer block 2: Concentration Measurement -- CM setup data -- size,
access, and Modbus register columns

Index Parameter

concentration

measurement

CM setup data

Message

type

Data type/
structure

Size Store/
rate

(hz)

Access Modbus

register /
coil

66 SNS_ED_CurveLock

(DD Name:

Lock/Unlock

ED Curves)

ENUM Unsigned8 1 S R/W Coil-0085

67 SNS_ED_Mode

(DD Name:

Derived Variable)

ENUM Unsigned16 2 N-CP R/W R-0524

68 SNS_ED

_ActiveCurve

(DD Name: Active

Calculation Curve)

VARIABLE Unsigned16 2 N-CP R/W R-0523

69 UNI_ED_CurveIndex

(DD Name:

Curve Configured)

VARIABLE Unsigned8 1 D R/W R-0527

70 UNI_ED_TempIndex

(DD Name:

Curve
Temperature

Isotherm Index

(X-Axis))

VARIABLE Unsigned8 1 D R/W R-0528

71 UNI_ED_ConcIndex

(DD Name:

Curve
Concentration

Index (Y-Axis))

VARIABLE Unsigned8 1 D R/W R-0529
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Table F-53: Transducer block 2: Concentration Measurement -- CM setup data -- size,
access, and Modbus register columns (continued)

Index Parameter

concentration

measurement

CM setup data

Message

type

Data type/
structure

Size Store/
rate

(hz)

Access Modbus

register /
coil

72 SNS_ED_TempISO

(DD Name: Curve N

(6*5) Temp

Isotherm X

Value (X-Axis))

VARIABLE Float 4 N-CP R/W R-0531

73 SNS_ED

_DensAtTempISO

(DD Name: Curve N

(6*5) Density

@ Temp Isotherm X,

Concentration Y)

VARIABLE Float 4 N-CP R/W R-0533

74 SNS_ED_Dens

AtTempCoeff

(DD Name: Curve N
(6*5)

Coeff @ Temp

Isotherm X,

Concentration Y)

VARIABLE Float 4 D R R-0535

75 SNS_ED

_ConcLabel55

(DD Name: Curve N
(6*5)

Concentration Y

Value

(Label For Y-Axis))

VARIABLE Float 4 N-CP R/W R-0537

76 SNS_ED

_DensAtConc

(DD Name: Curve N

(5*1) Density

@ Concentration Y

(At Ref Temp))

VARIABLE Float 4 N-CP R/W R-0539
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Table F-53: Transducer block 2: Concentration Measurement -- CM setup data -- size,
access, and Modbus register columns (continued)

Index Parameter

concentration

measurement

CM setup data

Message

type

Data type/
structure

Size Store/
rate

(hz)

Access Modbus

register /
coil

77 SNS_ED_Dens

AtConcCoeff

(DD Name: Curve N

(5*1) Coeff

@ Concentration Y

(At Ref Temp))

VARIABLE Float 4 D R R-0541

78 SNS_ED

_ConcLabel51

(DD Name: Curve N

(5*1)

Concentration Y

Value (Y-Axis))

VARIABLE Float 4 N-CP R/W R-0543

79 SNS_ED_RefTemp

(DD Name: Curve N

Reference

Temperature)

VARIABLE Float 4 N-CP R/W R-0545

80 SNS_ED_SG

WaterRefTemp

(DD Name: Curve N

Water Reference
Temperature)

VARIABLE Float 4 N-CP R/W R-0547

81 SNS_ED_SG

WaterRefDens

(DD Name: Curve N

Water Reference
Density)

VARIABLE Float 4 N-CP R/W R-0549

82 SNS_ED_SlopeTrim

(DD Name:

Curve N Trim Slope)

VARIABLE Float 4 N-CP R/W R-0551
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Table F-53: Transducer block 2: Concentration Measurement -- CM setup data -- size,
access, and Modbus register columns (continued)

Index Parameter

concentration

measurement

CM setup data

Message

type

Data type/
structure

Size Store/
rate

(hz)

Access Modbus

register /
coil

83 SNS_ED_OffsetTrim

(DD Name:

Curve N Trim Offset)

VARIABLE Float 4 N-CP R/W R-0553

84 SSNS_ED

_ExtrapAlarmLimit

(DD Name: Curve N

Alarm Limit (%))

VARIABLE Float 4 N-CP R/W R-0555

85 SNS_ED_CurveName

(DD Name: Curve N

Curve Name

VARIABLE OCTET
string

12 N-CP R/W R-2771-
2776

86 SNS_ED

_MaxFitOrder

(DD Name:

Curve Fit Max Order)

VARIABLE Unsigned16 2 N-CP R/W R-0564

87 SNS_ED_FitResults

(DD Name: Curve N

Fit Results)

ENUM Unsigned16 2 D R R-0569

88 SNS_ED

_ConcUnitCode

(DD Name: Curve N

Concentration Units)

ENUM Unsigned16 2 N-CP R/W R-0570

89 SNS_ED

_ExpectedAcc

(DD Name: Curve N

Curve Fit

Expected Accuracy)

VARIABLE Float 4 D R R-0571

90 SNS_ED_ResetFlag

(DD Name: Reset

All Curve

Information)

METHOD Unsigned8 1 N-CP R/W Coil-249
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Table F-53: Transducer block 2: Concentration Measurement -- CM setup data -- size,
access, and Modbus register columns (continued)

Index Parameter

concentration

measurement

CM setup data

Message

type

Data type/
structure

Size Store/
rate

(hz)

Access Modbus

register /
coil

91 SNS_ED_Enable

DensLowExtrap

(DD Name:

Enable Density
Low)

METHOD Unsigned8 1 N-CP R/W Coil-250

92 SNS_ED_Enable

DensHighExtrap

(DD Name:

Enable Density
High)

METHOD Unsigned8 1 N-CP R/W Coil-251

93 SNS_ED_Enable

TempLowExtrap

(DD Name:

Enable
Temperature Low)

METHOD Unsigned8 1 N-CP R/W Coil-252

94 SNS_ED_Enable

TempHighExtrap

(DD Name:

Enable
Temperature
High)

METHOD Unsigned8 1 N-CP R/W Coil-253

95 DB_SNS_Puck

DeviceTypeCode

(DD: Name: Puck

Device Type)

VARIABLE Unsigned16 2 D/20 R R-1162

96 SNS_ED_ConcUnits VARIABLE String 8 N-CP R/W R- 573-576

97 SNS_MflowText String OCTET
STRING

8 N R/W R-52-55

98 SNS_MtotText String OCTET
string

8 N R/W R-56-59
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Table F-53: Transducer block 2: Concentration Measurement -- CM setup data -- size,
access, and Modbus register columns (continued)

Index Parameter

concentration

measurement

CM setup data

Message

type

Data type/
structure

Size Store/
rate

(hz)

Access Modbus

register /
coil

99 SNS_VflowText String OCTET
string

8 N R/W R- 60-63

100 SNS_VtotText String OCTET
string

8 N R/W R-64-67

101 SNS_GSVflowText String OCTET
string

8 N R/W R2607-2610

102 SNS_GSVtotText String OCTET
string

8 N R/W R2611-2614

103 SNS_StartStopTotals

DD Name:

Start/Stop

All Totalizers

METHOD Unsigned8 1 D R/W Coil-0002

104 SNS_ResetAllTotal METHOD Unsigned8 1 D R/W Coil-0003

105 SNS_Reset

AllInventories

METHOD Unsigned8 1 D R/W Coil-0004

106 SNS_ResetMassTotal

DD Name:

Reset Mass Total

METHOD Unsigned8 1 D R/W Coil-0056

107 SNS_Reset

LineVolTotal

DD Name:

Reset Volume Total

METHOD Unsigned8 1 D R/W Coil-0057

108 EMPTY

109 Transducer Block 2

View 1

F.2.6 Transducer block 2 object and views
The following tables show the transducer block 2 object and views.

Transducer block 2 object

• Transducer block 2 object:: Table F-54
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• Transducer block 2 view #1: Table F-55
• Transducer block 2 view #2: Table F-56

Table F-54: Transducer block 2 object

Slot/
Index

Element name Data type Size

in

bytes

Value

Slot 12/
Index 0

Reserved Unsigned 8 1 250 (default)

Block_Object Unsigned 8 1 03

Parent_Class Unsigned 8 1 03

Class Unsigned 8 1 128

(manufacturer-specific class)

DD_Reference Unsigned 32 4 00 ,00, 00, 00 (reserved)

DD_Revision Unsigned 16 2 00 ,00 (reserved)

Profile Octet string 2 64 02 (compact class B)

Profile_Revision Unsigned 16 2 03 01 (3.01)

Execution_Time Unsigned 8 1 00 (for future use)

Number-Of_Parameters Unsigned 16 2 00 98( Maximum number of
Transducer Block 2 Parameters)

Address_of_View_1 Unsigned 16 2 12 98 (slot, index)

Number_of_Views Unsigned 8 1 01 (1 view)

Transducer block 2 (device information, API, and CM) views

The following tables show the views for transducer block 2.

Table F-55: Transducer block 2 view #1 -- standard parameters

OD index Parameter mnemonic

-- standard parameters

View 1 View 2 View 3 View 4

0 BLOCK_OBJECT

1 ST_REV 2

2 TAG_DESC

3 STRATEGY

4 ALERT_KEY

5 TARGET_MODE

6 MODE_BLK 3
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Table F-55: Transducer block 2 view #1 -- standard parameters (continued)

OD index Parameter mnemonic

-- standard parameters

View 1 View 2 View 3 View 4

7 ALARM_SUM 8

Overall sum of bytes in View Object 13

Table F-56: Transducer block 2 view #2 -- standard parameters

OD index Parameter mnemonic

-- standard parameters

View 1 View 2 View 3 View 4

98 Overall sum of bytes in View Object

(+ 13 Standard parameters bytes)

13

F.2.7 I & M functions
The following tables show the parameters for I & M functions.

I & M IM-Default parameter

The following tables show the values for the IM-Default parameter. The first table focuses
on definitions, default values, and the enumerated list of values allowed, while Table F-58
provides the Modbus register column and other relevant values.

Note
The index entry for all items in this topic is 255.

Table F-57: I & M values for IM-Default parameter -- definitions, defaults, and range of
values in sub-index 65000

Definition
I&M 0

(Mandatory)

Default value

---

Enumerated

list

of values

/range

HEADER -Reserved 0x00 ---

MANUFACTURER_ID – Identification code

of the Manufacturer of the PA Device

0x00 ---

ORDER_ID –Order No. of the Device 2700S Profibus PA ---

SERIAL_NO –Production Serial No. of the device ---- ---

HARDWARE_REVISION –Revision No. of the Hardware 0xFFFF ---

SOFTWARE_REVISION –Software or Firmware revision ---- ---
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Table F-57: I & M values for IM-Default parameter -- definitions, defaults, and range
of values in sub-index 65000 (continued)

Definition
I&M 0

(Mandatory)

Default value

---

Enumerated

list

of values

/range

REV_COUNTER – According to /I&M/. The REV_COUNTER
is incremented if a parameter content with static attribute
in the according slot has Changed. Slot 0 carries a
REV_COUNTER that counts all changes of static
parameters of the whole device.

0 ---

PROFILE_ID –Profile type of supporting Profile 0x9700 ---

PROFILE_SPECIFIC_TYPE –Specific Profile Type
0x01

0x01

---

M_VERSION –Implemented version of I & M function
0x01

0x01

---

IM_SUPPORTED –Indicated Availability of I & M Records
0x00

0x07

---

Table F-58: I & M values for IM-Default parameter -- size, access, and Modbus register
columns in sub-index 65000

Definition

I&M 0

(Mandatory)

Message

type

VARIABLE

Data type/

structure

OCTET string

Size

64

Store
/rate
(hz)

Access

R

Modbus

register / coil

--

HEADER String
Octet

string

10 S R Hard Coded

MANUFACTURER_ID VARIABLE Unsigned16 2 S R
Physical Block

Index 26

DEVICE_MAN_ID

ORDER_ID String
Visible

string

20 S R R 2545 – 2554
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Table F-58: I & M values for IM-Default parameter -- size, access, and Modbus register
columns in sub-index 65000 (continued)

Definition

I&M 0

(Mandatory)

Message

type

VARIABLE

Data type/

structure

OCTET string

Size

64

Store
/rate
(hz)

Access

R

Modbus

register / coil

--

SERIAL_NO. String
Visible

string

16 S R
Physical Block

Index 28

– DEVICE_SER_NUM

HARDWARE

_REVISION

VARIABLE Unsigned16 2 S R 0xFFFF

SOFTWARE

_REVISION

VARIABLE
1Char

3 Unsigned8

4 S R
V 0xFF

0xFF

0xFF

REV_COUNTER VARIABLE Unsigned16 2 S R
Sum of ST_REV

of all Blocks such as:

TB1 + TB2+

AI1+AI2

+AI3+AI4+

TOT1+TOT2

+TOT3+TOT4 +

AO1+AO2

PROFILE_ID VARIABLE Unsigned16 2 S R Hard Coded

PROFILE_SPECIFIC_TY
PE

VARIABLE
Octet

string

2 S R
Byte 0:BLOCK

_OBJECT.BlockObje
ct

Byte
1:BLOCK_OBJECT

.ParentClass

M_VERSION VARIABLE
2 –

Unsigned8

2 S R Hard Coded
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Table F-58: I & M values for IM-Default parameter -- size, access, and Modbus register
columns in sub-index 65000 (continued)

Definition

I&M 0

(Mandatory)

Message

type

VARIABLE

Data type/

structure

OCTET string

Size

64

Store
/rate
(hz)

Access

R

Modbus

register / coil

--

IM_SUPPORTED VARIABLE
Octet

string

2 S R Hard Coded

I & M values for IM-1 parameter

The following tables show the values for the IM-1 parameter. The first table focuses on
definitions, default values, and the enumerated list of values allowed, while Table F-60
provides the Modbus register column and other relevant values.

Note
The index entry for all items in this topic is 255.

Table F-59: I & M values for IM-1 parameter -- definitions, defaults, and range of
values in sub-index 65001

Definition
I&M 1 (Mandatory)

Default value

---

Enumerated list of
values /range

HEADER -Manufacture Specific 0x00 ----

TAG_FUNCTION –Device Identification Tag
Blank

0x20

---

TAG LOCATION –Device Identification Tag
Blank

0x20

---

Table F-60: I & M values for IM-1 parameter -- size, access, and Modbus register
columns in sub-index 65001

Definition

I&M 1 (Mandatory)

Message

type

VARIABLE

Data type/
structure

OCTET string

Size Store/

rate

(hz)

Access

R

Modbus

register

/ coil

--

HEADER -

Manufacture Specific

String OCTET string 10 S R Hard

Coded
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Table F-60: I & M values for IM-1 parameter -- size, access, and Modbus register
columns in sub-index 65001 (continued)

Definition

I&M 1 (Mandatory)

Message

type

VARIABLE

Data type/
structure

OCTET string

Size Store/

rate

(hz)

Access

R

Modbus

register

/ coil

--

TAG_FUNCTION

–Device

Identification Tag

String Visible string 32 S R
Physical

Block

Index 18

TAG_DESC

TAG LOCATION

–Device

Identification Tag

String Visible string 22 S R Hard

Coded

I & M values for IM-2 parameter

The following tables show the values for the IM-2 parameter. The first table focuses on
definitions, default values, and the enumerated list of values allowed, while Table F-62
provides the Modbus register column and other relevant values.

Note
The index entry for all items in this topic is 255.

Table F-61: I & M values for IM-2 parameter -- definitions, defaults, and range of
values in sub-index 65002

Definition
I&M 2 (Mandatory)

Default value

---

Enumerated list

of values /range

HEADER -Manufacture Specific 0x00 ----

Date – Date of installation of PA Device
Blank

0x20

---

Reserved 0x00 ----
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Table F-62: I & M values for IM-2 parameter -- size, access, and Modbus register
columns in sub-index 65002

Definition

I&M 2 (Mandatory)

Message

type

VARIABLE

Data
type/
structure

OCTET
string

Size Store/
rate
(hz)

Access

R

Modbus

register

/ coil

--

HEADER

-Manufacture

Specific

String OCTET
string

10 S R Hard Coded

Date

–Date

of installation

of PA Device

String Visible
string

16 S R
Physical Block

Index 38

DEVICE

_INSTALL_DATE

Reserved
String OCTET

string
38 S R ---

I & M values for the PA_IM_0 parameter

The following tables show the values for the PA_IM_0 parameter. The first table focuses on
definitions, default values, and the enumerated list of values allowed, while Table F-64
provides the Modbus register column and other relevant values.

Note
The index entry for all items in this topic is 255.

Table F-63: I & M values for PA_IM_0 parameter -- definitions, defaults, and range of
values in sub-index 65016

Definition Default

value

Enumerated list

of values /range

Header – Reserved
0x00

Hard Coded

PA_IM_VERSION – Version of the process device profile specific
extensions of I&M

Octet 1 (MSB) = major version number, for example 1 of version
1.0

Octet 2 (LSB) = minor version number, for example 0 of version
1.0

0x01

0x00

Hard Coded

HARDWARE_REVISION – Hardware Revision according to Physical
Component Blank Physical Block

– Index-25
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Table F-63: I & M values for PA_IM_0 parameter -- definitions, defaults, and range of
values in sub-index 65016 (continued)

Definition Default

value

Enumerated list

of values /range

SOFTWARE_REVISON – Firmware Revision of the according
Physical Component Blank Physical Block

– Index-24

Reserved

PA_IM_SUPPORTED
0x00

0x00

Hard Coded

Table F-64: I & M values for PA_IM_0 parameter -- size, access, and Modbus register
columns in sub-index 65016

Definition

I&M 2

Message

type

Data type

/ structure

Size Store

/rate

(hz)

Access Modbus

register

/ coil

--

Header – Reserved String OCTET
string

10 S R Hard Coded

PA_IM_VERSION VARIABLE Unsigned8 2 S R Hard Coded

HARDWARE

_REVISION

String Visible
string

16 S R
Physical Block

Index 25

SOFTWARE

_REVISON

String Visible
string

16 S R
Physical Block

Index 24

Reserved 18

PA_IM

_SUPPORTED

String OCTET
string

2 S R Hard Coded

F.2.8 Analog Input (AI) function block parameters
The following tables show the parameters for AI function block.

AI standard PA parameters (16-25)

The following tables show the parameters for the AI standard PA parameters (16-25). The
first table focuses on definitions, default values, and the enumerated list of values allowed
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for each parameter, while Table F-66 provides the Modbus register column and other
relevant values.

Table F-65: AI function block standard PA parameters -- definitions, defaults, and
range of values

Index Parameter

Mnemonic

Standard

Parameters

Definition Default
value

Enumerated list
of values /range

16 BLOCK_OBJECT This object contains the characteristics
of the block.

---- NA

17 ST_REV A block has static block parameters
that are not changed by the process.
Values are assigned to this parameter
during the configuration of
optimization. The value of ST_REV
increases by 1 after every change of a
static block parameter.

0 NA

18 TAG_DESC Every block can be assigned a textual
TAG description. The TAG_DESC must
be unambiguous and unique in the
field bus system.

' ' NA

19 STRATEGY Grouping of function block. The
STRATEGY field can be used to group
blocks.

0 NA

20 ALERT_KEY This parameter contains the
identification number of the plant unit.

0 NA

21 TARGET_MODE This parameter contains desired mode
normally set by a control application of
an operator. The modes are valid
alternatively only; for example,only
one mode can be set at one time. A
write access to this parameter with
more than one mode is out of the
range of the parameter and has to be
rejected.

AUTO
(0x08) 0x8 -- Auto

0x10 – Manual

0x80 – Out of
Service

22 MODE_BLK This parameter contains the current
mode and the permitted and normal
mode of the block.

---- NA

23 ALARM_SUM This parameter contains the current
states of the block alarms.

0,0,0,0 NA

24 BATCH This parameter is intended to be used
in Batch applications in line with IEC
61512 Part1. Only Function Blocks
carry this parameter. There is no
algorithm necessary within a Function
Block.

0,0,0,0 NA
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Table F-65: AI function block standard PA parameters -- definitions, defaults, and
range of values (continued)

Index Parameter

Mnemonic

Standard

Parameters

Definition Default
value

Enumerated list
of values /range

25 Reserved

Table F-66: AI block standard PA parameters -- size, access, and Modbus register
columns

Index Parameter

Mnemonic

Standard

Parameters

Message

type

Data type/
structure

Size Store/
rate

(hz)

Access Modbus
register /
coil

16 BLOCK_OBJECT RECORD DS-32 20 Cst R NA

17 ST_REV SIMPLE Unsigned16 2 N R NA

18 TAG_DESC SIMPLE OCTET

string

32 S R/W NA

19 STRATEGY SIMPLE Unsigned16 2 S R/W NA

20 ALERT_KEY SIMPLE Unsigned8 1 S R/W NA

21 TARGET_MODE SIMPLE Unsigned8 1 S R/W R-1506

22 MODE_BLK RECORD DS-37 3 D R R-1507

23 ALARM_SUM RECORD DS-42 8 D R NA

24 BATCH RECORD DS-67 10 S R/W NA

25 RESERVED

AI function block standard parameters (26-61)

The following tables show the parameters for the AI function block parameters (26-61).
The first table focuses on definitions, default values, and the enumerated list of values
allowed for each parameter, while Table F-68 provides the Modbus register column and
other relevant values.
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Table F-67: AI function block standard parameters -- definitions, defaults, and range
of values

Index Parameter

device

information

block

transmitter

data

Definition Default
value

Enumerated list
of values /range

26 OUT

(DD Name: AI Out)

The Function Block parameter OUT
contains the current measurement
value in a vendor-specific or
configuration-adjusted engineering
unit and the belonging state in AUTO
MODE. The Function Block parameter
OUT contains the value and status set
by an operator in MAN MODE.

---- NA

27 PV_SCALE

(DD Name:

AI PV Scale)

Conversion of the Process Variable
into percent using the high and low
scale values.

100.00 NA

28 OUT_SCALE

(DD Name:

AI Out Scale)

Scale of the Process Variable 100.00 NA

29 LIN_TYPE

(DD Name:

AI Linearization
Type)

Type linearization. 1 NA

30 CHANNEL

(DD Name:

AI Channel)

Reference to the active Transducer
Block which provides the
measurement value to the Function
Block.

--- NA

31 Reserved

32 PV_FTIME

(DD Name:

AI PV Filter Time)

Filter time of the Process Variable. 0 NA

33 Reserved

34 Reserved
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Table F-67: AI function block standard parameters -- definitions, defaults, and range
of values (continued)

Index Parameter

device

information

block

transmitter

data

Definition Default
value

Enumerated list
of values /range

35 ALARM_HYS

(DD Name:

AI Alarm Hys)

Hysteresis 0.5% of
the
range

N/A

36 Reserved

37 HI_HI_LIM

(DD Name:

AI Hi Hi Lim)

Value for upper limit of alarms Max
Value

N/A

38 Reserved

39 HI_LIM

(DD Name:

AI Hi Lim)

Value for upper limit of warnings Max
Value

N/A

40 Reserved

41 LO_LIM

(DD Name:

AI Lo Lim)

Value for lower limit of warnings Min
Value

N/A

42 Reserved

43 LO_LO_LIM

(DD Name:

AI Lo Lo Lim)

Value for the lower limit of alarms Min
Value

N/A

44 Reserved

45 Reserved

46 Reserved

47 Reserved

48 Reserved
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Table F-67: AI function block standard parameters -- definitions, defaults, and range
of values (continued)

Index Parameter

device

information

block

transmitter

data

Definition Default
value

Enumerated list
of values /range

49 Reserved

50 SIMULATE

(DD Name:

AI Simulate)

For commissioning and test purposes
the input value from the Transducer
Block in the Analog Input Function
Block AI-FB can be modified.

Disable N/A

51 Reserved

52 Reserved

53 Reserved

54 Reserved

55 Reserved

56 Reserved

57 Reserved

58 Reserved

59 Reserved

60 Reserved

61 AI BLOCK VIEW1
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Table F-68: AI function block standard parameters -- size, access, and Modbus
register columns

Index Parameter

device

information

block

transmitter

data

Message

type

Data type/
structure

Size Store/
rate
(hz)

Access Modbus

register / coil

26 OUT

(DD Name: AI Out)

RECORD 101 5 D R/W

Can be

written

only in

Manual
Mode.

NA

27 PV_SCALE

(DD Name:

AI PV Scale)

ARRAY Float 8 S R/W NA

28 OUT_SCALE

(DD Name:

AI Out Scale)

RECORD DS-36 11 S R/W R-1509

(Only units)

29 LIN_TYPE

(DD Name:

AI Linearization
Type)

SIMPLE Unsigned8 1 S R/W R-1510

30 CHANNEL

(DD Name:

AI Channel)

SIMPLE Unsigned16 2 S R/W R-1508

31 Reserved

32 PV_FTIME

(DD Name:

AI PV Filter Time)

SIMPLE Float 4 S R/W N/A

33 Reserved

34 Reserved
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Table F-68: AI function block standard parameters -- size, access, and Modbus
register columns (continued)

Index Parameter

device

information

block

transmitter

data

Message

type

Data type/
structure

Size Store/
rate
(hz)

Access Modbus

register / coil

35 ALARM_HYS

(DD Name:

AI Alarm Hys)

SIMPLE Float 4 S R/W N/A

36 Reserved

37 HI_HI_LIM

(DD Name:

AI Hi Hi Lim)

SIMPLE Float 4 S R/W N/A

38 Reserved

39 HI_LIM

(DD Name:

AI Hi Lim)

SIMPLE Float 4 S R/W N/A

40 Reserved

41 LO_LIM

(DD Name:

AI Lo Lim)

SIMPLE Float 4 S R/W N/A

42 Reserved

43 LO_LO_LIM

(DD Name:

AI Lo Lo Lim)

SIMPLE Float 4 S R/W N/A

44 Reserved

45 Reserved

46 Reserved

47 Reserved

48 Reserved
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Table F-68: AI function block standard parameters -- size, access, and Modbus
register columns (continued)

Index Parameter

device

information

block

transmitter

data

Message

type

Data type/
structure

Size Store/
rate
(hz)

Access Modbus

register / coil

49 Reserved

50 SIMULATE

(DD Name:

AI Simulate)

RECORD DS-50 6 S R/W N/A

51 Reserved

52 Reserved

53 Reserved

54 Reserved

55 Reserved

56 Reserved

57 Reserved

58 Reserved

59 Reserved

60 Reserved

61 AI BLOCK VIEW1

F.2.9 Analog input block objects and views
The following tables show the analog input block object and views. There are four AI
blocks.

Analog input block objects

• AI block objects: Table F-69
• AI block view #1: Table F-70
• AI block view #2: Table F-71
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Table F-69: Analog Input block objects

Slot/
Index

Element name Data type Size

in bytes

Value

Slots 1, 2,
3, 5

/Index 16

Reserved Unsigned 8 1 250 (default)

Block_Object Unsigned 8 1 02 (function block)

Parent_Class Unsigned 8 1 01 (input)

Class Unsigned 8 1 01 (AI)

DD_Reference Unsigned 32 4 00 ,00, 00, 00 (reserved)

DD_Revision Unsigned 16 2 00 ,00 (reserved)

Profile Octet string 2 64 02 (compact class B)

Profile_Revision Unsigned 16 2 03 01 (3.01)

Execution_Time Unsigned 8 1 00 (for future use)

Number-Of_Parameters Unsigned 16 2 00 45 (Maximum number of AI
Block Parameters)

Address_of_View_1 Unsigned 16 2
AI1 = 01 61 (slot, index)

AI2 = 02 61 (slot, index)

AI3 = 03 61 (slot, index)

AI4 = 05 61 (slot, index)

Number_of_Views Unsigned 8 1 01 (1 view)

AI function block views

The following tables show the views for the AI block.

Table F-70: AI block view #1 

OD index Parameter mnemonic

-- standard parameters

View 1 View 2 View 3 View 4

16 BLOCK_OBJECT

17 ST_REV 2

18 TAG_DESC

19 STRATEGY

20 ALERT_KEY

21 TARGET_MODE

22 MODE_BLK 3
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Table F-70: AI block view #1 (continued)

OD index Parameter mnemonic

-- standard parameters

View 1 View 2 View 3 View 4

23 ALARM_SUM 8

Overall sum of bytes in View Object 13

Table F-71: AI block view #2 -- standard parameters

OD index Parameter mnemonic

-- standard parameters

View 1 View 2 View 3 View 4

26 Out 5

61 Overall sum of bytes in View Object

(+ 13 Standard parameters bytes)

5 + 13

F.2.10 AO function block parameters
The following tables show the parameters for A0 function block.

A0 standard PA parameters (16-24)

The following tables show the parameters for the A0 standard PA parameters (16-24). The
first table focuses on definitions, default values, and the enumerated list of values allowed
for each parameter, while Table F-73 provides the Modbus register column and other
relevant values.

Table F-72: A0 standard PA parameters -- definitions, defaults, and range of values

Index Parameter

mnemonic

Standard PA

parameters

Definition Default

value

Enumerated list of
values /range

16 BLOCK_OBJECT This object contains the
characteristics of the block.

---- NA

17 ST_REV A block has static block
parameters that are not changed
by the process. Values are
assigned to this parameter
during the configuration of
optimization. The value of
ST_REV increases by 1 after every
change of a static block
parameter.

0 NA
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Table F-72: A0 standard PA parameters -- definitions, defaults, and range of values
(continued)

Index Parameter

mnemonic

Standard PA

parameters

Definition Default

value

Enumerated list of
values /range

18 TAG_DESC Every block can be assigned a
textual TAG description. The
TAG_DESC must be
unambiguous and unique in the
field bus system.

' ' NA

19 STRATEGY Grouping of function block. The
STRATEGY field can be used to
group blocks.

0 NA

20 ALERT_KEY This parameter contains the
identification number of the
plant unit.

0 NA

21 TARGET_MODE This parameter contains desired
mode normally set by a control
application of an operator. The
modes are valid alternatively
only; for example, only one mode
can be set at one time. A write
access to this parameter with
more than one mode is out of the
range of the parameter and has
to be rejected.

AUTO
(0x08) 0x8 -- Auto

0x10 – Manual

0x80

– Out of Service

22 MODE_BLK This parameter contains the
current mode and the permitted
and normal mode of the block.

--- NA

23 ALARM_SUM This parameter contains the
current states of the block
alarms.

0,0,0,0 NA

24 BATCH This parameter is intended to be
used in Batch applications in line
with IEC 61512Part1. Only
Function Blocks carry this
parameter. There is no algorithm
necessary within a Function
Block.

0,0,0,0 NA
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Table F-73: A0 standard PA parameters -- size, access, and Modbus register columns

Index Parameter

mnemonic

Standard PA

parameters

Message

type

Data type/

structure

Size Store/
rate

(hz)

Access Modbus

register / coil

16 BLOCK_OBJECT RECORD DS-32 20 Cst R NA

17 ST_REV SIMPLE Unsigned16 2 N R NA

18 TAG_DESC SIMPLE OCTET
STRING

32 S R/W NA

19 STRATEGY SIMPLE Unsigned16 2 S R/W NA

20 ALERT_KEY SIMPLE Unsigned8 1 S R/W NA

21 TARGET_MODE SIMPLE Unsigned8 1 S R/W R-2295

22 MODE_BLK RECORD DS-37 3 D R R-2296

23 ALARM_SUM RECORD DS-42 8 D R NA

24 BATCH RECORD DS-67 10 S R/W NA

A0 function block standard PA parameters (25-61)

The following tables show the parameters for the A0 standard PA parameters (25-61). The
first table focuses on definitions, default values, and the enumerated list of values allowed
for each parameter, while Table F-75 provides the Modbus register column and other
relevant values.

Table F-74: A0 function block standard parameters -- definitions, defaults, and range
of values

Index Parameter

information

A0 function
block

standard

parameters

Definition Default

value

Enumerated list of values /range

25 SP

(DD Name:

AO Set Point)

Set point ---- NA

26 Reserved
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Table F-74: A0 function block standard parameters -- definitions, defaults, and range
of values (continued)

Index Parameter

information

A0 function
block

standard

parameters

Definition Default

value

Enumerated list of values /range

27 PV_SCALE

(DD Name:

AO PV Scale)

Conversion of the
PV in engineering
units to PV in
percent as the
input value of the
Function Block.

100, .00% NA

28 READBACK

(DD Name:

AO ReadBack

Value)

The actual
position of the
final control
element within
the travel span
(between OPEN
and CLOSE
position) in units
of PV_SCALE.

---- NA

29 Reserved

30 Reserved

31 Reserved

32 Reserved

33 Reserved

34 Reserved

35 Reserved

36 Reserved

37 IN_CHANNEL

(DD Name:

AO IN Channel)

Reference to the
active Transducer
Block and its
parameter that
provides the
actual position of
the final control
element.

--- N/A
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Table F-74: A0 function block standard parameters -- definitions, defaults, and range
of values (continued)

Index Parameter

information

A0 function
block

standard

parameters

Definition Default

value

Enumerated list of values /range

38 OUT

_CHANNEL

(DD Name:

AO OUT

Channel)

Reference to the
active Transducer
Block and its
parameter that
provides the
position value for
the final control
element.

---- N/A

39 FSAFE_TIME

(DD Name:

AO Fail Safe

Time)

Time in seconds
from detection of
failure of the
actual used set
point (SP = BAD or
RCAS_IN <>
GOOD) to the
action of the
block if the
condition still
exists.

0 N/A
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Table F-74: A0 function block standard parameters -- definitions, defaults, and range
of values (continued)

Index Parameter

information

A0 function
block

standard

parameters

Definition Default

value

Enumerated list of values /range

40 FSAFE_TYPE

(DD Name:

AO Fail Safe

Type)

Defines reaction
of the device, if a
failure of the
actual used set
point is still
detected after
FSAFE_TIME or if
the status of
actual used set
point is Initiate
FailSafe.

2

0: value FSAFE_VALUE is used

as set point status

of OUT = UNCERTAIN

– Substitute Value

1: use last valid set point status

of OUT = UNCERTAIN –

Last usable Value or B–D –

No communication, no LUV

2: actuator goes to fail-safe
position

defined by ACTUATOR_ACTION

(only useful for actuators with
spring return)

status of OUT = B–D – non specific

41 FSAFE_VALUE

(DD Name:

AO Fail Safe

Value)

Set point is used if
FSAFE_TYPE = 1
and FSAFE is
activated.

0 N/A

42 Reserved

43 Reserved

44 Reserved

45 Reserved

46 Reserved
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Table F-74: A0 function block standard parameters -- definitions, defaults, and range
of values (continued)

Index Parameter

information

A0 function
block

standard

parameters

Definition Default

value

Enumerated list of values /range

47 POS_D

(DD Name:

AO POS_D)

The current
position of the
valve

---
0: not initialized

1: closed

2: opened

3: intermediate

48 Reserved

49 CHECK_BACK

(DD Name:

AO Check
Back)

Detailed
information of the
device, bitwise
coded. More than
one message is
possible at once.

----- N/A

50 CHECK_BACK_
MASK

(DD Name:

AO Check Back

Mask)

Definition of
supported
CHECK_BACK
information bits.

---
0: not supported

1: supported

51 SIMULATE

(DD Name:

AO Simulate)

For
commissioning
and maintenance
reasons, it is
possible to
simulate the
READBACK by
defining the value
and the status.

Disabled N/A
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Table F-74: A0 function block standard parameters -- definitions, defaults, and range
of values (continued)

Index Parameter

information

A0 function
block

standard

parameters

Definition Default

value

Enumerated list of values /range

52 INCREASE

_CLOSE

(DD Name:

AO Increase

Close)

Direction of
positioned in
mode Rcas and
Auto

0
0: rising

(increasing of set point input
results

in OPENING of the valve)

1: falling

(increasing of set point input
results

in CLOSING of the valve)

53 OUT

(DD Name:

AO Out)

This parameter is
the process
variable of the AO
Block in
engineering units
in AUTO mode
and is the value
specified by the
operator in
Manual mode.

---- N/A

54 OUT_SCALE

(DD Name: AO

Out Scale)

Scale of the

Process Variable.

--- N/A

55 Reserved

56 Reserved

57 Reserved

58 Reserved

59 Reserved

60 Reserved

61 Reserved

62 Reserved
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Table F-74: A0 function block standard parameters -- definitions, defaults, and range
of values (continued)

Index Parameter

information

A0 function
block

standard

parameters

Definition Default

value

Enumerated list of values /range

63 Reserved

64 Reserved

65 AO BLOCK
VIEW1

Table F-75: A0 function block standard parameters -- size, access, and Modbus
register columns

Index Parameter

information

A0 function
block

standard

parameters

Message

type

Data type/

structure

Size Store/
rate

(hz)

Access Modbus

register /
coil

25 SP

(DD Name: AO
Set Point)

RECORD 101 5 D R/W NA

26 Reserved

27 PV_SCALE

(DD Name: AO
PV Scale)

RECORD DS-36 11 S R/W R-2298

(Only units)

28 READBACK

(DD Name: AO
Readback Value)

RECORD 101 5 D R NA

29 Reserved

30 Reserved

31 Reserved

32 Reserved

33 Reserved

34 Reserved
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Table F-75: A0 function block standard parameters -- size, access, and Modbus
register columns (continued)

Index Parameter

information

A0 function
block

standard

parameters

Message

type

Data type/

structure

Size Store/
rate

(hz)

Access Modbus

register /
coil

35 Reserved

36 Reserved

37 IN_CHANNEL

(DD Name: AO IN
Channel)

SIMPLE Unsigned16 2 S R/W R-2297

38 OUT_CHANNEL

(DD Name: AO
OUT Channel)

SIMPLE Unsigned16 2 S ----
R-2275 --

AO Out

Channel

R-2299 --

AO Out
Scale

Units

R2298 --

AO PV

Scale
Units

39 FSAFE_TIME

(DD Name: AO
Fail Safe Time)

SIMPLE Float 4 S R/W N/A

40 FSAFE_TYPE

(DD Name: AO
Fail Safe Type)

SIMPLE Unsigned8 1 S R/W N/A

41 FSAFE_VALUE

(DD Name: AO
Fail Safe Value)

SIMPLE Float 4 S R/W N/A

42 Reserved

43 Reserved
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Table F-75: A0 function block standard parameters -- size, access, and Modbus
register columns (continued)

Index Parameter

information

A0 function
block

standard

parameters

Message

type

Data type/

structure

Size Store/
rate

(hz)

Access Modbus

register /
coil

44 Reserved

45 Reserved

46 Reserved

47 POS_D

(DD Name:

AO POS_D)

RECORD 102 2 D R N/A

48 Reserved

49 CHECK_BACK

(DD Name: AO
Check Back)

SIMPLE Octet String 3 D R N/A

50 CHECK_BACK

_MASK

(DD Name: AO

Check Back
Mask)

SIMPLE Octet String 3 Cst R N/A

51 SIMULATE

(DD Name: AO

Simulate)

RECORD DS-50 6 S R/W N/A

52 INCREASE

_CLOSE

(DD Name: AO

Increase Close)

SIMPLE Unsigned8 1 S R/W N/A

53 OUT

(DD Name:

AO Out)

RECORD 101 5 D R/W

(Can be

written

only in

Manual

Mode.

N/A
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Table F-75: A0 function block standard parameters -- size, access, and Modbus
register columns (continued)

Index Parameter

information

A0 function
block

standard

parameters

Message

type

Data type/

structure

Size Store/
rate

(hz)

Access Modbus

register /
coil

54 OUT_SCALE

(DD Name: AO

Out Scale)

RECORD DS-36 11 S R/W N/A

55 Reserved

56 Reserved

57 Reserved

58 Reserved

59 Reserved

60 Reserved

61 Reserved

62 Reserved

63 Reserved

64 Reserved

65 AO BLOCK VIEW1

F.2.11 Analog output block objects and views
The following tables show the AO block object and views. There are two AO blocks, with
separate slot assignments.

Analog blocks 1 and 2 output block object

• AO block objects: Table F-76
• AO block in channel values (slots) Table F-77
• AO block out channel values (slots) Table F-78
• AO block view #1: Table F-79
• AO block view #2: Table F-80
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Table F-76: Analog Output blocks 1 and 2 block object

Slot/
Index

Element name Data type Size

in

bytes

Value

Slot 9

/Index 16

Reserved Unsigned 8 1 250 (default)

Block_Object Unsigned 8 1 02 (function block)

Parent_Class Unsigned 8 1 02 (output)

Class Unsigned 8 1 01 (AO)

DD_Reference Unsigned 32 4 00 ,00, 00, 00 (reserved)

DD_Revision Unsigned 16 2 00 ,00 (reserved)

Profile Octet string 2 64 02 (compact class B)

Profile_Revision Unsigned 16 2 03 01 (3.01)

Execution_Time Unsigned 8 1 00 (for future use)

Number-Of_Parameters Unsigned 16 2 00 49 (Maximum number of
AO1 Block Parameters)

Address_of_View_1 Unsigned 16 2
AO1 = 09 65 (slot, index)

AO2 = 10 65 (slot, index)

Number_of_Views Unsigned 8 1 01 (1 view)

AO block channel assignments

Table F-77: AO block In channel values

In channel slot In channel index In channel value Corresponding TB process variable

11 (0x0B) 29(0x1D) 0x0B1D Temperature

11 (0x0B) 114(0x72) 0x0B72 Pressure

Table F-78: AO block out channel values

Out channel slot Out channel slot Out channel slot Corresponding TB process variable

11 (0x0B) 111(0x6F) 0x0B6F Temperature

11 (0x0B) 113(0x71) 0x0B71 Pressure

AO function block views

The following tables show the views for the AO block.
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Table F-79: AO block view #1 

OD index Parameter mnemonic

-- standard parameters

View 1 View 2 View 3 View 4

16 BLOCK_OBJECT

17 ST_REV 2

18 TAG_DESC

19 STRATEGY

20 ALERT_KEY

21 TARGET_MODE

22 MODE_BLK 3

23 ALARM_SUM 8

Overall sum of bytes

in View Object

13

Table F-80: AO block view #2 -- standard parameters

OD index Parameter mnemonic

-- standard parameters

View 1 View 2 View 3 View 4

28 READBACK 5

47 POS_D 2

49 CHECK_BACK 3

61 Overall sum of bytes in View Object

(+ 13 Standard parameters bytes)
10+13

F.2.12 Totalizer block parameters
Totalizer standard PA parameters (16-25)

The following tables show the parameters for the Totalizer block standard PA parameters
(16-25). The first table focuses on definitions, default values, and the enumerated list of
values allowed for each parameter, while Table F-82 provides the Modbus register column
and other relevant values.
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Table F-81: Totalizer standard PA parameters -- definitions, defaults, and range of
values

Index Parameter

Mnemonic

Standard PA

Parameters

Definition Default

value

Enumerated list

of values /range

16 BLOCK_OBJECT This object contains the characteristics
of the block.

---- NA

17 ST_REV A block has static block parameters that
are not changed by the process. Values
are assigned to this parameter during
the configuration of optimization. The
value of ST_REV increases by 1 after
every change of a static block
parameter.

0 NA

18 TAG_DESC Every block can be assigned a textual
TAG description. The TAG_DESC must
be unambiguous and unique in the field
bus system.

' ' NA

19 STRATEGY Grouping of function block. The
STRATEGY field can be used to group
blocks.

0 NA

20 ALERT_KEY This parameter contains the
identification number of the plant unit.

0 NA

21 TARGET_MODE This parameter contains desired mode
normally set by a control application of
an operator. The modes are valid
alternatively only; for example, only one
mode can be set at one time. A write
access to this parameter with more than
one mode is out of the range of the
parameter and has to be rejected.

AUTO
(0x08) 0x8 -- Auto

0x10 – Manual

0x80 – Out of
Service

22 MODE_BLK This parameter contains the current
mode and the permitted and normal
mode of the block.

--- NA

23 ALARM_SUM This parameter contains the current
states of the block alarms.

0,0,0,0 NA

24 BATCH This parameter is intended to be used in
Batch applications in line with IEC
61512 Part1. Only Function Blocks carry
this parameter. There is no algorithm
necessary within a Function Block.

0,0,0,0 NA

25 Reserved
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Table F-82: Totalizer standard PA parameters -- size, access, and Modbus register
columns

Index Parameter

Mnemonic

Standard PA

Parameters

Message

type

Data type/
structure

Size Store/
rate
(hz)

Access Modbus

register / coil

16 BLOCK_OBJECT RECORD DS-32 20 S R NA

17 ST_REV SIMPLE Unsigned16 2 N R NA

18 TAG_DESC SIMPLE OCTET
STRING

32 S R/W NA

19 STRATEGY SIMPLE Unsigned16 2 S R/W NA

20 ALERT_KEY SIMPLE Unsigned8 1 S R/W NA

21 TARGET_MODE SIMPLE Unsigned8 1 S R/W R-2287

22 MODE_BLK RECORD DS-37 3 D R R-2288

23 ALARM_SUM RECORD DS-42 8 D R NA

24 BATCH RECORD DS-67 10 S R/W NA

25 Reserved

Totalizer standard parameters (26-53)

The following tables show the parameters for the Totalizer block standard parameters
(26-53). The first table focuses on definitions, default values, and the enumerated list of
values allowed for each parameter, while Table F-84 provides the Modbus register column
and other relevant values.

Table F-83: Totalizer function block standard parameters -- definitions, defaults, and
range of values

Index Parameter

mnemonic

totalizer

function

block standard

parameters

Definition Default

value

Enumerated list

of values /range

26 TOTAL

(DD Name:

TOT Total)

The Function Block
parameter TOTAL
contains the
integrated quantity of
the rate parameter
provided by CHANNEL
and the associated
status.

0 NA
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Table F-83: Totalizer function block standard parameters -- definitions, defaults, and
range of values (continued)

Index Parameter

mnemonic

totalizer

function

block standard

parameters

Definition Default

value

Enumerated list

of values /range

27 UNIT_TOT

(DD Name:

TOT Total Units)

Unit of the totalized
quantity

direct

integral

of the

channel

value unit

NA

28 CHANNEL

(DD Name:

TOT Channel)

Reference to the
active Transducer
Block, which provides
the measurement
value to the Function
Block.

--- NA

29 SET_TOT

(DD Name:

TOT Set Total)

Reset of the internal
value of the FB
algorithm to 0, or set
this value to
PRESET_TOT.

0:

TOTALIZE
0: TOTALIZE

1: RESET

2: PRESET

30 MODE_TOT

(DD Name:

TOT Mode Total)

This Function Block
parameter governs
the behavior of the
totalization.

0:

BALANCED
0: BALANCED

1: POS_ONLY

2: NEG_ONLY

3: HOLD

31 FAIL_TOT

(DD Name:

TOT Fail Total)

Fail-safe mode of the
Totalizer Function
Block. This parameter
governs the behavior
of the Function Block
during the occurrence
of input values with
BAD status.

0: RUN
0: RUN

1: HOLD

2: MEMORY

32 PRESET_TOT

(DD Name:

TOT Preset Total)

This value is used as a
preset for the internal
value of the FB
algorithm. The value is
effective if using the
SET_TOT function.

0 NA
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Table F-83: Totalizer function block standard parameters -- definitions, defaults, and
range of values (continued)

Index Parameter

mnemonic

totalizer

function

block standard

parameters

Definition Default

value

Enumerated list

of values /range

33 ALARM_HYS

(DD Name:

TOT Alarm Hys)

Hysteresis 0 NA

34 HI_HI_LIM

(DD Name:

TOT Hi Hi Lim)

Value for upper limit
of alarms

Max Value NA

35 HI_LIM

(DD Name:

TOT Hi Lim)

Value for upper limit
of warnings

Max Value N/A

36 LO_LIM

(DD Name:

TOT Lo Lim)

Value for lower limit of
warnings

Min Value NA

37 LO_LO_LIM

(DD Name:

TOT Lo Lo Lim)

Value for the lower
limit of alarms

Min Value N/A

38 Reserved

39 Reserved

40 Reserved

41 Reserved

42 Reserved

43 Reserved

44 Reserved

45 Reserved

46 Reserved

47 Reserved

48 Reserved
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Table F-83: Totalizer function block standard parameters -- definitions, defaults, and
range of values (continued)

Index Parameter

mnemonic

totalizer

function

block standard

parameters

Definition Default

value

Enumerated list

of values /range

49 Reserved

50 Reserved

51 Reserved

52 Totalizer

Selection

(DD Name: TOT
Selection)

Selection of Totalizer
operation mode

0
0 – Standard (Profile
Specific)

1 – Internal Mass Total

2 – Internal Volume Total

3 – Internal Mass Inventory

4 – Internal volume
Inventory

5 – Internal GSV Total

6 – Internal GSV Inventory

7 – Internal API CorrVol Total

8 – Internal API CorrVol

Inventory

9 – Internal ED_StdVolTotal

10 – Internal ED_StdVolInv

11 – Internal
ED_NetMassTotal

12 – Internal ED_NetMassInv

13 – Internal
ED_NetVolTotal

14 – Internal ED_NetVolInv

53 TOTALIZER
BLOCK VIEW1
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Table F-84: Totalizer function block standard parameters -- size, access, and Modbus
register columns

Index Parameter

mnemonic

totalizer

function

block standard

parameters

Message

type

Data type/
structure

Size Store/
rate (hz)

Access Modbus

register / coil

26 TOTAL

(DD Name:

TOT Total)

RECORD 101 5 N R/W

Can be
written
only in
Manual
Mode.

NA

27 UNIT_TOT

(DD Name:

TOT Total Units)

SIMPLE Unsigned16 2 S R/W R-2290

28 CHANNEL

(DD Name:

TOT Channel)

SIMPLE Unsigned16 2 S R/W R-2289

29 SET_TOT

(DD Name:

TOT Set Total)

SIMPLE Unsigned8 1 N R/W R-2292

30 MODE_TOT

(DD Name:

TOT Mode Total)

SIMPLE Unsigned8 1 N R/W R-2293

31 FAIL_TOT

(DD Name:

TOT Fail Total)

SIMPLE Unsigned8 1 S R/W N/A

32 PRESET_TOT

(DD Name:

TOT Preset Total)

SIMPLE Float 4 S R/W N/A

33 ALARM_HYS

(DD Name:

TOT Alarm Hys)

SIMPLE Float 4 S R/W N/A
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Table F-84: Totalizer function block standard parameters -- size, access, and Modbus
register columns (continued)

Index Parameter

mnemonic

totalizer

function

block standard

parameters

Message

type

Data type/
structure

Size Store/
rate (hz)

Access Modbus

register / coil

34 HI_HI_LIM

(DD Name:

TOT Hi Hi Lim)

SIMPLE Float 4 S R/W N/A

35 HI_LIM

(DD Name:

TOT Hi Lim)

SIMPLE Float 4 S R/W N/A

36 LO_LIM

(DD Name:

TOT Lo Lim)

SIMPLE Float 4 S R/W N/A

37 LO_LO_LIM

(DD Name:

TOT Lo Lo Lim)

SIMPLE Float 4 S R/W N/A

38 Reserved

39 Reserved

40 Reserved

41 Reserved

42 Reserved

43 Reserved

44 Reserved

45 Reserved

46 Reserved

47 Reserved

48 Reserved

49 Reserved

50 Reserved

51 Reserved
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Table F-84: Totalizer function block standard parameters -- size, access, and Modbus
register columns (continued)

Index Parameter

mnemonic

totalizer

function

block standard

parameters

Message

type

Data type/
structure

Size Store/
rate (hz)

Access Modbus

register / coil

52 Totalizer

Selection

(DD Name:

TOT Selection)

SIMPLE Unsigned8 1 S R/W R-2291

53 TOTALIZER
BLOCK VIEW1

F.2.13 Totalizer block objects and function block views
The following tables show the totalizer block object and views. There are four totalizer
blocks, each with its own slot.

Totalizer block objects

• Totalizer block object: : Table F-85
• Totalizer block view #1: Table F-86
• Totalizer block view #2: Table F-87
• Totalizer block channel assignmnets Table F-88

Table F-85: Totalizer block object

Slot/

Index

Element name Data type Size in
bytes

Value

Slots
04, 06,
07, and
08/

Index
16

Reserved Unsigned 8 1 250 (default)

Block_Object Unsigned 8 1 02 (function block)

Parent_Class Unsigned 8 1 05 (calculation class)

Class Unsigned 8 1 08 (TOT)

DD_Reference Unsigned 32 4 00 ,00, 00, 00 (reserved)

DD_Revision Unsigned 16 2 00 ,00 (reserved)

Profile Octet string 2 64 02 (compact class B)

Profile_Revision Unsigned 16 2 03 01 (3.01)

Execution_Time Unsigned 8 1 00 (for future use)
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Table F-85: Totalizer block object (continued)

Slot/

Index

Element name Data type Size in
bytes

Value

Number-Of_Parameters Unsigned 16 2
00 37 ( Maximum number

of Totalizer Blocks 1-4
Parameters)

Address_of_View_1 Unsigned 16 2 • TOT1 = 04 53 (slot, index)
• TOT2 = 06 53 (slot, index)
• TOT3 = 07 53 (slot, index)
• TOT4 = 08 53 (slot, index)

Number_of_Views Unsigned 8 1 01 (1 view)

Totalizer function block views

The following tables show the totalizer function block views.

Table F-86: Totalizer block view #1

OD index Parameter mnemonic

-- standard parameters

View 1 View 2 View 3 View 4

16 BLOCK_OBJECT

17 ST_REV 2

18 TAG_DESC

19 STRATEGY

20 ALERT_KEY

21 TARGET_MODE

22 MODE_BLK 3

23 ALARM_SUM 8

Overall sum of bytes in View Object 13

Table F-87: Totalizer block view #2

OD index Parameter mnemonic

-- standard parameters

View 1 View 2 View 3 View 4

26 TOTAL
DIAGNOSIS

5

53 Overall sum of bytes in View Object
(+ 13 Standard parameters bytes)

5 + 13
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Table F-88: Totalizer block channel assignments

Channel value Process variable

Slot Index Value

11 (0x0B) 17 (0x11) 0x0B11 Volume flow

11 (0x0B) 21 (0x15) 0x0B15 Mass flow

11 (0x0B) 25 (0x19) 0x0B19 Density

11 (0x0B) 29 (0x1D) 0x0B1D Temperature

11 (0x0B) 64 (0x40) 0x0B40 Gas Standard Volume Flow

11 (0x0B) 114 (0x072 0x0B72 Pressure

11 (0x0B) 160 (0xA0) 0x0BA0 Drive Gain

12 (0x0C) 29 (0x1D) 0x0C1D API Corrected Density

12 (0x0C) 30 (0x1E) 0x0C1E API Corrected Volume Flow

12 (0x0C) 31 (0x1F) 0x0C1F API Average Corrected Density

12 (0x0C) 32 (0x20) 0x0C20 API Average Corrected Temp

12 (0x0C) 33 (0x21) 0x0C21 API CTL

12 (0x0C) 47 (0x2F) 0x0C2F ED Reference Density

12 (0x0C) 48 (0x30) 0x0C30 ED Specific Gravity

12 (0x0C) 49 (0x31) 0x0C31 ED Standard Volume Flow

12 (0x0C) 50 (0x32) 0x0C32 ED Net Mass Flow

12 (0x0C) 51 (0x33) 0x0C33 ED Net Volume Flow

12 (0x0C) 52 (0x34) 0x0C34 ED Concentration

12 (0x0C) 53 (0x35) 0x0C35 ED Baume
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G NE53 history
This appendix documents the change history of the Model 2700 transmitter with
PROFIBUS-PA software.

The following table describes the change history of the transmitter software. Operating
instructions are English versions. Instructions in other languages have different part
numbers but matching revision letters.

Table G-1: Transmitter software change history

Date Software
version

Type Change Document

revision

09/2000 1.0 Initial release NA 20000327

Rev. A

08/2001 1.1 Software

improvements

Expanded the ability to control
totalizers through multiple
communication protocols

20000327

Rev. B

02/2002 2.0 Software

improvements

• Improved the handling of
RS-485 communication via the
service port

• Improved the user experience
with the display

• Expanded the ability to control
totalizers through multiple
communication protocols

• Tightened data
synchronization when
accessing data via different
communication tools.

• Enhanced volume flow
functionality

20000327

Rev. C

20000327

Rev. C

through
20000327

Rev. D

20000327

Rev. C

through
20000327

Rev. E

Feature

additions

Expanded the ability to control
totalizers through multiple
communication protocols

08/2008 2.2 Software

improvements

• Improved the user experience
with the display

• Increased immunity to line
noise

20000327

Rev. F
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Table G-1: Transmitter software change history (continued)

Date Software
version

Type Change Document

revision

Feature

additions

• Added drive gain as an Analog
Input channel

• Added the ability to configure
blocks without putting them in
Out of Service mode.

• Added improved diagnostic
reporting.

• Added density cutoffs

10/2009 3.0 Software

improvements

• Improved EDD more closely
matches ProLink III

• Added petroleum
measurement application

• Added enhanced density
application

• Improved consistency with
other Micro Motion 2700
transmitters

20000327

Rev. FA

Feature

additions

• Added compatibility with
enhanced core processor

• Added gas standard volume
measurement.

• Added configurable alarm
severity

• Added meter verification
• Expanded LDO capability

10/2010 3.1 Feature

additions

• Added support for Smart
Meter Verification

• Expanded LDO capability

20000327

Rev. FB

10/2010 3.2 Software

improvements

• Maintenance release 20000327

Rev. FB

07/2016 4.0 Software

improvements

• Added support to configurable
preambles

• Added alarm A106
• Moved some parameters from

Transducer Block 1 to
Transducer Block 2 per the
PROFIBUS specification since
they were mapped to reserved
indexes.

20000327

Rev. FC

Feature

additions

• Added special unit support
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Table G-1: Transmitter software change history (continued)

Date Software
version

Type Change Document

revision

08/2017 4.0 Feature

additions

• Added index entries in "
Transducer block 1:
standard flow parameters
(8-30)".

• The R48 register has been
mapped to Serial Number
(Index 28 DEVICE_SER_NUM)
in Physical Block Parameters.

20000327

Rev. FD

Configuration and Use Manual  NE53 history
20000327 October 2018

Configuration and Use Manual  393



*20000327*
20000327

Rev. FD
2018

Micro Motion Inc. USA
Worldwide Headquarters
7070 Winchester Circle
Boulder, Colorado USA 80301
T +1 303-527-5200
T +1 800-522-6277
F +1 303-530-8459
www.emerson.com

Micro Motion Europe
Emerson Automation Solutions
Neonstraat 1
6718 WX Ede
The Netherlands
T +31 (0) 70 413 6666
F +31 (0) 318 495 556
www.micromotion.nl

Micro Motion Asia
Emerson Automation Solutions
1 Pandan Crescent
Singapore 128461
Republic of Singapore
T +65 6363-7766
F +65 6770-8003

Micro Motion United Kingdom
Emerson Automation Solutions
Emerson Process Management Limited
Horsfield Way
Bredbury Industrial Estate
Stockport SK6 2SU U.K.
T +44 0870 240 1978
F +44 0800 966 181

©2018 Micro Motion, Inc. All rights reserved.

The Emerson logo is a trademark and service mark of Emerson Electric Co. Micro Motion, ELITE,
ProLink, MVD and MVD Direct Connect marks are marks of one of the Emerson Automation
Solutions family of companies. All other marks are property of their respective owners.

http://www.emerson.com
http://www.micromotion.nl

	Contents
	1 Before you begin
	1.1 About this manual
	1.2 Transmitter model code
	1.3 Profibus-PA functionality
	1.4 Determining version information
	1.5 Communication tools
	1.6 Additional documentation and resources

	2 Startup
	2.1 Applying power
	2.2 Setting the node address
	2.3 Setting the IO mode
	2.3.1 Overriding the status byte format

	2.4 Make a startup connection to the transmitter
	2.5 Verify the zero
	2.5.1 Terminology used with zero verification and zero calibration


	3 Introduction to configuration and commissioning
	3.1 Planning the configuration
	3.2 Pre-configuration worksheet
	3.3 Restoring a working configuration

	4 Configuration
	4.1 Overview
	4.2 Default target mode
	4.3 Configuration map
	4.4 Configuring the analog input function block channels
	4.5 Configuring the totalizer block mode
	4.6 Configuring standard volume flow measurement for gas
	4.6.1 Enabling and configuring gas standard volume

	4.7 Changing the measurement units
	4.8 Configuring the petroleum measurement application
	4.8.1 About the petroleum measurement application
	4.8.2 Configuring for petroleum measurement

	4.9 Configuring the concentration measurement application
	4.9.1 About the concentration measurement application
	4.9.2 Configuring for concentration measurement

	4.10 Changing the output scale
	4.11 Changing process alerts
	4.11.1 Changing alert values
	4.11.2 Changing alert hysteresis

	4.12 Configuring alert status severity
	4.13 Changing the damping values
	4.13.1 Damping and volume measurement

	4.14 Changing two-phase flow (slug flow) limits and duration
	4.15 Configuring cutoffs
	4.16 Changing the measurement mode parameter
	4.17 Configuring sensor parameters
	4.18 Configuring the display
	4.18.1 Guidelines for setting the scroll rate
	4.18.2 Guidelines for setting the update period
	4.18.3 Guidelines for setting the off-line password
	4.18.4 Guidelines for setting the display language
	4.18.5 Changing the display variables and precision

	4.19 Enabling LD optimization
	4.20 Configuring pressure compensation
	4.20.1 Pressure Compensation Values
	4.20.2 Enabling pressure compensation
	4.20.3 Configuring a pressure source

	4.21 Configuring temperature compensation
	4.21.1 Enabling Temperature Compensation
	4.21.2 Configuring a temperature source


	5 Configure device options and preferences
	5.1 Configure the transmitter display
	5.1.1 Configure the language used for the display
	5.1.2 Configure the process variables and diagnostic variables shown on the display
	5.1.3 Configure the number of decimal places (precision) shown on the display
	5.1.4 Configure the refresh rate of data shown on the display
	5.1.5 Enable or disable automatic scrolling through the display variables
	5.1.6 Enable or disable the display backlight
	5.1.7 Enable or disable Status LED Blinking

	5.2 Enable or disable operator actions from the display
	5.2.1 Enable or disable​ Totalizer Start/Stop from the display
	5.2.2  Enable or disable​ Totalizer Reset from the display
	5.2.3 Enable or disable the Acknowledge All Alerts display command

	5.3 Configure security for the display menus
	5.4 Configure alert handling
	5.4.1 Configure Fault Timeout
	5.4.2 Configure Status Alert Severity
	Status alerts and options for Status Alert Severity


	5.5 Configure informational parameters
	5.5.1 Configure Sensor Serial Number
	5.5.2 Configure Sensor Material
	5.5.3 Configure Sensor Liner Material
	5.5.4 Configure Sensor Flange Type
	5.5.5 Configure Descriptor


	6 Complete the configuration
	6.1 Test or tune the system using sensor simulation
	6.1.1 Sensor simulation

	6.2 Back up transmitter configuration

	7 Transmitter operation
	7.1 Record the process variables
	7.2 Viewing process variables
	7.3 I&M functions
	7.4 Using sensor simulation mode
	7.5 Accessing diagnostic information with a PROFIBUS host
	7.6 Viewing transmitter status and alerts
	7.7 View and acknowledge status alerts
	7.7.1 View and acknowledge alerts using the display
	7.7.2 View and acknowledge alerts using ProLink III
	7.7.3 Alert data in transmitter memory

	7.8 Using the totalizers and inventories
	7.8.1 Viewing current values for totalizers and inventories

	7.9 Read totalizer and inventory values
	7.10 Start and stop totalizers and inventories
	7.10.1 Start and stop totalizers and inventories using the display

	7.11 Reset totalizers
	7.11.1 Reset totalizers using the display

	7.12 Reset inventories

	8 Measurement support
	8.1 Options for measurement support
	8.2 Calibration
	8.3 Comparison and recommendations
	8.4 Use Smart Meter Verification (SMV)
	8.4.1 SMV requirements
	8.4.2 SMV test preparation
	8.4.3 Run SMV
	Run an SMV test using the display
	SMV flowchart: Running a test using the display

	Run an SMV test using ProLink III​

	8.4.4 View test data
	View test result data using the display
	SMV flowchart: Viewing test results using the display

	View test result data using ProLink III​
	Understanding SMV results

	8.4.5 Schedule automatic execution of the SMV test
	Manage scheduled test execution using the display
	SMV flowchart: Scheduling test execution using the display

	Manage scheduled test execution using ProLink III​


	8.5 Zero the meter
	8.5.1 Performing the zeroing procedure

	8.6 Meter validation and meter factors
	8.6.1 Performing meter validation

	8.7 Performing density calibration
	8.7.1 Procedure for calibrating density


	9 Troubleshooting
	9.1 Guide to troubleshooting topics
	9.2 Transmitter does not operate
	9.3 Transmitter does not communicate
	9.4 Function blocks in OOS mode
	9.5 Zero or calibration failure
	9.6 Output problems
	9.7 Status alerts
	9.8 Diagnosing wiring problems
	9.9 Checking two-phase flow (slug flow)
	9.10 Obtaining and checking the diagnostic variables
	9.11 Checking the core processor
	9.12 Checking sensor coils and RTD
	9.12.1 4-wire remote or integral installation
	Reinstalling the core processor



	A Flow meter installation types and components
	B Using the transmitter display
	B.1 Components of the transmitter interface
	B.2 Use the optical switches
	B.3 Access and use the display menu system
	B.3.1 Enter a floating-point value using the display
	B.3.1 Enter a floating-point value using decimal notation
	B.3.1 Enter a floating-point value using exponential notation


	B.4 Display codes for process variables
	B.5 Codes and abbreviations used in display menus
	B.6 Display menus

	C Using ProLink III with the transmitter
	C.1 Basic information about ProLink III
	C.2 Connect with ProLink III
	C.2.1  Connection types supported by ProLink III​
	C.2.2 Connect with ProLink III​ to the service port


	D PROFIBUS-PA status byte
	E Slave diagnostic response bytes
	F Model 2700 PROFIBUS block parameters
	F.1 Slot identification
	F.2 Physical block
	F.2.1 Physical block object and views
	F.2.2 Transducer block 1 (measurement, calibration, and diagnosis)
	F.2.3 Transducer block 1: diagnostic block
	F.2.4 Transducer block 1 object and views
	F.2.5 Transducer block 2 (device information, API, CM) parameters
	F.2.6 Transducer block 2 object and views
	F.2.7 I & M functions
	F.2.8 Analog Input (AI) function block parameters
	F.2.9 Analog input block objects and views
	F.2.10 AO function block parameters
	F.2.11 Analog output block objects and views
	F.2.12 Totalizer block parameters
	F.2.13 Totalizer block objects and function block views


	G NE53 history

